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Overview
Welcome to the Generative Structural Analysis User's Guide. This guide is intended for users
who need to become quickly familiar with the Generative Structural Analysis Version 5
workbench.
This overview provides the following information:
●

Generative Structural Analysis in a Nutshell

●

Before Reading this Guide

●

Getting the Most Out of this Guide

●

Accessing Sample Documents

●

Conventions Used in this Guide

Generative Structural Analysis in a Nutshell
Generative Structural Analysis

allows you to rapidly perform first order mechanical

analysis for 3D systems.
This workbench is composed of the following products:
●

●

●

●

The Generative Part Structural Analysis (GPS) product is intended for the casual user.
Indeed, its intuitive interface offers the possibility to obtain mechanical behavior information
with very few interactions. The dialog boxes are self explanatory and require practically no
methodology, all defining steps being commutative.
The ELFINI Structural Analysis (EST) product is a natural extensions of both above
mentioned products, fully based on the V5 architecture. It represents the basis of all future
mechanical analysis developments.
The Generative Assembly Structural Analysis (GAS) product has been designed as an
integrated extension to Generative Part Structural Analysis enabling the study of the
mechanical behavior of a whole assembly. The product has been conceived with the same
"easy to learn" and "fun to use" ergonomics principles.
The Generative Dynamic Analysis (GDY) product will let you work in a dynamic response
context.
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The Generative Structural Analysis User's Guide has been designed to show you how to analyze
a system consisting of single parts or of assemblies of parts, operating within a specified
environment. There are several ways for undergoing a part to external actions.

Before Reading this Guide
Before reading this guide, the user should be familiar with the basic Version 5 concepts such as
document windows, standard and view toolbars. We therefore recommend that you read the
Infrastructure User's Guide that describes generic capabilities common to all Version 5 products.
We also recommend that you read the Finite Element Reference Guide.
You may also like to read the following complementary product guides, for which the appropriate
license is required:
●

Part Design User's Guide

●

Assembly Design User's Guide

●

Real Time Rendering User's Guide

●

Generative Shape Design, Optimizer, Developed Shapes & BiW Design User's Guide

●

Automotive Body in White Fastening User's Guide

Getting the Most Out of this Guide
To get the most out of this guide, we suggest that you start performing the step-by-step Getting
Started section.
Once you have finished, you should move on to the User Tasks section.
At any time, you can access the Frequently Asked Questions section and the Reference
Information section.
The Workbench Description section, which describes the Generative Structural Analysis
workbench, and the Customizing section, which explains how to set up the options, will also
certainly prove useful.
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Accessing Sample Documents
To perform the scenarios, you will be using sample documents contained in the
online/estug/samples folder.
For more information about this, please refer to Accessing Sample Documents in the
Infrastructure User's Guide.

Conventions Used in this Guide
To learn more about the conventions used in this guide, please refer to Conventions section.
In addition to these conventions, you can find the following icons in the Generative Structural
Analysis User's Guide:

This icon ...

Means that the functionality is only available with ...

the ELFINI Structural Analysis (EST) product

the Generative Assembly Structural Analysis (GAS) product

the Generative Dynamic Analysis (GDY) product
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Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and
understand important concepts and specifications.

Graphic Conventions
The three categories of graphic conventions used are as follows:
●

Graphic conventions structuring the tasks

●

Graphic conventions indicating the configuration required

●

Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks
Graphic conventions structuring the tasks are denoted as follows:
This icon...

Identifies...
estimated time to accomplish a task
a target of a task
the prerequisites
the start of the scenario
a tip
a warning
information
basic concepts
methodology
reference information
information regarding settings, customization, etc.
the end of a task
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functionalities that are new or enhanced with this release
allows you to switch back to the full-window viewing mode

Graphic Conventions Indicating the Configuration Required
Graphic conventions indicating the configuration required are denoted as follows:
This icon...

Indicates functions that are...
specific to the P1 configuration
specific to the P2 configuration
specific to the P3 configuration

Graphic Conventions Used in the Table of Contents
Graphic conventions used in the table of contents are denoted as follows:
This icon...

Gives access to...
Site Map
Split View mode
What's New?
Overview
Getting Started
Basic Tasks
User Tasks or the Advanced Tasks
Workbench Description
Customizing
Reference
Methodology
Glossary
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Index

Text Conventions
The following text conventions are used:
●

The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●

File -> New identifies the commands to be used.

●

Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse
The use of the mouse differs according to the type of action you need to perform.
Use this
mouse button... Whenever you read...

●

●

Select (menus, commands, geometry in graphics area, ...)
Click (icons, dialog box buttons, tabs, selection of a location in the document
window, ...)

●

Double-click

●

Shift-click

●

Ctrl-click

●

Check (check boxes)

●

Drag

●

Drag and drop (icons onto objects, objects onto objects)

●

Drag

●

Move

●

Right-click (to select contextual menu)
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What's New?
New Functionalities
Model Manager
Importing Composite Property
You can import a composite property.
Creating a User Material
You can create a user material in the analysis context.
Modifying Material Physical Properties
You can modify physical properties of a material.
Changing Element Type
You can change the type of 1D and 2D elements.

Groups
Creating Point Group by Neighborhood
You can create a proximity point group.
Creating Line Group by Neighborhood
You can create a proximity line group.
Creating Surface Group by Neighborhood
You can create a proximity surface group.

Analysis Connections
Surface Analysis Connection
You can create a surface analysis connection (adhesive connection).
Surface Analysis Connection within one Part
You can create a surface analysis connection (adhesive connection) within one part.

Connection Properties
Surface Weld Connection Properties
You can create a surface weld connection property.

Analysis Assembly
About Analysis Assembly
Give general information about the Analysis Assembly context.
Methodology
Methodology in assembly analysis.
Analysis Assembly 2D Viewer
Gives you the analysis document structure.
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Loads
Importing Temperature Field from Thermal Solution
Import temperature from thermal solution.

Sensors
Integration with Product Engineering Optimization
Gives you information about the analysis sensors used in the derivatives computation.

Interoperability
Analysis Impact Graph
Gives you information about the Impact Graph of Analysis document.
Synchronizing Analysis Document with Versioned Parts or Products
Gives you information about the synchronization of analysis document with versioned parts or
products.

Enhanced Functionalities
Model Manager
Creating 1D Mesh Part
The Beam Meshing dialog box has been enhanced.
Creating 1D Properties
Two new options as Section type: Beam from surface and Bar.
Editing User Isotropic Materials
You can only edit user isotropic materials that have been created in a previous release.
Associativity
Free groups and proximity groups are allowed as support.

Analysis Connections
General Analysis Connection
Mesh part filter is available.
Point Analysis Connection
Mesh part filter is available.
Point Analysis Connection within one Part
Mesh part filter is available.
Line Analysis Connection
You can define the connection orientation (curve-curve connection).
Mesh part filter is available.
Line Analysis Connection within one Part
You can define the connection orientation (curve-curve connection).
Mesh part filter is available.
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Restraints
Associativity
Free groups and proximity groups are allowed as support.

Loads
Associativity
Free groups and proximity groups are allowed as support.
Bearing Load
You can choose the distribution orientation.

Masses
Associativity
Free groups and proximity groups are allowed as support.

Results Visualization
Images Layout
You can define a distance between two images to enhance the visualization.
Editing Images
The Image Edition dialog box has been enhanced.
Generating Images
New images are available under the analysis solution and the properties set.
Generating 2D Display Visualization
The 2D Display for dynamic solutions has been enhanced.
The edition of the 2D Display parameters has been enhanced.

Customizing Settings
Post-processing
You can now deactivate the automatic preview mode in the image edition functionality.
External Storage
Option names have been changed.
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Getting Started
This tutorial will guide you step-by-step through your first ELFINI and Generative Part Structural
Analysis session, allowing you to get acquainted with the product. You just need to follow the
instructions as you progress.

Entering the Generative Structural Analysis Workbench
Creating a Surface Slider Restraint
Creating a Distributed Force Load
Computing a Static Case Solution
Viewing Displacements Results
Inserting a Frequency Analysis Case
Creating an Iso-static Restraint
Creating a Non-Structural Mass
Computing a Frequency Case Solution
Viewing Frequency Results

These tasks should take about 20 minutes to complete.
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Entering the Generative Structural Analysis
Workbench
This first task will show you how to load a .CATPart document (and display the
corresponding specification tree) by entering the Generative Structural Analysis workbench
and defining that you will create a Static Analysis case.
Creating a static analysis case means that you will analyze the static boundary conditions
of the CATAnalysis document one after the other.
Before you begin:
●

Note:
In this example, a material has been previously assigned to the part you will open. In
the case no material has been previously assigned to the part, before entering the
Generative Structural Analysis workbench, you should proceed as follows:

1. Select the part in the specification tree.
2. Click the Apply Material icon

.

The Material library appears.
3. Select a material family, then select the desired material from the displayed list,
then click OK.
The material is applied.
You can visualize the material properties and its analysis characteristics by selecting the
material in the specification tree and using Edit -> Properties -> Analysis.
If you select Start->Analysis & Simulation -> Generative Structural Analysis from a
CATPart document containing a part without any material assigned, the material library will
appear directly for an easy material selection.
●

Warning:
Avoid having CATAnalysis documents automatically saved. For this, go to Tools>Options->General (menu bar) and select the No automatic backup option.
Otherwise, on some models, each computation will be followed by a Save operation,
thus making temporary data become persistent data.
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1. Open the CATPart Document.

For this, select File -> Open, then select the desired .CATPart file.
In this tutorial, you will open CATPart named sample01.CATPart.
This opens a Part Design document containing the selected part.

2. Define the View Mode.

For this, select the View -> Render Style -> Customize View menu.
The Custom View Modes dialog appears: activate the Shading option and then the
Materials option in the Custom View Modes dialog box.
3. Enter Generative Structural Analysis Workbench.

Select Start -> Analysis & Simulation -> Generative Structural Analysis
from the menu bar.
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The New Analysis Case dialog box appears with Static Analysis as default option.

❍

❍

❍

❍

Static Analysis means that you will analyze the static boundary conditions of
the CATAnalysis document one after the other.
Frequency Analysis means that you will analyze the dynamic boundary
conditions of the CATAnalysis document .
Free Frequency Analysis means that you will analyze the buckling dynamic
conditions of the CATAnalysis document.
Keep as default starting analysis case means that when you next open the
Generative Structural Analysis workbench from the menu bar, the selected
case appears as default.

4. Select an Analysis Case type in the New Analysis Case dialog box.

In this particular case, also keep Static Analysis type selected.
5. Click OK in the New Analysis Case dialog box to enter the workbench.
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The CATAnalysis document now opens. It is named Analysis1. You will now
perform different operations in this document.
A link exist between the CATPart and the CATAnalysis document.

Double-clicking on the green symbol allows displaying mesh specifications or setting
meshing parameters.
The standard structure of the Analysis specification tree is displayed.
As you can see below, the Finite Element Model contains a Static Case, which contains
empty Restraints and Loads objects sets, along with an empty Static Case Solution.1
object set. All along this tutorial, you will assign a Restraint and a Load to the CATAnalysis
document and then compute the Static Case Solution.
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Creating a Surface Slider Restraint
This task will show you how to restrain several faces of your part in such a way that it can
only slide along their tangent planes (geometry supports). You will create a surface slider
restraint on a Finite Element Model containing a Static Analysis Case.

1. Select the Restraints.1 object in the specification tree to make it active.

2. Click the Surface Slider icon

.

The Surface Slider dialog box appears.

3. Select in sequence the four faces as indicated.
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Symbols representing the surface sliders appear as you select the four faces. The
elements supporting the surface slider are automatically displayed in the Surface
Slider dialog box.

4. Click OK in the Surface Slider dialog box to actually create this surface slider.

In the specification tree, the Surface Slider.1 object has been inserted under the
Restraints.1 object.
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Creating a Distributed Force Load
This task will show you how to distribute on a face of your part a resultant force. You will create a Distributed
Force on a Finite Element Model containing a Static Analysis Case.

1. Select the Loads.1 object in the specification tree to make it active.

2. Select the Distributed Force icon

.

The Distributed Force dialog box appears.

You will distribute on a face of your part a resultant force of 50N parallel to the global z-direction
applied at the centroid of the face. For this:
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3. Enter -50N value in Z field (Force Vector).

The resultant Force Vector Norm field is automatically updated.
4. Select the part face as indicated below.

A symbol (arrow) representing the distributed force is displayed.
5. Click OK in the Distributed Force dialog box.

The Distributed Force.1 object has been inserted under the Loads.1 objects set in the specification
tree.
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Computing a Static Case Solution
This task will show you how to compute the Static Case Solution of a Finite Element
Model on which you previously created a Restraint object and a Load object. You will
store the results in a given directory.

1. Select the External Storage icon

.

The External Storage dialog box appears.

The Results and Computation Data are stored in one single file with given
extensions:
❍

xxx.CATAnalysisResults

❍

xxx.CATAnalysisComputations

2. If needed, change the path of the Result Data and/or Computation Data
directories.
3. Click OK in the External Storage dialog box.

4. Select the Compute icon

.
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The Compute dialog box appears.

5. Select the All default value proposed for defining which are the objects sets to be
updated.
6. Click OK in the Compute dialog box to launch the computation.

The Progress Bar dialog box provides a series of status messages (Meshing,
Factorization, Solution) that inform you of the degree of advancement of the
computation process.

Upon successful completion of the computation, the status of all objects
in the analysis specification tree up to the Static Case Solution.1
objects set is changed to valid. In other words, the
no more.

symbol appears

Version 5 Release 14
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The color change of the Restraints and Loads symbols to blue, also
reflecting the fact that the Static Case Solution computation was
successful.
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Viewing Displacements Results
This task will show you how to visualize the displacements of the CATAnalysis according to the restraints and load
you assigned to this CATAnalysis. You previously launched the computation of the Static Analysis Case and will now
generate a Report with computations of the displacements you are going to perform:
●

Displacement

●

Stress Von Mises

1. Click the Displacement icon

in the Image toolbar.

A plot of the displacement field is displayed with arrow symbols. If you go over the plot with the cursor, you
can visualize the nodes. The computed displacement field can now be used to compute other results such as
strains, stresses, reaction forces and so forth.

Arrows representing the displacement:

2. Click the Stress Von Mises icon

Zoomed arrows:

in the Image toolbar.
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Go to View -> Render Style -> Customize View and make sure the Materials option is active in the
Custom View Modes dialog box.

Both a Translational displacement vector image object and a Von Mises Stress (nodal value) image
object appear in the specification tree under the Static Case Solution.1 objects set.

You can choose to have both Translational displacement vector and Von Mises Stress (nodal
value) deformed mesh displayed. For this, right-click on Translational displacement vector in
the specification tree and select the Activate/Deactivate option that is displayed in the
contexual menu.
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3. Double-click the Von Mises Stress (nodal value) object in the specification tree to edit the image.

The Image Edition dialog box appears.
❍

Color value:
The Color Palette enables you to modify the color distribution and to focus on specific
values.

For more details on this functionality, please refer to Editing the Color Palette.

❍

Internal von Mises stress field values
To visualize internal von Mises stress field values in a plane section through the part,
click the Cut Plane Analysis icon
in the Analysis Tools toolbar.
You can handle the compass with the mouse in order to rotate or translate the Cutting
Plane (to do so, select an edge of the compass and drag the mouse).
To exit this view, click Close in the Cut Plane Analysis dialog box that appeared.
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For more details about this functionality, please refer to Cut Plane Analysis.

4. Click the Image Extrema icon

in the Analysis Tools toolbar to obtain local and global extrema values

of the von Mises stress field magnitude.

The Extrema Creation dialog box appears.

Click OK once you have defined the number of the extrema you need. In this particular case, you will define
that you need two Absolute extrema.
Locations of the global maxima and minima are indicated on the image, and the Extrema object appears in
the specification tree under the Static Case Solutions objects set.
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As you can see above, the values are not satisfying for our static case: you need more distributed force so
that the Stress Von Mises values might be more significant. You will therefore save the document, modify
the values and re-compute the static case in the following task.
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Inserting a Frequency Analysis Case
This task will show you how to insert a Frequency Analysis Case.
Creating a frequency analysis case means that you will analyze the dynamic boundary
conditions of the CATAnalysis document.

Before you begin:
Remember that we use the Materials view mode. If needed, go to View -> Render Style
-> Customize View option from the toolbar and activate the Materials option from the
displayed Custom View Modes dialog box.

1. Select Insert -> Frequency Case from the menu bar.
The Frequency Case dialog box appears with the possibility to either use the
existing Analysis case as Reference or create a Frequency case with New feature.

2. Click OK.
A new Analysis solution and the standard structure of Analysis specification tree is
displayed.
The Finite Element Model contains a Frequency Case, which contains empty
Restraints and Masses object sets, along with an empty Frequency Case
Solution.1 object set.
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Remember that if you selected Start->Analysis & Simulation -> New Generative
Analysis from a CATPart document containing the part without any material, the material
library will appear directly for an easy material selection.
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Creating an Iso-static Restraint
This task will show you how to create an Iso-static Restraint on a part. In other words,
you will apply statically definite restraints allowing you to simply support a body.

1. Select the Restraints.2 object in the specification tree to make it active.

2. Click the Isostatic Restraint icon

.

The Isostatic Restraint dialog box appears.

You can see that an Isostatic.1 object has been inserted under the Restraints.2
objects set in the specification tree.

You will restrain your part in such a way that it is statically definite and all rigidbody motion is impossible. The program will automatically determine the
restrained points and directions.
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3. Click OK in the Isostatic Restraint dialog box to create the Iso-static Restraint.
The Isostatic symbol appears on the part.
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Creating a Non-Structural Mass
This task will show you how to create a Mass Surface Density on the surface geometry
supports. In this example, you will distribute a mass density of 50kg/m2 on several faces
of your part.

1. Select the Masses.1 objects set in the specification tree to make it active.

2. Click the Surface Mass Density icon

.

The Surface Mass Density dialog box appears.

You can see that a Surface Mass Density.1 object is now inserted under the
Masses.1 object set in the specification tree.
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3. Select the faces on which you will distribute a mass density.
Red symbols representing the Mass Surface Density are displayed.

4. Enter a new Mass Density in the Surface Mass Density dialog box. In this
particular case, enter 50kg_m2.

5. Click OK in the Surface Mass Density dialog box.
Note that the invalid symbol has disappeared in the specification tree.
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Computing a Frequency Case Solution
This task will show you how to compute a Frequency Case Solution on which you
previously created a Restraint object and optionally a Mass object.

1. Click the External Storage icon

.

The External Storage dialog box appears.

Optionally change the path of the External Storage directory to another directory
and then click OK in the External Storage dialog box.
The results and computation data are stored in one single file with given
extensions:
❍
xxx.CATAnalysisResults
❍

xxx.CATAnalysisComputations

2. Click the Compute icon

.

The Compute dialog box appears.
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Take the default (All) proposed for the objects sets to update.
3. Click OK to perform the computation.

The Progress Bar dialog box provides a series of status messages (Meshing,
Factorization, Solution) that inform you of the degree of advancement of the
computation process.

Upon successful completion of the computation, the status of the Frequency Case
Solutions objects set is changed to valid in the specification tree. In other words,
the

symbol appears no more.

Version 5 Release 14

Generative Structural Analysis

Page 41

Note the green color change of the Restraints and Masses symbols,
reflecting the fact that the Frequency Case Solution computation was
successful.
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Viewing Frequency Results
This task will show you how to visualize Vibration Modes after computing the Frequency
Analysis Case and how to generate a Report.

1. Click the Deformation icon

.

An image of the deformation corresponding to the first vibration mode is
displayed, and a Deformed Mesh image object appears in the specification tree
under the Frequency Case Solution.1 objects set.

2. Double-click the Deformed Mesh object in the specification tree to edit the
image.
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The Image Edition dialog box, containing the list of vibration modes with the
corresponding frequency occurrences is visualized. You can visualize any mode by
clicking it in this multi-occurrence list.
3. Select the Occurrences tab in the Image Edition dialog box and select the
seventh mode.

The selected mode is visualized:

4. Click OK in the dialog box.

●

●

●

You can further manage your results by using the Results Management action icons on
the bottom of your screen.
For more details, please refer to Results Visualization.
In addition to standard information, the Report for a Frequency Case Solution contains
modal participation factors information, which allows you to evaluate the validity of
the modal truncation to the first 10 modes.
You can modify the number of computed modes by double-clicking the Solution and
editing the Solution Definition dialog box.
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User Tasks
The tasks you will perform in the Generative Structural Analysis workbench are mainly specifications
of analysis features that you will use for the mechanical analysis of your system (part or assembly of
parts) subjected to environmental actions.
Once the required specifications are defined, you need to compute and visualize the results.
The User Tasks section will explain and illustrate how to create physical attributes (which include
system attributes and environment attributes), specify computation parameters and visualize
results.
You can make extensive use of the CAD-CAE associativity concept.
Associativity means that any part modifications occurring outside the Analysis workbench are
automatically reflected when performing tasks within the Analysis workbench. In particular, any
parametric changes on the parts are automatically accounted for. So, you don't have to worry about
updating the part specifications.
The workbench provides generative capabilities: you do not have to tell the program explicitly all the
necessary steps to perform a mechanical analysis. In fact, all you need to enter are the specifications
about the system and the way in which the system is subjected to its environment. The program
captures your design-analysis intent, then produces the desired results by automatically generating
the intermediate steps.
The Basic Tasks can be grouped as follows:
●

●

●

FEM Model Definition
❍
Analysis Cases: specifying a computational procedure for a set of environmental factors.
System Definition
❍
Connections: specifying the way in which subsystems are to be connected.
❍

Virtual Parts: specifying bodies for which no geometric support exists.

❍

Mass Equipment: specifying the way in which non-structural mass is distributed.

Environment Definition
❍
Restraints: specifying essential (displacement-type) boundary conditions.
❍

●

Loads: specifying natural (force-type) boundary conditions.

Results
❍
Computation: generating finite elements solutions.
❍

Visualization: displaying and analyzing results.

Before You Begin
Analysis Cases
Modulation
Dynamic Response Sets
Model Manager
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Adaptivity
Groups
Analysis Connections
Connection Properties
Analysis Assembly
Virtual Parts
Mass Equipment
Restraints
Loads
Sensors
Results Computation
Results Visualization
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Before You Begin
Before you begin you should be familiar with the following basic concepts:
●

What Type of Analysis for What Type of Design?

●

What Types of Hypotheses are Used for Analysis?

●

About Supports...

●

Launching the Solver

●

Improving Performances on Multi-Processor Computers

●

Loading / Unloading Documents

●

Miscellaneous

What Type of Analysis for What Type of Design?
You will find here below three methodological cases for generating mesh, depending on the
type of the geometry.

GPS: Generative Part Structural Analysis workbench

FMS/FMD: Advanced Meshing Tools workbench

GSD: Generative Shape Design workbench

PRT: Part Design workbench

Analyzing in "Generative Part Structural Analysis" Workbench (GPS) After Meshing in
"Advanced Meshing Tools workbench" (FMS/FMD)
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The selected FMS mesh part will be used for analysis.
This mesh contains triangle and quadrangle shell elements. Those elements can be linear
(three nodes - four nodes) or parabolic (six nodes - eight nodes). They have six degrees of
freedom per node (three translations and three rotations) to take into account membrane and
bending effects.
The thickness of the part needs to be specified by double-clicking on Material Property in the
specification tree.
All the preprocessing specifications (Loads, Restraints, Masses) will have to be applied to the
geometries that were selected in FMS workbench (by clicking the Surface Mesh

icon).

Analyzing in "Generative Part Structural Analysis" (GPS) Workbench
Surface Geometry Designed in "Generative Shape Design" (GSD)
Workbench

1. First case
You first indicated in GSD which geometry you want to be analyzed by going into Tools
-> External View commands from the menu bar.
The following will be generated: mesh parts and shell properties.
A 2D Octree mesh Part is automatically created when starting GPS.
This mesh part will generate triangle shell elements. Those elements can be linear
(three nodes) or parabolic (six nodes). They have six degrees of freedom per node
(three translations and three rotations) to take into account membrane and bending
effects.
2. Second case
You did not indicate in GSD which geometry you want to be analyzed.
You will have to use Mesh Part commands to generate Mesh Parts and properties
commands to generate properties.
Notes
●

You can edit, delete or re-create mesh parts and properties at any time.
In case of inconsistencies, use the Check command

.
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All the specifications (Loads, Restraints, Masses) will have to be applied to a
geometry on which a Mesh part and property was created.

Analyzing in "Generative Part Design" (GPS) Workbench Solid Geometry
Designed in Part Design (PRT)

●

●

●

A 3D OCTREE mesh Part is automatically created.
This mesh part will generate tetrahedron elements. Those elements can be linear (four
nodes) or parabolic (ten nodes). They have three degrees of freedom per node (three
translation).
All the preprocessing specifications (Loads, Restraints, Masses) will be applied to the Part
Body geometry.

Generative Structural Analysis

Version 5 Release 14

Page 49

What Type of Hypotheses are Used for Analysis?
You will find here below three types of hypotheses used when working in Analysis
workbench.
1. Small displacement (translation and rotation)
2. Small strain
3. Linear constitutive law: linear elasticity
For static case solutions, one can say that:
●

●

If there is no contact feature (either virtual or real), no pressure fitting property and no
bolt tightening (either virtual or real) feature, then the problem is linear, that is to say,
the displacement is a linear function of the load.
If there is at least one contact feature (being virtual or not) or pressure fitting property or
bolt tightening (being virtual or not) feature, then the problem is non linear, that is to
say, the displacement is a non linear function of the load.

About Supports ...
Analysis specifications can be applied to different types of supports (or features):
●

Geometrical Feature
- Point/Vertex (except GSM points)
- Curve/Edge
- Surface/Face
- Volume/Part
- Groups (points, curves, surfaces, parts)

●

Mechanical Feature

●

Analysis Feature

For more details about the Supports, please refer to Associativity the Frequently Asked
Questions section.
When you select a mechanical feature, the analysis specification is actually applied on the
resulting associated geometry. If this geometry is not an authorized geometrical supports (see
table below), you will not be able to select the mechanical feature. For example, selecting a
fillet for a Line Force Density will not be allowed because the resulting geometry of a fillet are
surfaces while the authorized geometrical entities for Line Force Density are line or edges.
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To apply a restraint, a load or a connection to one extremity of a beam, you need to
first put the point that were possibly created at the extremity of this beam, in order to
build the wireframe, into the Hide mode. As result, to apply the above mentioned
specifications, you will select the extremity of the wireframe and not the hidden point
(small cross in the 3D view) as this point is not linked to the mesh.

Launching the Solver
The below capability is only available with the ELFINI Structural Analysis (EST) product.
The kernels steps of the solver are launched transparently on a different process.
This concerns the steps that are consuming a lot of memory. The slave process will benefit
from small contiguous available memory for computation.
It is strongly recommended that you extend the memory of the used machine with extended
paginated memory. The master process will automatically paginate its own data on this paging
memory.

Improving Performances on Multi-Processor
Computers
●

On Windows platforms: the ElfiniSolver is multithreaded if more than one processor is
found.

●

On SGI machines: you have to specify the number of processor to be used with the UNIX
command:
export ELF_NUM_THREADS=2 (if you want to use two processors)
By default, one processor will be used.

●

On AIX machines: you may specify the number of processors to be used with the UNIX
command:
export XLSMPOPTS="parthds=2" (if you want to use two processors)
By default, all the available processors will be used.
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Loading / Unloading Documents
You can unload geometry document (CATPart, CATProduct) using the File->Desk menu.
Unloading a document allows you to liberate memory while working on large models (postprocessing and computation). Moreover, specifications you have defined are kept up-to-date.
In the FileDesk workbench, right-click the CATPart or CATProduct document you want to
unload and select the Unload contextual menu:

In this example, the pointed documents (two CATPart files) are also unloaded.
For more details, please refer to Using the FileDesk Workbench in the Infrastructure User's
Guide.

Miscellaneous
DMU Space Analysis workbench:
Any CATAnalysis document that will be imported into a product needs to be updated if you
wish to use it in DMU Space Analysis workbench.
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Analysis Cases
A new Analysis Case is a set of objects sets (a template) corresponding to a new set of
specifications of simultaneous environmental actions on a given system.
Create a Finite Element Model
Generate a Finite Element Model, optionally containing an empty Static of
Frequency Analysis Case.

Inserting Analysis Cases
Insert a New Static Case
Generate a Static Analysis Case objects set.
Insert a New Static Constrained Case
Generate a Static Constrained Analysis Case objects set.
Insert a New Frequency Case
Generate a Frequency Analysis Case objects set.
Insert a New Buckling Case:
Generate a Buckling Analysis Case objects set.
Insert a New Combined Case
Generate a Combined Analysis Case objects set.
Insert a Harmonic Dynamic Response Case
Generate a Harmonic Dynamic Response Analysis Case objects set.

Insert a Transient Dynamic Response Case
Generate a Transient Dynamic Response Analysis Case objects set.
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Creating a Finite Element Model
This task shows you how to create a Finite Element Model, and optionally an Analysis
Case.
Finite Element Models are representations used for performing computer-aided
engineering analysis (CAEA) of products. They are complementary to computer-aided
design (CAD) models, which are mainly geometric representations of products.
A Finite Element Model consists of:
●

●

a system representation, consisting of:
❍
a Mesh objects set (containing Node and Element objects)
❍

a Properties objects set (containing Property-type objects)

❍

a Materials objects set (containing Material-type objects)

❍

an Axis objects set (containing Axis-type objects)

various environment actions representations, each consisting of:
❍
an Analysis Case object sets, defining implicitly the type of analysis (solution
procedure) expected, and possibly containing:
■
a Restraints objects set (containing Restraint-type objects)

❍

■

a Loads objects set (containing Load-type objects)

■

a (NS) Masses objects set (containing Mass-type objects)

for each Analysis Case, a Solution objects set, defining the type of results sought:
■
images
■

analyses

■

reports

■

graphs...

The Finite Element Model can initiate a solution process when a sufficient amount of
specifications have been captured in the objects constituting the representations of the
model.
At the creation of a Finite Element Model, the program automatically generates the
system representation template, and proposes to also generate an Analysis Case template
for the environment representation and also for indicating the type of solution procedure
sought.
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If you do not have the ELFINI Structural Analysis product license, your Finite Element
Model can simultaneously contain at most one Static Analysis Case and one Frequency
Analysis Case.
You can use the sample01.CATPart document from the samples directory for this task.
1. Select Start -> Analysis & Simulation -> Generative Structural Analysis.

The New Analysis Case dialog box appears.
You can create several types of template:
❍

Static Analysis Case

❍

Frequency Analysis Case

❍

Free Frequency Analysis Case

2. Select the desired Analysis Case in the list.
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The Finite Element Model specification tree template shows the standard system
representation objects sets.
The Analysis Case representation contains the following empty object sets:
❍

Restraints

❍

Loads

❍

Masses

❍

Solution

❍

Sensors

3. Select the Keep As Default option in the New Analysis Case dialog box if you
want to set the current choice as the default choice.
4. Click OK in the New Analysis Case dialog box.

When you have the ELFINI Structural Analysis product installed, the Finite Element Model
can contain an arbitrary number of (Static and/or Frequency) Analysis Cases.
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Inserting a New Static Case
This task shows you how to insert a Static Case.
Inserting a new Static Case allows you to create objects sets for the new environmental
specifications, and to implicitly require a static solution procedure for the computation of
the system response to applied static loads under given restraints.
Only available with the ELFINI Structural Analysis (EST) product.

You can use the sample00.CATAnalysis document from the samples directory for this task.

1. Select Insert -> Static Case menu

.

The Static Case dialog box is displayed.

For each type of objects set (Restraints, Loads, Masses), you can require that
your new Static Case contains either an empty objects set or an objects set
existing in a previously defined Analysis Case.
The New and Reference switches for Restrains, Loads and Masses objects
sets allow you to choose between these two options:
❍

❍

New: the new objects set is empty.
Reference: the new objects set is a copy of an objects set existing in a
previously defined Analysis Case.

2. Set the options for each type of objects set.
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In this particular example:
❍

select New as Restraints and Loads options

❍

deactivate the Masses option

3. Click OK in the Static Case dialog box.

A new Static Case objects set appears in the Finite Element Model specification
tree.

The new Static Analysis Case representation consists of the following object sets:
❍

Restraints

❍

Loads

❍

Solution

4. You can edit the static case. For this, double-click the Static Case Solution.1
object in the specification tree.

The Static Solution Parameters dialog box appears:
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Method
❍

auto: one of the three methods below is automatically computed

❍

gauss: direct method, recommended for computing small/medium models

❍

❍

gradient: solving iterative method which is memory saving but not CPU time
saving, recommended for computing huge models
gauss R6: fast Gauss method recommended for computing large size models

Gradient parameters
❍

maximum iteration number

❍

accuracy

Products Available in Analysis Workbench
If you deactivate the Hide existing analysis cases option in the Static Case dialog box,
the symbols of objects created in previous Analysis Cases will remain displayed.
By default, the last created (inserted) Analysis Case is set as current, and the
corresponding objects set is underlined in the analysis features tree.
A right mouse click (key 3) on a Static Case objects set further allows the following
action:
Set as Current: allows you to define the Static Analysis Case as being the currently
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active one.
The Static Case is then underlined in the features tree and all subsequent actions refer to
it.
Once a New Analysis Case has been inserted, its Definition parameters cannot be
changed.
To modify the Analysis Case Definition parameters you can only replace it (delete followed
by insert) in the analysis features tree.

If you do not have the ELFINI Structural Analysis product license, your Finite Element
Model can simultaneously contain at most one Static Analysis Case and one Frequency
Analysis Case.
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Inserting a New Static Constrained Case
This task shows you how to insert a new Static Constrained Case.
Inserting a New Static Constrained Case allows you to create a restraint set (new or
reference to an existing one).
Only available with the ELFINI Structural Analysis (EST) product.
You can use the sample04.CATAnalysis document from the samples directory.

1. Select the Insert -> Static Constrained Modes

menu.

The Static Constrained Modes dialog box appears.

❍

Restraints:
■
New: allows you to create a new restraints set that will be empty.
■

❍

Reference: allows you to choose an existing restraints set as reference.

Hide existing analysis cases: allows you to hide the analysis cases that
have been previously created.

2. Click OK in the Static Constrained Modes dialog box.

A Static Constrained Modes feature appears in the specification tree.
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Inserting a New Frequency Case
This task shows you how to insert a new Frequency Case.
This capability is only available with the ELFINI Structural Analysis product (except for
inserting a first Frequency Analysis Case).
Inserting a new Frequency Case allows you to create objects sets for the new
environmental specifications, and to implicitly require a normal modes solution procedure
for the computation of the system vibration frequencies and normal modes for a given
non-structural mass distribution under given restraints.

Remember that if you do not have the ELFINI Structural Analysis product license, your
Finite Element Model can simultaneously contain at most one Static Analysis Case and one
Frequency Analysis Case.

You can use the sample00.CATAnalysis document from the samples directory for this task.

1. Select Insert -> Frequency Case

.

The Frequency Case dialog box is displayed.

For each type of objects set (Restraints, Masses, Static Case Solution), you
can require that your new Frequency Case contains either an empty objects set
or an objects set existing in a previously defined Analysis Case.
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The New and Reference switches for Restrains and Masses objects sets allow
you to choose between these two options:
❍

❍

❍

New: the new objects set is empty.
Reference: the new objects set is a copy of an objects set existing in a
previously defined Analysis Case.
Static Case Solution option allows you to perform a pre-loaded frequency
computation by selecting a static solution. The frequency computation will
then take the corresponding loads into account and generate a (non-linear,
load-dependent) pre-loaded frequency computation.
This capability is only available with the ELFINI Structural
Analysis (EST) product.

2. Set the switch for each type of objects set and click OK.

A new Frequency Case template (objects sets set) appears in the Finite Element
Model specification tree template displayed on the left.

The new Frequency Analysis Case representation consists of the following (empty)
object sets:
❍

Restraints

❍

Masses

❍

Solution

You can edit the frequency case, by double-clicking on the Frequency Case
Solution object in the specification tree.
The following dialog box will appear:

Generative Structural Analysis

❍

❍

Version 5 Release 14

Page 63

Number of modes
Method (Iterative subspace, lanczos) (only available if you have ELFINI
Structural Analysis product installed, otherwise, the default method is
Iterative subspace).
If you select the lanczos Method, the Shift option appears: compute the
modes beyond a given value: Auto, 1Hz, 2Hz and so forth. Auto means
that the computation is performed on a structure that is partially free.

❍

Dynamic parameters (maximum iteration number, accuracy)
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By default, the last created (inserted) Analysis Case is set as current, and the
corresponding objects set is underlined in the analysis features tree.
A right mouse click (key 3) on a Frequency Case objects set further allows the following
action:
Set as Current: allows you to define the Frequency Analysis Case as being the currently
active one. The Frequency Case is then underlined in the features tree and all subsequent
actions refer to it.
If you inactivate the Hide Existing Analysis Cases switch in the Frequency Case dialog
box, the symbols of objects created in previous Analysis Cases will remain displayed.
Once a New Analysis Case has been inserted, its Definition parameters cannot be
changed.
To modify the Analysis Case Definition parameters you can only replace it (Delete
followed by Insert) in the analysis specification tree.
To compute free vibration modes, you need a Frequency Analysis Case containing no
Restraints objects set. This means that you must insert a new Frequency Analysis Case
without Restraints.

To compute free vibration modes, you need a Frequency Analysis Case containing no
Restraints objects set. This means that you must first delete the existing Frequency
Analysis Case and insert a new Frequency Analysis Case without Restraints.
To subsequently compute supported (non-free) vibration modes, you must delete the
previous, Restraints-less (free vibration modes) Frequency Analysis Case and insert a new
(supported) Frequency Analysis Case with Restraints.
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Inserting a New Buckling Case
This task shows you how to insert a Buckling Case.
Inserting a New Buckling Case allows you to require a buckling modes solution procedure
for the computation of the system buckling critical loads and buckling modes for a given
Static Analysis Case.
Only available with the ELFINI Structural Analysis (EST) product.

You can use the sample00.CATAnalysis document from the samples directory for this task.

1. Select Insert -> Buckling Case

.

The Buckling Case dialog box appears.
2. Select the Static Case Solution (Reference) field to which you will associate
your new Buckling Case.

You can associate your new Buckling Case either to an existing Static Case or to a
new one.

The Hide Existing Analysis Cases option allows you to hide all symbols
representing physical attributes applied to your part.
A new Buckling Case template (objects sets set) appears in the Finite Element
Model specification tree template displayed on the left.
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The new Buckling Analysis Case representation consists of the following (empty)
object sets:
❍

Static Case Solution

❍

Buckling Case Solution

3. Click OK in the Buckling Case dialog box.

Products Available in Analysis Workbench
By default, the last created (inserted) Analysis Case is set as current, and the
corresponding objects set is underlined in the analysis features tree.
Once a New Analysis Case has been inserted, its Definition parameters cannot be
changed.
To modify the Analysis Case Definition parameters you can only replace it (delete followed
by insert) in the analysis specification tree.
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Inserting a New Combined Case
This task shows you how to insert a new Combined Case.
Inserting a Combined Case allows you to specify reference Static Analysis Cases and
associated coefficients when editing.
You can now compute a small number of static cases and perform lots of combinations
when performing post-processing analyses.
Only available with the ELFINI Structural Analysis (EST) product.
You can use the sample03.CATAnalysis document from the samples directory.

1. Select Insert -> Combined Case

.

The Combined Static Case Solution.1 feature appears in the specification tree.

2. Double-click on the Combined Static Case Solution.1 in the specification tree.

The Combined Solution dialog box appears: you can now select the static cases to
be combined.
Once the Combined Solution dialog box below appears, you will select in the
specification tree the static cases to be combined and, if needed, the Coefficient
associated to each solution. In this particular case, select both Static Case
Solution.1 and Static Case Solution.2. and leave the coefficient to 1 for both
solutions.
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3. Select the first static case: Static Case Solution.1.
4. Right-click the solution that has just been added (Static Case Solution.1) and
then select the Add contextual menu.
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Note that using this contextual menu, you can also edit, delete one or
all the solutions.
5. Select the second static case: Static Case Solution.2.

The features corresponding to the selected solutions are automatically highlighted
in the specification tree.
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The Combined Solution dialog box is updated.
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6. Click OK in the Combined Static Solution dialog box when you are satisfied with
the selected solutions.

At any time, you can double-click on the Combined Static Case Solution.1 in the
specification tree and perform the desired operations (see above described contextual
menu).

Generative Structural Analysis

Page 72

Version 5 Release 14

Inserting a Harmonic Dynamic Response Case
This task shows you how to insert a Harmonic Dynamic Response Case containing an excitation (load excitation
or restraint excitation) and a damping.
Inserting a Harmonic Dynamic Response Case allows you to create objects sets and to set up a harmonic
dynamic solution where loads or restraint will be excited.

Only available with the Generative Dynamic Response Analysis (GDY) product.
To insert a Harmonic Dynamic Response Case:
●

a Frequency Case must be defined.
For more details, please refer to Inserting a Frequency Case.

●

a Static Case must be defined only if you choose a load excitation set.
For more details, please refer to Inserting a Static Case.

Open the sample56.CATAnalysis document from the samples directory.
In this particular example, a static case and a frequency case have been previously defined.

1. Select the Insert -> Harmonic Dynamic Response Case

The Harmonic Dynamic Response Case dialog box appears.

❍

Reference: allows you to choose a reference solution case.

menu.
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Excitation set: lets you choose the excitation set.
A load excitation set and a restraint excitation set cannot be created simultaneously.
■

Load excitation set: allows you to choose to create a new load excitation set or to
reference an existing one.
■
New: allows you to create a new load excitation set that will be empty.
■

■

Restraint excitation set: allows you to choose to create a new restraint excitation set
or to reference an existing one.
■
New: allows you to create a new restraint excitation set that will be empty.
■

❍

❍

Reference: allows you to choose an existing load excitation set as reference.

Reference: allows you to choose an existing restraint excitation set as reference.

Damping set: informs you that a new Damping set will be created.
Hide existing analysis cases: allows you to hide the analysis cases that have been previously
created.

2. Select the Frequency Case Solution.1 solution as Frequency Case Solution reference.
3. Choose the desired excitation set.

For this, activate the desired option in the Harmonic Dynamic Response Case dialog box.
❍

❍

Activate the Load excitation option if you want to apply a load excitation set (for a dynamic load).

Activate the Restraint excitation option if you want to apply a restraint excitation set (for an
imposed motion of the support).

4. Click OK in the Harmonic Dynamic Response Case dialog box.
The Harmonic Dynamic Response Case feature appears in the specification tree.
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Restraint excitation option activated:

You now have to define the excitation (Load or Restraint) how you will excite the part as well as the damping of
this part.
For this, please refer to Modulation and Dynamic Response Sets chapters in this guide.
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Inserting a Transient Dynamic Response Case
This task shows you how to insert a Transient Dynamic Response Case containing an excitation (load excitation
or restraint excitation) and a damping.
Inserting a Transient Dynamic Response Case allows you to create objects sets and to set up a dynamic solution
where loads or restraint will be excited.

Only available with the Generative Dynamic Response Analysis (GDY) product.
To insert a Transient Dynamic Response Case:
●

a Frequency Case must be defined.
For more details, please refer to Inserting a Frequency Case.

●

a Static Case must be defined only if you choose a load excitation set.
For more details, please refer to Inserting a Static Case.

Open the sample56.CATAnalysis document from the samples directory.
In this particular example, a static case and a frequency case have been previously defined.

1. Select the Insert -> Transient Dynamic Response Case

The Transient Dynamic Response Case dialog box appears.

❍

Reference: allows you to choose a reference solution case.

menu.
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Excitation set: lets you choose the excitation type.
A load excitation set and a restraint excitation set cannot be created simultaneously.
■

Load excitation set: allows you to choose to create a new load excitation set or to
reference an existing one.
■
New: allows you to create a new load excitation set that will be empty.
■

■

Restraint excitation set: allows you to choose to create a new restraint excitation set or
to reference an existing one.
■
New: allows you to create a new restraint excitation set that will be empty.
■

❍

❍

Reference: allows you to choose an existing load excitation set as reference.

Reference: allows you to choose an existing restraint excitation set as reference.

Damping set: informs you that a new damping set will be created.
Hide existing analysis cases: allows you to hide the analysis cases that have been previously
created.

2. Select the Frequency Case Solution.1 solution as Frequency Case Solution reference.
3. Choose the desired excitation set.

For this, activate the desired option in the Transient Dynamic Response Case dialog box.
❍

❍

Activate the Load excitation option if you want to apply a load excitation set (for a dynamic load).

Activate the Restraint excitation option if you want to apply a restraint excitation set (for an
imposed motion of the support).

4. Click OK in the Transient Dynamic Response Case dialog box.
The Transient Dynamic Response Case feature appears in the specification tree.
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Restraint excitation option activated:

You now have to define the excitation (Load or Restraint) how you will excite the part as well as the damping of
this part.
For this, please refer to Modulation and Dynamic Response Sets chapters in this guide.
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Modulation
Only available with the Generative Dynamic Response Analysis (GDY) product.
Create White Noise Modulation
Create a constant modulation (equal to one).
Import Frequency Modulation
Import a frequency modulation from an existing xls or txt file.
Import Time Modulation
Import a time modulation from an existing xls or txt file.
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Creating White Noise Modulation
This task will show you how to create a white noise modulation.
A White Noise Modulation is a constant modulation (equal to one).
●

●

This functionality is only available if you installed the Generative Dynamic
Response Analysis (GDY) product.
A Dynamic Response Case must have been previously inserted.

Open the sample56_1.CATAnalysis document from the samples directory.

1. Click the White Noise icon

.

The White Noise Modulation dialog box appears.

A Modulations.1 set has been created in the specification tree under the Finite
Element Model.1 set.

2. Modify the name of modulation you just have created, if needed.
3. Click OK in the White Noise Modulation dialog box.

Generative Structural Analysis
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You can now define the load excitation set or the restraint excitation set.
For this, please refer to the Dynamic Response Sets chapter in this guide.

●

You can have several modulation objects (white noise modulation or imported
modulation) in the modulation set.
To know how to import a modulation from an existing file, please refer to Importing
Frequency Modulation or Import Time Modulation in this guide.
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Importing Frequency Modulation
This task will show you how to import frequency modulation values from a previously created file (.xls or .txt file).
●

This functionality is only available if you installed the Generative Dynamic Response Analysis (GDY) product.

●

A Dynamic Response Case must have been previously inserted.

●

A file containing modulation values must have been previously created. The file must contain the (Hz) or (kHz)
characters.
The file format can be:
❍
.xls (two columns Excel file): on Windows
❍

.txt (Text): on Windows and on Unix

Open the sample56_1.CATAnalysis document from the samples directory.

1. Click the Frequency Modulation icon

.

The Frequency Modulation dialog box appears.

A Modulations.1 set is created (if it does not already exist) under the Finite Element Model.1 set.

2. Click the Browse button to select the file that contains the modulation values. This file can be an excel (.xls)
file on Windows or a text (.txt) file on Unix.
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The File Selection dialog box appears and lets you select the file you need.

In this particular case, you can select the signal_carre.txt file from the sample directory.
3. Click Open in the File Selection dialog box.

The Frequency Modulation dialog box is updated and the path directory of the imported file is displayed.

4. Click the Edit button to visualize the parameters defined in the file you just have imported.
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The Imported Table dialog box appears.

5. Click Close in the Imported Table dialog box.
6. Click OK in the Frequency Modulation dialog box.

●

You can now define the load excitation set or the restraint excitation set.
For this, please refer to the Dynamic Response Sets chapter in this guide.

●

You can have several modulation objects (white noise modulation or imported modulation) in the modulation set.
To know more, please refer to Creating White Modulation or Importing Time Modulation in this guide.

●

You can create a 2D Display document to visualize the modulation.
For more details, please refer to Generating 2D Display Visualization.
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Importing Time Modulation
This task will show you how to import time modulation values from a previously created file (.xls or .txt file).
●

This functionality is only available if you installed the Generative Dynamic Response Analysis (GDY) product.

●

A dynamic response case must have been previously inserted.

●

A file containing modulation values must have been previously created. The file must contain the (s) (or other time
units supported by CATIA) characters.
The file format can be:
❍
.xls (two columns Excel file): on Windows
❍

.txt (Text): on Windows and on Unix

Open the sample56_1.CATAnalysis document from the samples directory.

1. Click the Time Modulation icon

.

The Time Modulation dialog box appears.

A Modulations.1 set and a Time Modulation.1 object are created (if it does not already exist) under the
Finite Element Model.1 set.

2. Click the Browse button to select the file that contains the time modulation values. This file can be an excel
(.xls) file on Windows or a text (.txt) file on Unix.
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The File Selection dialog box appears and lets you select the file you need.

In this particular case, you can select the signal_time.txt file from the sample directory.
3. Click Open in the File Selection dialog box.

The Modulation dialog box is updated and the path directory of the imported file is displayed.

4. Click the Edit button to visualize the parameters defined in the file you just have imported.
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The Imported Table dialog box appears.

5. Click Close in the Imported Table dialog box.
6. Click OK in the Time Modulation dialog box.

●

You can now define the load excitation set or the restraint excitation set.
For this, please refer to the Dynamic Response Sets chapter in this guide.

●

You can have several modulation objects (white noise modulation or imported modulation) in the modulation set.
To know more, please refer to Creating White Modulation or Importing Frequency Modulation in this guide.

●

You can create a 2D Display document to visualize the modulation.
For more details, please refer to Generating 2D Display Visualization.
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Dynamic Response Sets
Only available with the Generative Dynamic Response Analysis (GDY) product.
When you insert a Dynamic Response Analysis case (harmonic or transient), you have to
define the load excitation set and the damping set.

Define a Load Excitation Set
Apply a modulation to the load that is supposed to excite the part.
Define a Restraint Excitation Set
Apply a modulation to the restraint that is supposed to excite the part.
Define a Damping Set
Define the resulting damping of a part once a force has been applied on this part.
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Defining a Load Excitation Set
This task will show you how to define the load excitation set in a:
●

harmonic dynamic response analysis case

●

transient dynamic response analysis case

Defining a load excitation set allows you to define the force type load you will apply.

Harmonic Dynamic Response Case
Open the sample57.CATAnalysis document from the samples directory.
Before You Begin
●

insert a Harmonic Dynamic Response Analysis Case (and choose a load excitation set)

●

define a white noise modulation or define a frequency modulation
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1. Double-click the load excitation set from the specification tree.
In this particular case, double-click the Load Excitation.1 object of the
Harmonic Dynamic Response Case set.
The Load Excitation Set dialog box appears.

❍

❍

Name: gives the name of the excitation set. You can modify it.
Selection:
■
Selected load: lets you select the load you want to excite.
■

Selected modulation: lets you select a white noise modulation or a
frequency modulation.
You cannot select a time modulation.

■

■

Selected factor: lets you select the factor that will multiply the
modulation.
Selected phase: lets you associate a phase component of a dynamic load
excitation (load, modulation and factor).
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2. Set the desired parameters in the Load Excitation Set dialog box.
In this particular example, you can:
❍
select Pressure.1 as Selected load
❍

select Frequency Modulation.1 as Selected modulation

❍

enter 1 as Selected factor value

❍

enter 2deg as Selected phase value

3. Press Enter to update the Load Excitation Set dialog box.
The Load Excitation Set dialog box appears as shown bellow:

You can add or delete load excitation parameters using contextual menus in the
Load Excitation Set dialog box.
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The available contextual menus are:
❍

Add: lets you add a load excitation

❍

Delete: lets you delete a load excitation

❍

Delete All: lets you delete all the load excitations you have previously defined

4. Right-click in the frame and select the Add contextual menu.
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5. Select the desired load, modulation, factor and phase.
In this particular example, you can:
❍
select the Loads.1 set as Selected load
❍

select the White noise.1 as Selected modulation

❍

enter 2 as Selected factor value

❍

enter 1 as Selected phase value
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6. Right-click the second line and select the Delete contextual menu.
7. Click OK in the Load Excitation Set dialog box.

Transient Dynamic Response Case

Page 93

Generative Structural Analysis

Version 5 Release 14

Page 94

Open the sample57.CATAnalysis document from the samples directory.
Before You Begin
●

insert a Transient Dynamic Response Analysis Case (and choose a load excitation set)

●

define a time modulation

In this particular example, a transient dynamic response case and a modulation set have
been already inserted.

1. Double-click the load excitation set from the specification tree.
In this particular case, double-click the Load Excitation.1 feature.
The Load Excitation Set dialog box appears.
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❍

❍

Name: gives the name of the excitation set. You can modify it.
Selection:
■
Selected load: lets you select the load you want to excite.
■

Selected modulation: lets you select a time modulation.
You cannot select a frequency modulation.

■

Selected factor: lets you select the factor that will multiply the
modulation.

2. Select the load you want to excite in the specification tree.
In this particular example, you can:
❍
select Pressure.1 as Selected load
❍

select Time Modulation.1 as Selected modulation

❍

enter 1 as Selected factor value

3. Press Enter to update the Load Excitation Set dialog box.
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The Load Excitation Set dialog box appears as shown bellow:

You can add or delete load excitation parameters using contextual menus in the
Load Excitation Set dialog box.
4. Click OK in the Load Excitation Set dialog box.
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Defining a Restraint Excitation Set
This task will show you how to define the restraint excitation set in a:
●

harmonic dynamic response analysis case

●

transient dynamic response analysis case

Defining a restraint excitation set allows you to define an imposed motion of the support
in the frequency domain or in the time domain.

Harmonic Dynamic Response Case
Open the sample57_1.CATAnalysis document from the samples directory.
Before You Begin
●

●

insert a Harmonic Dynamic Response Analysis Case (and choose a restraint excitation
set)
define a white noise modulation or define a frequency modulation
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1. Double-click the restraint excitation object belonging to the harmonic dynamic
response case.
In this particular case, double-click the Restraint Excitation.1 feature.
The Restraint Excitation Set dialog box appears.

❍

❍

Name: gives the name of the restraint excitation set. If needed, you can
modify it.
Axis System:
■
Type:
■
Global: if you select the Global Axis system, the components field will
be interpreted as relative to the fixed global rectangular coordinate
system.
■

User: if you select a User-defined Axis system, the components will be
interpreted as relative to the specified rectangular coordinate system.

Version 5 Release 14

Generative Structural Analysis

■

■

■

❍

Current axis: lets you select the desired axis system
Local orientation: (Cartesian) the components are interpreted
as relative to a fixed rectangular coordinate system aligned with
the Cartesian coordinate directions of the User-defined Axis.

Display locally: lets you display the axis system locally on the geometry.

Selection:
■
Selected modulation: lets you select a white noise modulation or a
frequency modulation.
You cannot select a time modulation in a harmonic dynamic
response analysis case.
■
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Selected acceleration: lets you select the acceleration that will be
modulated.
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Selected phase: lets you specify the phase value.

Degrees of freedom: gives you the list of the degrees of freedom, the
associated modulation, acceleration and phase (T for translation and R for
Rotation)

2. Set the desired parameters in the Restraint Excitation Set dialog box.
In this particular example, you can:
❍
select the Global option as Axis System Type
❍

if needed, select the Display locally option

❍

select Frequency Modulation.1 as Selected modulation

❍

enter 1m_s2 as Selected acceleration

❍

enter 1deg as Selected phase

3. Press Enter to update the Restraint Excitation Set dialog box.

The TX degree of freedom is defined and the Restraint Excitation Set dialog box
appears as shown bellow:
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You can define other degrees of freedom.
For this:
4. Select an other degree of freedom.
In this particular example, select the RY degree of freedom.
5. Set the different parameters (associated modulation, acceleration and phase).
In this particular example:
❍
select the White Noise.1 modulation as Selected modulation
❍

enter 3rad_s2 as Selected acceleration

❍

enter 2deg as Selected phase

6. Press Enter to update the Restraint Excitation Set dialog box.
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The RY degree of freedom is defined and the Restraint Excitation Set dialog box
appears as shown bellow:

7. Click OK in the Restraint Excitation Set dialog box.

Transient Dynamic Response Case
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Open the sample57_1.CATAnalysis document from the samples directory.
Before You Begin
●

●

insert a Transient Dynamic Response Analysis Case (and choose a restraint excitation
set)
define a time modulation

1. Double-click the restraint excitation belonging to a transient dynamic response
case.
In this particular case, double-click the Restraint Excitation.1 feature.
The Restraint Excitation Set dialog box appears.
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❍

❍
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Name: gives the name of the restraint excitation set. If needed, you can
modify it.
Axis System:
■
Type:
■
Global: if you select the Global Axis system, the components field will
be interpreted as relative to the fixed global rectangular coordinate
system.
■

User: if you select a User-defined Axis system, the components will be
interpreted as relative to the specified rectangular coordinate system.
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■

■

■

❍

Current axis: lets you select the desired axis system
Local orientation: (Cartesian) the components are interpreted
as relative to a fixed rectangular coordinate system aligned with
the Cartesian coordinate directions of the User-defined Axis.

Display locally: lets you display the axis system locally on the geometry.

Selection:
■
Selected modulation: lets you select a time modulation.
You cannot select a frequency modulation.
■

❍
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Selected acceleration: lets you select the acceleration that will be
modulated.

Degrees of freedom: gives you the list of the degrees of freedom, the
associated modulation, acceleration (T for translation)

2. Set the desired parameters in the Restraint Excitation Set dialog box.
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In this particular example, you can:
❍

select the Global option as Axis System Type

❍

if needed, select the Display locally option

❍

select Time Modulation.1 as Selected modulation

❍

enter 1m_s2 as Selected acceleration

3. Press Enter to update the Restraint Excitation Set dialog box.

The Restraint Excitation Set dialog box appears as shown bellow:

You can define other degrees of freedom.
For this:
4. Select an other degree of freedom.

In this particular example, select the TY degree of freedom.
5. Set the different parameters (associated modulation and acceleration).
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In this particular example:
❍

select the White Noise.1 modulation as Selected modulation

❍

enter 3rad_s2 as Selected acceleration

6. Press Enter to update the Restraint Excitation Set dialog box.

The TY degree of freedom is defined and the Restraint Excitation Set dialog box
appears as shown bellow:

7. Click OK in the Restraint Excitation Set dialog box.
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Defining a Damping Set
This task will show you how to define the damping set in a Dynamic Response Analysis
case.
Defining a Damping Set allows you to define the resulting damping of the part once the
force has been applied to this part.
You can choose between two damping types: Modal or Rayleigh.
By default, the damping is modal.
Before You Begin
●
insert a Dynamic Response Analysis Case
●

define a white noise excitation or define an imported modulation

Open the sample57.CATAnalysis document from the samples directory.
In this particular example, a dynamic response case and a modulation set have been
already inserted.
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1. Double-click the damping set from the specification tree.
In this particular case, double-click the Damping.1 object.
The Damping Choice dialog box appears.

❍

❍

Name: if needed, you can change the name of the damping set.
Damping type:
■
Modal damping
■

Rayleigh damping

2. Select the desired Damping type.

Modal Damping Type
The modal damping is a fraction of the critical damping.
The critical damping is computed as follow:

where m is the mass of the system and k the stiffness of the system.

Rayleigh Damping Type
The Rayleigh damping is defined as follow:

where [M] is the mass matrix, [K] is the stiffness matrix.
3. Compute the frequency solution.
For more details, please refer to Computing Frequency Solutions.
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You have to compute the frequency solution before defining the damping
parameters.

4. Click the Component edition button

to define the damping parameters.

The Damping Defintion dialog box appears.

Modal Damping Defintion

❍

❍

Global ratio: lets you define the factor of the critical damping for all the
modes (in %).
Definition mode by mode: lets you define the critical damping ratio (in %)
independently for each mode.
Multi-selection is available in this case.

Rayleigh Damping Definition
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❍

Global ratio: lets you define the Alpha (mass ratio) and/or Beta
(stiffness ratio) coefficients for all the modes.
■
Alpha (mass ratio): lets you define the factor of the mass ratio (in %).
■

❍
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Beta (stiffness ratio): lets you define the factor of the stiffness ratio (in
%).

Definition mode by mode: lets you define the Alpha (mass ratio) and/or
Beta (stiffness ratio) coefficients (in %) independently for each selected
mode.
Multi-selection is available in this case.

5. Define the desired damping parameters and click OK in the Damping Choice dialog
box.
6. Click OK in the Damping Definition dialog box.
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Model Manager
Mesh Creation
Create 3D Mesh Part
Delete and/or add OCTREE tetrahedron mesh
Create 2D Mesh Part
Delete and/or add OCTREE triangle mesh
Create 1D Mesh Part
Create beam mesher

Element Type
Create Local Mesh Sizes
Generate local element sizes.
Element Type
Specify the element type.
Create Local Mesh Sags
Generate local element sags.

Mesh Property Creation
Create 3D Property
Create 3D properties.
Create 2D Property
Create 2D properties globally and, if needed, locally.
Import Composite Property
Import composite property.

Create 1D Property
Create 1D properties globally and, if needed, locally.
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Create Imported Beam Property
Create beam properties globally and, if needed, locally.
Changing Element Type
Change the type of 1D or 2D element.

Creating a User Material
Create an analysis material without specifying a geometrical support.
Modifying Material Physical Properties
Modify the physical properties of a material.
Editing a User Isotropic Material
Edit a user isotropic material that has been created in the previous releases.

Mesh Check
Check the Model
Check whether mesh part, properties and material were properly applied. Check can
be performed on bodies, connection and/or others (specifications).
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Creating 3D Mesh Parts
This task shows you how to add 3D mesh part.
3D mesh can be deleted and/or added to parts manually.
Open the sample39.CATAnalysis document from the samples directory.
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1. Delete OCTREE Tetrahedron Mesh.2: Part1.2.
For this, right-click on the feature in the specification tree and select the Delete
option from the displayed contextual menu.
The specification tree appears as shown here:

2. Click the Octree Tetrahedron Mesher icon

.

3. Select the part you want to assign a new Mesh part. In this particular case, select
PartBody.

The OCTREE Tetrahedron Mesh dialog box appears.
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Global tab: change global parameters
❍

Size

❍

Absolute sag

❍

Element type
■
Linear
■

Parabolic

Local tab: create local parameters
❍

Local size

❍

Local sag

❍

Imposed points

4. Enter the desired options in the OCTREE Tetrahedron Mesh dialog box. In this case,
change the Size to 24mm.
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5. Click OK in the OCTREE Tetrahedron Mesh dialog box.

The new mesh has been created manually and the specification tree is updated.

To know more about the Element Type you have to choose in the OCTREE Tetrahedron
Mesh dialog box, see Linear Tetrahedron and Parabolic Tetrahedron in the Finite Element
Reference Guide.
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Creating 2D Mesh Parts
This task shows you how to add 2D mesh part.
2D mesh can be deleted and/or added to parts manually.
Open the sample40.CATAnalysis document from the samples directory.
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1. Click the Octree Triangle Mesher icon

.

2. Select the 2D element.

The OCTREE Triangle Mesh dialog box appears.

Global tab: change global parameters
❍

Size

❍

Absolute sag

❍

Element type
■
Linear
■

Parabolic

To know more about the Element Type you have to choose in the
OCTREE Tetrahedron Mesh dialog box, please refer to Linear Triangle and
Parabolic Triangle in the Finite Element Reference Guide.

Local tab: create local parameters
❍

Local size

❍

Local sag

❍

Imposed points

3. If needed, modify the option in the OCTREE Triangle Mesh dialog box. In this
particular case, keep the default options.
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4. Click OK in the OCTREE Triangle Mesh dialog box.

The OCTREE Triangle Mesh.2 feature now appears in the specification tree.
Note that now the corresponding 2D Property is missing. For more details on how
to add this missing 2D property, see task called Creating 2D Property.

You can change the physical property of 2D mesh element you just
created using the Changing Element Type contextual menu.

At any time, you can delete the Mesh feature.
For this, right-click on the feature in the specification tree and select the Delete
contextual menu.
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Creating 1D Mesh Parts
This task shows you how to add beam mesh to a Generative Shape Design CATPart.

●

You cannot select a sketch geometry.

●

You cannot mesh 1D body belonging to hybrid body.

Open the sample47.CATAnalysis document from the sample directory.

1. Click the Beam Mesher icon

.

2. Select the beam to be meshed.

The Beam Meshing dialog box appears.
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❍

Element Type: lets you choose the 1D element type:
■

■

❍

❍

(linear): 1D element without intermediate node.
By default, this element is a beam but you can work with linear bar
element using the Change Element Type contextual menu.
For more details about these elements, please refer to Beam and
Linear Bar in the Finite Element Reference Guide.

(parabolic): 1D element with an intermediate node.
This element can only be a parabolic bar. For more details about
this element, please refer to Parabolic Bar in the Finite Element
Reference Guide.

Element size: lets you specify the element size.
Sag control:
■
Sag: lets you define the distance between the mesh elements and
the geometry.
■

Min size: lets you define the minimum element size.

3. Select the desired Element Type.

In this particular example, select linear by clicking the

button.

4. Enter the desired Element size value in the Beam Meshing dialog box.
In this particular case, enter 3mm.
5. Activate the Sag control option in the Beam Meshing dialog box.
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6. Modify the Sag control parameters if needed.
7. Click OK in the Beam Meshing dialog box.

The 1D Mesh.1 feature now appears in the specification tree. Note that now the
corresponding Beam Property is missing.
For more details on how to add this Beam Property, see task called Creating
Beam Property.

●

●

To apply a restraint, a load or a connection to one extremity of a beam, you need to
first put the point that were possibly created at the extremity of this beam, in order to
build the wireframe, into the Hide mode. As result, to apply the above mentioned
specifications, you will select the extremity of the wireframe and not the hidden point
(small cross in the 3D view) as this point is not linked to the mesh.
You cannot apply beam properties and 1D mesh parts on geometry included in a
sketch.

1D or beam mesh can be deleted and/or added to parts manually.
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Creating Local Mesh Sizes
This task will show you how to create a Local Mesh Size specification on a Mesh Part and
how to specify element type.
The Mesh Part objects set contains all user specifications relative to the Mesh. In particular,
global size and sag specifications, as well as global element order specifications.
Local Mesh Sizes are local specifications relative to the size of the elements constituting the
finite element mesh.
You can use the sample00.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Local Mesh Size icon

.

The Local Mesh Size dialog box is displayed.
In the case of an assembly, you will select from the specification tree the Mesh
object which you want to modify the size (Nodes and Elements feature).
You can change the name of the Local Size by editing the Name field.

2. Enter an element size in the Value field.
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You can use the ruler button on the right of the field to enter a distance between
two supports by selecting them in sequence.
The smallest element size which can be used to generate a mesh is 0.1mm. In
order to avoid geometrical problems in the mesher, the smallest size of an element
is set to 100 times the geometrical model tolerance. This tolerance is actually set to
0.001mm and cannot be modified whatever the dimension of the part. This is why
the mesh global size must be bigger than 0.1mm.
3. Select a geometry for applying a local size.

4. Click OK to create the Local Size.

A symbol representing the Local Size is visualized on the support.
A Local Size object appears in the specification tree under the active Mesh Part
objects set.
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You can select several geometry supports to apply the Local Size to all simultaneously.
To edit the Mesh Part objects set, simply right-click on the Mesh Part objects set (key 3)
and select .object -> Definition, or double-click the Mesh Part symbol.

Element Type
You can specify the element type.

For this, click the Element Type icon

from the Model Manager toolbar.

The Element Type dialog box lets you modify the type of the element.

To know more about the Element Type you have to choose in the OCTREE Tetrahedron
Mesh dialog box, see Linear Tetrahedron and Parabolic Tetrahedron in the Finite Element
Reference Guide.
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Edit the Tetrahedron Mesh Specifications
You can edit the Tetrahedron Mesh specifications.
For this, double-click the OCTREE Tetrahedron Mesh.1 feature in the specification tree.
The OCTREE Tetrahedron Mesh dialog box appears.
Global tab:

●

Size

●

Absolute sag

●

Element type
❍
Linear
❍

Parabolic

Local tab:

Generative Structural Analysis

●

Local size

●

Local sag

●

Imposed points
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The local size actions described above are all accessible in this alternate way, by setting the
specification and pressing the Add button.
You can apply in sequence several Local Size specifications to the system. A separate object
will be created for each specification in the specification tree.
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Creating Local Mesh Sags
This task shows how to create a Local Mesh Sag specification on a Mesh Part.
The Mesh Part objects set contains all user specifications relative to the Mesh. In particular,
global size and sag specifications, as well as global element order specifications.
Local Mesh Sags are local specifications relative to the maximum distance between the
element boundaries and the boundary of the system.
You can use the sample00.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Local Mesh Sag icon

.

The Local Mesh Sag dialog box appears.
In the case of an assembly, you will select from the specification tree the Mesh
object of which you want to modify the sag (Nodes and Elements feature).

You can change the name of the Local Sag by editing the Name field.
2. Enter an element sag in the Value field.
You can use the ruler button on the right of the field to enter a distance between
two supports by selecting them in sequence.
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3. Select a geometry for applying a local sag.

4. Click OK to create the Local Sag.
A symbol representing the Local Sag is visualized on the support.
A Local Sag object appears in the features tree under the active Mesh Part objects
set.

●

●

●

You can select several geometry supports to apply the Local Sag to all simultaneously.
To edit the Mesh Part objects set, simply right-click on the Mesh Part objects set and
select .object -> Definition, or double-click the Mesh Part symbol in the features tree.
To edit the global and local characteristics of the OCTREE tetrahedron mesh, simply
right-click on the OCTREE Tetrahedron Mesh.1 feature and select .object ->
Definition, or double-click the OCTREE Tetrahedron Mesh.1 feature in the
specification tree.
The OCTREE Tetrahedron Mesh dialog box appears.

You can edit the following global characteristics in the Global tab of the dialog box:
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●

Size

●

Absolute sag

●
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Element type
❍
Linear
❍

Parabolic

You can further edit the following local characteristics by pressing the Local tab of the
dialog box:

●

Local size

●

Local sag

●

Imposed points

The local sag actions described above are all accessible in this alternate way, by setting the
specification and pressing the Add button.
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You can apply in sequence several Local Sag specifications to the system. A separate object
will be created for each specification in the features tree.

To know more about the Element Type you have to choose in the OCTREE Tetrahedron
Mesh dialog box, see Linear Tetrahedron and Parabolic Tetrahedron in the Finite Element
Reference Guide.
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Creating 3D Properties
This task shows you how to add 3D physical properties to a body, on the condition a mesh
part was previously created.
A 3D property is a physical property assigned to a 3D part. A solid property references a
material assigned to this 3D part. A solid property is associative to the geometry this
property points at.
To know more about this property, see Solid Property in the Finite Element Reference Guide.
Open the sample41.CATAnalysis document from the samples directory.
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1. Click the 3D Property icon
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.

The 3D Property dialog box appears.

❍

Name: lets you change the name of the property.

❍

Support: lets you select a support.

❍

Select Mesh Parts: this button is only available if you have selected a support.

❍

Material: indicates that a material has been applied on the selected support.

❍

User-defined material: lets you select an user isotropic material on condition
that it has been previously created.
For more details, please refer Creating an User Material.

2. Select the part to be applied a 3D property.

The 3D Property dialog box now appears as shown here:

3. Click OK in the 3D Property dialog box.
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The 3D property is created.
The specification tree is updated: the 3D Property.1 feature is displayed.

You can manually add and delete 3D properties.
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Creating 2D Properties
This task shows you how to:
●
add 2D physical properties to a modified product
●

create local 2D properties (on the condition a shell property was previously added to the
part)

A 2D property is a physical property assigned to a surface part. A 2D property references a
material assigned to the surface Part and describes a thickness associated to this surface
Part. A 2D property is associative to the geometry this property points at. You can also
associate a local thickness to a piece of the geometry.
To know more about this property, see Shell Property in the Finite Element Reference Guide.
Open the sample51.CATAnalysis document.
In this particular case, a mesh part has been previously created.

Before You Begin:
Be aware that the default thickness corresponds to the thickness that was possibly previously
defined in Generative Shape Design workbench (Tools->Thin Parts Attributes option in
the menu bar). Associativity exists between the thickness of the part and the corresponding
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CATAnalysis shell property. Of course, you can modify this thickness as necessary using
Analysis workbench, afterwards.

Add 2D Physical Properties
You can add 2D physical properties to a body.

1. Click the 2D Property icon

.

The 2D Property dialog box appears.

❍

Name: lets you modify the name of the property

❍

Supports: lets you select a support

❍

Select Mesh Parts: this button is only available if you have selected a support

❍

Material: indicates you that a material has been applied on the selected support

❍

User-defined material: lets you select an user isotropic material on condition
that it has been previously created
For more details, please refer Creating an User Material..

❍

Thickness: lets you change the value of the thickness

❍

Data Mapping
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You can re-use data (Data Mapping) that are external from this version
(experimental data or data coming from in-house codes or procedures). For
more details, see Data Mapping (only available if you installed the ELFINI
Structural Analysis (EST) product).

2. Select the support to be applied a 2D property.

The 2D Property dialog box is updated as shown here:

3. Enter 2mm as Thickness value.
4. Click OK in the 2D Property dialog box.
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The 2D Property is created and a symbol appears on the geometry:

A 2D Prorperty.1 feature appears in the specification tree:

Create Local 2D Property
You can associate a local thickness to a piece of the geometry.
This functionality is only available if you installed the ELFINI Structural Analysis
(EST) product.
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1. Right-click the 2D Property.1 feature previously created in the specification tree and
select the Local 2D Property contextual menu

.

The Local 2D Property dialog box appears.

❍

Name: you can modify the name of the property.

❍

Supports: you can select a support.

❍

Select Mesh Parts: this button is only available if you have selected a support.

❍

Material: indicates you that a material has been applied on the selected support.

❍

User Defined Material: lets you select an user isotropic material on condition
that it has been previously created
For more details, please refer Creating an User Material.

❍

Thickness: you can change the value of the thickness.

❍

Data Mapping: for more details, see Data Mapping.

2. Select the part of the geometry on which you want to apply a local 2D property.
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The Local 2D Property dialog box is updated as shown here:

3. Enter 1mm as Thickness value.
4. Click OK in the Local 2D Property dialog box.
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The Local 2D Property is created and symbols appear on the geometry.

A Local 2D Prorperty.1 feature appears in the specification tree.

Note that you can manually edit or delete a 2D Property and a Local 2D Property.

Page 142

Version 5 Release 14

Generative Structural Analysis

Page 143

Importing Composite Properties
This task shows you how to import a composite property.
In the analysis context, composite properties will be applied on 2D geometries on which composite design has
been defined in the Composite Design workbench.
For more details, please refer to the Composite Design User's Guide.
You will see here how to generate a composite finite element model from the design by:
●

zones

●

plies

Only available with the ELFINI Structural Analysis (EST) product.

Definition Based on Zones
Open the sample06.CATAnalysis document.

1. Click the Imported Composite Property icon

.

The Imported Composite Property dialog box appears.

❍

Name: lets you modify the name of the property.

❍

Supports: lets you select a 2D body as support.

❍

Analysis: lets you choose the zone approach or the ply approach.
■
By zone: lets you choose the zone approach.
■
Zones must have been defined in the Composite Design workbench.
■

■

❍

Transition zones defined in the Composite Design workbench are ignored.

By ply: lets you choose the ply approach.

Core sampling depth: lets you define an optional tolerance to control the number of plies or zones
taken into account in the analysis context.

2. Select the support as shown bellow.
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The Imported Composite Property dialog box is updated as shown bellow:

3. Select By zone as Analysis option.
4. Click OK in the Imported Composite Property dialog box.

An Imported Composite Prorperty.1 feature appears in the specification tree under the Properties.1
set.

Note that the applied materials are not visible under the Materials.1 set in the specification tree.
However you can edit and change the material properties.
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For this:
a. Select the File -> Desk menu.
b. Right-click the CompositesCatalog.CATMaterial document and select the Open contextual
menu.
c. Double-click a material to edit it.

The Properties dialog box appears.
d. Change the desired parameters in the Analysis tab of the Properties dialog box.

For more details about this tab, please refer to Modifying Material Physical Properties in this guide.
e. Click OK in the Properties dialog box.
In this particular example, do not change material physical properties.
5. Click the Compute icon and select Mesh Only in the Compute dialog box.
6. Right-click the Properties.1 set and select the Generate Image contextual menu.
7. Select Composite angle symbol as image and click OK in the Image Generation dialog box.

The following image visualization is displayed:

8. Edit the image you just generated.
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In this particular example:
❍

double-click the Composite angle symbol.1 image,

❍

click the More button to expand the Image Edition dialog box,

❍

enter 6 as Lamina value,

❍

click OK in the Image Edition dialog box.

The image visualization is updated and lets you visualize the sixth lamina:

Definition Based on Plies
Open the sample06.CATAnalysis document.

1. Click the Imported Composite Property icon

.
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The Imported Composite Property dialog box appears.

To know more about the Imported Composite Property dialog box, please click here.
2. Select the support as shown bellow.

The Imported Composite Property dialog box is updated as shown bellow:

3. Select By ply as Analysis option.
4. Click OK in the Imported Composite Property dialog box.
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An Imported Composite Prorperty.1 feature appears in the specification tree under the Properties.1
set.

In this particular example, do not change material physical properties.
5. Click the Compute icon and select Mesh Only in the Compute dialog box.
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Creating 1D Properties
This task shows you how to:
●

●

add 1D physical properties to a shape design by selecting a meshed wireframe geometry
create local 1D properties (on the condition a 1D property was previously applied to the
geometry)

A 1D property is a physical property assigned to a section of a part. You can also associate
a local 1D property to a piece of the geometry.
To know more about this property, see Beam Property in the Finite Element Reference
Guide.

Open the sample52.CATAnalysis document from the sample directory.

●

●

Make sure a material was applied to the geometry and a linear 1D mesh part was
assigned to the beam (it is already done in this particular case).
To know more about linear 1D mesh part, please refer to Creating 1D Mesh Parts in this
guide.
You cannot apply 1D properties and 1D mesh parts on geometry included in a sketch.

Add 1D Physical Properties
You can add 1D physical properties to a shape design by selecting a meshed wireframe
geometry
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1. Click the 1D Property icon
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.

The 1D Property dialog box appears.

❍

Name: lets you modify the name of the property.

❍

Supports: lets you select a support.

❍

❍

❍

Select Mesh Parts: this button is only available if you have selected a support.
For more details, please click here.
Material: indicates you that a material has been applied.
Type: lets you choose the type of section (and symbol) and define the
parameters.
Cylindrical

■

Radius: R

■

Outside Radius: Ro

■

Inside Radius: Ri

■

Length (Y): L

■

Height (Z): H

beam:
Tubular beam:

Rectangular
beam:
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Thin Box beam:

Thin U-beam:

Thin I-beam:

■

Exterior Length (Y): Le

■

Exterior Height (Z): He

■

Interior Length (Y): Li

■

Interior Height (Z): Hi

■

Global Length (Y): L

■

Global Height (Z): H

■

Global Thickness: T

■

Global Length (Y): L

■

■

■

Thin T-beam:

■

■

■

■

Thin X-beam:

■

■

■

■

Associated Thickness:
Tl
Global Height (Z): H
Associated Thickness:
Th
Global Length (Y): L
Associated Thickness:
Tl
Global Height (Z): H
Associated Thickness:
Th

Global Length (Y): L
Associated Thickness:
Tl
Global Height (Z): H
Associated Thickness:
Th
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User-defined
beam:

Beam from
surface *:

Bar *:

■

Cross-sectional Area

■

Ixx

■

Iyy

■

Izz

■

Shear center (Y)

■

Shear center (Z)

■

Shear Factor (XY)

■

Shear Factor (XZ)

■

Arbitrary section

■

■

Compute and display
■
Cross-sectional Area
■

Ixx

■

Iyy

■

Izz

■

Shear center (Y)

■

Shear center (Z)

■

Shear Factor (XY)

■

Shear Factor (XZ)

Cross-sectional Area

Any section

Any surface section**

Any section**

*: only available with the ELFINI Structural Analysis (EST) product.

**:
❍

❍

Beam from surface option:
■

The surface must be a 2D feature (as Fill, Join, ...).

■

You cannot select a sketch.

■

The surface must be plane and continue.

Bar option:
Before launching a Mesh only or All computation with this option, make
sure that the mesh element type is bar.
For more details, please refer to Changing Element Type.

If you select a geometry option, all the data of the user-defined beam are
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computed.
❍

Orientation Point: the orientation point gives the orientation of the Y direction
for any wire frame at any point: X is fixed tangent to the wire frame and in the
direction of the oriented wire frame. After computation is performed, to
visualize particular axis on each element, right-click on the property set and
select the Generate Image called Local axis symbol (see further below for
more details).
Avoid creating an orientation point that is tangent to the line or the
curve. If so, you may have some problems when computing the case.

❍

❍

User-defined material: lets you select an isotropic material that you have
created.
For more details, please refer Creating an User Material.
Variable beam factors: lets you create a linear approximation of variable
cross section beams.
If you activate this option, two new fields appear in the Beam Property dialog
box.

The Multiplication Factors on extremities frame will let you give a scaling
factor on each side of the section. The beam will then be modeled as a
sequence of constant section beams with linearly decreasing dimensions.
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■

Starting Factor

■

Ending Factor
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2. Select the support geometry to be applied a 1D property.

The 1D Property dialog box is updated as shown here:

3. Select Rectangular beam as Section option.

4. Click the Component Edition button
dimensions.

in the 1D Property dialog box to define
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The Beam Definition dialog box appears.

5. Enter 10 mm in the Length (Y) field and 10 mm in the Height (Z) field.
6. Click OK in the Beam Definition dialog box.

Symbols appear on the geometry to simulate the section of the beam.

7. Activate the Orientation Point field and select a point.

The 1D Property dialog box appears as shown here:
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8. Click OK in the 1D Property dialog box.

The 1D Property is added. In this case, 1D Prorperty.1 feature appears in the
specification tree.
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Create Local 1D Property
This functionality is only available if you installed the ELFINI Structural Analysis
(EST) product.
You can associate a local section to a piece of the geometry.

1. Right-click the 1D Property.1 feature previously created in the specification tree
and select the Local 1D Property contextual menu.

The Local 1D Property dialog box appears.

❍

Name: lets you modify the name of the property.

❍

Supports: lets you select a support.

❍

❍

❍

❍

❍

Select Mesh Parts: this button is only available if you have selected a support.
For more details, please click here.
Material: indicates you that a material has been applied.
User Defined Material: lets you select an user isotropic material on condition
that it has been previously created.
For more details, please refer Creating an User Material.
Type: lets you choose the type of section (and symbol) and define the
parameters.
For more details, please click here.
Orientation Point: the orientation point gives the orientation of the Y direction
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for any wire frame at any point: X is fixed tangent to the wire frame and in the
direction of the oriented wire frame. After computation is performed, to visualize
particular axis on each element, right-click on the property set and select the
Generate Image called Local axis symbol (see further below for more details).
❍

Variable beam factors: lets you create a linear approximation of variable cross
section beams.
If you activate this option, two new fields appear in the Local 1D Property dialog
box.

The Multiplication Factors on extremities frame will let you give a scaling
factor on each side of the section. The local 1D will then be modeled as a
sequence of constant section beams with linearly decreasing dimensions.
■

Starting Factor

■

Ending Factor

2. Select the part of the geometry on which you want to apply a local 1D property.
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The Local 1D Property is updated as shown here:

3. Change the Type option. In this particular case, select the Thin box beam option.

The geometry appears as shown here.

4. Click the Component Edition button
define the dimensions of the section.

in the Local 1D Property dialog box to
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The Beam Definition dialog box appears.
5. Enter the following values in the different fields of the Beam Definition dialog box.

6. Click OK in the Beam Definition dialog box.
7. Select a point as Orientation Point.

8. Click OK in the Local 1D Property dialog box.

A Local 1D Property.1 feature appears in the specification tree.

Note that you can manually edit or delete 1D properties.
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Creating Imported Beam Properties
This task will show you how to create a beam property on a beam imported from the Equipment Support
Structures workbench.
The Equipment Support Structures beams will be recognized as features to 1D mesh during the transition (the
wire frame along which the section of the beam is swept is the geometry that will be 1D mesh). A beam
property will be created as well with mechanical properties imported from the Equipment Support Structures
catalogs.
The only sections supported in the Analysis solutions are the Standard Catalog Sections of the
Equipment Support Structures workbench.
The User-defined Sections are not supported in the Analysis solutions.
Moreover, the beam mesher will accept the selection of an Equipment Support Structures beam and a specific
command lets you import the mechanical properties from the model into a beam property.
For more details about the beam creation in the Equipment Support Structures workbench, please refer to the
Equipment Support Structures User's Guide.
Loads and restraints can be applied only on beam vertices.
You have to make a list of sections and create a member in the Equipment Support Structures workbench, then
you have to enter in the Generative Structural Analysis workbench.
Open the sample10.CATAnalysis document from the sample directory.
In this example, all the pre-requisites are done. Note that:
●

the Nodes and Elements set contains a 1D Mesh object

●

the Properties set contains an Imported Beam Property object.
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1. Double-click the Imported Beam Property.1 object in the specification tree.
The Imported Beam Property dialog box appears.

❍

Name: lets you change the name of the property.

❍

Supports: lets you select the support on which the imported beam property will be applied.

❍

Select Mesh Parts: this button is only available if you have selected a support.

❍

Material: gives you information about the material associated to the selected support.

2. Click the Clamp icon.
The Clamp dialog box appears.
3. Select a vertex as Support.

4. Click OK on the Clamp dialog box.
5. Click the Distributed Force icon.
The Distributed Force dialog box appears.
6. Select a vertex as Support, enter 100N in the Z field.

7. Click OK in the Distributed Force dialog box.
8. Compute the solution.
For this, click the Compute icon, select the All option in the Compute dialog box and click OK.
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9. Click the Deformation icon.
You can visualize the deformation of the beam.

To have a better visualization of the deformation, you can use the Animate icon.
For more details, please refer to Animating Images.
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Changing Element Type
This task shows you how to use the Change Type contextual menu in the Generative
Structural Analysis workbench and the Advanced Meshing Tools workbench (only with the
FEM Surface product).
You can change the type of:
●

1D element

●

the physical property associated to 2D element

Only available with the ELFINI Structural Analysis (EST) product.

Changing Type of 1D Element
Open the sample52.CATAnalysis document from the sample directory.

1. Click the 1D Property icon

and select the 1D geometry.

2. Select Bar as Type option.

A message appears to inform you that you cannot apply a bar property to
beam elements.
You have to change the element type from beam to bar.
3. Click Cancel in the 1D Property dialog box.
4. Right-click the 1D Mesh.1 object in the specification tree (under the Nodes and
Elements set) and select the Change Type contextual menu
.
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The Change Physical Type dialog box appears.

❍

Type: lets you select the desired element type.
■
Beam: this element type is useful for all the beam property you can select in
the 1D Property dialog box.
For more details about the beam element, please refer to Beam in the Finite
Element Reference Guide.
■

Bar: this element type is recommended if you select Bar as 1D property
type.
For more details about the bar element, please refer to Linear Bar or
Parabolic Bar in the Finite Element Reference Guide.

5. Select the desired Type option.

In this particular example, select Bar as Type option.
6. Click OK in the Change Physical Type dialog box.

7. Click the 1D Property icon

.

8. Set the following parameters:
❍

select the 1D geometry as Support,

❍

select Bar as Type option.

9. Click OK in the 1D Property dialog box.
10. Compute the case.

Changing Physical Property of 2D Element
Open the sample52.CATAnalysis document from the sample directory.
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1. Right-click a 2D mesh part in the specification tree (under the Nodes and
Elements set) and select the Change Type contextual menu
.

The Change Physical Type dialog box appears.

❍

Type: lets you change the physical property of 2D element mesh.
■
Shell: lets you associate a shell property to 2D element.
For more details about the shell property, please refer to Shell Property in
the Finite Element Reference Guide.
■

■

Membrane: lets you associate a membrane property to 2D element.
For more details about the membrane property, please refer to Membrane
Property in the Finite Element Reference Guide.
Shear panel: only available for linear smart surface (linear quadrangle)
mesh part.
lets you associate a shear panel property to 2D element.
For more details about the shear panel property, please refer to Shear Panel
Property in the Finite Element Reference Guide.
If you define a parabolic smart surface (parabolic quadrangle) mesh
part with Shear panel elements, all the elements will be changed in
Membrane elements.

2. Select the desired Type option.
3. Click OK in the Change Physical Type dialog box.
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Creating a User Material
This task shows you how to create a user material with no geometrical support.
The user material will be added under the Material set in the analysis context contrary to
the Apply Material functionality.
For example, this material should be useful for properties that have mesh support.

Open the sample51.CATAnalysis document from the sample directory.

1. Click the User Material icon

.

The Library dialog box appears.
For more details about the Library dialog box, please refer to the Real Time
Rendering User's Guide.
2. Choose the desired material in the Library dialog box.

In this particular example, select Aluminium in the Metal tab.
3. Click OK in the Library dialog box.
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A User Material.1 object appears in the specification tree under the Material.1
set.

4. Double-click the User Material.1 object in the specification tree.
You can also right-click the User Material.1 object and select the Properties
contextual menu.

The Properties dialog box appears. This dialog box lets you modify the physical
properties of the user material using the Analysis tab.
For more details about the Analysis tab of the Properties dialog box, please refer to
Modifying Material Physical Properties.
5. Select the Analysis tab in the Properties dialog box.

By default, the Analysis tab appears as shown bellow:
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6. Modify the parameters if needed.
7. Click OK in the Properties dialog box.
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Modifying Material Physical Properties
This task shows you how to modify physical properties of a material belonging to a .CATPart or
a .CATProduct document or a user material contained in the Material set of a .CATAnalysis
document.

Open the sample51.CATAnalysis document from the sample directory.
1. Right-click a material in the specification tree and select the Property contextual menu
or double-click a user material under the Material set.

In this particular example, right-click the Iron material under the Part1-Geometrical
Set.1-Extrude.1 object in the specification tree and select the Properties contextual
menu.
The Properties dialog box appears.
For more details about the Properties dialog box, please refer to the Real Time Rendering
User's Guide.
2. Select the Analysis tab in the Properties dialog box.

Generative Structural Analysis
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Material: lets you change the material type.
Structural Properties: lets you modify the physical parameters associated a
material type.

The Structural Properties parameters depend on the selected Material option:
❍

Isotropic material:

❍

Orthotropic material 2D:

Page 171

Generative Structural Analysis

❍

Fiber material:
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❍

Honey comb material:

❍

Orthotropic material 3D:
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❍

Anisotropic material:
This option is not available if you work with composite materials.
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The following components lets you define the mechanical behavior of the selected
material.
3. Select the desired Material option in the Properties dialog box.
4. Enter the desired parameters in the Properties dialog box.
5. Click OK in the Properties dialog box.
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Editing a User Isotropic Material
This task shows you how to edit a user isotropic material with no geometrical support.
For example, this material should be useful for properties that have mesh support.

From the V5R14 release, you cannot create a user isotropic material anymore.
You can only edit a user isotropic material that has been created in the previous releases.

Open the sample48_1.CATAnalysis document from the sample directory.

1. Double-click the User Isotropic Material object under the Material.1 set in the
specification tree to edit it.

The User Isotropic Material dialog box appears.

❍

❍

Name: lets you change the name of the user isotropic material.
The following components lets you define the mechanical behavior of the
material
■
Young Modulus (in N_m2)
■

Poisson Ratio

Version 5 Release 14

Generative Structural Analysis

■

Density (in kg_m3)

■

Thermal Expansion

■

Yield Strength (in N_m2)

2. If needed, modify the parameters in the User Isotropic Material dialog box.
3. Click OK in the User Isotropic Material dialog box.
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Checking the Model
This task lets you know how to check whether specification assigned to a model are consistent. You can perform check
operations on:
●

Bodies

●

Connections

●

Others

Note that this check on features considered as inconsistent is performed both via the dialog box (one line per feature
and a dedicated diagnostic box) and via highlighted associated features in the specification tree.

We advise that you perform a check before computing a case.

Check on Bodies
Check on bodies means on all the Mesh parts (1D, 2D, 3D) as well as their properties and supports.

Scenario1: You created a new property
For this, you selected the Solid Property command and selected pad1.
Open the sample37.CATAnalysis document from the samples directory.

1. Click the Model Check icon

from the Model Manager toolbar.
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The Model Check dialog box appears with the following tabs:
❍

Bodies: the lists of all the Mesh parts (1D, 2D, 3D) as well as their properties and supports.

❍

Connections: any connection specification

❍

Others: specification features (loads, restraints, virtual parts)

The Model Check dialog box displays all the parts (one per line in the dialog box) which are assigned at least
one mesh part or property.
A status is assigned to each Mesh part you select in the dialog box, to let you know whether:
❍

you forgot to assign the material

❍

you assigned no or too many Mesh parts

❍

you assigned no or too many properties.

When you select a part in the table, the corresponding features in the specification tree and in the model as
well as the assigned properties and material are also highlighted.
In this particular case, more than one property has been defined.
2. Click OK to leave the dialog box.
3. Delete the property you do not need and get this:

4. Click the Model Check icon

from the Model Manager toolbar.
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The specifications are now consistent: all the states are set to OK.

5. Click OK to leave the dialog box.

Scenario2: You deleted the material from an OCTREE mesh part
Open the sample38.CATAnalysis document from the samples directory.

1. Click the Model Check icon

from the Model Manager toolbar.
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The Model Check dialog box appears with the following tabs:
❍

Bodies: the lists of all the Mesh parts (1D, 2D, 3D) as well as their properties and supports.

❍

Connections: any connection specification

❍

Others: specification features (loads, restraints, virtual parts)

The Model Check dialog box displays the lists of all the Mesh parts as well as their properties and supports.

A status is assigned to each Mesh part to let you know whether:
❍

you forgot to assign the material

❍

you assigned no or too many Mesh parts

❍

you assigned no or too many properties.

When you select a part in the table, the corresponding features in the specification tree and in the model as
well as the assigned properties and material are also highlighted.
In this particular case, No Mesh Part is defined
2. Click OK to leave the dialog box.
3. Create a mesh part applied on PartBody of Part1.3 and get this:

4. Click the Model Check icon

.
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The specifications are now consistent: all the states are set to OK.

5. Click OK to leave the dialog box.

Check on Connections
Check on connections means on any connection specification. In other words, you will check the consistency of the
connections regarding the following: missing mesh parts, properties, materials ; connected supports with no
associated mesh parts ; overlapping connections and so forth.

Scenario: You deleted the mesh part of a part that was connected to another
Open the sample50.CATAnalysis document from the samples directory.
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from the Model Manager toolbar.

The Model Check dialog box appears with the following tabs:
❍

Bodies: the lists of all the Mesh parts (1D, 2D, 3D) as well as their properties and supports.

❍

Connections: any connection specification

❍

Others: specification features (loads, restraints, virtual parts)

The Model Check dialog box and Connections tab display all the parts (one per line in the dialog box) which are
assigned at least one connection:
❍

Mesh part and property assigned to this mesh part

❍

Connected mesh part

❍

Product to which the constraints was assigned

❍

Names of both mesh parts connected to each others

❍

Material (has no impact on Connection valid state).
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When you select a connected mesh part in the table, the corresponding features in the specification tree and in
the model as well as the assigned properties, material and constraints are also highlighted.

In this particular case, Face does not have a Mesh Part defined on it.
2. Click OK to leave the dialog box.
3. Create mesh parts on the geometry.

Check on Others
Check on others means on specification features such as loads, restraints, virtual parts, masses and periodic
conditions.

Scenario: You deleted the mesh part of a clamped part that was connected to another
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Open sample50.CATAnalysis document.

1. Click the Model Check icon

from the Model Manager toolbar.

The Model Check dialog box appears with the following tabs:
❍
Bodies: the lists of all the Mesh parts (1D, 2D, 3D) as well as their properties and supports.
❍

Connections: any connection specification

❍

Others: specification features (loads, restraints, virtual parts)

2. Delete OCTREE Tetrahedron Mesh.1 : Part1.1 feature in the specification tree.

The Model Check dialog box and Others tab display all the specifications features (one per line in the dialog
box) which are not correct as well as details on the status of the selected line. In this particular case, Clamp1 is
KO as the part the clamp was assigned to has been deleted.
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In this particular case, the root design feature is no more support of any Mesh specification for
Clamp.1 and Clamp.2.
3. Click OK to leave the dialog box.

The solution is therefore to add the mesh part to the invalidated part.
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Adaptivity
The adaptivite method implemented is the H-method.
At constant element order, the mesh is selectively refined (decrease element size) in such
a way as to obtain a desired results accuracy. The mesh refining criteria are based on a
technique called predictive error estimation, which consists of determining the
distribution of a local error estimate field for a given Static Analysis Case.
As a result, the use of the adaptative method makes it possible to reduce the memory
costs and the time costs.

Compute first the solution with parabolic elements.
Create Global Adaptivity Specifications
Generate glocal adaptive mesh refinement specifications.
Create Local Adaptivity Specifications
Generate a local adaptive mesh refinement specifications.

Computing with Adaptivity
Compute with Adaptivity
Computing adaptive solutions.
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Creating Global Adaptivity Specifications
This task shows how to create an Adaptivity on a Mesh Part for a given Static Analysis Case
Solution.
●

●

The Adaptivity functionalities are only available with static analysis solution or a
combined solution that references a static analysis solution.
The former adaptivity specifications (created before V5R12) can be edited but they can
not be computed with adaptativity.
If you modify these specifications and launch a computation with adaptativity, a
warning message informs you that these specifications will not be taken into account.
You have to create new adaptativity specifications.

Open the sample07.CATAnalysis document from the samples directory.
Before You Begin:
●

Compute the solution.
For this:
❍

click the Compute icon

❍

select the All option

❍

click OK in the Compute dialog box.
For more details, please refer to the Compute Objects Sets.

●

Optionally, you can generate an error map image to visualize the current error.
For this, click the Precision icon

.

For more details, please refer to Visualizing Precisions.
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.

The Global Adaptivity dialog box appears.

❍

Name: lets you change the name of the global adaptivity.

❍

Supports: lets you select the supports on which you want to refine the mesh.
You can select as support one or several mesh part (Octree 2D or
Octree 3D).

❍

❍

❍

Solution: gives you inform information on the referenced solution name.
Objective error (%): lets you specify the objective error of the selected mesh
part.
Current error (%): gives you information on the current error of the selected
mesh part.

2. Select the desired mesh part.
In this particular example, select the OCTREE Tetrahedron Mesh.1: Part3 object
under the Nodes and Elements set.

The Global Adativity dialog box is updated. You can now visualize the value (in %)
of the current error.
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3. Enter the desired Objective error (%) value.
In this particular example, enter 9 as Objective error (%) value.
4. Click OK in the Global Adativity dialog box.
An Adaptivities.1 set is created in the specification tree containing a Global
Adaptivity.1 object.

●

●

You can edit the global adaptivity you just created.
For this, double-click the Global Adaptivity.1 object in the specification tree.
You can create several Adaptivities objects associated to the same Static Solution and
corresponding to the different mesh parts.

You can now compute the model with adaptivity (for more details, please refer to
Computing with Adpativity) or create local adaptivity specifications (for more details, please
refer to Creating Local Adpativity Specifications).
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Creating Local Adaptivity Specifications
This task shows how to create a local adaptivity on a Mesh Part for a given Static Analysis Case
Solution.

This functionality is only available if you installed the ELFINI Structural Analysis product.
●

●

The Adaptivity functionalities are only available with static analysis solution or a combined solution
that references a static analysis solution.
A global adaptivity must have been defined.
For more details about global adaptivity, please refer to Creating Global Adaptivity
Specifications.

Open the sample07_1.CATAnalysis document from the samples directory.
In this particular example, a global adaptivity has been already defined.
1. Right-click the Global Adaptivity.1 object in the specification tree and select the Local
Adaptivity contextual menu

.

The Local Adaptivity dialog box appears.

❍

❍

❍

❍

❍

Name: lets you change the name of the local adaptivity.
Supports: gives you the list of the selected elements.
Multi-selection is available: you can select as support one or several vertices,
edges, faces or group (except body group).
This multi-selection may be non-homogeneous (that means that you can select two
edges and three faces, as example).
Solution: gives you inform information on the referenced solution.
Exclude elements: if you select this option, the selected elements will not have an
objective error and then, the Objective error (%) field will disappear.
In this case, elements will not be taken into account in the re-meshing algorithm.
Objective error (%): lets you specify the objective error of the selected mesh part.
This option is available only if the Exclude elements is deactivated.
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Current error (%): gives you information on the current error of the selected support.

2. Select the desired elements as support.
In this particular example, select one edge and two surfaces:

The Local Adativity dialog box is updated.
You can now visualize the value (in %) of the current error (on the condition you have not
activate the Exclude elements option).

You can visualize the other selected elements of the Supports list by clicking the arrows as
shown here:
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3. Enter the desired Objective error (%) value.
In this particular example, enter 20 as Objective error (%) value.
4. Click OK in the Local Adativity dialog box.
An Local Adaptivity.1 object is created under the Adaptivities.1 set in the specification tree.

You can edit the local adaptivity.
For this, double-click the Local Adaptivity.1 object in the specification tree.
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Computing with Adaptivity
This task shows how to compute with adaptivity.
Adaptivity management consists of setting global adaptivity specifications and computing
adaptive solutions.
●

The Adaptivity functionalities are only available with a static analysis solution or a
combined solution that references a static analysis solution.

●

To compute with adaptivity, you need to update the solution(s).

●

A global adaptivity and optionally a local adaptivity must have been defined.

●

●

The former adaptivity specifications (created before V5R12) can be edited but they can
not be computed with adaptativity.
If you modify these specifications and launch a computation with adaptativity, a warning
message informs you that these specifications will not be taken into account. You have to
create new adaptativity specifications.
Open the sample07_2.CATAnalysis document from the samples directory.
In this particular example, a global adaptivity and a local adaptivity have been already
defined.

●

Compute the static solution.

1. Activate the Estimated local error image to visualize the quality elements.

For this, right-click the Estimated local error image in the specification tree and
select the Activate/Deactivate contextual menu.

2. Double-click the Global Adaptivity.1 object in the specification tree to visualize the
current error.
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The Global Adaptivity appears.

Click Cancel to close the Global Adaptivity dialog box.
3. Double-click the Local Adaptivity.1 object in the specification tree.

The Local Adaptivity appears.

Click Cancel to close the Local Adaptivity dialog box.

4. Click the Compute with Adaptivity icon

.
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The Adaptivity Process Parameters dialog box appears.

❍

❍

❍

Name: gives you the name of the adaptivity set you want to compute.
Iterations Number: lets you specify the maximum number of iterations you
want to perform to reach the objective error you have defined.
Allow unrefinement: lets you choose to allow refinement or not.
If you allow unrefinement, the global sizes of the mesh parts may be
modified.

❍

Deactivate global sags: lets you choose to ignore the global sags.
Existing global sags will be deactivated.

❍

Minimum size: lets you specify a minimum mesh size.
The objective size must be superior to the mesh size.

❍

Sensor stop criteria: lets you specify a sensor.
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If you activate this option, the Parameter Convergence frame appears:

■

Sensor parameter: lets you select the sensors.
Multi-selection of sensor criteria is available.

■

Tolerance (%): lets you specify the tolerance value.

To sum up, the adaptivity process stops as soon as:
❍

the maximum number of iterations is reached,

❍

or all objective errors are reached,

❍

or all sensors converged.

5. Deactivate the Minimum size option.
6. Select the Sensor stop criteria option in the Adaptivity Process Parameters dialog
box.
7. Activate the Sensor parameter field, select a sensor and enter a Tolerance value
(in %).
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In this particular example, select the Energy sensor as shown bellow:

You can add other sensor criteria, delete a sensor criteria or delete all the
sensor criteria.
For this, right-click a line and select the desired contextual menu: Add,
Delete or Delete All.

8. Click OK in the Adaptivity Process Parameters dialog box.
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The Computation Status dialog box appears.
At the end of the computation, a Warnings message appears to inform you that the
selected sensor has not converged and the objective error is not reached.

9. Click OK in the Warnings message.

Note that a Local Mesh Size Map.1 object has been created under OCTREE
Tetrahedron Mesh.1 in the specification tree and that the Adaptivities.1 set is
now valid.

10. Activate the Estimated local error image to visualize the quality elements.
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For this, right-click the Estimated local error image in the specification tree and
select the Activate/Deactivate contextual menu.

11. Double-click the Global Adaptivity.1 object in the specification tree to visualize the
current error value.

The Global Adaptivity dialog box appears.

Note that: after the first iteration of computation with adaptivity, the objective error
you have specified (9%) is not reached.
12. Click OK in the Global Adaptivity dialog box.

13. Click the Compute with Adaptivity icon

.

The Adaptivity Process Parameters dialog box appears.
14. Enter 2 as Iterations Number value and click OK in the Adaptivity Process.
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15. Double-click the Global Adaptivity.1 object in the specification tree to visualize the
current error value.

The Global Adaptivity dialog box appears.

The objective global error you have specified is reached.
16. Double-click the Local Adaptivity.1 object in the specification tree.
The Local Adaptivity appears.

The objective local error you have specified is reached.
17. Activate the Estimated local error image to visualize the quality elements.
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Groups
Grouping elements allows you to apply pre-processing specifications to a pre-defined
group of elements (points, lines, surfaces or bodies) and to generate images from this
group.

Geometrical Groups
Group Points
Create groups of points.

Group Lines
Create groups of lines.

Group Surfaces
Create groups of surfaces.

Group Bodies
Create groups of bodies.

Free Groups
Box Group
Create groups based on box.

Sphere Group
Create groups based on sphere.

Proximity Groups
Group Point by Neighborhood
Create proximity point groups.
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Group Line by Neighborhood
Create proximity line groups.

Group Surface by Neighborhood
Create proximity surface groups.

Update
Update Groups
Update a group or a group set.
Analyze Group
Analyze and display the nodes, elements, faces of element and edges element of a
group.
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Grouping Points
This task shows how to group points and how to generate images from this group.
Grouping elements allows you to apply pre-processing specifications to a pre-defined group
of elements (points, lines, surfaces or bodies) and to generate images from this group.
This functionality is only available if you installed the ELFINI Structural Analysis (EST)
product.
Open the sample49.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Point Group icon

.

The Point Group dialog box appears.

2. Select in sequence the points you want to group.
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The Point Group dialog box is updated.

3. Click OK in the Point Group dialog box.

A Point Group.1 object appears in the specification tree but it is not updated.

4. Update the Point Group.
For more details, please refer to Updating a Group.

You can now visualize Deformation, Von Mises Stresses, Displacements, Principal
Stresses and Precisions images, either for all the geometry or only for the selected
points. The scenario is the same for the five images.
In this particular case, you will visualize the Von Mises Stresses image:
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5. Activate the Von Mises Stress image.

For this, right-click the Von Mises Stress (nodal value) object in the specification
tree and select the Activate/Deactivate option.

6. Double-click the Von Mises Stress (nodal value) object in the specification tree.

The Image Edition dialog box appears.
7. Double-click the Point Group.1 object in the Selections tab and click OK in the
Image Edition dialog box.

You will see the result only for the points belonging to the point group.

For more details about images, please refer to Results Visualization (Image
Creation, Generate Images and Editing Images).

You can manually edit or delete a group.
For this, right-click the group object in the specification tree and select the desired
contextual menu.
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Grouping Lines
This task shows how to group lines and how to generate images from this group.
Grouping elements allows you to apply pre-processing specifications to a pre-defined group
of elements (points, lines, surfaces or bodies) and to generate images from this group.
This functionality is only available if you installed the ELFINI Structural Analysis (EST)
product.
Open the sample49.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Line Group icon

.

The Line Group dialog box appears.

2. Select in sequence the lines you want to group.
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The Line Group dialog box is updated.

3. Click OK in the Line Group dialog box.

A Line Group.1 object appears in the specification tree but it is not updated.

4. Update the Line Group.
For more details, please refer to Updating a Group.

You can now visualize Deformation, Von Mises Stresses, Displacements, Principal
Stresses and Precisions images, either for all the geometry or only for the selected
lines. The scenario is the same for the five images.
In this particular case, you will visualize the Von Mises Stresses image:
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5. Activate the Von Mises Stress image.

For this, right-click the Von Mises Stress (nodal value) object in the specification
tree and select the Activate/Deactivate option.

6. Double-click the Von Mises Stress (nodal value) object in the specification tree.

The Image Edition dialog box appears.
7. Double-click the Line Group.1 object in the Selections tab and click OK in the
Image Edition dialog box.

You will see the result only for the lines belonging to the line group.

For more details about Images, please refer to Results Visualization (Image
Creation, Generate Images and Editing Images).

You can manually edit or delete a group. For this, right-click the group object in the
specification tree and select the desired contextual menu.
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Grouping Surfaces
This task shows how to group surfaces and how to generate images from this group.
Grouping elements allows you to apply pre-processing specifications to a pre-defined group
of elements (points, lines, surfaces or bodies) and to generate images from this group.
This functionality is only available if you installed the ELFINI Structural Analysis (EST)
product.
Open the sample49.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Surface Group icon

.

The Surface group dialog box appears.

2. Select in sequence the surfaces you want to group.
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The Surface Group dialog box is updated.

3. Click OK in the Surface Group dialog box.

A Surface Group.1 object appears in the specification tree but it is not updated.

4. Update the Surface Group.
For more details, please refer to Updating a Group.

You can now visualize Deformation, Von Mises Stresses, Displacements, Principal
Stresses and Precisions images, either for all the geometry or only for the selected
surfaces. The scenario is the same for the five images.
In this particular case, you will visualize the Von Mises Stresses image:
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5. Activate the Von Mises Stress image.

For this, right-click the Von Mises Stress (nodal value) object in the specification
tree and select the Activate/Deactivate option.

6. Double-click the Von Mises Stress (nodal value) object in the specification tree.

The Image Edition dialog box appears.
7. Double-click the Surface Group.1 object in the Selections tab and click OK in the
Image Edition dialog box.

You will see the result only around the surfaces belonging to the surface group.

For more details about Images, please refer to Results Visualization (Image Creation,
Generate Images and Editing Images).

You can manually edit or delete a group. For this, right-click the group object in the
specification tree and select the desired option in the contextual menu.
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Grouping Bodies
This task shows how to group bodies and how to generate images from this group.
Grouping elements allows you to apply pre-processing specifications to a pre-defined group
of elements (points, lines, surfaces or bodies) and to generate images from this group.
This functionality is only available if you installed the ELFINI Structural Analysis (EST)
product.
Open the sample49.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Body Group icon

.

The Body Group dialog box appears.

2. Select in sequence the bodies you want to group.
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The Body Group dialog box is updated.

3. Click OK in the Body Group dialog box.

A Body Group.1 object appears in the specification tree but it is not updated.

4. Update the Body Group.
For more details, please refer to Updating a Group.

You can now visualize Deformation, Von Mises Stresses, Displacements, Principal
Stresses and Precisions images, either for all the geometry or only for the selected
bodies. The scenario is the same for the five images.
In this particular case, you will visualize the Von Mises Stresses image:

Generative Structural Analysis

Version 5 Release 14

Page 216

5. Activate the Von Mises Stress image.

For this, right-click the Von Mises Stress (nodal value) object in the specification
tree and select the Activate/Deactivate option.

6. Double-click the Von Mises Stress (nodal value) object in the specification tree.

The Image Edition dialog box appears.
7. Double-click the Body Group.1 object in the Selections tab and click OK in the
Image Edition dialog box.

You will see the result only around the bodies belonging to the body group.

For more details about Images, please refer to Results Visualization (Image Creation,
Generate Images and Editing Images).

You can manually edit or delete a group. For this, right-click the group object in the
specification tree and select the desired option in the contextual menu.
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Box Group
This task shows how to group using a box and how to generate images from this group.
Grouping elements allows you to apply pre-processing specifications to a pre-defined group
of elements and to generate images from this group.
This functionality is only available if you installed the ELFINI Structural Analysis (EST)
product.
Open the sample49.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Box Group icon

.

A box and the Box Group dialog box appear.
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Name: lets you change the name of the box group.
Inactive/Active box: lets you respectively use a pre-defined box or position
and resize manually a box using the compass and the manipulators.
Select an extremum: lets you choose to position the box round an existing
extremum.

2. Activate the box.

For this, select the button as shown bellow:

The status of the box position and dimension can now be edited.
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The compass and manipulators (red points) are now available to let you position
and resize the box.

3. Change the position of the box.

For this, select the compass, drag and drop it to the desired position.
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4. Resize the box.

For this, select a manipulator, drag and drop it to the desired position.
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5. Click the Select an extremum button in the Box Group dialog box.
6. Select an existing extremum in the specification tree.

In this particular example, select the Global Minimum.2 object.
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7. Click OK in the Box Group dialog box.

A Box Group.1 object is displayed in the specification tree under the Groups.1
set.

8. Update the Box Group.1 object.
For more details, please refer to Updating a Group.

You can now visualize Deformation, Von Mises Stresses, Displacements, Principal
Stresses and Precisions images, either for all the geometry or only for the box
group. The scenario is the same for the five images.
In this particular case, you will visualize the Von Mises Stresses image that has
been previously created.
9. Activate the Von Mises Stress (nodal value) image.

For this, right-click the Von Mises Stress (nodal value) image in the specification
tree and select the Activate/Deactivate contextual menu.
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10. Double-click the Von Mises Stress (nodal value) image in the specification tree to
edit it.

The Image Edition dialog box appears.
11. Select the Box Group.1 object in the Selections tab and click OK in the Image
Edition dialog box.

You can visualize the result only around the box group.

For more details about Images, please refer to Results Visualization (Image
Creation, Generate Images and Editing Images).

You can manually edit or delete a group.
For this, right-click the group object in the specification tree and select the desired
contextual menu.
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Sphere Group
This task shows how to group using a sphere and how to generate images from this group.
Grouping elements allows you to apply pre-processing specifications to a pre-defined group
of elements and to generate images from this group.
This functionality is only available if you installed the ELFINI Structural Analysis (EST)
product.
Open the sample49.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Sphere Group icon

.

The Sphere Group dialog box appears.

❍

❍

❍

Name: lets you change the name of the sphere group.
Inactive/Active box: lets you respectively use a pre-defined sphere or position
and resize manually a sphere using the compass and the manipulators.
Select an extremum: lets you choose to position the sphere round an existing
extremum.

A sphere appears on the geometry with a default size and a default position.
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2. Activate the box.
For this, select the button as shown bellow:

The status of the sphere position and dimension can now be edited.
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The compass and manipulators (red points) are now available to let you position and
resize the box.

3. Change the position of the sphere.
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For this, select the compass, drag and drop it to the desired position.

You can also define the position using the axis of the compass (select an
axis of the compass, drag and drop it to the desired position).
4. Resize the sphere.
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For this, select a manipulator, drag and drop it to the desired position.

5. Click the Select an extremum button in the Box Group dialog box.
6. Select an existing extremum in the specification tree.
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In this particular example, select the Global Minimum.2 object.

7. Click OK in the Sphere Group dialog box.

A Sphere Group.1 object is displayed in the specification tree under the Groups.1
set.

8. Update the Sphere Group.
For more details, please refer to Updating a Group.
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You can now visualize Deformation, Von Mises Stresses, Displacements, Principal
Stresses and Precisions images, either for all the geometry or only for the sphere
group. The scenario is the same for the five images.
In this particular case, you will visualize the Von Mises Stresses image that has
been previously created.
9. Activate the Von Mises Stress (nodal value) image.

For this, right-click the Von Mises Stress (nodal value) image in the specification
tree and select the Activate/Deactivate contextual menu.
10. Double-click the Von Mises Stress (nodal value) object in the specification tree.

The Image Edition dialog box appears.
11. Click the Sphere Group.1 object in the Selections tab and click OK in the Image
Edition dialog box.

You can visualize the result only around the sphere group.

For more details about Images, please refer to Results Visualization (Image
Creation, Generate Images and Editing Images).
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You can manually edit or delete a group.
For this, right-click the group object in the specification tree and select the desired
contextual menu.

Page 231

Generative Structural Analysis

Page 232

Version 5 Release 14

Grouping Points by Neighborhood
This task shows how to group points by neighborhood, that means grouping points by
selecting geometry and entering a tolerance value.
Grouping elements by neighborhood allows you to apply pre-processing specifications to
finite elements belonging to mesh parts without geometry support (for example: extrude
mesh parts).
This functionality is only available if you installed the ELFINI Structural Analysis (EST)
product.
Open the sample49.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Point Group by Neighborhood icon

.

The Point Group by Neighborhood dialog box appears.

❍

Name: lets you specify the name of the group.

❍

Supports: lets you select the points you want to group.
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■

You can select only Points or Vertices as point group by
neighborhood Support.

■

❍

This group enables to capture only proximity node elements.

Tolerance: lets you define the tolerance value.

2. Select in sequence the points you want to group.

The Point Group by Neighborhood dialog box is updated:

3. Enter the Tolerance value.

In this particular example, enter 5mm as Tolerance value.
4. Click OK in the Point Group by Neighborhood dialog box.
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A Point Group by Neighborhood.1 object appears in the specification tree but it
is not updated.

5. Update the proximity point group.
For more details, please refer to Updating a Group.

You can now visualize Deformation, Von Mises Stresses, Displacements, Principal
Stresses and Precisions images, either for all the geometry or only for the selected
points. The scenario is the same for the five images.
In this particular case, you will visualize the Von Mises Stresses image:
6. Activate the Von Mises Stress image.

For this, right-click the Von Mises Stress (nodal value) object in the specification
tree and select the Activate/Deactivate option.

7. Double-click the Von Mises Stress (nodal value) object in the specification tree.

The Image Edition dialog box appears.
8. Double-click the Point Group by Neighborhood.1 object in the Selections tab
and click OK in the Image Edition dialog box.
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For more details about images, please refer to Results Visualization (Image
Creation, Generate Images and Editing Images).

You can manually edit or delete a group.
For this, right-click the group object in the specification tree and select the desired
contextual menu.
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Grouping Lines by Neighborhood
This task shows how to group lines by neighborhood, that means grouping lines by selecting
geometry and entering a tolerance value.
Grouping elements by neighborhood allows you to apply pre-processing specifications to
finite elements belonging to mesh parts without geometry support (for example: extrude
mesh parts).
This functionality is only available if you installed the ELFINI Structural Analysis (EST)
product.
Open the sample49.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Line Group by Neighborhood icon

.

The Line Group by Neighborhood dialog box appears.

❍

Name: lets you specify the name of the group.

❍

Supports: lets you select the lines you want to group.
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■

You can select only Edges or 1D Features as line group by
neighborhood Support.

■

This group enables to capture proximity node elements, edge
elements and all the 1D elements.

❍

Tolerance: lets you define the tolerance value.

2. Select in sequence the lines you want to group.

The Line Group by Neighborhood dialog box is updated:

3. Enter a Tolerance value.

In this particular example, enter 3mm as Tolerance value.
4. Click OK in the Line Group by Neighborhood dialog box.
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A Line Group by Neighborhood.1 object appears in the specification tree but it is
not updated.

5. Update the line group by neighborhood.
For more details, please refer to Updating a Group.

You can now visualize Deformation, Von Mises Stresses, Displacements, Principal
Stresses and Precisions images, either for all the geometry or only for the selected
lines. The scenario is the same for the five images.
In this particular case, you will visualize the Von Mises Stresses image:
6. Activate the Von Mises Stress image.

For this, right-click the Von Mises Stress (nodal value) object in the specification
tree and select the Activate/Deactivate option.

7. Double-click the Von Mises Stress (nodal value) object in the specification tree.

The Image Edition dialog box appears.
8. Double-click the Line Group by Neighborhood.1 object in the Selections tab and
click OK in the Image Edition dialog box.
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You will see the result only around the selected lines.

For more details about Images, please refer to Results Visualization (Image
Creation, Generate Images and Editing Images).

You can manually edit or delete a group. For this, right-click the group object in the
specification tree and select the desired option in the contextual menu.

Page 239

Generative Structural Analysis

Page 240

Version 5 Release 14

Grouping Surfaces by Neighborhood
This task shows how to group surfaces by neighborhood, that means grouping surfaces by
selecting geometry and entering a tolerance value.
Grouping elements by neighborhood allows you to apply pre-processing specifications to
finite elements belonging to mesh parts without geometry support (for example: extrude
mesh parts).
This functionality is only available if you installed the ELFINI Structural Analysis (EST)
product.
Open the sample49.CATAnalysis document from the samples directory for this task.
Before You Begin
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Surface Group by Neighborhood icon

.

The Surface Group by Neighborhood dialog box appears.

❍

Name: lets you specify the name of the group.

❍

Supports: lets you select the surface you want to group.
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■
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You can select only Surfaces or 2D Features as surface group by
neighborhood Support.

■

This group enables to capture proximity node elements, face elements
and all the 2D elements.

❍

Tolerance: lets you define the tolerance value.

2. Select in sequence the surfaces you want to group.

The Surface Group by Neighborhood dialog box is updated:

3. Enter the Tolerance value.

In this particular example, enter 8mm as Tolerance value.
4. Click OK in the Surface Group by Neighborhood dialog box.
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A Surface Group.1 object appears in the specification tree but it is not updated.

5. Update the surface group by neighborhood.
For more details, please refer to Updating a Group.

You can now visualize Deformation, Von Mises Stresses, Displacements, Principal
Stresses and Precisions images, either for all the geometry or only for the selected
surfaces. The scenario is the same for the five images.
In this particular case, you will visualize the Von Mises Stresses image:
6. Activate the Von Mises Stress image.

For this, right-click the Von Mises Stress (nodal value) object in the specification
tree and select the Activate/Deactivate option.

7. Double-click the Von Mises Stress (nodal value) object in the specification tree.

The Image Edition dialog box appears.
8. Double-click the Surface Group by Neighborhood.1 object in the Selections tab
and click OK in the Image Edition dialog box.
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You will see the result only around the selected surfaces.

For more details about Images, please refer to Results Visualization (Image Creation,
Generate Images and Editing Images).

You can manually edit or delete a group. For this, right-click the group object in the
specification tree and select the desired option in the contextual menu.
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Updating Groups
This task shows how to:
●

update a group you just have created or you have edited

●

update all groups belonging to a same group set.

Open the sample49_2.CATAnalysis document from the samples directory for this task.
A line group, a surface group and a body group are already created.

The symbol

in the specification tree shows you that the different groups are not updated.

1. Right-click the Surface Group.1 object in the specification.

2. Select the Update Group contextual menu
The symbol

.

disappears in the specification tree.

3. Edit the surface group.
For this, double-click the Surface Group.1 object in the specification tree.
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The Surface Group dialog box appears.
4. Select a surface and click OK in the Surface Group dialog box.

The symbol

reappears in the specification tree.

5. Right-click the Groups.1 set in the specification tree and select the Update All
Groups contextual menu
The symbol

disappears in the specification tree.

.
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Analyze Group
This task shows how to know and visualize the content of a group (nodes, elements, faces of element,
edges of element).
●

●

The group set must be updated.
Elements belonging to connection are not taking into account by the box groups and the sphere
groups.

Open the sample49_1.CATAnalysis document from the samples directory for this task.
1. Update the surface group.

For more details, please refer to Updating a Group.
2. Right-click the surface group set in the specification tree and select the Analyze Group
contextual menu

.

The Group Content dialog box appears.

❍

❍

❍

❍

Node: gives you the number of nodes belonging to the selected group and lets you visualize
these nodes on the geometry.
Element: gives you the number of elements belonging to the selected group and lets you
visualize these elements on the geometry.
Face of element: gives you the number of element faces belonging to the selected group
and lets you visualize these element faces on the geometry.
Edge of element: gives you the number of element edges belonging to the selected group
and lets you visualize these element edges on the geometry.

3. Select the Node option in the Group Content dialog box.
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The Group Content dialog box gives you the number of nodes belonging to the selected group.

In this particular example, you can see that the select group is composed of 90 nodes.
Moreover, the nodes can be visualized on the geometry.

4. Select the Face of element option in the Group Content dialog box.

Both the Group Content dialog box and the geometry are updated.
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If you want to visualize only the element faces (without the nodes), deactivate the Node
option in the Group Content dialog box.
You will obtain the following result:

5. Click OK in the Group content dialog box.
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Analysis Connections
The following functionalities are only available in the Generative Assembly Structural
Analysis (GAS) product.
General Analysis Connection
Allow connection between points, edges, surfaces and mechanical features.
Point Analysis Connection
Allow the connection of surfaces and the selection of one open body containing points.
Point Analysis Connection Within One Part
Allow the connection of one surface and the selection of one open body containing
points.
Line Analysis Connection
Allow the connection of surfaces and the selection of one open body containing lines.
Line Analysis Connection Within One Part
Allow the connection of one surface and the selection of one open body containing
lines.
Surface Analysis Connection
Allow the connection of surfaces.
Surface Analysis Connection Within One Part
Allow the connection of one surface.
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General Analysis Connection
This task will show you how to create a General Analysis Connection.
General analysis connections are used for connecting any part from an assembly with or without handler
point, on an assembly model.
This can be performed between any type of geometry.
This is very useful when you want to benefit from the representation of part without actually designing this
part.
●

This functionality is only available in the Generative Assembly Structural Analysis (GAS) product
.

●

●

The connection has to connect two components.
A component can be:
❍
a vertex
❍

an edge or a multi-selection of edges belonging to the same feature

❍

a surface or a multi-selection of surfaces belonging to the same part body

❍

a mechanical feature (i.e. sketch, pad, assemble, remove, ...)

A connection with a vertex on one side does not accept a handler point.

Open the sample42.CATAnalysis from the samples directory.

1. Click the General Analysis Connection icon

.

The General Analysis Connection dialog box appears.

❍

❍

Name: lets you change the name of the connection.
First component: lets you select the first "side" of the part that will support the connection.
■
Multi-selection is not available for vertex and mechanical feature.
■

Multi-selection of edges or surfaces must be homogeneous and must belong to the
same mesh part.
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■

❍

Select Mesh Parts: this button is available only if a support is selected.
For more details, please click here.

Second Component: lets you select the second "side" of the part that will support the
connection.
■
Multi-selection is not available for vertex and mechanical feature.
■

■

❍
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Multi-selection of edges or surfaces must be homogeneous and must belong to the
same mesh part.

Select Mesh Parts: this button is available only if a support is selected.
For more details, please click here.

Handler point: lets you specify an optional handler point.
A connection with a vertex on one side does not accept a handler point.

2. Select the first component.

In this particular case, select two edges belonging to the Part3 (Part 3.1).

3. Activate the Second component field.

For this, select the Second component edit box as shown below:

4. Select the second component.
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In this particular case, select a surface belonging to the Part3 (Part 3.2).

5. Optionally, you can activate the Handler point field by selecting the Handler point edit box.

In this particular example, you do not need to select a handler point.
6. Optionally, select a point as handler point.
7. Click OK in the General Analysis Connection dialog box.
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A symbol representing the general connection is visualized.

The General Analysis Connection.1 object is displayed in the specification tree under the
Analysis Connection Manager.1 set.

●

You can update analysis connections. For this:
❍
right-click the Analysis Connection Manager.1 set in the specification tree
❍

●

select the Update all analysis connections contextual menu.

You can now apply a connection property on the connection you just have created.
For more details, please refer to the Connection Properties section.
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Point Analysis Connection
This task will show you how to create a Point Analysis Connection.
Point analysis connections are used for projecting welding points onto parallel faces, on an
assembly model.
●

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product

.

●

The connection has to connect two bodies (2D or 3D).

●

Multi-selection is not available.

Open the sample48.CATAnalysis from the samples directory.

1. Click the Point Analysis Connection icon

.

The Point Analysis Connection dialog box appears.

❍

❍

Name: lets you change the name of the connection.
First component: lets you select the first "side" of the part that will support the
connection.
You can select one body (2D or 3D).
■

❍

Select Mesh Parts: this button is available only if a support is selected.
For more details, please click here.

Second Component: lets you select the second "side" of the part that will support
the connection.
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You can select one body (2D or 3D).
■

❍

Select Mesh Parts: this button is available only if a support is selected.
For more details, please click here.

Points: lets you select the welding points.
You can select an Open body containing several points.

2. Select the first component.
In this particular example, select the Part6(Part6.1).

3. Activate the Second component field.
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For this, select the Second component edit box as shown below:

4. Select the second component.

In this particular example, select the Part5(Part5.1).

5. Activate the Points field.
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For this, select the Points edit box as shown below:

6. Select the welding points.

In this particular example, select the Points open body (under the Part5).
A symbol representing the point design connection appears on the assembly.

7. Click OK in the Point Analysis Connection dialog box.
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The Point Analysis Connection.1 is displayed in the specification tree under the
Analysis Connection Manager.1 set.

●

You can update design connections. For this:
❍
right-click the Analysis Connection Manager.1 set in the specification tree
❍

●

select the Update all analysis connections contextual menu.

You can now apply a connection property on the connection you just have created.
For more details, please refer to Creating Spot Welding Connection Property.
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Point Analysis Connection Within One Part
This task will show you how to create a Point Connection Within One Part.
Point analysis connections within one part are used for projecting welding points onto
parallel faces, belonging to the same part.

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.

Open the sample09.CATAnalysis from the samples directory.

1. Click the Point Analysis Connection within one Part icon

.

The Point Analysis Connection within one Part dialog box appears.

❍

Name: lets you change the name of the connection.

❍

First component: lets you select the part that will support the connection.
You can select one body (2D or 3D).
■

❍

Select Mesh Parts: this button is available only if a support is selected.
For more details, please click here.

Points: lets you select the welding points.
You can select an Open body containing several points.
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2. Select the open body.

In this particular example, select the Extrude.1 open body in the specification tree
or select the geometry as shown bellow:

3. Activate the Points field.

For this, select the Points edit box as shown bellow:

4. Select the welding points.

In this particular example, select the Open body.2 (Points) open body in the
specification tree.
5. Click OK in the Point Analysis Connection within one Part dialog box.
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The Point Analysis Connection within one Part.1 is displayed in the
specification tree under the Analysis Connection Manager.1 set.

●

You can update design connections. For this:
❍
right-click the Analysis Connection Manager.1 set in the specification tree
❍

●

select the Update all analysis connections contextual menu.

You can now apply a connection property on the connection you just have created.
For more details, please refer to Creating Spot Welding Connection Property.
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Line Analysis Connection
This task will show you how to create a Line Analysis Connection.
Line analysis connections are used for simulating welding seam onto parallel faces, on an
assembly model.
●

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product

.

●

The connection has to connect two bodies (2D or 3D).

●

Multi-selection is not available.

Open the sample48.CATAnalysis from the samples directory.

1. Click the Line Analysis Connection icon

.

The Line Analysis Connection dialog box appears.

❍

❍

Name: lets you change the name of the connection.
First component: lets you select the first "side" of the part that will support
the connection.
You can select one body (2D or 3D).
■

Select Mesh Parts: this button is available only if a support is selected.
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For more details, please click here.
❍

Second component: lets you select the second "side" of the part that will
support the connection.
You can select one body (2D or 3D).
■

❍

Select Mesh Parts: this button is available only if a support is selected.
For more details, please click here.

Lines: lets you select the welding line.
■
Multi-selection is not available.
■

The line can be:
■
a border of the geometry
■

❍

feature (line, curve)

Guide line on each component: lets you select a second line that will guide
the connection orientation.

2. Select the first component.

In this particular example, select the Fill.1 in the Part6(Part6.1).
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3. Activate the Second component field.

For this, select the Second component edit box as shown below:

4. Select the second component.

In this particular example, select the Extrude.1 in the Part5(Part5.1).

5. Activate the Lines field.
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For this, select the Lines edit box as shown below:

6. Select the desired line.

In this particular example, select the following edge.

7. Click OK in the Line Analysis Connection dialog box.

Page 265

Generative Structural Analysis

Version 5 Release 14

Page 266

The Line Analysis Connection.1 object appears in the specification tree under
the Analysis Connection Manager.1 set.

●

You can update design connections. For this:
❍
right-click the Analysis Connection Manager.1 set in the specification tree
❍

●

select the Update all analysis connections contextual menu.

You can now apply a connection property on the connection you just have created.
For more details, please refer to Creating Seam Welding Connection Property.
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Line Analysis Connection Within One Part
This task will show you how to create a Line Analysis Connection Within One Part.
Line analysis connections within one part are used for simulating welding seam onto parallel
faces, belonging to the same part.

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.

Open the sample09.CATAnalysis from the sample directory.

1. Click the Line Analysis Connection within one Part icon

.

The Line Analysis Connection within one Part dialog box appears.

❍

Name: lets you change the name of the connection.

❍

First component: lets you select the part that will support the connection.
You can select one body (2D or 3D).
■

❍

Select Mesh Parts: this button is available only if a support is selected.
For more details, please click here.

Lines: lets you select the welding line.
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Multi-selection is not available.

❍

Guide line on each component: lets you select a second line that will guide the
connection orientation.

2. Select the open body.

For this particular example, select the Extrude.1 open body.

3. Activate the Lines field.

For this, select the Lines edit box as shown bellow:

4. Select the line.
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In this particular example, select the Line.1 object under the Open body.2
(Points) open body.

5. Click OK in the Line Analysis Connection within one Part dialog box.

The Line Analysis Connection within one Part.1 object appears in the
specification tree under the Analysis Connection Manager.1 set.

●

You can update design connections. For this:
❍
right-click the Analysis Connection Manager.1 set in the specification tree
❍

●

select the Update all analysis connections contextual menu.

You can now apply a connection property on the connection you just have created.
For more details, please refer to Creating Seam Welding Connection Property.
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Surface Analysis Connection
This task will show you how to create a Surface Analysis Connection.
Surface analysis connections are used for simulating welding surface onto parallel faces,
on an assembly model.
●

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product

.

●

The connection has to connect two bodies (2D or 3D).

●

Multi-selection is not available.

Open the sample11.CATAnalysis from the samples directory.

1. Click the Surface Analysis Connection icon

.

The Surface Analysis Connection dialog box appears.

❍

❍

Name: lets you change the name of the connection.
First component: lets you select the first "side" of the part that will support
the connection.
■
Multi-selection is not available.
■

■

You can select a 2D body, 3D body or a mesh part as support.

Select Mesh Parts: this button is available only if a support is selected.
For more details, please click here.
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❍

Second component: lets you select the second "side" of the part that will
support the connection.
■
Multi-selection is not available.
■

■

❍
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You can select a 2D body, 3D body or a mesh part as support.

Select Mesh Parts: this button is available only if a support is selected.
For more details, please click here.

Surface: lets you select the welding surface.
■
Multi-selection is not available.
■

You can only select a 2D body as adhesive surface.

2. Select the first component.

In this particular example, select Support.1 - Fill.4.
3. Activate the Second component field.

For this, select the Second component edit box as shown below:

4. Select the second component.

In this particular example, select Support.2 - Fill.3.
5. Activate the Surface field.
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For this, select the Surface edit box as shown below:

6. Select the desired surface.

In this particular example, select Surface.1 - Fill.3 as shown bellow:

7. Click OK in the Surface Analysis Connection dialog box.
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The Surface Analysis Connection.1 object appears in the specification tree
under the Analysis Connection Manager.1 set.

●

You can update design connections. For this:
❍
right-click the Analysis Connection Manager.1 set in the specification tree
❍

●

select the Update all analysis connections contextual menu.

You can now apply a connection property on the connection you just have created.
For more details, please refer to Creating Surface Welding Connection Property.
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Surface Analysis Connection Within One
Part
This task will show you how to create a Surface Analysis Connection Within One Part.
Surface analysis connections within one part are used for simulating welding surface onto
parallel faces, belonging to the same part.

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.

Open the sample11.CATAnalysis from the sample directory.

1. Click the Surface Analysis Connection within one Part icon

.

The Surface Analysis Connection within one Part dialog box appears.

❍

❍

Name: lets you change the name of the connection.
First component: lets you select the part that will support the connection.
■
Multi-selection is not available.
You can select a 2D body, 3D body or a mesh part as support.

■

■

❍

Select Mesh Parts: this button is available only if a support is selected.
For more details, please click here.

Surface: lets you select the welding surface.
■

Multi-selection is not available.

■

You can only select a 2D body as adhesive surface.
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2. Select the support.

In this particular example, select OneSupport - Extrude.1 as shown bellow:

3. Activate the Surface field.

For this, select the Surface edit box as shown bellow:

4. Select the desired surface.
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In this particular example, select Surface.2 - Fill.5 as shown bellow:

5. Click OK in the Surface Analysis Connection within one Part dialog box.

The Surface Analysis Connection within one Part.1 object appears in the
specification tree under the Analysis Connection Manager.1 set.

●

You can update design connections. For this:
❍
right-click the Analysis Connection Manager.1 set in the specification tree
❍

●

select the Update all analysis connections contextual menu.

You can now apply a connection property on the connection you just have created.
For more details, please refer to Creating Surface Welding Connection Property.
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Connection Properties
The following functionalities are only available in the Generative Assembly Structural
Analysis (GAS) product.
Connections properties are assembly connections used to specify the boundary interaction
between bodies in an assembled system. Once the geometric assembly positioning
constraints are defined at the Product level, the user can specify the physical nature of the
constraints.
About Connection Properties
Give information about connection properties.

Face Face Connection Properties
Create Slider Connection Properties
Fasten bodies together at their common interface in the normal direction while
allowing them to slide relative to each other in the tangential directions.
Create Contact Connection Properties
Prevent bodies from penetrating each other at a common interface.
Create Fastened Connection Properties
Fasten bodies together at their common interface.
Create Fastened Spring Connection Properties
Create an elastic link between two faces.
Create Pressure Fitting Connection Properties
Prevent bodies from penetrating each other at a common interface.
Create Bolt Tightening Connection Properties
Prevent bodies from penetrating each other at a common interface.

Distant Connection Properties
Create Rigid Connection Properties
Create a link between two bodies which are stiffened and fastened together at their
common boundary, and will behave as if their interface was infinitely rigid.
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Create Smooth Connection Properties
Create a link between two bodies which are fastened together at their common
boundary, and will behave approximately as if their interface was soft.
Create Virtual Rigid Bolt Tightening Connection Properties
Take into account pre-tension in a bolt-tightened assembly in which the bolt is not
included.
Create Virtual Spring Bolt Tightening Connection Properties
Specify the boundary interaction between bodies in an assembled system.
Customize User-Defined Connection Properties
Specify the types of elements as well as their associated properties included inside a
distant connection.

Weld Connection Properties
Create Spot Welding Connection Properties
Create a link between two bodies, using analysis welding point connections.
Create Seam Weld Connection Properties
Create a link between two bodies, using analysis seam weld connections.
Create Surface Weld Connection Properties
Create a link between two bodies, using analysis surface weld connections.
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About Connection Properties
When you want to use the connection properties of the Generative Assembly Structural Analysis product, you first need to define a
connection that the connection property will reference.
The connections can be created in different ways:
●

in a product context:
❍
Assembly Constraints in the Assembly Design workbench
❍

Welding Joints in the Body in White Fastener workbench

❍

Joint Connections in the the Ship Structure Detail Design workbench

❍

Analysis Connections created before V5R12
The former Analysis Connections are still maintained but you cannot create them any more.

●

in an analysis context:
❍
Analysis Connections in the Generative Structural Analysis workbench (from V5R12)

Why you will use Connections of the Analysis Workbench?
In some cases, constraints are not sufficient to modelize connections from an Analysis viewpoint:
1. In order to support properties, users often need to define too many constraints using the Assembly Design workbench, leading to overconstrained models that cannot be updated.
2. It is impossible to define constraints that are not positioning constraints but connection constraints.
3. It is impossible to select several geometries to define connections in a product context.
4. It is impossible to select a mechanical feature to define connections in a product context.
In order to meet these different needs, a new Analysis Connection toolbar was added to the Generative Assembly Structural Analysis
product of the Generative Structural Analysis workbench.
This toolbar lets you create all these connections dedicated to analysis modeling.
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What Type of Hypotheses are Used for Analysis?
You will find here below three types of hypotheses used when working in Analysis workbench.
1. Small displacement (translation and rotation)
2. Small strain
3. Linear constitutive law: linear elasticity
For static case solutions, one can say that:
●

●

If there is no contact feature (either virtual or real), no pressure fitting property and no bolt tightening (being virtual or not) feature, then
the problem is linear, that is to say, the displacement is a linear function of the load.
In other cases, the problem is non linear, that is to say, the displacement is a non linear function of the load.

What Type of Property For What Type of Connection?
Welding Connections Properties
●

●

●

Spot Welding Connection Property:
❍
Point Analysis Connection defined in the Generative Structural Analysis workbench (from V5R12)
❍

Point Analysis Connection within one Part defined in the Generative Structural Analysis workbench (from V5R12)

❍

Joint Body containing at least a (point) Joint Element and defined in the Body in White Fastener workbench

❍

Spot Welding Analysis Connection defined (before V5R12)

Seam Weld Connection Property:
❍
Line Analysis Connection defined in the Generative Structural Analysis workbench (from V5R12)
❍

Line Analysis Connection within one Part defined in the Generative Structural Analysis workbench (from V5R12)

❍

Joint Body containing at least a (line) Joint Element and defined in the Body in White Fastener workbench

❍

Spot Welding Analysis Connection defined (before V5R12)

Surface Weld Connection Property:
❍
Surface Analysis Connection defined in the Generative Structural Analysis workbench
❍

Surface Analysis Connection within one Part defined in the Generative Structural Analysis workbench

Other Connection Properties
When you define a connection property, you can select as support:
●

General Analysis Connection of the Generative Structural Analysis workbench (from V5R12)

●

Assembly Constraints (Contact Constraint, Coincidence Constraint or Offset Constraint) of the Assembly Design workbench

●

General Analysis Connection and Face Face Analysis Connection created before V5R11

General Analysis Connection (from V5R12)

Connection Properties

Slider
Contact
Fastened
Fastened Spring
Pressure Fitting

Point /
Point

Point /
Line

Point /
Face

Point /
Mechanical
Feature

Line /
Line

Line /
Face

Line /
Mechanical
Feature

Face /
Face

Mechanical
Face /
Feature /
Mechanical
Mechanical
Feature
Feature
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Bolt Tightening
Rigid

*

*

*

*

*

*

Smooth

*

*

*

*

*

*

Virtual Rigid Bolt
Tightening
Virtual Spring Bolt
Tightening
User-Defined

* with optional handler point

Assembly Constraints
Point / Point

Line / Line

Line / Face

Face / Face

Slider

Contact
Coincidence

Contact
Coincidence

Contact
Coincidence

Contact

Contact
Coincidence

Contact
Coincidence

Contact
Coincidence

Fastened

Contact
Coincidence

Contact
Coincidence

Contact
Coincidence

Fastened Spring

Contact
Coincidence

Contact
Coincidence

Contact
Coincidence

Pressure Fitting

Contact
Coincidence

Contact
Coincidence

Contact
Coincidence

Bolt Tightening

Contact
Coincidence

Contact
Coincidence

Contact
Coincidence

Contact

Contact *

Contact *

Contact *

Rigid

Point / Line

Contact

Point / Face

Contact

Contact

Contact *

Contact *

Contact *

Virtual Rigid Bolt Tightening

Contact
Coincidence
Offset

Contact
Coincidence
Offset

Contact
Coincidence
Offset

Contact
Coincidence
Offset

Contact
Coincidence
Offset

Virtual Spring Bolt Tightening

Contact
Coincidence
Offset

Contact
Coincidence
Offset

Contact
Coincidence
Offset

Contact
Coincidence
Offset

Contact
Coincidence
Offset

Contact

Contact

Contact

Contact

Contact

Smooth

User-Defined

Contact

* with optional handler point

Former General Analysis Connections and Face Face Analysis Connections (before V5R12)
Point / Point

Point / Line

Point / Face

Line / Line

Line / Face

Face / Face

Slider

General
Face Face

General
Face Face

General
Face Face

Contact

General
Face Face

General
Face Face

General
Face Face

Fastened

General
Face Face

General
Face Face

General
Face Face

Fastened Spring

General
Face Face

General
Face Face

General
Face Face

Pressure Fitting

Face Face

Face Face

Face Face

Bolt Tightening

Face Face

Face Face

Face Face

Rigid

General

General

General *

General *

General *

Smooth

General

General

General *

General *

General *

Virtual Rigid Bolt Tightening

General

General

General

General

General

Virtual Spring Bolt Tightening

General

General

General

General

General

General

General

General

General

General

User-Defined

* with optional handler point

General
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Precisions and Restrictions
Here you will find precisions and restrictions for certain connection properties.

●

Slider: Slider Connection Property
❍
The slider direction is defined according to the geometry on which the joins are landed.
If you select a former Face Face Analysis Connection (before V5R12) as support, the slider directions are
automatically parallel or coaxial.

●

●

Contact: Contact Connection Property, User-Defined Distant Connection Property (if you select Contact as Start or End
option).
❍
Can be generated only on a geometry belonging to a 3D body.
Pressure Fitting: Pressure Fitting Connection Property
❍
Can be generated only on a geometry belonging to a 3D body.
❍

The fitting direction is defined according to the geometry on which the joins are landed.
If you select a former Face Face Analysis Connection (before V5R12) as support, the slider directions are
automatically parallel or coaxial.

●

Bolt: Bolt Tightening Connection Property, Virtual Bolt Tightening Connection Property, Virtual Spring Bolt
Tightening Connection Property, User-Defined Distant Connection Property (if you select Bolt as Middle option)
❍
On each side of the assembly, multi-selection of geometry is available.
In this case, if a geometry has a revolution axis, the other geometries (belonging to the same side of the assembly) must
have a revolution axis that must be the same.
❍

●

Moreover, if the two sides have a revolution axis (tightening direction), this axis must be the same.

User-Defined: User-Defined Distant Connection Property
❍
cf. Contact
❍

cf. Bolt
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Creating Slider Connection Properties
This task shows how to create a Slider Connection Property between two parts.
●

●

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.
To have precisions and to know restrictions, please refer to About Connection
Properties.

A Slider Connection is the link between two bodies which are constrained to move
together in the local normal direction at their common boundary, and will behave as if
they were allowed to slide relative to each other in the local tangential plane. Since bodies
can be meshed independently, the slider connection is designed to handle incompatible
meshes.
The slider connection relations take into account the elastic deformability of the interfaces.
The program proceeds as follows:
●

●

●

●

●

each node of the finer surface mesh is projected parallel to the local outer normal of
the first surface onto the second surface mesh.
a projection point is located whenever possible at the intercept of the projection
direction with the second surface mesh (extrapolated at the face boundary by roughly
half an element width).
if a projection point exists, the start node is connected by a kinematical spider
element to all nodes of the element face on which the projection point has landed.
a set of join-type relations (involving interpolation using element shape functions and
a rig-beam relations) is computed between the start node degrees of freedom and the
connected nodes degrees of freedom.
these relations are projected on the local normal direction yielding a single scalar
relation between the start node degrees of freedom and the connected nodes degrees
of freedom.

Thus, the slider connection generates at most as many spider kinematical elements as
there are nodes on the finer surface mesh for which a projection onto the opposite surface
mesh exists.
To know more about the Slider Join element, see Slider Join in the Finite Element
Reference Guide.
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Open the sample16.CATAnalysis document: you applied constraints to the assembly
(Assembly Design workbench).
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Slider Connection Property icon

.

The Slider Connection Property dialog box appears.

2. Select an assembly constraint previously created in the Assembly Design
workbench.
The only allowed constraint type is Contact between surfaces.
A symbol representing the slider connection property is visualized on the
corresponding faces.
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3. Click OK in the Slider Connection Property dialog box.
Note that two elements appear in the specification tree:
❍
a Slider Connection Mesh.1 object under the Nodes and Elements set,
❍

●

●

a Slider Connection Property.1 object appears in the specification tree
under the Properties.1 set.

The Finite Element Model contains two Mesh objects, one for each part of the
assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols.

Generative Structural Analysis

Version 5 Release 14

Page 286

Creating Contact Connection Properties
This task shows how to create a Contact Connection between two parts.
●

The following functionality is only available in the Generative Assembly Structural
Analysis (GAS) product

●

●

.

To have precisions and to know restrictions, please refer to About Connection
Properties.
The Gradient method is not available if several Contact connections reference the
same degree of freedom.
In this case, try to choose another method type.

A Contact Connection is the link between two part bodies which are prevented from interpenetrating at their common boundary, and will behave as if they were allowed to move
arbitrarily relative to each other as long as they do not come into contact within a userspecified normal clearance. When they come into contact, they can still separate or slide
relative to each other in the tangential plane, but they cannot reduce their relative normal
clearance. Since part bodies can be meshed independently, the Contact Connection is
designed to handle incompatible meshes.
The Contact Connection relations take into account the elastic deformability of the
interfaces.
The program proceeds as follows:
●

●

●

●

●

●

each node of the finer body surface mesh is projected parallel to the local outer
normal of the first surface onto the second surface mesh.
a projection point is located whenever possible at the intercept of the projection
direction with the second body surface mesh (extrapolated at the face boundary by
roughly half an element width).
if a projection point exists, the start node is connected by a node-to-face element with
contact property to all nodes of the element face on which the projection point has
landed.
a set of join-type relations (involving interpolation using element shape functions) is
computed between the projection point degrees of freedom and the degrees of
freedom of the element face nodes (the projection point virtual degrees of freedom
are eliminated in the process).
rigid body kinematical relations are computed between the start node and the
projection node.
after the elimination of the projection point degrees of freedom, a contact relation is
generated by projecting these relations in the local normal direction yielding a single
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scalar inequality between the start node degrees of freedom and the degrees of
freedom of the element face nodes, with a right-hand side equal to the user-defined
clearance.
Thus, the Contact Connection generates at most as many node-to-face elements with
contact property as there are nodes on the finer surface mesh for which a projection onto
the opposite surface mesh exists.
To know more about the Contact Join element, see Contact Join in the Finite Element
Reference Guide.
Open the sample16.CATAnalysis document: you applied constraints to the assembly
(Assembly Design workbench).
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Contact Connection Property icon

.

The Contact Connection Property dialog box appears.

The Clearance field can be used to enter an algebric value for the maximum
allowed normal clearance reduction:
❍

❍

❍

a positive clearance value (used to model a known gap between the surfaces)
means that the surfaces can still come closer until they come in contact.
a negative clearance value (used for instance to model a press-fitted clamp
between the surfaces) means that the surfaces are already too close, and the
program will have to push them apart.
the default value used for the clearance represents the actual geometric
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spacing between surfaces.
2. Select an assembly constraint previously created in the Assembly Design
workbench.
The only allowed constraint type is Contact between body surfaces.
A symbol representing the Contact Connection is visualized on the corresponding
faces.

3. Optionally modify the default value of the Clearance parameter.
4. Click OK in the Contact Connection Property dialog box.
Note that two elements appear in the specification tree:
❍
a Contact Connection Mesh.1 object under the Nodes and Elements set,
❍

a Contact Connection Property.1 object appears in the specification tree
under the Properties.1 set.
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The Finite Element Model contains two Mesh objects, one for each part of the
assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols.
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Creating Fastened Connection Properties
This task shows how to create a Fastened Connection between two parts.

The following functionality is only available in the Generative Assembly Structural
Analysis (GAS) product.
A Fastened Connection is the link between two bodies which are fastened together at their
common boundary, and will behave as if they were a single body. From a finite element
model viewpoint, this is equivalent to the situation where the corresponding nodes of two
compatible meshes are merged together. However, since bodies can be meshed
independently, the Fastened Connection is designed to handle incompatible meshes.
The Fastened Connection relations take into account the elastic deformability of the
interfaces.
The program proceeds as follows:
●

●

●

●

each node of the finer surface mesh is projected parallel to the local outer normal of
the first surface onto the second surface mesh.
a projection point is located whenever possible at the intercept of the projection
direction with the second surface mesh (extrapolated at the face boundary by roughly
half an element width).
if a projection point exists, the start node is connected by a kinematical spider
element to all nodes of the element face on which the projection point has landed.
a set of join-type relations (involving interpolation using element shape functions and
a rig-beam relations) is computed between the start node degree of freedom and the
connected nodes degree of freedom.

Thus, the Fastened Connection generates at most as many spider kinematical elements as
there are nodes on the finer surface mesh for which a projection onto the opposite surface
mesh exists.
To know more about the Fastened Join element, see Fastened Join in the Finite Element
Reference Guide.

Generative Structural Analysis

Page 291

Version 5 Release 14

Open the sample16.CATAnalysis document from the samples directory: you applied
constraints to the assembly (Assembly Design workbench).
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Fastened Connection Property icon

.

The Fastened Connection Property dialog box appears.

2. Select the assembly constraint previously created in the Assembly Design
workbench.
The only allowed constraint type is Contact between surfaces.
A symbol representing the fastened connection property is visualized on the
corresponding faces.
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3. Click OK in the Fastened Connection Property dialog box.
Note that two elements appear in the specification tree:
❍
a Fastened Connection Mesh.1 object under the Nodes and Elements set,
❍

●

●

a Fastened Connection Property.1 object appears in the specification tree
under the Properties.1 set.

The Finite Element Model contains two Mesh objects, one for each part of the
assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols.
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Creating Fastened Spring Connection
Properties
This task shows how to create a Fastened Spring Connection between two parts.
This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.
A Fastened Spring Connection is an elastic link between two faces. From a finite element
model viewpoint, this is equivalent to the situation where the corresponding nodes of two
compatible meshes are merged together. However, since bodies can be meshed
independently, the Fastened Spring Connection is designed to handle incompatible
meshes.
The Fastened Spring Connection relations take into account the elastic deformability of the
interfaces.
The program proceeds as follows:
●

●

●

●

each node of the finer surface mesh is linked to a fastened spring that is itself linked
to the slave node.
rigidity is distributed on all the elements of the Fastened Spring connection. This
rigidity in defined interactively.
if a projection point exists, the start node is connected by a kinematical spider element
to all nodes of the element face on which the projection point has landed.
a set of join-type relations (involving interpolation using element shape functions and
a rig-beam relations) is computed between the start node degree of freedom and the
connected nodes degree of freedom.

Thus, the Fastened Connection generates at most as many spider kinematical elements as
there are nodes on the finer surface mesh for which a projection onto the opposite surface
mesh exists.
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Open the sample16.CATAnalysis document from the samples directory: you applied
constraints to the assembly (Assembly Design workbench).
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Fastened Spring Connection Property icon

.

The Fastened Spring Connection Property dialog box appears.

2. Select the assembly contact or coincidence constraint or joint body previously
created in the Assembly Design workbench.
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A symbol representing the Fastened Connection is visualized on the corresponding
faces.

3. Enter the desired Translation and Rotation values. In this particular case, state
Translation stiffness 2 and Translation stiffness 3 to 70N_m.
4. Click OK in the Fastened Spring Connection Property dialog box.
Note that two elements appear in the specification tree:
❍
a Spring Connection Mesh.1 object under the Nodes and Elements set,
❍

●

●

a Fastened Spring Connection Property.1 object appears in the
specification tree under the Properties.1 set.

The Finite Element Model contains two Mesh objects, one for each part of the
assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols.
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Creating Pressure Fitting Connection
Properties
This task shows how to create a Pressure Fitting Connection between two parts.
●

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product

●

●

.

To have precisions and to know restrictions, please refer to About Connection
Properties.
The Gradient method is not available if several Pressure Fitting connections reference
the same degree of freedom. In this case, try to choose another method type.

The pressure fitting connection uses assembly surface contact constraint as a support. A
pressure fitting connection is the link between two bodies which are assembled in a
Pressure Fitting configuration, more precisely when there are interferences or overlaps
between both parts. Along the surface normal, the connection behaves as a contact
connection with negative clearance value (positive overlap). The difference lies in the
tangential directions where both parts are linked together. Since bodies can be meshed
independently, the Pressure Fitting Connection is designed to handle incompatible meshes.
The Pressure Fitting Connection relations take into account the elastic deformability of the
interfaces.
The program proceeds as follows:
●

●

●

●

●

●

each node of the finer surface mesh is projected parallel to the local outer normal of the
first surface onto the second surface mesh.
a projection point is located whenever possible at the intercept of the projection
direction with the second surface mesh (extrapolated at the face boundary by roughly
half an element width).
if a projection point exists, the start node is connected by a a node-to-face element
with contact property to all nodes of the element face on which the projection point has
landed.
a set of join-type relations (involving interpolation using element shape functions) is
computed between the degrees of freedom of the start node and the degrees of
freedom of element face nodes (the projection point virtual degrees of freedom are
eliminated in the process).
rigid body kinematical relations are computed between the start node and the nodes of
element face.
these relations are rotated in a coordinate system the third vector of which corresponds
to the normal of the local surface.
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after the elimination of the projection point degrees of freedom, a pressure fitting
relation is generated between the start node and the projected node, transforming the
scalar equality relation into an inequality relation with a right-hand side equal to the
minus user-defined overlap.
two scalar equality relations are generated in the tangential plane to link the tangential
displacement of the start node and its projection.

Thus, the Pressure Fitting Connection generates at most as many node-to-face elements
with Pressure Fitting property as there are nodes on the finer surface mesh for which a
projection onto the opposite surface mesh exists.
To know more about the generated element, see Fitting Join in the Finite Element
Reference Guide.
Open the sample16.CATAnalysis document from the samples directory: you applied
constraints to the assembly (Assembly Design workbench).
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Pressure Fitting Connection Property icon

.

The Pressure Fitting Connection Property dialog box appears.

❍

Name: lets you change the name of the connection property.

❍

Support: lets you select the supports.

❍

Overlap: lets you enter an algebraic value for the maximum allowed normal
clearance reduction. The overlap indicates the interference between both parts.
It is intended to be positive.
■
a positive Overlap value (used for instance to model a press-fitted clamp
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between the surfaces) means that the surfaces are already too close, and
the program will have to push them apart.
■

■

a negative Overlap value (used to model a known gap between the
surfaces) means that the surfaces can still come closer until they come in
contact.
the default value used for the Overlap represents the actual geometric
spacing between surfaces.

2. Select an assembly constraint previously created in the Assembly Design
workbench.
The only allowed constraint type is Contact between body surfaces.
A symbol representing the Pressure Fitting Connection is visualized on the
corresponding faces.

3. Optionally modify the default value of the overlap parameter. In this case, enter
0.001mm.
4. Click OK in the Pressure Fitting Connection Property dialog box.

Generative Structural Analysis

Version 5 Release 14

Page 299

Note that two elements appear in the specification tree:
❍
a Pressure Fitting Connection Mesh.1 object under the Nodes and
Elements set,
❍

a Pressure Fitting Connection Property.1 object appears in the specification
tree under the Properties.1 set.
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Creating Bolt Tightening Connection
Properties
This task shows how to create a Bolt Tightening Connection between two parts.
●

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product

●

●

.

To have precisions and to know restrictions, please refer to About Connection
Properties.
The Gradient method is not available if several Bolt Tightening connections reference
the same degree of freedom. In this case, try to choose another method type.

As a support, the bolt tightening connection requires a surface constraint of face-face type
between the bolt thread and the bolt support tapping. Note that both these surfaces should
be coincident.
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In this example, Surface 1 and Surface 2 are supports for the assembly constraint of
surface contact type.
A bolt tightening connection is a connection that takes into account pre-tension in bolttightened assemblies. The computation is carried out according to the two-step traditional
approach. In the first step of the computation, the model is submitted to tension forces
relative to bolt tightening by applying opposite forces on the bolt thread and on the support
tapping, respectively. Then, in the second step, the relative displacement of these two
surfaces (obtained in the first step) is imposed while the model is submitted to user loads.
During these two steps, the bolt and the support displacements are linked in the direction
normal to the bolt axis. Since bodies can be meshed independently, the Bolt Tightening
Connection is designed to handle incompatible meshes.
The Contact Connection relations take into account the elastic deformability of the
interfaces.
The program proceeds as follows:
●

●

●

●

●

●

●

●

each node of the finer surface mesh is projected parallel to the local outer normal of the
first surface onto the second surface mesh.
a projection point is located whenever possible at the intercept of the projection
direction with the second surface mesh (extrapolated at the face boundary by roughly
half an element width).
if a projection point exists, the start node is connected by a node-to-face element with
Bolt Tightening property to all nodes of the element face on which the projection point
has landed.
a set of join-type relations (involving interpolation using element shape functions) is
computed between the degrees of freedom of the start node and the degrees of
freedom of element face nodes (the projection point virtual degrees of freedom are
eliminated in the process).
rigid body kinematical relations are computed between the start node and the nodes of
element face.
after the elimination of the projection point degrees of freedom, these relations are
rotated in a coordinate frame the third vector of which is aligned with the tension
direction (bolt axis).
two scalar equality relations are generated in the first two directions of the coordinate
frame, in order to link the displacement of the start node and the nodes of the element
face in the plane normal to the bolt axis.
a cable relation (the reverse of a contact relation) is generated between the start node
and the nodes of element face in the third direction, generating an inequality.

Thus, the Bolt Tightening Connection generates at most as many node-to-face elements
with Bolt Tightening property as there are nodes on the finer surface mesh for which a
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projection onto the opposite surface mesh exists.
To know more about the generated element, see Tightening Join in the Finite Element
Reference Guide.
Open the sample12.CATAnalysis document from the samples directory.
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Bolt Tightening Connection icon

.

The Bolt Tightening Connection dialog box appears.

2. Select an analysis connection.
In this particular example, select the General Analysis Connection.1 in the
specification tree (under the Analysis Connection Manager.1 set).

3. Optionally modify the default value of the force and orientation parameters.
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Choose either the same or the opposite orientation so that the graphic
representation of the Bolt Tightening Connection matches the bolt direction.

Same Orientation

Opposite Orientation

4. Click OK in the Bolt Tightening Connection dialog box to create the Bolt Tightening
Connection.
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A symbol representing the Bolt Tightening Connection is visualized on the
corresponding faces.

To obtain the same visualization of the assembly, select the Shading with
Edges and Hidden Edges icon in the View toolbar.
Note that two elements appear in the specification tree:
❍
a Tightening Connection Mesh.1 object under the Nodes and Elements set,
❍

a Bolt Tightening Connection Property.1 object appears in the specification
tree under the Properties.1 set.
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Creating Rigid Connection Properties
This task shows how to create a Rigid Connection between two parts.
This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.
A rigid connection is the link between two bodies which are stiffened and fastened together
at their common boundary, and will behave as if their interface was infinitely rigid. Since
bodies can be meshed independently, the Rigid Connection is designed to handle
incompatible meshes.
The Rigid Connection relations do not take into account the elastic deformability of the
interfaces.
The program proceeds as follows:
●

a null-length rigid bar is created at the midpoint between the centroids of the two
systems of points represented by the nodes of the two meshes (or at handler point, if
specified).
In case of a Point/Point connection, the length of the rigid bar is non null.

●

●

each extremity of the null-length rigid bar is connected by a rigid spider element to all
nodes of the first and of the second meshes.
a set of rig-beam relations is generated between the central node degree of freedom
and the connected nodes degree of freedom.

Thus, the Rigid Connection generates as many rig-beam kinematical elements as there are
nodes on the two surface meshes.

To know more about the generated element, see Rigid Spider in the Finite Element
Reference Guide.
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Open the sample16.CATAnalysis document from the samples directory.
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Rigid Connection Property icon

.

The Rigid Connection Property dialog box appears.

2. Select an analysis connection.

In this particular example, select the General Analysis Connection.1 in the
specification tree (under the Analysis Connection Manager.1 set).
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A symbol representing the Rigid Connection Property is visualized on the
corresponding faces.

By default, if you deactivate the Transmitted degrees of freedom option, all the
degrees of freedom are transmitted.
You can also release some degree of freedom to the distant connection, if needed.
The degrees of freedom are released at the null-length element.
Translation 1 = Translation in x
Translation 2 = Translation in y
Translation 3 = Translation in z
Rotation 1 = Rotation in x
Rotation 2 = Rotation in y
Rotation 3 = Rotation in z
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The Axis System Type combo box allows you to choose between Global or Userdefined Axis systems for defining the degrees of freedom directions.
❍

❍

Global: if you select the Global Axis system, the degree of freedom directions
will be interpreted as relative to the fixed global rectangular coordinate
system.
User: if you select a User Axis system, the degree of freedom directions will be
relative to the specified Axis system. Their interpretation will further depend on
your Axis System Type choice.
The degrees of freedom are released only for the null-length element, so
the User Axis System is defined only for the null-length element.
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To select a User-defined Axis system, you must activate an existing Axis by
clicking it in the features tree. Its name will then be automatically displayed in
the Current Axis field.
If you select the User-defined Axis system, the Local orientation combo box
further allows you to choose between Cartesian and Cylindrical Local Axis
Orientations.
■

Cartesian: the degrees of freedom directions are relative to a fixed
rectangular coordinate system aligned with the cartesian coordinate
directions of the User-defined Axis.

■

Cylindrical: the degrees of freedom directions are relative to a local
variable rectangular coordinate system aligned with the cylindrical
coordinate directions of each point relative to the User-defined Axis.

3. If needed, set the Axis system.
4. Click OK in the Rigid Connection Property dialog box.

Note that two elements appear in the specification tree:
❍

❍

a Rigid Connection Mesh.1 object under the Nodes and Elements set,
a Rigid Connection Property.1 object appears in the specification tree under
the Properties.1 set.
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The Finite Element Model contains two Mesh objects, one for each part of the assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols.
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Creating Smooth Connection Properties
This task shows how to create a Smooth Connection between two parts.
This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.
A Smooth Connection is the link between two bodies which are fastened together at their
common boundary, and will behave approximately as if their interface was soft. Since
bodies can be meshed independently, the Smooth Connection is designed to handle
incompatible meshes.
The Smooth Connection relations take approximately into account the elastic deformability
of the interfaces. The approximation is based on a least squares fit of a slave node degree
of freedom rigidly linked to the master nodes (element shape functions are ignored).
The program proceeds as follows:
●

a null-length rigid bar is created at the midpoint between the centroids of the two
systems of points represented by the nodes of the two meshes (or at handler point, if
specified).
In case of a Point/Point connection, the length of the rigid bar is non null.

●

●

each extremity of the null-length rigid bar is connected by two smooth spider elements
to all nodes of the first and of the second meshes.
a set of mean (constr-n) relations is generated between the central node degree of
freedom and the connected nodes degree of freedom.

Thus, the Smooth Connection generates two spider kinematical elements.

To know more about the generated element, see Smooth Spider in the Finite Element
Reference Guide.
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Open the sample16.CATAnalysis document from the samples directory.
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Smooth Connection Property icon

.

The Smooth Connection Property dialog box appears.

2. Select an analysis connection.

In this particular example, select the General Analysis Connection.1 in the
specification tree (under the Analysis Connection Manager.1 set).
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A symbol representing the Smooth Connection Property is visualized on the
corresponding faces.

By default, if you deactivate the Transmitted degrees of freedom option, all the
degrees of freedom are transmitted.
You can also release some degree of freedom to the distant connection, if needed.
The degrees of freedom are released at the null-length element.
Translation 1 = Translation in x
Translation 2 = Translation in y
Translation 3 = Translation in z
Rotation 1 = Rotation in x
Rotation 2 = Rotation in y
Rotation 3 = Rotation in z
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The Axis System Type combo box allows you to choose between Global or Userdefined Axis systems for defining the degrees of freedom directions.
❍

❍

Global: if you select the Global Axis system, the degree of freedom directions
will be interpreted as relative to the fixed global rectangular coordinate system.
User: if you select a User Axis system, the degree of freedom directions will be
relative to the specified Axis system. Their interpretation will further depend on
your Axis System Type choice.
The degrees of freedom are released only for the null-length element, so
the User Axis System is defined only for the null-length element.
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To select a User-defined Axis system, you must activate an existing Axis by
clicking it in the features tree. Its name will then be automatically displayed in
the Current Axis field.
If you select the User-defined Axis system, the Local orientation combo box
further allows you to choose between Cartesian and Cylindrical Local Axis
Orientations.
■

■

Cartesian: the degrees of freedom directions are relative to a fixed
rectangular coordinate system aligned with the cartesian coordinate
directions of the User-defined Axis.
Cylindrical: the degrees of freedom directions are relative to a local
variable rectangular coordinate system aligned with the cylindrical
coordinate directions of each point relative to the User-defined Axis.

3. If needed, set the Axis system.
4. Click OK in the Smooth Connection Property dialog box.

Note that two elements appear in the specification tree:
❍

❍

●

●

a Smooth Connection Mesh.1 object under the Nodes and Elements set,
a Smooth Connection Property.1 object appears in the specification tree
under the Properties.1 set.

The Finite Element Model contains two Mesh objects, one for each part of the assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols.
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Creating Virtual Rigid Bolt Tightening
Connection Properties
This task shows how to create a Virtual Rigid Bolt Tightening Connection Property between
two parts.
●

●

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.
To have precisions and to know restrictions, please refer to About Connection
Properties.

Virtual Rigid Bolt Tightening Connections are used to specify the boundary interaction
between bodies in an assembled system. Once the geometric assembly positioning
constraints are defined at the Product level, the user can specify the physical nature of the
constraints. When creating this connection, both the coincidence constraints and the
Analysis Connections workbench constraints can be selected.
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Surface 1 and surface 2 are supports for the assembly constraints of
coincidence type.
A Virtual Rigid Bolt Tightening Connection is a connection that takes into account pretension in a bolt-tightened assembly in which the bolt is not included. The computation is
carried out according to the two-step traditional approach. In the first step of the
computation, the model is submitted to tension forces relative to bolt tightening by
applying opposite forces on the first surface (S1) and the second surface (S2) of the
assembly constraint, respectively. Then, in the second step, the relative displacement of
these two surfaces (obtained in the first step) is imposed while the model is submitted to
user loads. During these two steps, the rotations of both surfaces and the translations
perpendicular to the coincidence constraint axis are linked together, while taking into
account the elastic deformability of the surfaces. Since bodies can be meshed
independently, the Virtual Rigid Bolt Tightening Connection is designed to handle
incompatible meshes.
The program proceeds as follows:
●

●

●

●

●

a central node is created at the centroid of each surface of the assembly constraint
referenced as the support.
for each surface/central node couple, a set of mean (constr-n) relations is generated to
link the average displacement of the central node and the nodes of the surface.
the first central node is linked rigidly to the duplicata of the second central node.
the second central node is linked rigidly to its duplicata except for the translation in the
direction of the coincidence constraint.
in the direction of the coincidence constraint, a cable relation (the reverse of a contact
relation) is generated between translation degrees of freedom of the second central
node and its duplicata.

To know more about the generated element, see Tightening Beam and Rigid Spider in the
Finite Element Reference Guide.
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Virtual rigid bolt tightening connection property is equivalent to a user-defined distant
connection property defined with the following combination:
●

Smooth as Start option

●

Bolt-Rigid as Middle option

●

Smooth as End option

For more details about user-defined distant connection properties, please refer to Creating
User-defined Distant Connection Property in this guide.

Open the sample12.CATAnalysis document from the samples directory.
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Virtual Bolt Tightening Connection Property icon
The Virtual Bolt Tightening Connection Property dialog box appears.

2. Select an analysis connection.

.
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In this particular example, select the General Analysis Connection.1 in the
specification tree (under the Analysis Connection Manager.1 set).

A symbol representing the Virtual Bolt Tightening Connection Property is visualized
on the corresponding faces.

3. Optionally modify the default Tightening Force value.
4. Click OK in the Virtual Bolt Tightening Connection Property dialog box.
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Note that two elements appear in the specification tree:
❍

❍

a Virtual Bolt Connection Mesh.1 object under the Nodes and Elements
set,
a Virtual Bolt Tightening Connection Property.1 Connection object appears
in the specification tree under the Properties.1 set.
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Creating Virtual Spring Bolt Tightening
Connection Properties
This task shows how to create a Virtual Spring Bolt Tightening Connection between two
parts.
●

●

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.
To have precisions and to know restrictions, please refer to About Connection
Properties.

Virtual Spring Bolt Tightening Connections are used to specify the boundary interaction
between bodies in an assembled system. Once the geometric assembly positioning
constraints are defined at the Product level, the user can specify the physical nature of the
constraints. When creating this connection, both the coincidence constraints and the
Analysis Connections workbench constraints can be selected.

Surface 1 and surface 2 are supports for the assembly constraints of
coincidence type.
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Virtual Spring Bolt Tightening Connection is a connection that takes into account pretension in a bolt-tightened assembly in which the bolt is not included. The computation is
carried out according to the two-step traditional approach. In the first step of the
computation, the model is submitted to tension forces relative to bolt tightening by
applying opposite forces on the first surface (S1) and the second surface (S2) of the
assembly constraint, respectively. Then, in the second step, the relative displacement of
these two surfaces (obtained in the first step) is imposed while the model is submitted to
user loads. The Virtual Spring Bolt Tightening Connection takes into account the elastic
deformability of the surfaces and since bodies can be meshed independently, the Virtual
Spring Bolt Tightening Connection is designed to handle incompatible meshes.
The program proceeds as follows:
●

●

●

a central node is created at the centroid of each surface of the assembly constraint
referenced as the support.
for each surface/central node couple, a set of mean rigid body (constr-n) relations is
generated to link the average displacement of the central nodes and the nodes of the
surface.
the first central node is linked to the duplicata of the second central node using a
tightening element. This element generates:
❍
a set of equality relations linking both nodes according to the rigid body motion
except for the translation in the direction of the element.
❍

●

a cable inequality relation (the reverse of a contact element) in the direction of the
element. This cable relation is used to enforce the relative displacement of both
surfaces at the second step of the computation.

the second central node is linked to its duplicata using a spring element the
characteristics of which are defined by the user.

To know more about the generated elements, see Tightening Beam, Spring and Smooth
Spider in the Finite Element Reference Guide.
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By default, when creating a virtual spring bolt tightening connection property, the stiffness
rotations and translations are defined in a global axis system.
To select a user axis system, use a user-defined distant connection property defined with
the following combination:
●

Smooth as Start option,

●

Spring-Rigid-Bolt as Middle option,

●

Smooth as End option.

For more details about user-defined distant connection properties, please refer to Creating
User-defined Distant Connection Property in this guide.
Open the sample12.CATAnalysis document from the samples directory.
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Virtual Spring Bolt Tightening Connection Property icon
The Virtual Spring Bolt Tightening Connection Property dialog box appears.

.
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2. Select an analysis connection.

In this particular example, select the General Analysis Connection.1 in the
specification tree (under the Analysis Connection Manager.1 set).
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A symbol representing the Virtual Spring Bolt Tightening Connection Property is
visualized on the corresponding faces.

3. Optionally modify the default value of the force and stiffness parameters.
4. Click OK in the Virtual Spring Bolt Tightening Connection Property dialog box.
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Note that two elements appear in the specification tree:
❍

❍

a Tightening Connection Mesh.1 object under the Nodes and Elements set,
a Bolt Tightening Connection Property.1 object appears in the specification
tree under the Properties.1 set.
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Creating User-Defined Connection
Properties
This task shows you how to create user-defined distant connection properties.
●

●

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.
To have precisions and to know restrictions, please refer to About Connection
Properties.

Creating user-defined distant connection properties allows you to specify the types of
elements as well as their associated properties included inside a distant connection. For
example:

You will define which types of element will be featured in the connection. Remember that
you can possibly have the following types of connected elements:
●

Surface-Point part (left part). It describes the way the surface is connected to the
middle of the connection. The possible combinations will be:
❍

Smooth

❍

Rigid

❍

Spring-Smooth

❍

Spring-Rigid

❍

Contact-Rigid
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Middle part. It describes the elements featuring in the middle of the connection. The
possible combinations will be:
❍

Rigid

❍

Spring-Rigid-Spring

❍

Rigid-Spring-Rigid

❍

Spring-Rigid

❍

Rigid-Spring

❍

Beam

❍

Spring-Beam-Spring

❍

Beam-Spring-Beam

❍

Spring-Beam

❍

Beam-Spring

❍

Bolt-Rigid

❍

Rigid-Bolt

❍

Bolt-Beam

❍

Beam-Bolt

❍

Bolt-Rigid-Spring

❍

Spring-Rigid-Bolt

Point-Surface part. It describes the way the surface is connected to the middle of
the connection. The possible combinations will be:
❍

Smooth

❍

Rigid

❍

Smooth-Spring

❍

Rigid-Spring

❍

Rigid-Contact

Open sample12.CATAnalysis from the samples directory.
Before You Begin:
●

●

Make sure you created a Finite Element Model containing a Static Analysis Case from
this assembly.
Make sure you know all you need about what type of property you will use for what
type of connection.
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1. Click the User-Defined Distant Connection Property icon

.

The User-Defined Connection Property dialog box appears.

Depending on the selected combination type, the appropriate properties will be
proposed: lists in sub-windows describing all the elementary properties. For
example:
❍

❍

If the list of elements is RIGID + SPRING and BEAM + RIGID and CONTACT
Three sub-windows (elementary basic components) will display the properties
for each of the elements: Spring, Beam and Contact.

2. Select an analysis connection as support.

In this particular example, select the General Analysis Connection.1 in the
specification tree (under the Analysis Connection Manager.1 set).
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A symbol representing the User-Defined Connection Property is visualized on the
corresponding faces.

3. Define the types of the elements to be featured in the connection: Start, Middle
and End.
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Depending on the type of Start, Middle and End elements you will choose in the
User-Defined Connection Property dialog box, given definition boxes and options
will be available.
This is an example:
Set the parameters as shown bellow:

❍

Start: if you click the Component Edition button
dialog box appears:

, the Start Connection
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■

Axis System Type combo box lets you to choose between Global or User
Axis systems for defining the degrees of freedom directions.
■

■

Global: if you select the Global Axis system, the degree of freedom
directions will be interpreted as relative to the fixed global rectangular
coordinate system.
User: if you select a User Axis system, the degree of freedom
directions will be relative to the specified Axis system. Their
interpretation will further depend on your Axis System Type choice.
To select a User Axis system, you must activate an existing Axis by
clicking it in the features tree. Its name will then be automatically
displayed in the Current Axis field.
If you select the User Axis system, the Local orientation combo box
further allows you to choose between Cartesian, Cylindrical and
Spherical Local Axis Orientations.

■

❍

Translation and Rotation stiffness values.

Middle: if you click the Component Edition button
Connection dialog box appears:

, the Middle
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■

Axis System Type combo box lets you to choose between Global or User
Axis systems for defining the degrees of freedom directions.
■

■

Global: if you select the Global Axis system, the degree of freedom
directions will be interpreted as relative to the fixed global rectangular
coordinate system.
User: if you select a User Axis system, the degree of freedom
directions will be relative to the specified Axis system. Their
interpretation will further depend on your Axis System Type choice.
To select a User Axis system, you must activate an existing Axis by
clicking it in the features tree. Its name will then be automatically
displayed in the Current Axis field.
If you select the User Axis system, the Local orientation combo box
further allows you to choose between Cartesian, Cylindrical and
Spherical Local Axis Orientations.

■

❍

Translation and Rotation stiffness values.

End: if you click the Component Edition button
dialog box appears:

, the End Connection
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Axis System Type combo box lets you to choose between Global or User
Axis systems for defining the degrees of freedom directions.
■

■

Global: if you select the Global Axis system, the degree of freedom
directions will be interpreted as relative to the fixed global rectangular
coordinate system.
User: if you select a User Axis system, the degree of freedom
directions will be relative to the specified Axis system. Their
interpretation will further depend on your Axis System Type choice.
To select a User Axis system, you must activate an existing Axis by
clicking it in the features tree. Its name will then be automatically
displayed in the Current Axis field.
If you select the User Axis system, the Local orientation combo box
further allows you to choose between Cartesian, Cylindrical and
Spherical Local Axis Orientations.

■

Translation and Rotation stiffness values.

4. If needed, click OK in the Start, Middle or End Connection dialog box.
5. Click OK in the User-Defined Connection Property dialog box.
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Note that two elements appear in the specification tree:
❍

❍

●

●

●

a Generic Connection Mesh.1 object under the Nodes and Elements set,
a User-Defined Connection Property.1 object appears in the specification
tree under the Properties.1 set.

If the support of the connection is a Face to Point connection (connecting wire-frames
with solid or surface), only two of the three lists will be proposed (left part and middle
part).
If the support of the connection is Point to Point connection (connecting two wireframes), only the middle list will be proposed.
No handler point is proposed in that type of connection. To ensure that a Face to Face
connection will respect a given point, it will be necessary to split into a Face to Point
and a Point to Face connection sharing the same point. Like for virtual parts sharing
the same handler point, only one single node will be generated on the associated
point.
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Creating Spot Welding Connection
Properties
This task shows how to create a Spot Welding Connection between two parts.
A Spot Welding Connection is the link between two bodies, using point analysis
connections or point analysis connections within one part.

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.
●

●

Open the sample48_1.CATAnalysis document from the samples directory.
Make sure you know all you need about what type of property you will use for what
type of connection.

1. Click the Spot Welding Connection Property icon

.

The Spot Welding Connection Property dialog box appears.

❍

Name: lets you change the name of the connection property.

❍

Supports: lets you select the connection you want to associate to a property.
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You can apply the spot welding connection property:
■

on Point Analysis Connection and Point Analysis Connection
within one Part (from R12)

■

on a joint body of the Body in White Fastening workbench

■

on Spot Welding Connection (before R12)

For more details, please refer to About Connection Properties.

❍

Type: allows you to choose between:
■
Rigid
■

Spring-Rigid-Spring

■

Rigid-Spring-Rigid

■

Beam

■

Hexahedron

❍

If you select the Beam, Spring-Rigid-Spring, Rigid-Spring-Rigid or
Hexahedron option type, the Component edition icon appears
.

❍

❍

The Component edition icon can have two status:

■

valid:

■

invalid:

If you select Beam or Hexahedron option type, you can select an
user-defined material.

For more details, please refer Creating an User Material.
2. Select a spot welding connection.
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In this particular example, select the Point Analysis Connection.1 in the
specification tree.

3. Select the desired Type option.

In this particular example, select the Spring-Rigid-Spring option Type.

4. Click the Component edition icon

The Spot Weld Definition dialog box:

to specify the parameters.

Page 338

Version 5 Release 14

Generative Structural Analysis

❍

❍

Page 339

the Axis System Type combo box lets you to choose between Global or
User Axis systems for defining the degrees of freedom directions.
Translation and Rotation stiffness values.

❍

❍

Global: if you select the Global Axis system, the degree of freedom
directions will be interpreted as relative to the fixed global
rectangular coordinate system.
User: if you select a User Axis system, the degree of freedom
directions will be relative to the specified Axis system. Their
interpretation will further depend on your Axis System Type
choice.
To select a User Axis system, you must activate an existing Axis by
clicking it in the features tree. Its name will then be automatically
displayed in the Current Axis field.
If you select the User Axis system, the Local orientation combo
box further allows you to choose between Cartesian, Cylindrical
and Spherical Local Axis Orientations.
■

Cartesian: the degrees of freedom directions are relative to a
fixed rectangular coordinate system aligned with the Cartesian
coordinate directions of the User Axis.
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Cylindrical: the degrees of freedom directions are relative to a
local variable rectangular coordinate system aligned with the
cylindrical coordinate directions of each point relative to the
User Axis.
Spherical: the degrees of freedom directions are relative to a
local variable rectangular coordinate system aligned with the
spherical coordinate directions of each point relative to the
User Axis.

You can select six degrees of freedom per node:
1.
2.
3.
4.
5.
6.

Translation stiffness 1 = Translation in X
Translation stiffness 2 = Translation in Y
Translation stiffness 3 = Translation in Z
Rotation stiffness 1 = Rotation in X
Rotation stiffness 2 = Rotation in Y
Rotation stiffness 3 = Rotation in Z

5. Modify the desired parameters in the Spot Weld Definition dialog box.
6. Click OK in the Spot Weld Definition dialog box.
7. Click OK in the Spot Welding Connection dialog box.

A Spot Welding Connection Property.1 object appears in the specification tree
under the Properties.1 set and a Weld Spot Connection Mesh.1 object
appears under the Nodes and Elements set.
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You can edit the Weld Spot Connection Mesh.1 object.
For this, double-click the Weld Spot Connection Mesh.1 object in the specification
tree.
The Spot Welding Connection dialog box appears.

For more details about the weld spot connection mesh parts, please refer to Meshing
Spot Weld Connections in the Advanced Meshing Tools User's Guide.

●

You can visualize the connection mesh. For this:
❍
compute the mesh only (for more details, please refer to Computing Objects Sets)
❍

generate a Mesh image (for more details, please refer to Generating Images)
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Creating Seam Weld Connection Properties
This task shows how to create a Seam Weld Connection Property between two parts or within one part.
A Seam Weld Connection Property is a connection that is created from an existing Line Analysis Connection or
Line Analysis Connection Within One Part.

This functionality is only available in the Generative Assembly Structural Analysis (GAS) product.
●

Open the sample48_1.CATAnalysis document from the samples directory.

●

Make sure you know all you need about what type of property you will use for what type of connection.

1. Select the Seam Weld Connection Property icon

.

The Seam Weld Connection Property dialog box appears.

❍

Name: lets you change the name of the connection property.

❍

Support: lets you select the connection you want to associate to a property.
You can apply the spot welding connection property:
■

on Line Analysis Connection and Line Analysis Connection within one Part (from R12)

■

on a joint body of the Body in White Fastening workbench

■

on Seam Welding Connection (before R12)

For more details, please refer to About Connection Properties.

❍

Type:
■
Shell
■

Hexahedron

■

Rigid

■

Spring-Rigid-Spring

■

Rigid-Spring-Rigid

■

Contact: only available to connect 3D geometries.

■

Beam

❍

If you select the Shell, Hexahedron, Spring-Rigid-Spring, Rigid-Spring-Rigid,
Contact or Beam option type, the Component edition button appears

❍

❍
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.

The Component edition button can have two status:

■

valid:

■

invalid:

If you select Shell, Beam or Hexahedron option type, you can select an user-defined
material.

For more details, please refer Creating an User Material.
2. Select the seam welding connection.

In this particular example, select Line Analysis Connection.1 object in the specification tree.

3. Select the desired Type option.

In this particular example, select the Shell option type.

4. Click the Component edition button

to specify the parameters.

The Seam Weld Definition dialog box appears.

❍

❍

Material: gives you information about the associated material.
User-defined material: lets you select an user material.
For more details, please refer Creating an User Material.
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Thickness: lets you specify a thickness value.

5. Specify the desired parameters.

In this particular example:
❍

select the User Defined Isotropic Material option

❍

activate the Material text box

❍

select the User Isotropic Material.1 object in the specification tree

❍

enter 1mm as Thickness value

6. Click OK in the Seam Weld Definition dialog box.

Note that the Component Edition icon becomes valid.

7. Click OK in the Seam Weld Connection Property dialog box.

A Seam Weld Connection Property.1 object appears in the specification tree under the
Properties.1 set and a Weld Seam Connection Mesh.1 object appears under the Nodes and
Elements set.

Generative Structural Analysis

●
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You can edit the Weld Seam Connection Mesh.1 object.
For this, double-click the Weld Seam Connection Mesh.1 object in the specification tree.
The Seam Welding Connections dialog box appears.

For more details about the weld seam connection mesh part, please refer to Meshing Seam Welding
Connections in the Advanced Meshing Tools User's Guide.
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The weld seam connection mesh part is created with a default Step value.
This value is computed as a ratio of the seam length.
In case this value is much smaller than the size of the connected meshes, the size of the problem to
be solved is considerably increased. This may lead to an "Out of Memory" error.
You can find here a recommended methodology to avoid this error:

1. Create the Seam Weld Connection Property.
2. Edit the Weld Seam Connection Mesh part in the specification tree.
3. Check that the Step value respects the proportion of the connected meshes (commonly used
value: half of the smallest connected mesh).
4. Launch the computation.

●

You can visualize the connection mesh. For this:
❍
compute the mesh only (for more details, please refer to Computing Objects Sets)
❍

generate a Mesh image (for more details, please refer to Generating Images)
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Creating Surface Weld Connection
Properties
This task shows how to create a Surface Weld Connection Property between two parts or
within one part.
A surface weld connection property is a connection that is created from an existing Surface
Analysis Connection or Surface Analysis Connection Within One Part.

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.
●

●

Open the sample11_1.CATAnalysis document from the samples directory.
Make sure you know all you need about what type of property you will use for what type
of connection.

1. Select the Surface Weld Connection Property icon

.

The Surface Weld Connection Property dialog box appears.

❍

Name: lets you change the name of the connection property.

❍

Supports: lets you select the connection you want to associate to a property.
You can apply the surface welding connection property to Surface
Analysis Connection and Surface Analysis Connection within one Part
of the Generative Assembly Structural Analysis (GAS) product.
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For more details, please refer to About Connection Properties.

❍

Type:
■
Hexahedron: the connection is meshed using hexahedron elements.

■

Component Edition

: lets you specify the associated material.

The Component Edition button can have two status:

■

valid:

■

invalid:

2. Select the surface welding connection.

In this particular example, select Surface Analysis Connection.1 object in the
specification tree.

3. Click the Component Edition button

to specify the parameters.

The Surface Weld Definition dialog box appears.

❍

Material: gives you information about the associated material.

❍

User-defined material: lets you select an user material.
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For more details, please refer Creating an User Material.
4. Select the User-defined material option in the Surface Weld Definition dialog box.
5. Activate the Material text box as shown bellow:

6. Select User Material.1 as Material.

The Surface Weld Definition dialog box is updated:

7. Click OK in the Surface Weld Definition dialog box.

Note that the Component edition icon becomes valid in the Surface Weld
Connection Property dialog box:
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8. Click OK in the Surface Weld Connection Property dialog box.

A Surface Weld Connection Property.1 object appears in the specification tree
under the Properties.1 set and a Weld Surface Connection Mesh.1 object
appears under the Nodes and Elements set.

A symbol appears on the geometry:
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●
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You can edit the Weld Surface Connection Mesh.1 object.
For this, double-click the Weld Seam Connection Mesh.1 object in the specification
tree.
The Surface Welding Connections dialog box appears.
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For more details about the surface weld connection mesh part, please refer to Meshing
Surface Welding Connections in the Advanced Meshing Tools User's Guide.

●

You can visualize the connection mesh. For this:
❍
compute the mesh only (for more details, please refer to Computing Objects Sets)
❍

generate a Mesh image (for more details, please refer to Generating Images)
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Analysis Assembly
The following functionalities are only available with the Generative Assembly Structural
Analysis (GAS) product.
About Analysis Assembly
You can find here general information about the Analysis Assembly context.
Analysis Assembly Methodology
Methodology of work in Analysis Assembly context.
Analysis Assembly 2D Viewer
You can visualize the analysis document structure.
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About Analysis Assembly
You will find here general information about the Analysis Assembly concept.

This functionality is only available in the Generative Assembly Structural Analysis
(GAS) product.
Analysis assembly provides a general solution based on reusability of the analysis document
(.CATAnalysis file). Consequently the simulation of a complex product structure can be split
into several independent sub-analysis performed by several users and assembled together in
a global analysis called assembled analysis.
The Analysis Assembly definition will be done in both the Generative Structural Analysis
workbench and the Advanced Meshing Tools workbench.
All analysis data (such as mesh, properties and materials) are retrieved without data
duplication.

You can find here the notations used in this document:

The supported product structure are:

Product Structure:

Assembly of:
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Analysis on Part
●

The shape A1 must be activated when creating
the assembled analysis.

●

The part pointed by the A1 must be the same as
Part1.

Orphan mesh (imported mesh)
A1 is not pointing any geometry.

●

Finite Element Model:
Properties and mesh parts can be defined either in the sub-analysis or in the assembled
analysis but the mesh part and its associated property must be defined in the same
analysis (under the same Analysis Manager).

●

Connection Properties:
Only the weld connection properties (spot weld, seam weld and surface weld) are
authorized in the assembled analysis. All these connections can be applied between
mesh parts and geometrical bodies.

●

Pre-processing Specifications:
The pre-processing specifications such as restraints and loads can be defined either in
sub-analysis or in the assembled analysis.
The pre-processing specifications defined in a sub-analysis will be ignored in the
assembled Finite Element Model.
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All the functionalities belonging to the Generative Part Structural Analysis (GPS)
product and the ELFINI Structural Analysis (EST) product are available in the
assembled analysis. These specifications can be applied on any geometry and groups of
the specification tree. They are automatically linked to all meshes throughout the
assembly.

●

Solving Process:
The standard simulation solving processes are supported in the analysis assembly
context.

●

Post-processing Specifications:
The result management is supported in the analysis assembly context. Finite element
visualization is available on assembly, as well as sensors and reporting.
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Analysis Assembly Methodology
This task will show you how to work in Analysis Assembly context to build an assembly of:
●

analysis on part

●

orphan analysis

This functionality is only available in the Generative Assembly Structural Analysis (GAS) product.
Open the Assembly.CATProduct from the samples directory.
The product structure is the following:

Assembly of Analysis on Part
1. Associate one or several analysis to the Surface1 part and activate one analysis representation.

a. Right-click the Surface.1 part and select the Representations -> Manage Representations...
contextual menu

.

Make sure you work in a product context.
To work in a product context, double-click the root product in the specification tree (in this
particular example, double-click Assembly.
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The Manage Representations dialog box appears.

b. Click the Associate... button in the Manage Representations dialog box.

The Associate Representation dialog box appears.
c. Select the AnalysisSurface11.CATAnalysis document in the sample directory and click the Open
button.
d. Click the Associate... button in the Manage Representations dialog box, select the
AnalysisSurface11.CATAnalysis document in the sample directory and click the Open button.

The Manage Representation dialog box is updated:

Note that:
■

■

the two associated representations are deactivated.
you can remove, replace or rename a selected shape.
For more details, please refer to Managing Representations - Product Structure User's Guide.

e. Select AnalysisSurface11.CATAnalysis in the Manage Representations dialog box and click the
Activate button.
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The Manage Representation dialog box is updated:

f. Click Close in the Manage Representations dialog box.
Note that an Analysis Manager appears under the Surface1 part in the specification tree:

2. Associate the AnalysisSurface2.CATAnalysis document to the Surface2 part and activate this representation.

The specification tree is updated as shown bellow:

3. Enter the Generative Structural Analysis workbench.
For this, select the Start -> Analysis and Simulation -> Generative Structural Analysis menu.
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Select Static Case and click OK in the New Analysis Case dialog box.
The specification tree is updated as shown bellow:

The Nodes and Elements, Properties and Material sets are empty in the specification tree.
The Mesh Visualization contextual menu is available.
4. Create the pre-processing specifications either in the sub-analysis or in the assembled analysis.

❍

To activate an analysis, double-click the associated Analysis Manager.

❍

At any time you can add/remove a shape, activate/deactivate an associated shape or add/remove a
product component.
For more details, please refer to Analysis Assembly 2D Viewer.

At this step, you can open the sample14.CATAnalysis document in which all the analysis specifications have been
already defined and follow the scenario.
5. Compute the solution.
For this, click the Compute icon, select the All option and click OK in the Computation dialog box.
6. Define the post-processing specifications.

Any analysis shape which is not active at creation will be ignored in the assembly.
In case of several analysis shapes are associated to the same product instance, only the active shape will be taken into
account in the assembled analysis.
To check the content of the assembled analysis, you can use the Shape Management command.
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Assembly of Orphan Analysis (Imported Mesh)
You can find here the methodology for orphan analysis creation.

1. Create an new analysis document.
2. Use the Import Mesh command of the Advanced Meshing Tools workbench to import an .dat file.
For more details, please refer to the Advanced Meshing Tools User's Guide.
3. Complete the property set in the Generative Structural Analysis workbench.
4. Insert the orphan analysis in the product structure using the Existing Component command.
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Analysis Assembly 2D Viewer
This task will show you how to synchronize the analysis assembly content with the product changes.
At any time, you can add or remove a shape, activate or deactivate an existing shape and add or remove a
product component in a analysis assembly context. The content of the analysis assembly is not automatically
synchronize.
This functionality is only available in the Generative Assembly Structural Analysis (GAS) product.
Open the sample14.CATAnalysis from the samples directory.
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1. Click the Analysis Assembly 2D Viewer icon
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.

The Assembled Analysis Definition dialog box appears.

❍

❍

Graph: lets you visualize the analysis structure.
■

The

symbol indicates that the shape is deactivate.

■

The red highlight indicates that the shape is the current active shape.

Synchronize: lets you synchronize the analysis document with the activated shapes.
This button is available if you modify the product structure.

2. Click Cancel in the Assembled Analysis Definition dialog box.
3. Change the shape associated to a sub-analysis.

In this particular example:
a. Double-click Assembly in the specification tree.
b. Right-click the Surface.1 part and select the Representations -> Manage
Representations... contextual menu.
c. Select AnalysisSurface11.CATAnalysis in the Manage Representations dialog box and click
the Deactivate button.
d. Select ASurface12.CATAnalysis in the Manage Representations dialog box and click the
Activate button.
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e. Click Close in the Manage Representations dialog box.
4. Double-click Analysis Manager in the specification tree to retrieve the analysis context.

5. Click the Analysis Assembly 2D Viewer icon

.

The Assembled Analysis Definition dialog box appears as shown bellow:

The active shape (Shape 3 [ASurface12.CATPart] in this particular example) is not
highlighted.
You have to synchronize the analysis document with the activated shapes.
6. Click the Synchronize button.

The Assembled Analysis Definition is updated.
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The active shape is now red-highlighted.
7. Click OK in the Assembled Analysis Definition dialog box.

You can find here the specification tree of an assembly of orphan analysis:
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Note that: Analysis1 (Analysis1.1) and Analysis1 (Analysis1.1) are not pointing any geometry
You can find here the graph of an assembly of orphan analysis:
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Virtual Parts
Virtual Parts are structures created without a geometric support. They represent bodies for
which no geometry model is available, but which play a role in the structural analysis of
single part or assembly systems.
Virtual Parts are used to transmit action at a distance. Therefore they can be thought of as
rigid bodies, except for the case where a lumped flexibility is explicitly introduced by the
means of a spring element.
Do not use Virtual Parts to simulate connections.
To simulate connections, please use Analysis Connections of the Generative Structural
Analysis (GAS) product.

Create Rigid Virtual Parts
Generate a stiff transmission rigid virtual part.
Create Smooth Virtual Parts
Generate a soft transmission rigid virtual part.
Create Contact Virtual Parts
Generate a contact transmission rigid virtual part.
Create Rigid Spring Virtual Parts
Generate a stiff transmission elastic spring virtual part.
Create Smooth Spring Virtual Parts
Generate a soft transmission elastic spring virtual part.
Create Periodicity Conditions
Simulate periodicity conditions by linking together the degrees of freedom of two
faces that undergo transformation.
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Creating Rigid Virtual Parts
This task shows how to create a Rigid Virtual Part between a point and a geometry
support.
A Rigid Virtual Part is a rigid body connecting a specified point to specified part
geometries, behaving as a mass-less rigid object which will stiffly transmit actions
(masses, restraints and loads) applied at the handle point, while locally stiffening the
deformable body or bodies to which it is attached.
The Rigid Virtual Part does not take into account the elastic deformability of the parts to
which it is attached.
The program proceeds as follows:
●

●

●

a node is created in coincidence with the specified handle point.
each node of the specified geometry supports meshes is connected by a kinematical
rig-beam element to the handle node.
a set of rig-beam relations is generated between the handle node degree of freedom
and the connected nodes degree of freedom.

Thus, the Rigid Virtual Part generates as many rig-beam kinematical elements as there
are nodes on specified support meshes.
The Rigid Virtual Part is built with a Rigid Spider element.

To know more about this element, see Rigid Spider in the Finite Element Reference Guide.
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Rigid Virtual Parts can be applied to the following types of Supports:

Geometrical Feature
Mechanical
Feature

Analysis Mesh
Point Curve
Surface Volume
Group Feature Part
or
or
or Face or Part
Vertex Edge

You can use the sample28.CATAnalysis document from the samples directory for this
task: Finite Element Model containing a Static Analysis Case and computed corresponding
Static Solution. A Part Design point was created on the associated CATPart document.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading,
Outlines and Materials options are active in the Custom View Modes dialog box.

1. Click the Rigid Virtual Part icon

.

The Rigid Virtual Part dialog box appears.

2. Select a face or an edge of the part as a geometry support. In this particular case,
select a face.
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3. Click the Select Mesh Parts button in the Rigid Virtual Parts dialog box.
4. Position the cursor on the Handler field in the Rigid Virtual Part dialog box and
select a vertex or a point as handler point (the handler point symbol appears as
your cursor passes over it). In this case, select a point.

❍

❍

❍

This point selected as handler must be a Part Design point.
If you do not specifically select a point, the centroid (the point at which
the lines meet) will be used as the handler point.
When several virtual parts share a same handler point, only one finite
element node is generated.
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The Rigid Virtual Part dialog box is updated.

5. Click OK to create the Rigid Virtual Part.

A Rigid Virtual Part object appears in the specification tree under the active Nodes
and Elements objects set.
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When a 1D mesh part is created by selecting two virtual parts handler, the nodes are not
condensed. The beam mesh part must be created first.
Do not use virtual parts to simulate connections. You should use the Analysis Connection.
●

●

You can select several geometry supports.
The Rigid Virtual Part will connect all supports to the handle point and stiffly transmit
all actions as a rigid body.
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Creating Smooth Virtual Parts
This task shows how to create a Smooth Virtual Part between a point and a geometry support.
A Smooth Virtual Part is a rigid body connecting a specified point to specified part geometries,
behaving as a mass-less rigid object which will softly transmit actions (masses, restraints and
loads) applied at the handle point, without stiffening the deformable body or bodies to which it is
attached.
The Smooth Virtual Part does approximately take into account the elastic deformability of the
parts to which it is attached.
The program proceeds as follows:
●

a node is created in coincidence with the specified handle point.

●

all nodes of the specified geometry supports meshes are connected by a kinematical spider
element to the handle node.

●

a set of mean (constr-n) relations is generated between the handle node degree of freedom
and the connected nodes degree of freedom.

The Smooth Virtual Part is built with a Smooth Spider element.

To know more about this element, see Smooth Spider in the Finite Element Reference Guide.
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Smooth Virtual Parts can be applied to the following types of Supports:

Mechanical
Feature

Geometrical Feature
Point or
Vertex

Curve or Surface or
Edge
Face

Volume or
Part

Analysis
Feature

You can use the sample28.CATAnalysis document from the samples directory for this task: Finite
Element Model containing a Static Analysis Case and computed corresponding Static Solution. A
Part Design point was created on the associated CATPart document.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines and
Materials options are active in the Custom View Modes dialog box.

1. Click the Smooth Virtual Part icon

.

The Smooth Virtual Part dialog box appears.

2. Select an edge or a face of the part as geometry support. In this case, select a face.
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3. Position the cursor on the Handler field in the Smooth Virtual Part dialog box and select
a point or a vertex as the handler point (the handler point symbol appears as your cursor
passes over it). In this case, select a point.

The Rigid Virtual Part dialog box is updated.
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If you do not specifically select a point, the centroid (the point at which the lines meet)
will be used as the handler point.
4. Click OK to create the Smooth Virtual Part.

When several virtual parts share a same handler point, only one finite element node is
generated.
The symbol appearing at the handler point represents the Smooth Virtual Part.

A Smooth Virtual Part object appears in the specification tree under the active Nodes
and Elements objects set.
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You can select several geometry supports.
The Smooth Virtual Part will connect all supports to the handle point and softly transmit all
actions as a rigid body.
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Creating Contact Virtual Parts
This task shows how to create a Contact Virtual Part between a point and a geometry
support.
A Contact Virtual Part is a rigid body connecting a specified point to specified part
geometries, behaving as a mass-less rigid object which will transmit actions (masses,
restraints and loads) applied at the handle point, while preventing from body interpenetration and thus without stiffening the deformable body or bodies to which it is
attached.
The Contact Virtual Part does take into account the elastic deformability of the parts to
which it is attached.
The program proceeds as follows:
●

a node is created in coincidence with the specified handle point.

●

each node of the specified geometry supports meshes is offset in the local normal
direction by a small amount and a contact element is generated between each pair of
offset nodes, generating a set of contact relations with a right-hand side equal to the
user-defined clearance.

●

each offset node is connected by a kinematical rig-beam element to the handle node.

●

a set of rig-beam relations is generated between the handle node degree of freedom
and the connected offset nodes degree of freedom.

Thus, the Contact Virtual Part generates as many rig-beam kinematical elements and as
many contact elements as there are nodes on specified support meshes.
The Contact Virtual Part is built with Rigid Spider and Contact Rod elements.
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To know more about those elements, see Rigid Spider and Contact Rod in the Finite
Element Reference Guide.

Contact Virtual Parts can be applied to the following types of Supports:

Mechanical
Feature

Geometrical Feature
Point or Curve Surface or Volume or
Vertex or Edge
Face
Part

Analysis
Feature

Open the sample28.CATAnalysis document from the samples directory for this task: Finite
Element Model containing a Static Analysis Case and computed corresponding Static
Solution. A Part Design point was created on the associated CATPart document.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading,
Outlines and Materials options are active in the Custom View Modes dialog box.
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1. Click the Contact Virtual Part icon

Page 381

.

The Contact Virtual Part dialog box appears.

2. Select a face of the part as a geometry support.

3. Position the cursor on the Handler field in the Contact Virtual Part dialog box and
select a point for the handler point (the handler point symbol appears as your
cursor passes over it).

Generative Structural Analysis

Version 5 Release 14

Page 382

If you do not specifically select a point, the centroid (the point at which the lines
meet) will be used as the handler point.
Optionally enter a clearance value in the Clearance field.

4. Click OK to create the Contact Virtual Part.
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When several virtual parts share a same handler point, only one finite element
node is generated.
The symbol appearing at the handler point represents the Contact Virtual Part.

A Contact Virtual Mesh object appears in the specification tree under the active
Nodes and Elements objects set.

●

●

You can select several geometry supports.
The Contact Virtual Part will connect all support offset nodes to the handle point into a
rigid body and transmit all actions via contact conditions between offset nodes and
supports.
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Creating Rigid Spring Virtual Parts
This task shows how to create a Rigid Spring Virtual Part between a point and a geometry
support.
A Rigid Spring Virtual Part is an elastic body connecting a specified point to a specified
geometry, behaving as a six degree of freedom spring in series with a mass-less rigid body
which will stiffly transmit actions (masses, restraints and loads) applied at the handle point,
while stiffening the deformable body or bodies to which it is attached.
The Rigid Spring Virtual Part does not take into account the elastic deformability of the parts
to which it is attached.
The program proceeds as follows:
●

a node is created in coincidence with the specified handle point.

●

a second node, offset from the first node, is created in a user-specified direction.

●

the offset node is connected by a user-specified spring element to the handle node.

●

all nodes of the specified geometry supports meshes are connected by rig-beam
kinematical elements to the offset node.

●

a set of rig-beam relations is generated between the offset node degree of freedom and
the connected nodes degree of freedom.

The Rigid Virtual Part is built with Rigid Spider and Spring elements.

To know more about those elements, see Rigid Spider and Spring in the Finite Element
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Reference Guide.

Rigid Spring Virtual Parts can be applied to the following types of Supports:

Mechanical
Feature

Geometrical Feature
Point or Curve or Surface or Volume or
Vertex
Edge
Face
Part

Analysis
Feature

You can use the sample28.CATAnalysis document from the samples directory for this task:
Finite Element Model containing a Static Analysis Case and computed corresponding Static
Solution. A Part Design point was created on the associated CATPart document.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Rigid Spring Virtual Part icon

.

The Rigid Spring Virtual Part dialog box appears.
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2. Select the cylindrical face of the hole as a geometry support.

3. Position the cursor on the Handler field in the Rigid Spring Virtual Part dialog box and
select a point for the handler point (the handler point symbol appears as your cursor

Generative Structural Analysis

Version 5 Release 14

Page 387

passes over it).

❍

❍

If you do not specifically select a point, the centroid will be used as the handler
point
When several virtual parts share a same handler point, only one finite element
node is generated.

The Axis System Type combo box allows you to choose between Global and Userdefined Axis systems, for entering components of the resultant moment vector.
❍

❍

Global: if you select the Global Axis system, the components of the resultant
moment vector will be interpreted as relative to the fixed global rectangular
coordinate system.
User-defined: if you select a User-defined Axis system, the components of the
resultant moment vector will be interpreted as relative to the specified rectangular
coordinate system.
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To select a User-defined Axis system, you must activate an existing Axis by clicking
it in the specification tree. Its name will then be automatically displayed in the
Current Axis field.
4. Set the Axis system.
5. Enter values for the six degree of freedom spring constants.
6. Click OK to create the Spring Rigid Virtual Part.
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The symbol appearing at the handler point represents the Rigid Spring Virtual Part.
A Rigid Spring Virtual Part Mesh.1 object appears in the specification tree under
the active Nodes and Elements objects set.

You can select several geometry supports.
The Spring Rigid Virtual Part will connect all supports to the handler point and stiffly transmit
all actions as a spring in series with a rigid body.
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Creating Smooth Spring Virtual Parts
This task shows how to create a Spring Smooth Virtual Part between a point and a
geometry support.
A Spring Smooth Virtual Part is an elastic body connecting a specified point to a specified
geometry, behaving as a 6-degree of freedom spring in series with a mass-less rigid body
which will softly transmit actions (masses, restraints and loads) applied at the handle
point, without stiffening the deformable body or bodies to which it is attached.
The Spring Smooth Virtual Part does approximately take into account the elastic
deformability of the parts to which it is attached.
The program proceeds as follows:
●

a node is created in coincidence with the specified handle point.

●

a second node, offset from the first node, is created in a user-specified direction.

●

the offset node is connected by a user-specified spring element to the handle node.

●

all nodes of the specified geometry supports meshes are connected by a kinematical
spider element to the offset node.

●

a set of mean (constr-n) relations is generated between the offset node degree of
freedom and the connected nodes degree of freedom.

The Spring Smooth Virtual Part is built with Smooth Spider and Spring elements.
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To know more about those elements, see Smooth Spider and Spring in the Finite Element
Reference Guide.

Spring Smooth Virtual Parts can be applied to the following types of Supports:

Mechanical
Feature

Geometrical Feature
Point or Curve Surface or Volume or
Vertex or Edge
Face
Part

Analysis
Feature

You can use the sample28.CATAnalysis document from the samples directory for this
task: Finite Element Model containing a Static Analysis Case and computed corresponding
Static Solution. A Part Design point was created on the associated CATPart document.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading,
Outlines and Materials options are active in the Custom View Modes dialog box.

1. Click the Smooth Spring Virtual Part icon

.

The Smooth Spring Virtual Part dialog box appears.
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2. Select the cylindrical face of the hole as a geometry support.

3. Position the cursor on the Handler field in the Smooth Spring Virtual Part dialog
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box and select a point for the handler point (the handler point symbol appears as
your cursor passes over it).

❍

❍

If you do not specifically select a point, the centroid will be used as the handler
point
When several virtual parts share a same handler point, only one finite element
node is generated.

The Axis System Type combo box allows you to choose between Global and
User-defined Axis systems, for entering components of the resultant moment
vector.
❍

❍

Global: if you select the Global Axis system, the components of the resultant
moment vector will be interpreted as relative to the fixed global rectangular
coordinate system.
User-defined: if you select a User-defined Axis system, the components of
the resultant moment vector will be interpreted as relative to the specified
rectangular coordinate system.
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To select a User Axis system, you must activate an existing Axis by clicking it
in the features tree. Its name will then be automatically displayed in the
Current Axis field.
4. Set the Axis system.
5. Enter values for the 6-degree of freedom spring constants.
6. Click OK to create the Smooth Spring Virtual Part.
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The symbol appearing at the handler point represents the Smooth Spring Virtual
Part.

A Smooth Spring Virtual Mesh object appears in the specification tree under the
active Nodes and Elements objects set.

●

●

You can select several geometry supports.
The Smooth Spring Virtual Part will connect all supports to the handler point and softly
transmit all actions as a spring in series with a rigid body.

Generative Structural Analysis

Version 5 Release 14

Page 396

Creating Periodicity Conditions
This task shows you how to simulate periodicity conditions by linking together the degrees
of freedom of two faces that undergo transformation. You will apply cyclic symmetry.
This functionality is only available if you installed the ELFINI Structural Analysis
product.
Periodicity conditions enable you to perform an analysis on the solid section of a periodic
part. This solid section should represent a cyclic period of the entire part as shown in two
examples below.
Applying periodicity conditions is cost saving: you compute only a section of the part and
get a result that is representative of the whole part.
Two types of periodicity conditions can be applied:
1. Cyclic symmetry of the geometry as well as both restraints and loads.
The actual part results from n rotations applied to the modelled solid section
where n=2 II : teta should be an integer.
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2. Regular symmetry of the sectioned geometry as well as both restraints and
loads:
The section is geometrically regular, there is no discontinuity. The entire actual
part results from an infinite number of translations (right and left) of the modeled
section.

To know more about this element, see Periodic Condition and Join Fasten in the Finite
Element Reference Guide.
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To use periodicity conditions, you need to make sure the geometry as well as the created
restraints and loads are periodic. The geometry also needs to be regular at the place the
section is cut: discontinuity is not allowed.
Open the sample44.CATAnalysis document from the samples directory for this task.

1. Click the Periodicity Conditions icon

.

The Periodicity Conditions dialog box appears.

2. Select on the model both planes to be used for generating periodicity of the part
section. In this particular case, select both pink faces.
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The selected planes are high-lighted.

The Periodicity Conditions dialog box is updated.

3. Click OK in the Periodicity Conditions dialog box.
The periodicity conditions are now created.
The specification tree is updated.
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If you want to apply Periodicity Conditions via regular symmetry, open the
sample43.CATAnalysis document from the samples directory.
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Mass Equipment
Create Distributed Mass Equipment
Generate a non-structural lumped mass distribution equivalent to a total mass
concentrated at a given point.

Create Mass Densities: Generates non-structural mass densities of given
intensity.
Create Line Mass Densities
Generate a scalar line mass field of given uniform intensity on a curve geometry.
Create Surface Mass Densities
Generate a scalar surface mass field of given uniform intensity on a surface
geometry.
Inertia on Virtual Part
Define inertia on virtual parts.
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Creating Distributed Masses
This task shows you how to create a Distributed Mass applied to a virtual part or to a geometry selection.
Distributed Masses are used to model purely inertial (non-structural) system characteristics such as
additional equipment. They represent scalar point mass fields equivalent to a total mass concentrated at a
given point, distributed on a virtual part or on a geometric selection.
The user specifies the total mass. This quantity remains constant independently of the geometry selection.
The point where the total mass is concentrated is automatically defined as follows:
●

For extended geometries, this point is the centroid of the geometry.

●

For virtual parts, this point is the handler of the virtual part.

The given concentrated-mass system is processed by the program as follows:
●

●

In the case of extended geometries, it is transformed into an equivalent lumped masses system
distributed over the selected support.
In the case of virtual parts connected to deformable bodies, it is transmitted as a lumped masses system
collectively to the entire connected geometry.

Units are mass units (typically kg in SI).
Mass sets can be included in static cases: in this case, they are used for loadings based inertia effects.
Distributed Mass can be applied to the following types of Supports:

Analysis Feature
Geometrical

Mechanical

Feature

Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Point/Vertex

Others

Virtual Part

Edge
Face
Homogeneous
selection
Open the sample16.CATAnalysis document from the samples directory.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines and Materials
options are active in the Custom View Modes dialog box.
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.

The Distributed Mass dialog box is displayed.

2. You can change the identifier of the Distributed Mass by editing the Name field.
3. Enter the value of the total Mass to define the mass magnitude.
4. Select the support (a vertex, an edge, a face or a virtual part) on which the concentrated mass is
applied at the pre-defined point. Any selectable geometry is highlighted when you pass the cursor
over it.

You can select several supports in sequence, to apply the Distributed Mass to all supports
simultaneously.
Symbols representing the total mass equivalent to the Distributed Mass are displayed at the
application point of the support to visualize the input lumped mass system.

5. Click OK to create the Distributed Mass.
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A Distributed Mass.1 object appears in the features tree under the active Masses objects set.

●

●

●

●

●

You can either select the support and then set the Distributed Mass specifications, or set the Distributed
Mass specifications and then select the support.
If you select several geometric supports, you can create as many Distributed Masses as desired with the
same dialog box. A series of Distributed Masses can therefore be created quickly. The point where the
total mass is initially concentrated is automatically assumed to be the centroid of the system of
individual supports centroids.
Non-Structural Masses are not required for either Stress Analysis or Modal computations.
If several Analysis Cases have been defined in the Finite Element Model, you must activate a Masses
objects set in the features tree before creating a Distributed Mass object (only available if you have
ELFINI Structural Analysis product installed).
Distributed Mass objects can be edited by a double click on the corresponding object or icon in the
features tree.

Make sure the computation is finished before starting any of the following operations.
Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a right mouse

●

click (key 3) on a Distributed Mass object:
❍

Distributed mass visualization on mesh: the translation of your Distributed Mass object
specifications into solver specifications can be visualized symbolically at the impacted mesh entities,
provided the mesh has been previously generated via a Compute action.
The ELFINI Structural Analysis product offers the following additional features with a right mouse

●

click (key 3) on a Masses objects set:
❍

Generate Image:
Generates an image of the Local Update action (which translates all user-defined Masses specs into
explicit solver commands on mesh entities), by generating symbols for the elementary masses
imposed by the Masses objects set. The image can be edited to include part or all of the options
available.
Right-click (key 3) on a Masses objects set and select the Generate Image option. The Image
Choice dialog box is displayed. You can select images by clicking them in the list.
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The resulting images sequence is obtained by superposition.

❍

Report:
The partial status and results of intermediate pre-processor computations are reported in HTML
format. It represents a subset of the global Report capability and generates a partial report of the
Masses objects set Computation.

Click the Basic Analysis Report icon
the Compute icon

(on the condition you previously computed a solution using

).

Click OK in the Reporting Options dialog box that appears (if you have more than one analysis case,
ensure that the relevant analysis case is highlighted in the dialog box).
The .html partial report file is displayed.
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Creating Line Mass Densities
This task shows you how to create a Line Mass Density applied to a virtual part or to a
geometry selection.
Line Mass Densities used to model purely inertial (non-structural) system characteristics
such as additional equipment. They represent scalar line mass density fields of given
intensity, applied to curve geometries.
The user specifies the line mass density. This quantity remains constant independently of
the geometry selection. Units are line mass density units (typically kg/m in SI).
Mass sets can be included in static cases: in this case, they are used for loadings based
inertia effects.

Line Mass Density can be applied to the following support types:

Analysis Feature
Geometrical

Mechanical

Feature

Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Edge

Open the sample16.CATAnalysis document from the samples directory.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.
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.

The Line Mass Density dialog box is displayed.

2. You can change the identifier of the Line Mass Density by editing the Name field.
3. Select the support (an edge, curve or line geometry) on which the line mass density
is applied. Any selectable geometry is highlighted when you pass the cursor over it.

You can select several supports in sequence, to apply the Line Mass Density to all
supports simultaneously.
4. Enter the desired Mass Density value to modify the mass density magnitude.
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5. Click OK in the Line Mass Density dialog box.
A Line Mass Density object appears in the specification tree under the active
Masses objects set.

Symbols representing the Line Mass Density are displayed on the support geometry.
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You can either select the support and then set the Line Mass Density specifications, or
set the Line Mass Density specifications and then select the support.
If you select other supports, you can create as many Line Mass Densities as desired
with the same dialog box. A series of Line Mass Densities can therefore be created
quickly.
Non-Structural Masses are not required for either Stress Analysis or Modal
computations.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Masses objects set in the features tree before creating a Line Mass Density
object (only available if you have ELFINI Structural Analysis product installed).
Line Mass Density objects can be edited by a double click on the corresponding object
or icon in the specification tree.

Make sure the computation is finished before starting any of the following operations.
Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a right
mouse click (key 3) on:

a Line Mass Density object:

●

❍

●

Line Mass Density Visualization on Mesh: the translation of your Line Mass
Density object specifications into solver specifications can be visualized symbolically
at the impacted mesh entities, provided the mesh has been previously generated
via a Compute action.
a Mass objects set:

Generative Structural Analysis
❍

❍
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Generate Image: generates an image of the Local Update action (which translates
all user-defined Masses specs into explicit solver commands on mesh entities), by
generating symbols for the elementary masses imposed by the Masses objects set.
The image can be edited to include part or all of the options available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Masses objects set Computation.
For more details, please refer to Creating Distributed Masses.
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Creating Surface Mass Densities
This task shows you how to create a Surface Mass Density applied to a virtual part or to a
geometry selection.
Surface Mass Densities are used to model purely inertial (non-structural) system
characteristics such as additional equipment. They represent scalar surface mass density
fields of given intensity, applied to surface geometries.
The user specifies the surface mass density. This quantity remains constant independently
of the geometry selection.
Units are surface mass density units (typically kg/m2 in SI).
Mass sets can be included in static cases: in this case, they are used for loadings based
inertia effects.

Surface Mass Density can be applied to the following types of Supports:

Analysis Feature
Geometrical

Mechanical

Feature

Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Face

Open the sample16.CATAnalysis document from the samples directory.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.
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The Surface Mass Density dialog box is displayed.

2. You can change the identifier of the Surface Mass Density by editing the Name
field.
3. Enter the value of the surface mass density.
4. Select the support (a surface or face geometry) on which the surface mass density
is applied. Any selectable geometry is highlighted when you pass the cursor over it.

You can select several supports in sequence, to apply the Surface Mass Density to
all supports simultaneously.
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5. Click OK in the Surface Mass Density dialog box to create the Surface Mass Density.
A Surface Mass Density object appears in the specification tree under the active
Masses objects set.
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You can either select the support and then set the Surface Mass Density specifications,
or set the Surface Mass Density specifications and then select the support.
If you select other supports, you can create as many Surface Mass Densities as desired
with the same dialog box. A series of Surface Mass Densities can therefore be created
quickly.
Non-Structural Masses are not required for either Stress Analysis or Modal
computations.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Masses objects set in the features tree before creating a Surface Mass
Density object (only available if you have ELFINI Structural Analysis product installed).
Surface Mass Density objects can be edited by a double click on the corresponding
object or icon in the features tree.

Make sure the computation is finished before starting any of the following operations.
Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a right
mouse click (key 3) on:

a Line Mass Density object:

●

❍

Surface Mass Density Visualization on Mesh: the translation of your Surface
Mass Density object specifications into solver specifications can be visualized
symbolically at the impacted mesh entities, provided the mesh has been previously
generated via a Compute action.
a Masses objects set:

●

❍

Generate Image: generates an image of the Local Update action (which translates
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all user-defined Masses specs into explicit solver commands on mesh entities), by
generating symbols for the elementary masses imposed by the Masses objects set.
The image can be edited to include part or all of the options available.
❍

Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Masses objects set Computation.
For more details, please refer to Creating Distributed Masses.
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Inertia on Virtual Part
This task shows you how to define inertias on virtual part.
Inertia on Virtual Part lets you take into account a spatial distribution of mass on a virtual
part.

Only available with the ELFINI Structural Analysis (EST) product.

Inertia can be applied to the following types of supports:

Analysis Feature
Geometrical

Mechanical

Feature

Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Virtual
Part

Open the sample28_1.CATAnalysis document from the samples directory.

1. Click the Inertia on Virtual Part icon

.

The Inertia on Virtual Part dialog box is displayed.
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❍

❍

Name: lets you change the name of the inertia.
Supports: lets you select a support.
■
The only authorized support is the virtual part.
■

❍
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Multi-selection is not available.

Axis System Type:
■
Global: if you select the Global Axis system, the directions will be
interpreted as relative to the fixed global rectangular coordinate system of
CATIA.
■

User: if you select a User Axis system, the directions will be relative to the
specified Current axis system. Their interpretation will further depend on
your Axis System Type choice.
To select a User-defined Axis system, you must activate an existing Axis by
clicking an axis created in the Part document. Its name will then be
automatically displayed in the Current axis field.
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Current axis: lets you select the desired axis system
Local orientation: (Cartesian) the components are interpreted as
relative to a fixed rectangular coordinate system aligned with the
Cartesian coordinate directions of the User-defined Axis.

❍

Display locally: lets you display the axis system locally on the geometry.

❍

Mass: lets you specify a mass magnitude value (in kg).

❍

I1: lets you specify the mass inertia value in the X-direction.

❍

I2: lets you specify the mass inertia value in the Y-direction.

❍

I3: lets you specify the mass inertia value in the Z-direction.

2. Select a virtual part as Support.
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In this particular case, select the Rigid Virtual Part.1 either from the specification
tree or directly on the geometry as shown bellow:

The Inertia on Virtual Part dialog box is updated.

3. Enter a Mass value to define the mass magnitude.

In this particular example, enter 5kg as Mass value.

Generative Structural Analysis

Version 5 Release 14

Page 421

4. Modify the mass inertia components.
5. Click OK in the Inertia on Virtual Part dialog box.

An Inertia on Virtual Part.1 object appears in the specification tree under the
Masses.1 set.
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Restraints
Create Clamps
Fix all degrees of freedom on a geometry selection

Technological Restraints
Create Surface Sliders
Generate surface constraint joins, which allow points of a surface to slide along a
coinciding rigid surface (fixes the translation degree of freedom for a surface in the
direction of the local normal)
Create Ball Joins
Generate spherical joins (balls), which allow a rigid body to rotate about a given
point (fixes all translation degrees of freedom of a point)
Create Sliders
Generate prismatic joins (sliders), which allow a rigid body to translate along a given
axis (fixes all degrees of freedom of a point, except for one translation)
Create Pivots
Generate conical joins (hinges), which allow a rigid body to rotate around a given
axis (fixes all degrees of freedom of a point, except for one rotation)
Create Sliding Pivots
Generate cylindrical joins (actuators) which allow a rigid body to translate about
and rotate around a given axis (fixes all degrees of freedom of a point, except for
one translation and one rotation)

Generic Restraints
Create Advanced Restraints
Fix any combination of degrees of freedom on a geometry selection
Create Iso-static Restraints
Generate statically determinate supports on a part
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Creating Clamps
This task shows how to create a Clamp on a geometry.
Clamps are restraints applied to surface or curve geometries, for which all points are to be
blocked in the subsequent analysis.

means that there is no translation degree of freedom left
in that direction.
Clamp objects belong to Restraint objects sets.
Make sure you fixed all the global degrees of freedom of your assembly, otherwise a global
singularity will be detected at the time of the Static Computation (such a model is
unsolvable). To allow you to easily correct the model (Static Analysis Cases only), the
singular displacement of the assembly will be simulated and visualized after computation.
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Clamps can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Point/Vertex

Others

Virtual

Edge

Part

Face

Open the sample02.CATAnalysis document from the samples directory for this task: a Finite
Element Model containing a Static or Frequency Analysis Case.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Clamp icon

.

The Clamp dialog box appears.
2. You can change the identifier of the Clamp by editing the Name field.

3. Select the geometry support (a surface, an edge or a virtual part). Any selectable
geometry is highlighted when you pass the cursor over it.
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You can select several supports in sequence, to apply the Clamp to all supports
simultaneously.
Symbols representing a fixed translation in all directions of the selected geometry
are visualized.
4. Click OK in the Clamp dialog box to create the Clamp.

A Clamp object appears in the features tree under the active Restraints objects
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set.

●

●

●

●

You can either select the support and then set the Clamp specifications, or set the
Clamp specifications and then select the support.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Restraints objects set in the features tree before creating a Clamp object.
Restraints are required for Stress Analysis computations. They are optional for Modal
Analysis computations (if not created, the program will compute vibration modes for the
free, unrestrained part).
Clamp objects can be edited by a double click on the corresponding object or icon in the
specification tree.

Make sure the computation is finished before starting any operation.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3) on a Clamp object:
●

Restraint visualization on mesh: the translation of your Clamp object specifications
into solver specifications can be visualized symbolically at the impacted mesh nodes,
provided the mesh has been previously generated via a Compute action.
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Right-click your clamp object and select the Restraint visualization on mesh option.

●

Generate Image: generates an image of the computed Restraint objects (along with
translating all user-defined Restraints specifications into explicit solver commands on
mesh entities), by generating symbols for the nodal restraints imposed by the Restraints
objects set. The image can be edited to include part or all of the options available.
Right-click on a Restraints objects set and select the Generate image option. The Image
Choice dialog box is displayed. You can select images by clicking them in the list.
The resulting images sequence is obtained by superposition.

●

Report: the partial status and results of intermediate pre-processor computations are
reported in HTML format. It represents a subset of the global Report capability and
generates a partial report of the Restraints objects set Computation.

Click the Basic Analysis Report icon
The .html partial report file is displayed.

on the bottom toolbar.
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Creating Surface Sliders
This task shows how to create a Surface Slider on a surface.
Surface Sliders are surface constraint joins, which allow points of a surface to slide along
a coinciding rigid surface.

means that there is no translation degree of freedom left in
that direction.
Surface Sliders are applied to surface geometries. Surface Slider objects belong to
Restraint objects sets.
Make sure you fixed all the global degrees of freedom of your assembly, otherwise a
global singularity will be detected at the time of the Static Computation (such a model is
unsolvable). To allow you to easily correct the model (Static Analysis Cases only), the
singular displacement of the assembly will be simulated and visualized after computation.
At each point of the deformable surface, the program automatically generates a constraint
which fixes the translation degree of freedom in the direction normal to the surface at that
point.
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Surface Slider can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Face

Open the sample15.CATAnalysis document from the samples directory for this task: a
Finite Element Model containing a Static or Frequency Analysis Case and computed
corresponding Solution.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading,
Outlines and Materials options are active in the Custom View Modes dialog box.

1. Click the Surface Slider icon

.

The Surface Slider dialog box appears.

2. You can change the identifier of the Surface Slider by editing the Name field, if
needed.
3. Select a geometry support (a face).
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You can select several supports in sequence, to apply the Surface Slider
simultaneously to all. Symbols representing the Surface Slider are displayed on
the support.
4. Click OK in the Surface Slider dialog box to create the Surface Slider.

A Surface Slider object appears in the specification tree under the active
Restraints objects set.
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You can either select the geometry support and then set the Surface Slider
specifications, or set the Surface Slider specifications and then select the geometry
support.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Restraints objects set by clicking it in the features tree before creating a
Surface Slider object.
Restraints are required for Stress Analysis computations. They are optional for Modal
Analysis computations (if not created, the program will compute vibration modes for
the free, unrestrained part).
Surface Slider objects can be edited by a double click on the corresponding object or
icon in the features tree.

Make sure the computation is finished before starting any of the following operations.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Surface Slider object:

●

❍

Restraint visualization on mesh: the translation of your Surface Slider object
specifications into solver specifications can be visualized symbolically at the
impacted mesh nodes, provided the mesh has been previously generated via a
Compute action.
on a Restraints objects set:

●

❍

❍

Generate Image: generates an image of the computed Restraint objects (along
with translating all user-defined Restraints specs into explicit solver commands on
mesh entities), by generating symbols for the nodal restraints imposed by the
Restraints objects set. The image can be edited to include part or all of the options
available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Restraints objects set Computation.
For more details, please refer to Creating Clamps.
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Creating Ball Joins
This task shows how to create a Ball Join on a virtual part.
Ball Joins are spherical join restraints applied to handle points of virtual parts, which result
in constraining the point to rotate around a coinciding fixed point. They can be viewed as
particular cases of general spherical joins, which allow a relative rotation between two
points (in the Ball Join case, one of the two points is fixed).

means that there is no translation degree of freedom left in that
direction.
Ball Join objects belong to Restraints objects sets.
For the fixed point, the program automatically picks the handle of the virtual part. The
virtual part as a whole is then allowed to rotate around this point.
Make sure you fixed all the global degrees of freedom of your assembly, otherwise a global
singularity will be detected at the time of the Static Computation (such a model is
unsolvable). To allow you to easily correct the model (Static Analysis Cases only), the
singular displacement of the assembly will be simulated and visualized after computation.
When connected to deformable bodies, the virtual part will transmit the effect of the Ball
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Join restraint collectively to the entire connected geometry.

Ball Joins can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Virtual

Point/Vertex

Part

Open the sample15.CATAnalysis document from the samples directory for this task: a Finite
Element Model containing a Static or Frequency Analysis Case and created a Virtual part.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Ball Join icon

.

The Ball Join dialog box appears.

2. You can change the identifier of the Ball Join by editing the Name field, if needed.
3. Select the virtual part.
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The Ball Join dialog box is updated.
A symbol representing the Ball Join is displayed on the virtual part.

4. Click OK in the Ball Join dialog box to create the Ball Join.

A Ball Join object appears in the specification tree under the active Restraints
objects set.
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You can either select the virtual part support and then set the Ball Join specifications, or set
the Ball Join specifications and then select the virtual part support.
If several Analysis Cases have been defined in the Finite Element Model, you must activate
a Restraints objects set by clicking it in the features tree before creating a Ball Join
object.
Restraints are required for Stress Analysis computations. They are optional for Modal
Analysis computations (if not created, the program will compute vibration modes for the
free, unrestrained part).
Ball Join objects can be edited by a double click on the corresponding object or icon in the
features tree.

Make sure the computation is finished before starting any of the following operations.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Ball Join object:

●

❍

Restraint visualization on mesh: the translation of your Ball Join object
specifications into solver specifications can be visualized symbolically at the
impacted mesh nodes, provided the mesh has been previously generated via a
Compute action.
on a Restraints objects set:

●

❍

❍

Generate Image: generates an image of the computed Restraint objects (along
with translating all user-defined Restraints specs into explicit solver commands on
mesh entities), by generating symbols for the nodal restraints imposed by the
Restraints objects set. The image can be edited to include part or all of the options
available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Restraints objects set Computation.
For more details, please refer to Creating Clamps.
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Creating Sliders
This task shows how to create a Slider on a virtual part.
Sliders are prismatic join restraints applied to handle points of virtual parts, which result
in constraining the point to slide along a given axis. They can be viewed as particular cases
of general prismatic joins, which allow a relative translation between two points (in the
Slider case, one of the two points is fixed, along with the sliding axis).

means that there is no translation degree of freedom left in that
direction.
means that there is no rotation degree of freedom left in the
direction.
Slider objects belong to Restraint objects sets.
For the fixed point, the program automatically picks the handle of the virtual part. The user
defines the sliding direction, and as a result the virtual part as a whole is allowed to slide
along an axis parallel to the sliding direction and passing through the fixed point.
Make sure you fixed all the global degrees of freedom of your assembly, otherwise a global
singularity will be detected at the time of the Static Computation (such a model is
unsolvable). To allow you to easily correct the model (Static Analysis Cases only), the
singular displacement of the assembly will be simulated and visualized after computation.
When connected to deformable bodies, the virtual part will transmit the effect of the Slider
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restraint collectively to the entire connected geometry.

Sliders can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Virtual
Part

Open the sample15.CATAnalysis document from the samples directory for this task.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Slider icon

.

The Slider dialog box appears.
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2. You can change the identifier of the Slider by editing the Name field, if needed.

The Axis Type combo box allows you to choose between Global and User-defined
Axis systems for entering components of the sliding axis.
❍

❍

Global: if you select the Global Axis system, the components of the sliding
direction will be interpreted as relative to the fixed global rectangular coordinate
system.
User-defined: if you select a User-defined Axis system, the components of the
sliding direction will be interpreted as relative to the specified rectangular
coordinate system.
To select a User-defined Axis system, you must activate an existing Axis by
clicking it in the features tree. Its name will then be automatically displayed in
the Current Axis field.

3. Set the Axis system.
4. In the X, Y, Z fields, enter the values corresponding to the components of the
sliding direction relative to the selected Axis System.
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You can define the sliding direction by using the compass. The values in
the X, Y, Z fields correspond to the direction components of the
compass principal axis.
You can modify the compass orientation either with the mouse or by
editing the compass.
By applying the compass to any part geometry, you can align the
compass directions with the implicit axis directions of that geometry:
drag the compass by handling the red square and drop it on the
appropriate surface. The normal direction to this surface defines the
new direction. Then, click on the Compass Direction button to take this
new direction into account. You can now invert the direction if desired,
by editing the values of the three components.

5. Select the virtual part.

Generative Structural Analysis
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A symbol representing the sliding direction is displayed on the virtual part.

6. Modify the sliding direction orientation.

The visualized Slider symbol orientation is automatically updated to reflect the
modifications of the compass principal direction.
7. Click OK in the Slider dialog box.

A Slider object appears in the specification tree under the active Restraints
objects set.
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You can either select the virtual part support and then set the Slider specifications, or set
the Slider specifications and then select the virtual part support.
If several Analysis Cases have been defined in the Finite Element Model, you must activate
a Restraints objects set by clicking it in the features tree before creating a Slider object
(only available if you have ELFINI Structural Analysis product installed).
Restraints are required for Stress Analysis computations. They are optional for Modal
Analysis computations (if not created, the program will compute vibration modes for the
free, unrestrained part).
Slider objects can be edited by a double click on the corresponding object or icon in the
features tree.
Make sure the computation is finished before starting any of the following operations.
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Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Slider object:

●

❍

Restraint visualization on mesh: the translation of your Slider object
specifications into solver specifications can be visualized symbolically at the
impacted mesh nodes, provided the mesh has been previously generated via a
Compute action.
on a Restraints objects set:

●

❍

❍

Generate Image: generates an image of the computed Restraint objects (along
with translating all user-defined Restraints specs into explicit solver commands on
mesh entities), by generating symbols for the nodal restraints imposed by the
Restraints objects set. The image can be edited to include part or all of the options
available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Restraints objects set Computation.
For more details, please refer to Creating Clamps.
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Creating Pivots
This task shows how to create a Pivot on a virtual part.
Pivots are hinge (conical join) restraints applied to handle points of virtual parts, which
result in constraining the point to rotate around a given axis. They can be viewed as
particular cases of general hinge joins, which allow a relative rotation between two points
(in the Pivot case, one of the two points is fixed, along with the pivot axis).
Pivot objects belong to Restraint objects sets.

means that there is no translation degree of freedom left in that
direction.
means that there is no rotation degree of freedom left in the
direction.
For the fixed point, the program automatically picks the handle of the virtual part. The user
defines the pivot direction, and as a result the virtual part as a whole is allowed to rotate
around an axis parallel to the pivot direction and passing through the fixed point.
Make sure you fixed all the global degrees of freedom of your assembly, otherwise a global
singularity will be detected at the time of the Static Computation (such a model is
unsolvable). To allow you to easily correct the model (Static Analysis Cases only), the
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singular displacement of the assembly will be simulated and visualized after computation.
When connected to deformable bodies, the virtual part will transmit the effect of the Pivot
restraint collectively to the entire connected geometry.

Pivots can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Virtual
Part

Open the sample15.CATAnalysis document from the samples directory for this task: a Finite
Element Model containing a Static or Frequency Analysis Case and created a Virtual part.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Pivot icon

.

The Pivot dialog box appears.
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2. You can change the identifier of the Pivot by editing the Name field, if needed.

The Axis System Type combo box allows you to choose between Global and Userdefined Axis systems for entering components of the pivot axis.
❍

❍

Global: if you select the Global Axis system, the components of the pivot
direction will be interpreted as relative to the fixed global rectangular coordinate
system.
User-defined: if you select a User-defined Axis system, the components of the
pivot direction will be interpreted as relative to the specified rectangular
coordinate system.
To select a User-defined Axis system, you must activate an existing Axis by
clicking it in the features tree. Its name will then be automatically displayed in
the Current Axis field.

3. Set the Axis system.
4. In the X, Y, Z fields, enter the values corresponding to the components of the pivot
direction relative to the selected Axis system.
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You can define the pivot direction by using the compass. The values in
the X, Y, Z fields correspond to the direction components of the
compass principal axis.
You can modify the compass orientation either with the mouse or by
editing the compass.
By applying the compass to any part geometry, you can align the
compass directions with the implicit axis directions of that geometry:
drag the compass by handling the red square and drop it on the
appropriate surface. The normal direction to this surface defines the
new direction. Then, click on the Compass Direction button to take this
new direction into account. You can now invert the direction if desired,
by editing the values of the three components.

5. Select a virtual part.

A symbol representing the pivot direction is displayed on the virtual part.

6. Modify the pivot direction orientation.

The visualized Pivot symbol orientation is automatically updated to reflect the
modifications of the compass principal direction.
7. Click OK in the Pivot dialog box.
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A Pivot object appears in the features tree under the active Restraints objects
set.

●

●

●

●

You can either select the virtual part support and then set the Pivot specifications, or set
the Pivot specifications and then select the virtual part support.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Restraints objects set by clicking it in the specification tree before creating a
Pivot object.
Restraints are required for Stress Analysis computations. They are optional for Modal
Analysis computations (if not created, the program will compute vibration modes for the
free, unrestrained part).
Pivot objects can be edited by a double click on the corresponding object or icon in the
features tree.

Make sure the computation is finished before starting any of the following operations.
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Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Pivot object:

●

❍

Restraint visualization on mesh: the translation of your Pivot object
specifications into solver specifications can be visualized symbolically at the
impacted mesh nodes, provided the mesh has been previously generated via a
Compute action.
on a Restraints objects set:

●

❍

❍

Generate Image: generates an image of the computed Restraint objects (along
with translating all user-defined Restraints specs into explicit solver commands on
mesh entities), by generating symbols for the nodal restraints imposed by the
Restraints objects set. The image can be edited to include part or all of the options
available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Restraints objects set Computation.
For more details, please refer to Creating Clamps.
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Creating Sliding Pivots
This task shows how to create a Sliding Pivot on a virtual part.
Sliding Pivots are cylindrical join restraints applied to handle points of virtual parts, which
result in constraining the point to simultaneously translate along and rotate around a given
axis. They can be viewed as particular cases of general cylindrical joins, which allow a
relative combined translation and rotation between two points (in the Sliding Pivot case, one
of the two points is fixed, along with the sliding pivot axis).

means that there is no translation degree of freedom left in that
direction.
means that there is no rotation degree of freedom left in the
direction.
Sliding Pivot objects belong to Restraint objects sets.
For the fixed point, the program automatically picks the handle of the virtual part. The user
defines the sliding pivot direction, and as a result the virtual part as a whole is allowed to
translate along and to rotate around an axis parallel to the sliding pivot direction and
passing through the fixed point.
Make sure you fixed all the global degrees of freedom of your assembly, otherwise a global
singularity will be detected at the time of the Static Computation (such a model is
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unsolvable). To allow you to easily correct the model (Static Analysis Cases only), the
singular displacement of the assembly will be simulated and visualized after computation.
When connected to deformable bodies, the virtual part will transmit the effect of the Sliding
Pivot restraint collectively to the entire connected geometry.

Sliding Pivots can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Virtual
Part

Open the sample15.CATAnalysis document from the samples directory for this task: a Finite
Element Model containing a Static or Frequency Analysis Case and created a Virtual part.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Sliding Pivot icon

.

The Sliding Pivot dialog box appears.
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2. You can change the identifier of the Sliding Pivot by editing the Name field, if
needed.

The Axis System Type combo box allows you to choose between Global and Userdefined Axis systems for entering components of the pivot axis.
❍

❍

Global: if you select the Global Axis system, the components of the slidng pivot
direction will be interpreted as relative to the fixed global rectangular coordinate
system.
User-defined: if you select a User-defined Axis system, the components of the
sliding pivot direction will be interpreted as relative to the specified rectangular
coordinate system.
To select a User-defined Axis system, you must activate an existing Axis by
clicking it in the features tree. Its name will then be automatically displayed in
the Current Axis field.

3. Set the Axis system.
4. Select a virtual part.
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A symbol representing the sliding pivot direction is displayed on the virtual part.

5. In the X, Y, Z fields, enter the values corresponding to the components of the
sliding pivot direction relative to the selected Axis System.
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You can define the sliding pivot direction by using the compass. The
values in the X, Y, Z fields correspond to the direction components of
the compass principal axis.
You can modify the compass orientation either with the mouse or by
editing the compass.
By applying the compass to any part geometry, you can align the
compass directions with the implicit axis directions of that geometry:
drag the compass by handling the red square and drop it on the
appropriate surface. The normal direction to this surface defines the
new direction. Then, click on the Compass Direction button to take this
new direction into account. You can now invert the direction if desired,
by editing the values of the three components.

6. Modify the sliding pivot direction orientation.

The visualized Sliding Pivot symbol orientation is automatically updated to reflect
the modifications of the compass principal direction.
7. Click OK in the Sliding Pivot dialog box.

A Sliding Pivot object appears in the specification tree under the active Restraints
objects set.
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You can either select the virtual part support and then set the Sliding Pivot
specifications, or set the Sliding Pivot specifications and then select the virtual part
support.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Restraints objects set by clicking it in the specification tree before creating a
Sliding Pivot object (only available if you have ELFINI Structural Analysis product
installed).
Restraints are required for Stress Analysis computations. They are optional for Modal
Analysis computations (if not created, the program will compute vibration modes for the
free, unrestrained part).
Sliding Pivot objects can be edited by a double click on the corresponding object or icon
in the features tree.

Make sure the computation is finished before starting any of the following operations.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Sliding Pivot object:

●

❍

Restraint visualization on mesh: the translation of your Sliding Pivot object
specifications into solver specifications can be visualized symbolically at the
impacted mesh nodes, provided the mesh has been previously generated via a
Compute action.
on a Restraints objects set:

●

❍

❍

Generate Image: generates an image of the computed Restraint objects (along
with translating all user-defined Restraints specs into explicit solver commands on
mesh entities), by generating symbols for the nodal restraints imposed by the
Restraints objects set. The image can be edited to include part or all of the options
available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Restraints objects set Computation.
For more details, please refer to Creating Clamps.
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Creating Advanced Restraints
This task shows how to create an Advanced Restraint on a geometry.
Advanced Restraints are generic restraints allowing you to fix any combination of
available nodal degrees of freedom on arbitrary geometries. There are three translation
degrees of freedom per node for continuum element meshes, and three translation and
three rotation degrees of freedom per node for structural element meshes.
(this is an example)

means that there is no translation degree of freedom left in that
direction.
means that there is no rotation degree of freedom left in the
direction.
Make sure you fixed all the global degrees of freedom of your assembly, otherwise a global
singularity will be detected at the time of the Static Computation (such a model is
unsolvable). To allow you to easily correct the model (Static Analysis Cases only), the
singular displacement of the assembly will be simulated and visualized after computation.
Advanced Restraint objects belong to Restraint objects sets.
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Advanced Restraints can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Point/Vertex

Others

Virtual

Edge

Part

Face

Open the sample20.CATAnalysis document from the samples directory for this task: a Finite
Element Model containing a Static or Frequency Analysis Case.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Advanced Restraint icon

.

The Advanced Restraint dialog box appears.
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2. You can change the identifier of the Advanced Restraint by editing the Name field, if
needed.
3. Set the Axis System Type.

The Axis System Type combo list allows you to choose between Global, Implicit
and User-defined Axis systems for defining the degrees of freedom directions:
❍

❍

❍

Global: if you select the Global Axis system, the degree of freedom directions
will be interpreted as relative to the fixed global rectangular coordinate
system.
Implicit: if you select the Implicit Axis system, the degree of freedom
directions will be interpreted as relative to a local variable coordinate system
whose type depends on the support geometry.
User: if you select a User Axis system, the degree of freedom directions will be
relative to the specified Axis system. Their interpretation will further depend on
your Axis Type choice.
To select a User-defined Axis system, you must activate an existing Axis by
clicking it in the features tree. Its name will then be automatically displayed in
the Current Axis field.
If you select the User-defined Axis system, the Local orientation combo box
further allows you to choose between Cartesian, Cylindrical and Spherical
Local Axis Orientations.
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Cartesian: the degrees of freedom directions are relative to a fixed
rectangular coordinate system aligned with the cartesian coordinate
directions of the User-defined Axis.
Cylindrical: the degrees of freedom directions are relative to a local
variable rectangular coordinate system aligned with the cylindrical
coordinate directions of each point relative to the User-defined Axis.
Spherical: the degrees of freedom directions are relative to a local variable
rectangular coordinate system aligned with the spherical coordinate
directions of each point relative to the User-defined Axis.

4. Select the geometry support (a surface or an edge). Any selectable geometry is
highlighted when you pass the cursor over it.

You can select several supports in sequence, to apply the Advanced Restraint to all
supports simultaneously.
Symbols representing fixed degrees of freedom in all restrained directions for the
selected geometry are visualized.

5. Activate the degrees of freedom which are to be fixed in the subsequent analysis.

You can fix up to six degrees of freedom per node:
1.
2.
3.
4.
5.
6.

Translation 1 = Translation in x
Translation 2 = Translation in y
Translation 3 = Translation in z
Rotation 1 = Rotation in x
Rotation 2 = Rotation in y
Rotation 3 = Rotation in z
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If you activate the Restrain Rotation options, make sure the selected
elements can actually be restrained at given rotations.
6. Click OK to create the Advanced Restraint.

A Restraint object appears in the specification tree under the active Restraints
objects set.

●

●

●

●

You can either select the support and then set the Advanced Restraint specifications, or
set the Advanced Restraint specifications and then select the support.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Restraints objects set by clicking it in the features tree before creating an
Advanced Restraint object.
Restraints are required for Stress Analysis computations. They are optional for Modal
Analysis computations (if not created, the program will compute vibration modes for the
free, unrestrained part).
Advanced Restraint objects can be edited by a double click on the corresponding object
or icon in the features tree.

Make sure the computation is finished before starting any of the following operations.
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Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on an Advanced Restraint object:

●

❍

Restraint visualization on mesh: the translation of your Advanced Restraint
object specifications into solver specifications can be visualized symbolically at the
impacted mesh nodes, provided the mesh has been previously generated via a
Compute action.
on a Restraints objects set:

●

❍

❍

Generate Image: generates an image of the computed Restraint objects (along
with translating all user-defined Restraints specs into explicit solver commands on
mesh entities), by generating symbols for the nodal restraints imposed by the
Restraints objects set. The image can be edited to include part or all of the options
available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Restraints objects set Computation.
For more details, please refer to Creating Clamps.
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Creating Iso-static Restraints
This task shows how to create an Iso-Static Restraint on a body.
Iso-static Restraints are statically definite restraints allowing you to simply support a
body.
(this is an example of a part iso-statically restrained)

means that there is no translation degree of freedom left in
that direction.
Iso-static Restraint objects belong to Restraint objects sets.
The program automatically chooses three points and restrains some of their degrees of
freedom according to the 3-2-1 rule. The resulting boundary condition prevents the body
from rigid-body translations and rotations, without over-constraining it.
Make sure you fixed all the global degrees of freedom of your assembly, otherwise a
global singularity will be detected at the time of the Static Computation (such a model is
unsolvable). To allow you to easily correct the model (Static Analysis Cases only), the
singular displacement of the assembly will be simulated and visualized after computation.

Open the sample00.CATAnalysis document from the samples directory for this task: a
Finite Element Model containing a Static or Frequency Analysis Case.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading,
Outlines and Materials options are active in the Custom View Modes dialog box.

Generative Structural Analysis

Version 5 Release 14

1. Click the Isostatic Restraint icon

Page 462

.

The Isostatic Restraint dialog box appears.

2. You can change the identifier of the Iso-static Restraint by editing the Name field.
3. Click OK in the Iso-static Restraint dialog box.

An Isostatic.1 object appears in the specification tree under the active
Restraints objects set.

An Iso-static symbol appears on the geometry.
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You can double-click the Iso-static symbol on the geometry or the Isostatic.1
object in the specification tree, to display the Iso-static Restraint dialog box and
modify the Name, if needed.

●

●

●

●

You can either select the support and then set the Iso-static Restraint specifications,
or set the Iso-static Restraint specifications and then select the support.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Restraints objects set by clicking it in the features tree before creating an
Iso-static Restraint object.
Restraints are required for Stress Analysis computations. They are optional for Modal
Analysis computations (if not created, the program will compute vibration modes for
the free, unrestrained part).
Iso-static Restraint objects can be edited by a double click on the corresponding object
or icon in the features tree.

Make sure the computation is finished before starting any of the following operations.
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Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on an Iso-Static Restraint object:

●

❍

Iso-static Restraint Visualization on Mesh: the translation of your Iso-static
Restraint object specifications into solver specifications can be visualized
symbolically at the impacted mesh nodes, provided the mesh has been previously
generated via a Compute action.
on a Restraints objects set:

●

❍

❍

Generate Image: generates an image of the computed Restraint objects (along
with translating all user-defined Restraints specs into explicit solver commands on
mesh entities), by generating symbols for the nodal restraints imposed by the
Restraints objects set. The image can be edited to include part or all of the options
available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Restraints objects set Computation.
For more details, please refer to Creating Clamps.
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Loads
Create Pressures
Generate pressure loads over a surface.

Distributed Force Systems
Create a Distributed Force
Generate a distributed force system equivalent to a pure force at a point (given
force resultant and zero moment resultant).
Create a Distributed Moment
Generate a distributed force system equivalent to a pure couple (given moment
resultant and zero force resultant).
Create a Bearing Load
Simulate contact loads applied to cylindrical parts.

Import Forces
Import forces from a text file or an excel file, either on a surface or on a virtual
part.

Import Moments
Import moments from a text or an excel file, on a surface.

Force Densities
Create a Line Force Density
Generate a line force field of given uniform intensity on a part edge.
Create a Surface Force Density
Generate a surface traction field of given uniform intensity on a part face.
Create a Body Force
Generate a volume body force field of given uniform intensity on a part.
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Create a Force Density
Generate the equivalent of the existing line and surface force densities and body
force by giving as input only a force in Newton (N).

Mass Body Forces
Create an Acceleration
Generate a uniform acceleration field over a part.
Create Rotations
Generate a linearly varying acceleration field over a part.
Create Enforced Displacements
Assign non-zero displacement values to restrained geometric selections.

Temperature
Create Temperature Field
Load a body with a given temperature.

Import Temperature Field from Thermal Solution
Load a body with temperature imported from an existing thermal solution.
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Creating Pressures
This task shows how to create a Pressure applied to surface geometry.
Pressures are intensive loads representing uniform scalar pressure fields applied to surface geometries, and
characterized by the fact that the force direction is everywhere normal to the surface.
Pressure objects belong to Loads sets.
Units are pressure units (typically N/m2 in SI).
Pressures can be applied to the following types of supports:
Geometrical Feature Mechanical Feature

Analysis Feature

Free Groups Geometrical Groups Proximity Groups Others

Face

Open the sample00.CATAnalysis document from the samples directory for this task: Finite Element Model
containing a Static Analysis Case and computed corresponding Static Solution.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines and Materials options
are active in the Custom View Modes dialog box.

1. Click the Pressure icon

.

The Pressure dialog box appears.
2. You can change the identifier of the Pressure by editing the Name field.
3. Set the value of the scalar pressure. A positive value describes a pressure whose resultant is directed
towards the material side of the selected surface.
4. Activate the Data Mapping option.

The data mapping functionality is only available with the ELFINI Structural Analysis (EST)
product.
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For more details about Data Mapping functionality and data mapping files, please refer to Data Mapping
of the Frequently Asked Questions section.
5. Click the Browse button in the Pressure dialog box and load the desired external file. Make sure the file
type is actually *.txt.

The File Browser dialog box lets you select the desired file.
In this particular example, select the MappingFileExample.txt file in the samples directory.
When you click Open, the Pressure dialog box is updated.

The Show button now lets you visualize the imported file inside the session. If you then modify the pointed
file, the values are synchronized and the load feature invalidated.
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6. Select the geometry support (a face) on which you want to apply the Pressure. Any selectable geometry is
highlighted when you pass the cursor over it.

You can select several supports in sequence, to apply the Pressure to all supports simultaneously.
Several arrows symbolizing the pressure are visualized.

7. Click OK in the Pressure dialog box.

A Pressure object appears in the specification tree under the active Loads objects set.
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You can either select the surface and then set the pressure value, or set the pressure value and then select the
surface.
If you select other surfaces, you can create as many Pressure Loads as desired with the same dialog box. A
series of Pressures can therefore be created quickly.
Loads are required for Stress Analysis computations.
If several Analysis Cases have been defined in the Finite Element Model, you must activate a Loads objects set
in the features tree before creating a Pressure object (only available if you have ELFINI Structural Analysis
(EST) product installed).
Pressure objects can be edited by a double-click on the corresponding object in the specification tree.

Make sure the computation is finished before starting any of the following operations.
Products Available in Analysis Workbench
The ELFINI Structural Analysis (EST) product offers the following additional feature with a right-click (key 3):
on a Pressure object:

●

❍

Pressure visualization on mesh: the translation of your Pressure object specifications into solver
specifications can be visualized symbolically at the impacted mesh elements, provided the mesh has been
previously generated via a Compute action.
Right-click on a Pressure object and select the Pressure visualization on mesh option.
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on a Loads set:

●

❍

Generate Image: generates an image of the computed Load objects (along with translating all userdefined Loads specs into explicit solver commands on mesh entities), by generating symbols for the
elementary loads imposed by the Loads objects set. The image can be edited to include part or all of the
options available.
Right-click on a Loads set in the specification tree and select the Generate Image contextual menu.
The Image Generation dialog box appears. You can select images by selecting them in the list.

The resulting images sequence is obtained by superposition.

❍

Report: the partial status and results of intermediate pre-processor computations are reported in HTML
format. It represents a subset of the global report capability and generates a partial report of the Loads set
Computation.
Right-click the Loads set in the specification tree and select the Report contextual menu.
The .html partial report file appears.

❍

Self balancing on Loads set: already named Inertia Relief.
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Double-click the Loads set. The Loads dialog box appears:

The Loads dialog box lets you choose whether you wish to apply self-balancing to the load. If activated, this
option automatically adds inertia forces in order to counter balance external loads. Thus the global loading
equals null.
This kind of loading is used when modeling free bodies submitted to constant external forces (for example:
a rocket during lift-off).
This option is usually combined with iso-static restraint. In this case, reaction forces are null, which
simulates a free body.
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Creating Distributed Forces
This task shows you how to create a Distributed Force applied to a virtual part or to a
geometry selection.
Distributed Forces are force systems statically equivalent to a given pure force
resultant at a given point, distributed on a virtual part or on a geometric selection.
Distributed Force objects belong to Loads objects sets.
The user specifies three components for the direction of the resultant force, along with a
magnitude information. Upon modification of any of these four values, the resultant force
vector components and magnitude are updated based on the last data entry. The resultant
force vector remains constant independently of the geometry selection.
The point of application of the force resultant is automatically defined as follows:
●

For extended geometries, this point is the centroid of the geometry.

●

For virtual parts, this point is the handler of the virtual part.

The given single-force system is processed by the program as follows:
●

In the case of extended geometries, it is transformed into an equivalent force system
distributed over the selected support.

●

In the case of virtual parts connected to deformable bodies, it is transmitted as a force
system collectively to the entire connected geometry.

Units are force units (typically N in SI).
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Distributed Forces can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Point/Vertex
Edge
Virtual

Face

Part
(homogeneous
selection)

Open the sample00.CATAnalysis document from the samples directory for this task: Finite
Element Model containing a Static Analysis Case and computed corresponding Static
Solution.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.

1. Click the Distributed Force icon

.

The Distributed Force dialog box appears.
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2. If needed, change the identifier of the Distributed Force by editing the Name field.
3. Set the Axis System Type.

The Axis System Type combo box allows you to choose between Global and User
Axis systems, for entering components of the resultant force vector.
❍

❍

Global: if you select the Global Axis system, the components of the resultant
force vector will be interpreted as relative to the fixed global rectangular
coordinate system.
User: if you select a User Axis system, the components of the resultant force
vector will be interpreted as relative to the specified rectangular coordinate
system.
To select a User Axis system, you must activate an existing Axis by clicking it in
the specification tree. Its name will then be automatically displayed in the
Current Axis field.
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You can define the resultant force vector direction by using the
compass.
You can modify the compass orientation either with the mouse or by
editing the compass.
By applying the compass to any part geometry, you can align the
compass directions with the implicit axis directions of that geometry:
drag the compass by handling the red square and drop it on the
appropriate surface. The normal direction to this surface defines the
new direction. Then, click on the Compass Direction button to take this
new direction into account. You can now invert the direction if desired,
editing the values of the three components.

4. Enter values for the X, Y, Z components of the resultant force vector.

For example, enter -50N as Z value.
The remaining three fields are automatically computed and displayed.
The visualized symbols orientation will also reflect the modification, once the
support will be selected.
5. Select the support (a virtual part or a geometry) on which the resultant force vector
is applied at the pre-defined point.

Any selectable geometry is highlighted when you pass the cursor over it.

You can select several supports in sequence, to apply the Distributed Force to all
supports simultaneously.
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A symbol representing the resultant force equivalent to the Distributed Force is
displayed at the application point of the support to visualize the input force system.
The Distributed Force dialog box now appears as shown here:

6. Optionally, select a point as Handler.
7. Click OK in the Distributed Force dialog box.
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A Distributed Force object appears in the specification tree under the active
Loads objects set.

●

●

Make sure the computation is finished before starting any of the following operations.
Be aware that the Distributed Force, as the Distributed Moment, applies directly to the
nodes of the selected entity, whereas a Surface Density Force, or a Pressure, applies to
the element faces of the selected entity. The latter type of forces is far more accurate
and should be used whenever equivalent to the Distributed Force.

As an example, consider a coarsely meshed cylinder whose top surface has been
submitted to a Distributed Force and whose bottom surface is clamped. As the nodes on
the edges have less neighbors that inner nodes, they are pulled a lot further than the
inner nodes, thus leading to an erroneous result near the edges. Mesh refinement is
needed to get proper results. On the contrary, the Surface Density Force leads to a
smoother and more accurate displacement.

Open DistribForce.CATAnalysis in this particular case.
Applying a Distributed Force results as shown here:
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You can either select the support and then set the Distributed Force specifications, or
set the Distributed Force specifications and then select the support.
If you select several geometric supports, you can create as many Distributed Forces as
desired with the same dialog box. A series of Distributed Forces can therefore be
created quickly. The point of application is automatically assumed to be the centroid of
the system of individual supports centroids.
Loads are required for Stress Analysis computations.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Loads objects set in the features tree before creating a Distributed Force
object.
Distributed Force objects can be edited by a double click on the corresponding object or
icon in the features tree.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Body Force object:

●

❍

Distributed Force Visualization on Mesh: the translation of your Distributed
Force object specifications into solver specifications can be visualized symbolically at
the impacted mesh nodes, provided the mesh has been previously generated via a
Compute action.
on a Loads objects set:

●

❍

❍

❍

Generate Image: generates an image of the computed Load objects (along with
translating all user-defined Loads specs into explicit solver commands on mesh
entities), by generating symbols for the elementary loads imposed by the Loads
objects set. The image can be edited to include part or all of the options available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Loads objects set Computation.
See Creating Pressures for more details.
Double-clicking on the Loads set, you will display the Loads dialog box that lets
you choose whether you wish to apply self-balancing to the load. Example of use: if
this option is used with iso-static specifications, it will allow you to simulate freebody loading. If you make the option active, the center of inertia results null.
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Creating Moments
This task shows you how to create a Moment applied to a virtual part or to a geometry
selection.
Moments are force systems statically equivalent to a given pure couple (single moment
resultant), distributed on a virtual part or on a geometric selection.
Moment objects belong to Loads objects sets.
The user specifies three components for the direction of the resultant moment, along with
a magnitude information. Upon modification of any of these four values, the resultant
moment vector components and magnitude are updated based on the last data entry. The
resultant moment vector remains constant independently of the geometry selection.
The given pure couple system is processed by the program as follows:
●

In the case of extended geometries, it is transformed into an equivalent force system
distributed over the selected support.

●

In the case of virtual parts connected to deformable bodies, it is transmitted as a force
system collectively to the entire connected geometry.

The point of application of the couple is arbitrary.
Units are moment units (typically Nm in SI).

Moments can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others
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Point/Vertex
Edge
Virtual

Face

Part
(homogeneous
selection)

Open the sample00.CATAnalysis document from the samples directory for this task: Finite
Element Model containing a Static Analysis Case and computed corresponding Static
Solution.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading,
Outlines and Materials options are active in the Custom View Modes dialog box.

1. Click the Moment icon

.

The Moment dialog box appears.
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2. You can change the identifier of the Moment by editing the Name field.
3. Set the Axis system.

The Axis System Type combo box allows you to choose between Global and
User Axis systems, for entering components of the resultant moment vector.
❍

❍

Global: if you select the Global Axis system, the components of the resultant
moment vector will be interpreted as relative to the fixed global rectangular
coordinate system.
User: if you select a User-defined Axis system, the components of the
resultant moment vector will be interpreted as relative to the specified
rectangular coordinate system.
To select a User Axis System, you must activate an existing Axis by clicking
it in the specification tree. Its name will then be automatically displayed in
the Current Axis field.
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You can define the resultant moment vector direction by using the
compass.
You can modify the compass orientation either with the mouse or by
editing the compass.
By applying the compass to any part geometry, you can align the
compass directions with the implicit axis directions of that geometry:
drag the compass by handling the red square and drop it on the
appropriate surface. The normal direction to this surface defines the
new direction. Then, click on the Compass Direction button to take
this new direction into account. You can now invert the direction if
desired, editing the values of the three components.

4. Select the support (a virtual part or a geometry) on which the resultant moment
vector is applied.

Any selectable geometry is highlighted when you pass the cursor over it.
You can select several supports in sequence, to apply the Moment to all supports
simultaneously.
A symbol representing the resultant moment equivalent to the Moment is
displayed at the application point of the support to visualize the input force
system.

5. Enter values for the X, Y, Z components of the resultant moment vector: the
corresponding Norm value is automatically computed and displayed.

The visualized symbols orientation is also updated to reflect the modification.
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6. Click OK in the Moment dialog box.

A Moment object appears in the specification tree under the active Loads
objects set.

●

●

●

●

●

You can either select the support and then set the Moment specifications, or set the
Moment specifications and then select the support.
If you select several geometric supports, you can create as many Moment loads as
desired with the same dialog box. A series of Moments can therefore be created
quickly.
Loads are required for Stress Analysis computations.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Loads objects set in the specification tree before creating a Moment object
(only available if you have ELFINI Structural Analysis product installed).
Moment objects can be edited by a double click on the corresponding object or icon in
the specification tree.

Make sure the computation is finished before starting any of the following operations.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Moment object:

●

❍

Moment Visualization on Mesh: the translation of your Moment object
specifications into solver specifications can be visualized symbolically at the
impacted mesh nodes, provided the mesh has been previously generated via a
Compute action.
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on a Loads objects set:

●

❍

❍

❍

Generate Image: generates an image of the computed Load objects (along with
translating all user-defined Loads specs into explicit solver commands on mesh
entities), by generating symbols for the elementary loads imposed by the Loads
objects set. The image can be edited to include part or all of the options available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Loads objects set Computation.
See Creating Pressures for more details.
Double-clicking on the Loads set, you will display the Loads dialog box that lets
you choose whether you wish to apply self-balancing to the load. Example of use:
if this option is used with iso-static specifications, it will allow you to simulate freebody loading. If you make the option active, the center of inertia results null.
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Creating a Bearing Load
This task shows you how to create a Bearing Load applied to a selected geometry.

Only available with the ELFINI Structural Analysis (EST) product.
Bearing Loads are simulated contact loads applied to cylindrical parts.
Creating Bearing Loads is done in only one step and is much quicker than creating first a virtual part and then a load.
Computation is also much less time-consuming, because Bearing Loads do not generate either costly contact beam
elements or virtual mesh parts.
The user selects a cylindrical boundary of the part. Any type of revolution surface can be selected. In the Bearing Load
definition panel, you have to specify the resulting contact force (direction and norm). The components of the force can
be given either in the global or in a user axis system (similar to the Distributed Force).
Bearing Loads are flexible: You can vary the angle sector on which the force is applied as well as the type of the
profile distribution.
Display of the applied sinusoidal traction:

Bearing Loads objects belong to Loads objects sets.
Bearing Loads can be applied to the following types of supports:
Geometrical Feature Mechanical Feature

Analysis Feature

Free Groups Geometrical Groups Proximity Groups Others

Cylindrical Surface
Cone
Revolution Surface
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Open the sample02.CATAnalysis document from the samples directory for this task.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines and Materials options are
active in the Custom View Modes dialog box.

1. Click the Bearing Load icon

.

The Bearing Load dialog box appears.

❍

❍

Name: lets you modify the name of the load.
Supports: lets you select cylindrical surfaces on which you want to apply a bearing load.
Multi-selection is available.
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Multi-selection must be used on different cylindrical surfaces and not on different elements
belonging to a same cylindrical surface.
Indeed, if you apply a 10N norm force vector on a multi-selection of three surfaces belonging to
the same geometry, the norm of the global resultant force will be equal to 30N (and not 10N).
To apply a 10N norm force vector on three different cylindrical surfaces, the following methods
are equivalent:
■

■

❍

❍

create one bearing load (multi-select three cylindrical surfaces) with a 10N norm force vector

Axis System Type: allows you to choose between Global and User Axis systems, for entering
components of the resultant force vector.
■
Global: if you select the Global Axis system, the components of the resultant force vector will be
interpreted as relative to the fixed global rectangular coordinate system.
■

❍

create three bearing loads (select one cylindrical surface for each bearing load) with a 10N
norm force vector

User: if you select a User Axis system, the components of the resultant force vector will be
interpreted as relative to the specified rectangular coordinate system.
To select a User Axis system, you must activate an existing Axis by clicking it in the specification
tree. Its name will then be automatically displayed in the Current Axis field.
Only the Force vector component which is perpendicular to the revolution axis is taken into account
because this component is a contact component.

Angle: corresponds to the angle over which the forces can be distributed. When entering an angle value,
a highly precise preview automatically appears on the model.
180 is the default value, < 180 is useful to take into account some positive clearance, > 180 is useful to
take into account some negative clearance.
Orientation: provides you with two ways for distributing forces:
■
Radial: all the force vectors at the mesh nodes are normal to the surface in all points. This is
generally used for force contact.
■

Radial:

Parallel: all the force vectors at the mesh nodes are parallel to the resulting force vectors. This can
useful in the case of specific loads.

Parallel:
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Profile: can be Sinusoidal, Parabolic or Law type, defining how you will vary the Force intensity
according to the angle: Sinusoidal, Parabolic or Law.
■
Law: or F=f(θ) requires that a formal law (Formal parameters) was defined in Knowledge Advisor
(Fog). On the condition you previously activated the Relations option in Tools -> Options -> Part
Design (Display tab) command, you can see the Law feature in the specification tree. No sooner do
you select this feature in the specification tree, that this formal parameter appears in the Law field
(Bearing Load dialog box).

Distribution: lets you specify the force distribution.
■

Outward:

B pushes on A
In this particular example, the result is the following:

■

Inward:

A pushes on B
In this particular example, the result is the following:
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2. You can change the identifier of the Bearing Load by editing the Name field.
3. Select Global as Axis System Type.
4. Enter values for the X, Y, Z components of the resultant force vector.
For example, enter -500N as X value.

The corresponding Norm value is automatically computed and displayed.
❍

❍

You can define the resultant force vector direction by using the compass.
By applying the compass to any part geometry, you can align the compass directions with the
implicit axis directions of that geometry: drag the compass by handling the red square and drop it
on the appropriate surface. The normal direction to this surface defines the new direction. Then,
click on the Compass Direction button to take this new direction into account. You can now invert
the direction if desired, editing the values of the three components.

5. Enter a value for the Angle parameter. For example, enter 90deg as Angle value.
6. Select the support (a geometry) on which the resultant Bearing Load vectors are applied.

Any selectable geometry is highlighted when you pass the cursor over it.
Selected support:

Resultant load:
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7. Select the following options:
❍

Radial as Orientation option,

❍

Parabolic as Profile Type option,

❍

Outward as Distribution option.

8. Click OK in the Bearing Load dialog box.

A Bearing Load object appears in the specification tree under the active Loads objects set.

●

●

●

●

You can either select the support and then set the Bearing Load specifications, or set the Bearing Load
specifications and then select the support.
Loads are required for Stress Analysis computations.
If several Analysis Cases have been defined in the Finite Element Model, you must activate a Loads objects set in
the specification tree before creating a Bearing Load object.
Bearing Load objects can be edited by a double click on the corresponding object or icon in the specification tree.

Make sure the computation is finished before starting any of the following operations.
Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a right mouse click (key 3):
on a Bearing Load object:

●

❍

Bearing Load Visualization on Mesh: the translation of the Bearing Load specifications into solver
specifications can be visualized symbolically at the impacted mesh nodes, provided the mesh has been
previously generated via a Compute action.
on a Loads objects set:

●

❍

❍

❍

Generate Image: generates an image of the computed Load objects (along with translating all user-defined
Loads specs into explicit solver commands on mesh entities), by generating symbols for the elementary loads
imposed by the Loads objects set. The image can be edited to include part or all of the options available.
Report: the partial status and results of intermediate pre-processor computations are reported in HTML
format. It represents a subset of the global Report capability and generates a partial report of the Loads
objects set Computation.
See Creating Pressures for more details.
Self-balancing: you can double-click the Loads set to automatically add inertia forces in order to counter
balance external loads.
For details, please click here.
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Importing Forces
This task shows you how to import forces from a .xls file:
●

on a surface

●

on a virtual part

Importing forces from a text file means importing and mapping force data from a text or excel file. This force
data can be either force extrapolated on the nodes of the closest element or force directly applied on the
associated node. This allows transferring light data.

Only available with the ELFINI Structural Analysis (EST) product.
Imported forces can be applied to the following types of supports:
Geometrical Feature Mechanical Feature

Analysis Feature

Free Groups Geometrical Groups Proximity Groups Others

Point/Vertex
Face

On a Surface
In this particular case, open the sample53.CATAnalysis document from the samples directory.

Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines and Materials
options are active in the Custom View Modes dialog box.

Version 5 Release 14

Generative Structural Analysis

1. Click the Imported Force icon
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.

The Imported Forces dialog box appears.

❍

Name

❍

Supports

❍

Axis System: The Axis System Type combo box allows you to choose between Global and User
Axis systems, for entering components of the resultant force vector.
■
Global: if you select the Global Axis system, the components of the force vector (in a file) will be
interpreted as relative to the fixed global rectangular coordinate system.
■

User: if you select a User Axis system, the components of the force vector (in a file) will be
interpreted as relative to the specified rectangular coordinate system.
To select a User Axis system, you must activate an existing Axis by clicking it in the specification
tree. Its name will then be automatically displayed in the Current Axis field.
If you select the User Type, the following options are available:

❍

File Selection: use the Browse button.

❍

Display Bounding Box, if needed, on the model.

2. Select the surface as the Support on which you want to import the Force.
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3. Click the Browse button in the Imported Forces dialog box to select the file to be imported.
The File Selection dialog box appears to let you choose the file to be imported. In this particular case,
select Data.xls file.
4. Once the File name has been selected, click Open in the File Selection dialog box.
The Imported Forces dialog box is updated.

5. If needed, click the Show button to display the Imported Table dialog box corresponding to the selected
file data.
In this particular case, the imported table appears as shown here:
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6. Click Close in the Imported Table box.
7. In this particular case, we also decided to activate the Display bounding box (as shown in the dialog
box above).
The model appears as shown here:

8. Click OK in the Imported Forces dialog box.
The resulting model appears as shown here:

The Imported Forces.1 feature is displayed in the specification tree.
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For each point in the data file, the corresponding force is distributed on the three closest nodes of the selected
support.
If the point coordinates correspond to a node, the force is directly applied on it.

On a Virtual Part
In this particular case, open the sample54.CATAnalysis document from the samples directory.

Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines and Materials
options are active in the Custom View Modes dialog box.

1. Click the Imported Force icon
2. Select a vertex as Support.

.
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The Imported Forces dialog box now appears as shown here:

3. Click the Browse button to select the file to be imported.
The File Selection dialog box appears to let you choose the file to be imported. In this particular case,
select Data.xls file.
4. Once the File name has been selected, click Open in the File Selection dialog box.
The Imported dialog box is updated.
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5. If needed, click the Show button to display the Imported Table box corresponding to the selected file
data.
In this particular case, the imported table appears as shown here:

6. Click Close in the Imported Table box.
7. Click OK in the Imported Forces dialog box.
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The model appears as shown here:

Note that for each point in the data file, the corresponding force is directly applied on the closest point handler of
a virtual part.
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Importing Moments
This task shows you how to import moments from a text file on a surface.
Importing moment from a text file means importing and mapping moment data from a text
or excel file. Moments can be imported on surfaces, exclusively.

Only available with the ELFINI Structural Analysis (EST) product.

Imported moments can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Point/Vertex
Face

Open the sample55.CATAnalysis document from the samples directory for this task.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading
and Outlines options are active in the Custom View Modes dialog box.

1. Click the Imported Moment icon

.

Others
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The Imported Moments dialog box appears.

❍

Name

❍

Supports

❍

Axis System: The Axis System Type combo box allows you to choose
between Global and User Axis systems, for entering components of the
resultant moment vector.
■
Global: if you select the Global Axis system, the components of the
moment vector (in a file) will be interpreted as relative to the fixed global
rectangular coordinate system.
■

User: if you select a User Axis system, the components of the moment
vector (in a file) will be interpreted as relative to the specified rectangular
coordinate system.
To select a User Axis system, you must activate an existing Axis by clicking
it in the specification tree. Its name will then be automatically displayed in
the Current Axis field.
If you select the User Type, the following options are available:
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❍

File Selection: use the Browse button.

❍

Display Bounding Box, if needed, on the model.
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2. Select a surface as Support.

3. Click the Browse button in the Imported Moment dialog box to select the file to be
imported.

The File Selection dialog box appears to let you choose the file to be imported. In
this particular case, select DataFile.xls file from the samples directory.
4. Once the File name has been selected, click Open in the File Selection dialog box.

The Imported Moments dialog box is updated.
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5. If needed, click the Show button to display the Imported Table box corresponding
to the selected file data.

In this particular case, the imported table appears as shown here:

6. Click Close in the Imported Table box.
7. In this particular case, we also decided to activate the Display bounding box (as
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shown in the dialog box above).

The model appears as shown here: the face to be used as support for the imported
moment is bounded.

8. Click OK in the Imported Moments dialog box.

The resulting model appears as shown here:

The Imported Moments.1 feature is displayed in the specification tree.
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For each point in the data file, the corresponding moment is distributed on the three closest
nodes of the selected support. If the point coordinates correspond to a node, the moment is
directly applied on it.
The moments are converted into equivalent forces.
Imported moments works differently depending of the kind of support selected :
●

●

If selected supports are surfaces: imported moments works the same way imported
moments do, except that moments are converted to equivalent moments distributed on
the three closest nodes. Be aware that if the data file point coordinates corresponds to a
node, the moment won't be applied on the node but converted to moments on the
closest nodes.
If selected supports are points or vertices: moments will be directly applied on the
closest node.
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Creating Line Force Densities
This task shows you how to create a Line Force Density applied to a surface geometry.
Line Force Densities are intensive loads representing line traction fields of uniform
magnitude applied to curve geometries.
Line Force Density objects belong to Loads objects sets.
The user specifies three components for the direction of the field, along with a magnitude
information. Upon modification of any of these four values, the line traction vector
components and magnitude are updated based on the last data entry. The line traction
vector remains constant independently of the geometry selection.
Units are line traction units (typically N/m in SI).

Line Force Density can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Edge

Open the sample00.CATAnalysis document from the samples directory for this task: Finite
Element Model containing a Static Analysis Case and computed corresponding Static
Solution.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.
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The Line Force Density dialog box appears.
2. You can change the identifier of the Line Force Density by editing the Name field.
3. Set the Axis System.

The Axis System Type combo box allows you to choose between Global, Implicit
and User Axis systems for entering components of the line traction field vector:
❍

❍

❍

Global: if you select the Global Axis system, the components of the surface
traction field will be interpreted as relative to the fixed global coordinate
system.
Implicit: if you select the Implicit Axis system, the components of the line
traction field will be interpreted as relative to a local variable coordinate system
whose type depends on the support geometry.
User: if you select a User Axis system, the components of the line traction
field will be relative to the specified Axis system. Their interpretation will further

Version 5 Release 14

Generative Structural Analysis

Page 509

depend on your Axis Type choice.
To select a User Axis system, you must activate an existing Axis by clicking it
in the specification tree. Its name will then be automatically displayed in the
Current Axis field.
If you choose the User axis system, the Local orientation combo box further
allows you to choose between Cartesian, Cylindrical and Spherical local axis
orientations.
■

■

■

Cartesian: the components of the surface traction field are interpreted as
relative to a fixed rectangular coordinate system aligned with the cartesian
coordinate directions of the User-defined Axis.
Cylindrical: the components of the surface traction field are interpreted as
relative to a local variable rectangular coordinate system aligned with the
cylindrical coordinate directions of each point relative to the User-defined
Axis.
Spherical: the components of the surface traction field are interpreted as
relative to a a local variable rectangular coordinate system aligned with the
spherical coordinate directions of each point relative to the User-defined
Axis.

❍

❍

❍

❍

You can define the line traction field direction by using the compass.
You can modify the compass orientation either with the mouse or by
editing the compass.
By applying the compass to any part geometry, you can align the
compass directions with the implicit axis directions of that geometry:
drag the compass by handling the red square and drop it on the
appropriate surface. The normal direction to this surface defines the
new direction. Then, click on the Compass Direction button to take this
new direction into account. You can now invert the direction if desired,
editing the values of the three components.
Even if a User axis system has been referenced, the coordinates of the
data mapping stay in the Global axis system.
Only the User axis system directions are taken into account with data
mapping.

4. Select the geometry support (an edge) on which the line traction is to be applied.
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Any selectable geometry is highlighted when you pass the cursor over it.

You can select several supports in sequence, to apply the Line Force Density to all
supports simultaneously.
Symbols representing the Line Force Density are displayed on the support geometry
to visualize the traction field.
5. If needed, enter a new value for any one of the four fields: Norm, X, Y and Z in the
Line Force Density dialog box.

For example, enter below values for the X, Y, Z components of the line traction
field.
The corresponding Norm value is automatically computed and displayed.
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❍

The remaining three fields are automatically computed and displayed.

❍

The visualized symbols orientation is also updated to reflect the modification.

You can re-use data (Data Mapping) that are external from this version
(experimental data or data coming from in-house codes or procedures). For
more details, please refer to Data Mapping (only available if you installed
the ELFINI Structural Analysis product).
6. Click OK in the Line Force Density dialog box.
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A Line Force Density object appears in the features tree under the active Loads
objects set.

●

●

●

●

●

You can either select the edge and then set the Line Force Density specifications, or set
the Line Force Density specifications and then select the edge.
If you select other surfaces, you can create as many Line Force Density loads as desired
with the same dialog box. A series of Line Force Densities can therefore be created
quickly.
Loads are required for Stress Analysis computations.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Loads objects set in the specification tree before creating s Line Force Density
object (only available if you installed the ELFINI Structural Analysis product).
Line Force Density objects can be edited by a double click on the corresponding object
or icon in the specification tree.

Make sure the computation is finished before starting any of the below operations.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Line Force Density object:

●

❍

Line load visualization on mesh: the translation of your Line Force Density
object specifications into solver specifications can be visualized symbolically at the
impacted mesh elements, provided the mesh has been previously generated via a
Compute action.
on a Loads objects set:

●

❍

Generate Image: generates an image of the computed Load objects (along with
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translating all user-defined Loads specs into explicit solver commands on mesh
entities), by generating symbols for the elementary loads imposed by the Loads
objects set. The image can be edited to include part or all of the options available.
❍

❍

Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Loads objects set Computation.
See Creating Pressures for more details.
Double-clicking on the Loads set, you will display the Loads dialog box that lets
you choose whether you wish to apply self-balancing to the load. Example of use: if
this option is used with iso-static specifications, it will allow you to simulate freebody loading. If you make the option active, the center of inertia results null.
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Creating Surface Force Densities
This task shows you how to create a Surface Force Density applied to a surface geometry.
Surface Force Densities are intensive loads representing surface traction fields of uniform
magnitude applied to surface geometries.
Surface Force Density objects belong to Loads objects sets.
The user specifies three components for the direction of the field, along with a magnitude
information. Upon modification of any of these four values, the surface traction vector
components and magnitude are updated based on the last data entry. The surface traction
vector remains constant independently of the geometry selection.
Units are surface traction units (typically N/m2 in SI).

Surface Force Density can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Face

Open the sample00.CATAnalysis document from the samples directory for this task: Finite
Element Model containing a Static Analysis Case and computed corresponding Static
Solution.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.
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The Surface Force Density dialog box appears.

2. You can change the identifier of the Surface Force Density by editing the Name
field.
3. Set the Axis system.
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The Axis System Type combo box allows you to choose between Global, Implicit
and User Axis systems for entering components of the traction field vector:
❍

❍

❍

Global: if you select the Global Axis system, the components of the surface
traction field will be interpreted as relative to the fixed global coordinate
system.
Implicit: if you select the Implicit Axis system, the components of the surface
traction field will be interpreted as relative to a local variable coordinate system
whose type depends on the support geometry.
User: if you select a User Axis system, the components of the surface traction
field will be relative to the specified Axis system. Their interpretation will further
depend on your Axis Type choice.
To select a User Axis system, you must activate an existing Axis by clicking it
in the specification tree. Its name will then be automatically displayed in the
Current Axis field.
If you choose the User axis system, the Local orientation combo box further
allows you to choose between Cartesian, Cylindrical and Spherical local axis
orientations.
■

■

■

Cartesian: the components of the surface traction field are interpreted as
relative to a fixed rectangular coordinate system aligned with the cartesian
coordinate directions of the User-defined Axis.
Cylindrical: the components of the surface traction field are interpreted as
relative to a local variable rectangular coordinate system aligned with the
cylindrical coordinate directions of each point relative to the User-defined
Axis.
Spherical: the components of the surface traction field are interpreted as
relative to a a local variable rectangular coordinate system aligned with the
spherical coordinate directions of each point relative to the User-defined
Axis.
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You can define the surface traction direction by using the compass.
You can modify the compass orientation either with the mouse or by
editing the compass.
By applying the compass to any part geometry, you can align the
compass directions with the implicit axis directions of that geometry:
drag the compass by handling the red square and drop it on the
appropriate surface. The normal direction to this surface defines the
new direction. Then, click on the Compass Direction button to take this
new direction into account. You can now invert the direction if desired,
editing the values of the three components.
Even if a User axis system has been referenced, the coordinates of the
data mapping stay in the Global axis system.
Only the User axis system directions are taken into account with data
mapping.

4. Select the geometry support (a face) on which the surface traction is to be applied.

Any selectable geometry is highlighted when you pass the cursor over it.
You can select several supports in sequence, to apply the Surface Force Density to
all supports simultaneously.
Symbols representing the Surface Force Density are displayed on the support
geometry to visualize the traction field.

5. Enter a new value for any one of the four fields.
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For example, enter values for the X, Y, Z components of the surface traction field
as shown below
❍

The corresponding Norm value is automatically computed and displayed.

❍

The remaining three fields are automatically computed and displayed.

❍

The visualized symbols orientation is also updated to reflect the modification.

You can re-use data (Data Mapping) that are external from this version
(experimental data or data coming from in-house codes or procedures). For
more details, please refer to Data Mapping (only available if you installed
the ELFINI Structural Analysis product).
6. Click OK in the Surface Force Density dialog box.
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A Surface Force Density object appears in the features tree under the active
Loads objects set.

●

●

●

●

●

You can either select the surface and then set the Surface Force Density specifications,
or set the Surface Force Density specifications and then select the surface.
If you select other surfaces, you can create as many Surface Force Density loads as
desired with the same dialog box. A series of Surface Force Densities can therefore be
created quickly.
Loads are required for Stress Analysis computations.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Loads objects set in the features tree before creating a Surface Force Density
object (only available if you installed the ELFINI Structural Analysis product).
Surface Force Density objects can be edited by a double click on the corresponding
object or icon in the specification tree.

Make sure the computation is finished before starting any of the below operations.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Surface Force Density object:

●

❍

Surface load visualization on mesh: the translation of your Surface Force Density
object specifications into solver specifications can be visualized symbolically at the
impacted mesh elements, provided the mesh has been previously generated via a
Compute action.
on a Loads objects set:

●

❍

Generate Image: generates an image of the computed Load objects (along with
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translating all user-defined Loads specs into explicit solver commands on mesh
entities), by generating symbols for the elementary loads imposed by the Loads
objects set. The image can be edited to include part or all of the options available.
❍

❍

Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Loads objects set Computation.
See Creating Pressures for more details.
Self-balancing:xxx.
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Creating Volume Force Densities
This task shows you how to create a volume force density (named Body Force) applied to a
part.
Body Forces are intensive loads representing volume body force fields of uniform magnitude
applied to parts.
Body Force objects belong to the Loads objects set.
You need to specify three components for the direction of the field, along with a magnitude
information. Upon modification of any of these four values, the volume body force vector
components and magnitude are updated based on the last data entry. The volume body
force vector remains constant independently of the geometry selection.
Units are volume body force units (typically N/m3 in SI).

Body Forces can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Body 3D

Others

Mesh Part

Open the sample00.CATAnalysis document from the samples directory for this task: Finite
Element Model containing a Static Analysis Case and computed corresponding Static
Solution.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.
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The Body Force dialog box appears.

2. You can change the identifier of the Body Force by editing the Name field.
3. Set the Axis System. In this example, select Global.
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The Axis System Type combo box allows you to choose between Global and User
Axis systems for entering components of the volume body force field.
❍

❍

Global: if you select the Global Axis system, the components of the volume
body force field will be interpreted as relative to the fixed global rectangular
coordinate system.
User: if you select a User-defined Axis system, the components of the volume
body force field will be interpreted as relative to the specified rectangular
coordinate system.
To select a User-defined Axis system, you must activate an existing Axis by
clicking it in the specification tree. Its name will then be automatically
displayed in the Current Axis field.
If you choose the User axis system, the Local orientation combo box further
allows you to choose between Cartesian, Cylindrical and Spherical local axis
orientations.
■

■

■

Cartesian: the components of the surface traction field are interpreted as
relative to a fixed rectangular coordinate system aligned with the Cartesian
coordinate directions of the User-defined Axis.
Cylindrical: the components of the surface traction field are interpreted as
relative to a local variable rectangular coordinate system aligned with the
cylindrical coordinate directions of each point relative to the User-defined
Axis.
Spherical: the components of the surface traction field are interpreted as
relative to a a local variable rectangular coordinate system aligned with the
spherical coordinate directions of each point relative to the User-defined
Axis.

❍

❍

❍

❍

You can define the volume body force direction by using the compass.
You can modify the compass orientation either with the mouse or by
editing the compass.
By applying the compass to any part geometry, you can align the
compass directions with the implicit axis directions of that geometry:
drag the compass by handling the red square and drop it on the
appropriate surface. The normal direction to this surface defines the
new direction. Then, click on the Compass Direction button to take this
new direction into account. You can now invert the direction if desired,
editing the values of the three components.
Even if a User axis system has been referenced, the coordinates of the
data mapping stay in the Global axis system.
Only the User axis system directions are taken into account with data
mapping.

4. Select the geometry support (a part) on which the volume body force is to be
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applied.

Any selectable geometry is highlighted when you pass the cursor over it.

You can select several supports in sequence, to apply the Body Force to all supports
simultaneously. Symbols representing the Body Force are displayed on the support
geometry to visualize the volume body force field.
5. If needed, enter a new value for any one of the four fields.

For example, enter values for the X, Y, Z components of the volume body force
field as shown below
❍

The corresponding Norm value is automatically computed and displayed.

❍

The remaining three fields are automatically computed and displayed.

❍

The visualized symbols orientation is also updated to reflect the modification.
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You can re-use data (Data Mapping) that are external from this version
(experimental data or data coming from in-house codes or procedures). For
more details, please refer to Data Mapping (only available if you installed
the ELFINI Structural Analysis product).
6. Click OK in the Body Force dialog box.
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A Body Force object appears in the specification tree under the active Loads
objects set.

●

●

●

You can either select the part and then set the Body Force specifications, or set the
Body Force specifications and then select the part.
If you select other parts, you can create as many Body Force loads as desired with the
same dialog box. A series of Body Force objects can therefore be created quickly.
Loads are required for Stress Analysis computations.
If several Analysis Cases have been defined in the Finite Element Model, you

●

must activate a Loads objects set in the features tree before creating a Body Force
object (only available if you installed the ELFINI Structural Analysis product).
●

Body Force objects can be edited by a double click on the corresponding object or icon
in the specification tree.

Make sure the computation is finished before starting any of the below operations.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Body Force object:

●

❍

Volume load visualization on mesh: the translation of your Body Force object
specifications into solver specifications can be visualized symbolically at the
impacted mesh elements, provided the mesh has been previously generated via a
Compute action.
on a Loads objects set:

●

❍

Generate Image: generates an image of the computed Load objects (along with
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translating all user-defined Loads specs into explicit solver commands on mesh
entities), by generating symbols for the elementary loads imposed by the Loads
objects set. The image can be edited to include part or all of the options available.
❍

❍

Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Loads objects set Computation.
See Creating Pressures for more details.
Self-balancing:xxx.
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Creating Force Density
This task shows you how to create the equivalent of the existing line force density, surface force
density and body force by giving only as input a force in Newton (N in SI) and not a force density
(N/m in SI for a line force density, N/m2 in SI for a surface force density and N/m3 for body
force).

Only available with the ELFINI Structural Analysis (EST) product.
Force Densities can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Point/Vertex
Face
Body
(homogeneous
selection)

Open the sample00.CATAnalysis document from the samples directory for this task: Finite Element
Model containing a Static Analysis Case and computed corresponding Static Solution.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines and
Materials options are active in the Custom View Modes dialog box.
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The Force Density Defined by Force Vector dialog box appears.

❍

❍

Name: gives you the name of the force. If needed, you can change it.
Support: lets you select the support.
■
Multi-selection is available and must be homogeneous.
■

❍

You can select edge, surface or bodies (2D or 3D).

Axis System:
■
Type:
■
Global: if you select the Global Axis system, the components of the force
density field will be interpreted as relative to the fixed global rectangular
coordinate system.
■

User: if you select a User-defined Axis system, the components of the force
density field will be interpreted as relative to the specified rectangular coordinate
system.
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To select a User-defined Axis system, you must activate an existing Axis by
clicking it in the specification tree.
Its name will then be automatically displayed in the Current Axis field.
The Local orientation is Cartesian: the components of the surface traction
field are interpreted as relative to a fixed rectangular coordinate system aligned
with the Cartesian coordinate directions of the User-defined Axis.
■

■

■

■

❍

You can define the force density direction by using the compass.
You can modify the compass orientation either with the mouse or by
editing the compass.
By applying the compass to any part geometry, you can align the
compass directions with the implicit axis directions of that geometry:
drag the compass by handling the red square and drop it on the
appropriate surface. The normal direction to this surface defines the
new direction. Then, click on the Compass Direction button to take
this new direction into account. You can now invert the direction if
desired, editing the values of the three components.

Display locally: lets you display the selected axis system.

Force Vector: lets specify the value of the force vector component.

2. Specify the Axis System.
In this particular example, select Global as axis system Type.
3. Select the desired geometry support.

In this particular example, select the two following surfaces.

Symbols representing the force are displayed on the selected support to visualize the force
density field.
4. Specify the desired Force Vector value.
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In this particular example, enter 3N as X value and 10N as Z value.
Note that:
❍

The corresponding Norm value is automatically computed and displayed.

❍

The visualized symbols orientation is also updated to reflect the modification.

5. Click OK in the Force Density Defined by Force Vector dialog box.
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A Force Density object is displayed in the specification tree under the Loads.1 set.
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Creating Accelerations
This task shows you how to create an Acceleration applied to a part.
Accelerations are intensive loads representing mass body force (acceleration) fields of
uniform magnitude applied to parts.
Acceleration objects belong to Loads objects sets.
You need to specify three components for the direction of the field, along with a magnitude
information. Upon modification of any of these four values, the mass body force vector
components and magnitude are updated based on the last data entry.
Units are mass body force (or acceleration) units (typically N/kg, or m/s2 in SI).

Accelerations can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Body 1D

Mesh Part

Body 2D

Virtual

Body 3D

Part

Open the sample00.CATAnalysis document from the samples directory for this task: Finite
Element Model containing a Static Analysis Case and computed corresponding Static
Solution.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.
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The Acceleration dialog box appears.

2. You can change the identifier of the Acceleration by editing the Name field.
3. Set the Axis System.

The Axis System Type combo box allows you to choose between Global and User
Axis systems for entering components of the acceleration field.
❍

❍

Global: if you select the Global Axis system, the components of the
acceleration field will be interpreted as relative to the fixed global rectangular
coordinate system.
User: if you select a User Axis system, the components of the acceleration
field will be interpreted as relative to the specified rectangular coordinate
system.
To select a User Axis system, you must activate an existing Axis by clicking it in
the specification tree. Its name will then be automatically displayed in the
Current Axis field.
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You can define the mass body force direction by using the compass.
You can modify the compass orientation either with the mouse or by
editing the compass.
By applying the compass to any part geometry, you can align the
compass directions with the implicit axis directions of that geometry:
drag the compass by handling the red square and drop it on the
appropriate surface. The normal direction to this surface defines the
new direction. Then, click on the Compass Direction button to take this
new direction into account. You can now invert the direction if desired,
editing the values of the three components.

4. Enter values for the X, Y, Z components of the mass body force field: the
corresponding Norm value is automatically computed and displayed.

5. Select the geometry support (a part) on which the mass body force is to be applied.
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Any selectable geometry is highlighted when you pass the cursor over it.
You can select several supports in sequence, to apply the Acceleration to all
supports simultaneously.
Symbols representing the Acceleration are displayed on the support geometry to
visualize the volume body force field.

The remaining three fields are automatically computed and displayed.
The visualized symbols orientation is also updated to reflect the modification.
6. Click OK in the Acceleration dialog box.
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An Acceleration object appears in the specification tree under the active Loads
objects set.

●

●

●

●

●

You can either select the part and then set the Acceleration specifications, or set the
Acceleration specifications and then select the part.
If you select other parts, you can create as many Acceleration loads as desired with the
same dialog box. A series of Accelerations can therefore be created quickly.
Loads are required for Stress Analysis computations.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Loads objects set in the specification tree before creating an Acceleration
object (only available if you installed the ELFINI Structural Analysis product).
Acceleration objects can be edited by a double click on the corresponding object or icon
in the specification tree.

Make sure the computation is finished before starting any of the below operations.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on an Acceleration object:

●

❍

Translational acceleration visualization on mesh: the translation of your
Acceleration object specifications into solver specifications can be visualized
symbolically at the impacted mesh elements, provided the mesh has been previously
generated via a Compute action.
on a Loads objects set:

●

❍

Generate Image: generates an image of the computed Load objects (along with
translating all user-defined Loads specs into explicit solver commands on mesh
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entities), by generating symbols for the elementary loads imposed by the Loads
objects set. The image can be edited to include part or all of the options available.
❍

❍

Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Loads objects set Computation.
See Creating Pressures for more details.
Self-balancing:xxx.
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Creating Rotation Forces
This task shows you how to create a Rotation Force applied to a part.
Rotation Forces are intensive loads representing mass body force (acceleration) fields
induced by rotational motion applied to parts. Rotation Force objects belong to Loads
objects sets.
The user specifies a rotation axis and values for the angular velocity and angular
acceleration magnitudes, and the program automatically evaluates the linearly varying
acceleration field distribution.
Units are angular velocity and angular acceleration units (typically rad/s and rad/s2 in SI).

Rotation Forces can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Body 1D

Mesh Part

Body 2D

Virtual

Body 3D

Part

Open the sample00.CATAnalysis document from the samples directory for this task: Finite
Element Model containing a Static Analysis Case and computed corresponding Static
Solution.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading, Outlines
and Materials options are active in the Custom View Modes dialog box.
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The Rotation Force dialog box appears.

2. You can change the identifier of the Rotation Force by editing the Name field.
3. Select the geometry support (Supports field): the part on which the variable
acceleration field is to be applied.

Any selectable geometry is highlighted when you pass the cursor over it.
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You can select several supports in sequence, to apply the Rotation Force to all
supports simultaneously.
4. Select an existing line or a construction axis to specify the Rotation Axis.

Any selectable geometry is highlighted when you pass the cursor over it.

To select a User-defined Axis system, you must activate an existing Axis by clicking
it in the features tree. Its name will then be automatically displayed in the Axis
Name field.
Symbols representing the Rotation Force are displayed on the support geometry to
visualize the acceleration field.
5. Enter a value for the magnitude of the Angular Velocity about the rotation axis.
For example, 8turn_mn.
6. Enter a value for the magnitude of the Angular Acceleration about the rotation
axis. For example, 70rad_s2.
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7. Click OK in the Rotation Force dialog box.

A Rotation Force object appears in the specification tree under the active Loads
objects set.

●

●

●

●

●

You can either select the part and then set the Rotation Force specifications, or set the
Rotation Force specifications and then select the part.
If you select other parts, you can create as many Rotation Force loads as desired with
the same dialog box. A series of Rotation Forces can therefore be created quickly.
Loads are required for Stress Analysis computations.
If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Loads objects set in the specification tree before creating a Rotation Force
object (only available if you installed the ELFINI Structural Analysis product).
Rotation Force objects can be edited by a double click on the corresponding object or
icon in the specification tree.
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Make sure the computation is finished before starting any of the below operations.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on a Rotation Force object:

●

❍

Rotation Force Visualization on Mesh: the translation of your Rotation Force
object specifications into solver specifications can be visualized symbolically at the
impacted mesh elements, provided the mesh has been previously generated via a
Compute action.
on a Loads objects set:

●

❍

❍

❍

Generate Image: generates an image of the computed Load objects (along with
translating all user-defined Loads specs into explicit solver commands on mesh
entities), by generating symbols for the elementary loads imposed by the Loads
objects set. The image can be edited to include part or all of the options available.
Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Loads objects set Computation.
See Creating Pressures for more details.
Self-balancing:xxx.
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Creating Enforced Displacements
This task shows how to create an Enforced Displacement on a restrained geometry.
Enforced Displacements are loads applied to support geometries, resulting for the
subsequent analysis in assigning non-zero values to displacements in previously
restrained directions.
Enforced Displacement objects belong to Loads objects sets. An Enforced Displacement
object is by definition associated to a Restraint object.
Make sure you entered non-zero values only for those degrees of freedom which have
been fixed by the associated Restraint object. Non-zero values for any other degree of
freedom will be ignored by the program.

Enforced Displacements can be applied to the following types of Supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Restraint
specifications

Open the sample20.CATAnalysis document from the samples directory for this task: a
Finite Element Model containing a Static Analysis Case and a Restraint object.
Before You Begin:
Go to View -> Render Style -> Customize View and make sure the Shading,
Outlines and Materials options are active in the Custom View Modes dialog box.
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1. Click the Enforced Displacement icon
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.

The Enforced Displacement dialog box appears.

2. You can change the identifier of the Enforced Displacement by editing the Name
field.
3. Activate the appropriate Restraint object by clicking, for example, Clamp.1 in the
specification tree (Restraints.1 object set).
4. Enter values for the imposed displacement values corresponding to the restrained
degree of freedom of the selected Restraint.
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The values of the imposed displacements are displayed on the corresponding
Restraint symbol.

5. Click OK in the Enforced Displacement dialog box.
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An Enforced Displacement object appears in the specification tree under the
active Loads.1 objects set.

●

●

●

If several Analysis Cases have been defined in the Finite Element Model, you must
activate a Loads objects set in the specification tree before creating an Enforced
Displacements object (only available if you installed the ELFINI Structural Analysis
product).
Restraints are required for Stress Analysis computations. They are optional for Modal
Analysis computations (if not created, the program will compute vibration modes for
the free, unrestrained part).
Enforced Displacement objects can be edited by a double click on the corresponding
object or icon in the specification tree.

Make sure the computation is finished before starting any of the below operations.

Products Available in Analysis Workbench
The Elfini Structural Analysis product offers the following additional features with a
right mouse click (key 3):
on an Enforced Displacement object:

●

❍

Enforced Displacement Visualization on Mesh: the translation of your
Enforced Displacement object specifications into solver specifications can be
visualized symbolically at the impacted mesh nodes, provided the mesh has been
previously generated via a Compute action.
on a Loads objects set:

●

❍

Generate Image: generates an image of the computed Load objects (along with
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translating all user-defined Loads specs into explicit solver commands on mesh
entities), by generating symbols for the elementary loads imposed by the Loads
objects set. The image can be edited to include part or all of the options available.
❍

Report: the partial status and results of intermediate pre-processor computations
are reported in HTML format. It represents a subset of the global Report capability
and generates a partial report of the Loads objects set Computation.
See Creating Pressures for more details.
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Creating Temperature Field
This task shows you how to load a body with a given temperature.
Creating Temperature Field means applying a temperature constant or not (data mapping)
to a part.

Only available with the ELFINI Structural Analysis (EST) product.

Temperature Field can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Face

Others

Mesh Part

Body

Open the sample34.CATAnalysis document from the samples directory.

1. Select the Temperature Field icon

.

The Temperature Field dialog box appears which lets you define the Name,
Support and reference Temperature you wish to define.
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You can re-use data (Data Mapping) that are external from this version
(experimental data or data coming from in-house codes or procedures).
For more details, please refer to Data Mapping.
2. Select the part or surface (body) you wish to be applied a temperature.

The Temperature Field dialog box is updated.
A T symbol now appears on the selected part or surface.
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You can activate the Data mapping option and use the results coming
from a thermal solver.
3. Click OK in the Temperature Field dialog box.

The Specification tree is also updated: both the Environment.1 and the
Temperature Field.1 features appear:
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At any time you can double-click the Environment feature and define an Initial
temperature.

Double-clicking on the Loads set, you will display the Loads dialog box that lets you
choose whether you wish to apply self-balancing to the load. Example of use: if this option
is used with iso-static specifications, it will allow you to simulate free-body loading. If you
make the option active, the center of inertia results null.
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Importing Temperature Field from
Thermal Solution
This task shows you how to load a body with a given temperature.
Importing Temperature Field from an existing thermal solution means applying a
temperature constant or not to a part using an existing thermal solution.
Contrary to the temperature field, you will directly import the temperature field from a
thermal solution and so, you do not need to use the data mapping functionality.

Only available with the ELFINI Structural Analysis (EST) product.

Temperature Field can be applied to the following types of supports:
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Face

Mesh Part

Body

1. Select the Temperature Field from Thermal Solution icon

Others

.
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The Temperature Field from Thermal Solution dialog box appears.

❍

Name: lets you modify the name of the temperature field.

❍

Thermal Solution: lets you select an existing thermal solution.

2. Select the desired thermal solution.
3. Click OK in the Temperature Field from Thermal Solution dialog box.

The specification tree is updated: the Temperature Field from Thermal
Solution.1 features appears:

Double-clicking on the Loads set, you will display the Loads dialog box that lets you
choose whether you wish to apply self-balancing to the load. Example of use: if this option
is used with iso-static specifications, it will allow you to simulate free-body loading. If you
make the option active, the center of inertia results null.
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Sensors
A sensor is a physical output of a computation, optionally limited to a local area, on which you can apply a posttreatment.
You can get a synthesis of analysis results by creating sensors.

A sensor can produce two kinds of results, depending on the sensor definition and on the analysis case:
●

●

knowledge parameters (single value or list of values): the sensor set provides parameters that can be reused in Knowledgeware in order to set rules, checks, formulas and Product Engineering Optimizer
workbench.
2D Display (only in multi-occurrence case): allows you to display the variation of an output for different
occurrences.

Create Global Sensors
Create a sensor on entire model.
Create Local Sensors
Create a sensor on local area.
Create Reaction Sensors
Create a reaction sensor.
Display Values of Sensors
Display values of sensors in the specification tree under a sensor set.
Integration with Product Engineering Optimizer
Give information about the analysis data authorized in the Product Engineering Optimizer (PEO) product.
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Creating Global Sensors
This task will show you how to create global sensors, available for the entire model.
The global sensors can be used either in a mono-occurrence solution (static solution, combined
solution) or multi-occurrence solution (frequency solution, buckling solution).
Analysis
Case

Available
global sensor

Static Case
Energy
Error in Energy
Global Error Rate
(%)
Maximum
Displacement
Maximum Von
Mises
Mass

Frequency Case

Frequency
Mass

Buckling
Case

Buckling
Factors

Combined Case
Energy
Error in Energy
Global Error Rate
(%)
Maximum
Displacement
Maximum Von
Mises
Mass

The 2D Display result is not available for the global sensors.

●

Open the Sample08.CATAnalysis document from the samples directory for this task.

●

Compute all the solutions.
For this, click the Compute icon and select the All option.
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1. Right-click the Sensors.1 feature in the specification tree and select the Create Global
Sensor contextual menu.

The Create Sensors dialog box appears.

2. Select the desired global sensor in the Create Sensor dialog box.

In this particular case, select the Energy global sensor.
3. Click OK in the Create Sensor dialog box.
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An Energy object appears in the specification tree.

You can edit a parameter to change the name or to visualize the associated value.
For this, double-click the knowledge parameter in the specification tree.
The Edit Parameter dialog box appears.

4. Right-click the Sensors.2 feature in the specification tree and select the Create Global
Sensor contextual menu.

The Create Sensor dialog box appears.

5. Select the Frequency option and click OK in the Create Sensor dialog box.

A Frequency object appears in the specification tree under the Sensor.2 object.

You can see that a Frequency List has also appeared. This object lists the parameters
under only one specification tree node.
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6. Edit the frequency global sensor. For this, double-click the Frequency object in the
specification tree.

The Global Sensor dialog box appears.

❍

❍

Name: lets you change the name of the sensor
Occurrences: lets you preserve the selected occurrences
■
No Selection: no occurrence will be preserved
■

■

■

■

Value to Approach: lets you preserve the occurrences that approach a selected
value
Intervals: lets you preserve the occurrences include in a selected interval
Occurrence Numbers Selection: lets you preserve the occurrences of which the
numbers have been selected
Occurrence Values Selection: lets you select the occurrences of which the values
have been selected

■

All: lets you preserve all the occurrences

■

Component Edition

: this button lets you select the desired occurrences

This button is only available if you selected one of the following options:
Value to Approach, Intervals, Occurrence Numbers Selection or
Occurrence Values Selection.

■

Edit Filtered Occurrences
occurrences

: this button lets you visualize the selected
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This button is only available if you selected one of the following options:
Value to Approach, Intervals, Occurrence Numbers Selection,
Occurrence Values Selection or All.
For example, if you select the Intervals options:

7. Select the All as Occurrences option in the Global Sensor dialog box.

The Global Sensor dialog box appears as shown bellow:

You can visualize the occurrences you have chosen.
For this, click the Edit Filtered Occurrences button
The Solution dialog box appears.

in the Global Sensor dialog box.
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8. Click OK in the Solution dialog box and then in the Global Sensor dialog box.
9. Update the Frequency global sensor. For this, please refer the Update a sensor paragraph.
10. Double-click the Frequency List object in the specification tree.

The List Edition dialog box appears.

11. Click OK in the List Edition dialog box.

You can display the value of knowledge parameters in the specification tree.
For more details, please refer to Displaying Values of Sensors.
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You can update the sensor you just have created or modified. You can also update all the sensors
which are under a sensor set.
●

Update a sensor:
For this, right-click the sensor you want to be updated and select the Update Sensor contextual
menu.

●

Update all sensors under a sensor set:
For this, right-click the sensor set you want to be updated and select the Update All Sensors
contextual menu.
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Creating Local Sensors
This task will show you how to create and edit local sensors.
A local sensor is a physical output (stress, strain, force, ...) of the computation limited to a
local area (body, edge, face, vertex, mechanical feature), on which a post-treatment has
been optionally applied (Max, Min, Average, ...).
The local sensors can be used either in a mono-occurrence computed solution (static
solution) or multi-occurrence computed solution (frequency, buckling or dynamic solution).
●

mono-occurrence solution

●

multi-occurrence solution

Local Sensor

Static
Case

Dynamic
Case
Frequency
(Harmonic
Case
or
Transient)

Buckling Combined
Static
Case
Case
Constrained

Displacement
Magnitude

Displacement
Vector

Relative

(restraint

Displacement

excitation)

Rotation
Vector

Force

*

*

*

Moment

*

*

*
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Von Mises
Stress

Stress
*

*

*

*

*

*

*

*

*

*

*

*

*

*

*

Strain Tensor

*

*

*

*

*

Strain Tensor

*

*

*

*

*

*

*

*

*

*

Tensor

Principal
Shearing

Principal
Stress
Tensor

Principal

Elastic
Energy

Error

Acceleration
vector

*

Relative

*

Acceleration
vector

Velocity vector

(restraint
excitation)

*
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Relative
Velocity vector
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*
(restraint
excitation)

* only available with the ELFINI Structural Analysis (EST) product
Mono-occurrence:
The creation of knowledge parameters is restricted to:
●

the case of a single point support

●

the case of other support type only if the post-treatment is different of none

Multi-occurrence:
The creation of knowledge parameters and the generation of a 2D Display are restricted to
the cases of:
●

the case of a single point support

●

the case of other support type only if the post-treatment is different of none

For more details about the 2D Display generation, please refer to Generating 2D Display for
Sensors.
Open the sample08.CATAnalysis document from the samples directory for this task.
Before You Begin:
Compute all the solutions. For this, click the Compute icon and select the All option.
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You will now see two examples of local sensor creation in case of mono-occurrence solution
and in case of multi-occurrence solution.

Mono-occurrence solution
1. Activate a static case, if needed.
For this, right-click the Static Case set in the specification tree and select the Set As
Current Case contextual menu.
2. Right-click on the Sensors.1 feature in the specification tree and select the Create
Local Sensor contextual menu.
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The Create Sensors dialog box appears.

3. Select the desired local sensor and click OK in the Create Sensor dialog box.
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In this example, select the Displacement Vector local sensor.
The Displacement Vector object appears in the specification tree.

The Displacement Vector is not yet valid. To make it valid, you have to edit it.
4. Double-click the Displacement Vector object in the specification tree.

The Local Sensor dialog box appears.

❍

Name: gives you the name of the sensor.

❍

Supports: gives you the support definition (vertex, edge, face, body, group,
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feature).
❍

Solution: gives you the name of the solution on which you are working.

❍

Values: for more details, please click here.

❍

Filters: for more details, please click here.

❍

❍

Post-Treatment: lets you take the minimum, maximum or average value of the
results.
Create Parameters: lets you generate, when it is possible, knowledge
parameters.

5. Select the desired parameters in the Local Sensor dialog box.

In this particular example, select:
❍

a face as Support

❍

Real as Value type

❍

All as Components

❍

Maximum as Post-Treatment

❍

True as Create Parameters

6. Click OK in the Local Sensor dialog box.

The OK button is read only in the Local Sensor dialog box as long as the
sensor is not valid.
7. Update the Displacement Vector local sensor. For this, please refer to the Update
a sensor paragraph.

A knowledge parameter appears in the specification tree without associated value.

8. Double-click the Displacement Vector sensor in the specification tree.
9. Select C1 as Components option and click OK in the Local Sensor dialog box.
10. Update the Displacement Vector local sensor. For this, please refer to the Update
a sensor paragraph.
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A label containing the maximum value appears on the geometry.

This visualization type is only available if the local sensor:
a. is created in case of mono-occurrence solution
b. is defined with any of the Components options except the All
option.
c. is defined with a Minimum or Maximum Post-Treatment value
d. is updated

●

You can display the value of knowledge parameters in the specification tree.
For more details, please refer to Displaying Values of Sensors.

●

You can also export data associated to a local sensor (only available if you installed the
ELFINI Structural Analysis (EST) product.

The Export Data contextual menu is only available on mono-occurrence local
sensor without post-treatment.

To export data on local sensor, right-click a local sensor in the specification tree and
then select the Export Data contextual menu

Multi-occurrence solution

.
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1. Right-click on the Sensors.2 feature in the specification tree and select the Create
Local Sensor contextual menu.

The Create Sensors dialog box appears.

2. Select the desired local sensor in the Local Sensor dialog box.

In this example, select Von Mises Stress and click OK in the Create Sensor dialog
box.
The Von Mises Stress object appears in the specification tree.

The Von Mises Stress is not yet valid. To make it valid, you have to edit it.
3. Double-click the Von Mises Stress object in the specification tree.
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The Local Sensor dialog box appears.

❍

❍

❍

❍

Name: gives you the name of the sensor.
Supports: gives you the support definition (vertex, edge, face, body, group,
feature).
Solution: gives you the name of the solution on which you are working.
Occurrences: lets you preserve the selected occurrences.
■
No Selection: no occurrence will be preserved.
■

■

Value to Approach: lets you preserve the occurrences that approach a
selected value.
Intervals: lets you preserve the occurrences include in multi-selected
intervals.

Generative Structural Analysis
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Occurrence Numbers Selection: lets you preserve the occurrences of
which the numbers have been selected.
Occurrence Values Selection: lets you select the occurrences of which the
values have been selected.
All: lets you preserve all the occurrences.

Component Edition
occurrences.

: this button lets you select the desired

This button is only available if you selected one of the following
options: Value to Approach, Intervals, Occurrence Numbers
Selection or Occurrence Values Selection.

■

Edit Filtered Occurrences
occurrences.

: this button lets you visualize the selected

This button is only available if you selected one of the following
options: Value to Approach, Intervals, Occurrence Numbers
Selection, Occurrence Values Selection or All.
For example, if you select the Intervals options:
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❍

Values: for more details, please click here.

❍

Filters: for more details, please click here.

❍

❍
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Post-Treatment: lets you take the minimum, maximum or average value of the
results.
Create Parameters: lets you generate, when it is possible, knowledge
parameters.

4. Select the desired parameters in the Local Sensor dialog box.
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In this particular example, select:
❍

a vertex as Support

❍

All as Occurrences

❍

Node as Position

❍

Real as Value type

❍

Maximum as Post-Treatment

❍

True as Create Parameters

5. Click OK in the Local Sensor dialog box.
6. Update the Von Mises Stress local sensor. For this, please refer to the Update a
sensor paragraph.

The knowledge parameters appear in the specification tree without the values.

You can display the value of knowledge parameters in the specification tree.
For more details, please refer to Displaying Values of Sensors.
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You can update the sensor you just have created or modified. You can also update all the
sensors which are under a sensor set.
●

Update a sensor:
For this, right-click the sensor you want to be updated and select the Update Sensor
contextual menu

●

.

Update all sensors under a sensor set:
For this, right-click the sensor set you want to be updated and select the Update All
Sensors contextual menu.
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Creating Reaction Sensors
This task will show you how to create and edit reaction sensors.
A reaction represents the resulting force and moment at restraint and connection
specifications.

Reaction sensors are only available in a Static Analysis Case.
Open the Sample08.CATAnalysis document from the samples directory for this task.
Before You Begin:
Compute all the solutions. For this, click the Compute icon and select the All option.
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1. Right-click the Sensors.1 object in the specification tree and select the Create
Reaction Sensor contextual menu.

The Reaction Sensors dialog box appears.

❍

Available Entities: lets you choose the restraint and connection properties
(except for Spot Weld and Seam Weld Connections)
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You can access the values of the reactions inside any connection using
the image edition.
For this:
a. Right-click the Properties set in the specification tree.
b. Select the Generate Image contextual menu.
The Image Generation dialog box appears.
c. Select the Point Force Vector image or the Point Moment
Vector image and click OK in the Image Generation dialog box.
The Point Force Vector and the Point Moment Vector
images are only available if you installed the ELFINI
Structural Analysis product.
d. Double-click the image you just have generated in the
specification tree.
The Image Edition dialog box appears.
e. Select:
■

■

■

Text type in the Visu tab
Node of element as Position Value Control in the Filters
tab
Connection Mesh object in the Selections tab

f. Click OK in the Image Edition dialog box.
For more details about image generation and image edition, please refer
to Generating Images and Editing Images in this guide.

❍

Reference Axis Type: lets you choose the type of axis in which the reaction
sensor will be computed and displayed in the 3D view
■
Global (global origin): corresponds to the absolute origin
■

■

Global (local origin): corresponds to the handling point for a virtual point
entity or a geometric center for other entities
User: lets you select an existing reference axis system either in the
specification tree or directly in the 3D view.

2. Select the desired Available Entities (previously created on the CATAnalysis
document) in the Reaction Sensor dialog box.
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Note that: multi-selection is available (for example, you can select several
restraints).
In this particular case, select the Clamp.1 in the Reaction Sensor dialog box.
3. Select the desired Reference Axis Type in the Reaction Sensor dialog box.

In this particular case, select the Global (global origin) option.

4. Click OK in the Reaction Sensor dialog box.

The Reaction -> Clamp.1 object appears in the specification tree.

You can edit the reaction sensor name you just have created and visualize the
different parameters you just have defined.
For this, double-click the Reaction -> Clamp.1 object in the specification tree.
The Reaction Tensor dialog box appears.
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❍

Name: gives you the name of the selected entity

❍

Axis: reminds you the reference axis type you have previously selected

❍

Force tab: gives the force values of the parameters

❍

Moment tab: gives the moment values of the parameters

❍
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Origin tab: gives the coordinates of the center point of the axis (relative to
the global axis)

You can update the sensor you just have created or modified. You can also update all the
sensors which are under a sensor set.
●

●

Update a sensor:
For this, right-click the sensor you want to be updated and select the Update Sensor
contextual menu.
Update all sensors under a sensor set:
For this, right-click the sensor set you want to be updated and select the Update All
Sensors contextual menu.
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Displaying Values of Sensors
This task will show you how to display the values of the knowledge parameters in the case of global and
local sensors.
1. Select the Tools -> Options... command to open the Options dialog box.
2. Click the Knowledge tab in the General -> Parameters and Measures category.
3. Select the With value option in the Knowledge tab.

4. Click OK in the Options dialog box.
The specification tree is automatically updated and you can visualize the sensor value.
You can retrieve hereunder the result of the knowledge parameters display for the examples of the
the Creating Global Sensors and Creating Local Sensors tasks:

❍

Energy global sensor

❍

Displacement Vector local sensor (mono-occurrence solution)

❍

Von Mises Stress local sensor (multi-occurrence solution)
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Customizing the decimal number
You can also change the decimal number in the Units tab of the Options dialog box.
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Results Computation
External Storage
Specify External Storage
Specify the path of an external storage file directory (computation and result data).
Clear Data
Clear Elfini Storage in order to save space on your disk (either computation data
exclusively or both result and computation data.
Specify Temporary Data Directory
Specify a temporary data directory for the CATElfini stored data and computation
results.

Computation
Compute Objects
Perform finite element computations on one or several objects.
Compute a Static Solution
Perform a static computation on one or several Static Analysis Cases.
Compute a Static Constrained Solution
Perform a static constrained computation on one or several Static Constrained
Modes.
Compute a Frequency Solution
Perform a normal vibration modes computation on one or several Frequency
Analysis Cases.
Compute a Buckling Solution
Perform a normal buckling modes computation on one or several Buckling Analysis
Cases.
Compute a Harmonic Dynamic Case
Perform a normal dynamic modes computation on one or several Harmonic Dynamic
response Cases.
Compute a Transient Dynamic Case
Perform a normal dynamic modes computation on one or several Transient Dynamic
response Cases.
Compute Using a Batch
Update and compute a CATAnalysis document using a batch.

Computing with Adaptivity
Compute with Adaptivity
Computing adaptive solutions.
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Specifying External Storage
This task shows how to specify External Storage in a particular case.
All ELFINI Solver computations (matrices, operators, displacements, intermediate entities and so forth) are
systematically stored in a structured way out of core memory, on an external file.
External Storage is the file of the directory where this structured computed data is stored.
The link between the .CATAnalysis document and the External Storage is maintained after the end of a session, in a
way similar to the link between a .CATPart document and the associated .CATAnalysis document.
Stored data resulting from analysis are stored in two files, one for results and one for computations. After the opening
of a new analysis document, the default directories in which they are stored are the last directories chosen by the user.
Result data is data necessary for generating images: displacements, loads, restraints, singularities, strain energy and
so forth. This data is self sufficient if only results are to be saved and no more computations should be performed from
them. Result data takes small disk space, any newly performed computation starts from the beginning and therefore
may take time.
Computation data corresponds to matrices such as stiffness. This data is needed to perform new computations from the
loaded data which will benefit from it. It is time saving, but as a counterpart needs much disk space storage.
Computation data can be removed by activating the "Clear storage" command before saving the analysis document.
The default storage location of computation files can be previously set.
For more details, please refer to External Storage in the Customizing section.
Open the sample01.CATAnalysis document from the samples directory.

1. Click the External Storage icon

.

The External Storage dialog box appears.

The results and computation data are stored in one single file with given extensions:
❍
xxx.CATAnalysisResults
❍

xxx.CATAnalysisComputations

2. If needed, click the Modify button.
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The Selection dialog box appears.
3. Select the desired external storage directory and then click Save in the Selection dialog box.

The selected path name is visualized in the External Storage dialog box.

You can still modify or cancel your file selection by clicking the Modify or Cancel buttons.
4. Click OK in the External Storage dialog box.

Your External Storage file has been stored and the extensions are kept.
The file locations objects (CATAnalysisResults and CATAnalysisComputations) appear in the specification
tree, under Links Manager.

●

●

You can modify the location using the specification tree. Double-click either the CATAnalysis Results and
CATAnalysis Computations in the specification tree: the External Storage dialog box appears with the selected
link only. You can now modify the path of the file again.

When External Storage files are created, the default file names are based on the current analysis document file
name.
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Both files (CATAnalysisResults and CATAnalysisComputations) are created when:
- a computation is launched,
- one of the external storage commands is launched.
Note that storage names only change if you request it, except for the above mentioned cases.
Attention should be ported on the Save As operation : changing the CATAnalysis path without changing those of
the external storage files will not be allowed (unless you activate the Automatic Renaming option). An error
message will be displayed.

●

If computations file size exceeds two Gb, additional CATAnalysisComputations files are created and the
corresponding links appear in the Links Manager feature (specification tree).
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Clearing External Storage
This task shows how to clear external storage in order to save space on your disk.
Open the sample18.CATAnalysis document from the samples directory.

1. Click the External Storage Clean-up icon

.

The External Storage Clean-up dialog box appears

❍

Clear computation data: lets you clear only computation data

❍

Clear result and computation data: lets you clear both result and
computation data

2. Select the desired option.

In this particular case, select the Clear computation data option.
3. Click OK in the External Storage Clean-up dialog box.

As mentioned in the confirmation dialog box that appears, you should know that
this command will remove some data from all the solutions and that it may take
time to rebuild them.
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Specifying Temporary External Storage
This task shows how to specify a temporary data directory for the CATAnalysis stored data
and computation results.

During an analysis session, current data is stored in a temporary directory.
The Save operation makes current data become persistent by saving it from the
temporary data directory into two result computation storage files. As a result, current
changes do not alter previously loaded results and computations data unless you perform
a Save operation.
The temporary data directory is cleared each time the related analysis session is closed.
The default settings for the temporary data directory is the temporary directory of your
computer. Due to the important disk space generally required for analysis computations,
it is highly recommended that you change default settings by specifying a new temporary
directory.
Open the sample01.CATAnalysis document from the samples directory.

1. Click the Temporary External Storage icon

.

The Temporary External Storage dialog box appears.

2. If needed, click the Modify button.

The Selection dialog box appears.
3. Select the desired temporary external storage directory and then click OK in the
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Selection dialog box.

The selected path name is visualized in the Temporary External Storage dialog
box.
4. Click OK in the Temporary External Storage dialog box.

Both CATAnalysis stored data and computation results files can now be accessed
from the directory you previously defined.
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Computing Objects Sets
This task will show you how to compute objects sets.
In this particular example, you will see how to compute a Mesh.
Computing a mesh will enable the analysis of any object of Restraints, Loads and Masses
type, without requiring the computation of a Solution.
A finite element computation is a succession of data manipulation processes in which
input data resulting from a previous process (or directly input by the user) is converted
into output data ready to be used by a subsequent process. Such ready-to-use data is
stored in program objects sets such as those appearing in the analysis features tree under
Analysis Cases (Restraints, Loads, Masses, Solutions) objects sets.
When data contained in such an objects set is ready for use in the subsequent finite
element computation process, the object has been computed and can be analyzed. Thus,
computing an objects set consists in generating finite elements results for all objects and
objects sets necessary to analyze the specified objects set.
The computation of an objects set requires two distinct actions:
●

First, the user-defined specifications attached to each object belonging to the objects
set in the specification tree must be translated by the pre-processor into solverinterpretable commands.
Since solvers can only interpret data applied on mesh entities (nodes and elements),
this first translation step requires the existence of a mesh support for converting user
input specifications on the geometry into explicit solver commands on nodes and
elements.

●

Next, the solver translates the solver commands into data ready for algorithmic
treatment as required by the numeric procedure invoked.
Since algorithms deal only with operators dimensioned by the problem size (number of
degrees of freedom (degree of freedom)), this second translation step requires the
exact knowledge of the behavioral hypotheses of the finite elements (properties),
which contain the required degree of freedom information.
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As a result of such action, the program translates the user-defined specifications into
solver-interpretable commands applied on mesh entities, and you can visualize on the
mesh the result of this translation. This analysis capability, used especially for displaying
program feedback on applied Restraints, Loads or Masses objects in the case of large size
models (when you do not wish the entire computation to be performed), is available with
a right (key 3) click on:
●

Restraint, Load and Mass type objects, in the form of the object Visualization on Mesh
action

●

Restraints, Loads, Masses and Solutions objects sets, in the form of the following
objects set actions:
❍

objects set Image Generation

❍

objects set Reporting

A prerequisite to these actions is the existence of a Mesh.

Avoid having CATAnalysis documents automatically saved. For this, go to Tools>Options->General (menu bar) and de-activate the Automatic save every xx
minutes option. Otherwise, on some models, each computation will be followed by a
Save, thus making temporary data become persistent data.

You can use the sample00.CATAnalysis document from the samples directory for this
task: Finite Element Model containing a Static Analysis Case and computed corresponding
Static Solution.
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.

The Compute dialog box appears.
❍
The list allows you to choose between several options for the set of objects to
update:

■

All: all objects defined in the analysis features tree will be computed.

■

Mesh Only: only the mesh will be computed.

■

■

Analysis Case Solution Selection: only a selection of user-specified
Analysis Case Solutions will be computed, with an optimal parallel
computation strategy.
Selection by Restraint: only the selected characteristics will be computed
(Properties, Loads, Masses).
This option is only available with the ELFINI Structural Analysis
(EST) product

❍

The Preview option allows you to obtain an estimate of the time and memory
required to perform the computation.

2. Select the Mesh Only option.
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3. Click OK in the Compute dialog box.
The Mesh is computed and can be visualized.
The status of the Nodes and Elements objects set is changed to valid in the
analysis features tree.
A valid Mesh object also appears under the Nodes and Elements objects set.

Any object in the Finite Element Model can now be analyzed (visualized on the Mesh).
By extension, all objects belonging to any objects set in the Finite Element Model can also
be analyzed (visualized in various Generated Images or analyzed in a Report).
For mode details on object Visualization on Mesh and on objects set Report and
Image Generation, see the creation of objects of Restraints, Loads and Masses types.
You can change the definition parameters of an object either by replacing it by a new one
(delete followed by create) or by modifying it (edit the definition parameters).
To edit the definition parameters of an object, activate it in the analysis features tree and
double-click the object (or right-click, then click .Object -> Definition ) to re-display
the object definition dialog box.
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Computing Static Solutions
This task shows how to compute a Static Case Solution.
The Compute command is most often applied to Analysis Case Solutions (which are
particular types of objects sets). In this case, it generates the analysis case solution,
along with partial results for all objects involved in the definition of the Analysis Case.
The primary Static Solution Computation result consists of a displacement vector whose
components represent the values of the system degree of freedom. This result can be
further processed to produce other results such as stresses, reaction forces and so forth.
The program can compute simultaneously several Solution objects sets, with optimal
parallel computation whenever applicable.

Avoid having CATAnalysis documents automatically saved. For this, go to Tools>Options->General (menu bar) and de-activate the Automatic save every xx
minutes option. Otherwise, on some models, each computation will be followed by a
Save, thus making temporary data become persistent data.

You can use the Sample08.CATAnalysis document from the samples directory for this
task.

1. Click the Compute icon

.

The Compute dialog box appears.
❍
The list allows you to choose between several options for the set of objects to
update:
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All: all the objects defined in the analysis features tree will be computed.
Mesh Only: the preprocessing parts and connections will be meshed. The
preprocessing data (loads, restraints and so forth) will be applied onto the
mesh.
Capability is only available with the ELFINI Structural Analysis product:
for your information, in case the Mesh only option was previously
activated, you will then be able to visualize the applied data on the mesh
by using the Visualization on Mesh option (contextual menu)

■

Analysis Case Solution Selection: only a selection of user-specified
Analysis Case Solutions will be computed, with an optimal parallel
computation strategy. This capability is only available with the ELFINI
Structural Analysis product

■

❍

.

Selection by Restraint: only the selected characteristics will be computed
(Properties, Restraints, Loads, Masses).

The Preview option allows you to obtain an estimate of the Time and Memory
required to perform the computation, prior to triggering the actual
computation.

2. Select the All (or Analysis Case Solution Selection) option.
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In this case, the program will compute by default all objects up to (and including)
the Static Case Solution in the analysis features tree.
3. Select the Preview option and click OK in the Compute dialog box.
The estimates are displayed in the Preview dialog box. You can proceed with the
computation or choose to postpone it.

4. Click Yes to launch the computation.
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The Progress Bar dialog box provides a series of status messages (Meshing,
Factorization, Solution) that inform you of the degree of advancement of the
computation process.
The Static Analysis Solution is computed and can be visualized.
Upon successful completion of the computation, the FEM mesh is visualized on
your part, and the status of all objects in the analysis specification tree up to the
Static Case Solution objects set is changed to valid. You can now:

●

●

❍

analyze the report of the computation

❍

visualize images for various results

The status and results of all intermediate computations necessary to compute the
solution are reported in HTML format. For more detail see the basic global Report
capability .
To display CPU time and memory requirement estimates prior to launching any
computations, activate the Estimates switch in the Update dialog box.
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Products in Analysis Workbench
●

The ELFINI Structural Analysis product offers the following additional feature:
If several Static Analysis Cases have been defined, you can compute them
simultaneously by following the same procedure. You can also compute only a
selection of cases by selecting Analysis Cases Solution Selection. You can then specify
the cases in the Compute dialog box.
The Definition parameters of an Analysis Case, (available, in the ELFINI Structural
Analysis product, in the New Case dialog box at the time of a Case Insertion) cannot
be modified once the Case has been created. These must not be confused with the
Computation parameters of a Case Solution, which are proposed by default at
creation, and are editable afterwards.
To edit the default values of the Computation parameters of a Case Solution, doubleclick the Solution objects set in the analysis features tree (or right-click, then click
.Object -> Definition ) to display the Definition Parameters dialog box.

The Static Solution Parameters dialog box contains the following parameters which can
all be modified in the dialog box:
❍

Auto

❍

Gauss

❍

Gradient Parameters
■
Maximum iterations number

■

❍

●
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Accuracy

Gauss R6

The ELFINI Structural Analysis product offers the following additional features with
a right-click (key 3) on a Static Case Solution objects set:
❍
Generate Image: proposes to generate the various images available along with
the Static Solution objects set. The image can be edited to include part or all of the
options available.
Right-click the Load object in the specification tree and click the Generate Image
contextual menu (on the condition you previously computed a solution using the
Compute icon

).

The Image Generation dialog box appears. You can select images by clicking them
in the list.
The resulting images sequence is obtained by superposition.
❍

Report: the global status and results of all computations are reported in HTML
format.

Click the Basic Analysis Report icon

(on the condition you previously

computed a solution using the Compute icon

).

The .html partial report file is displayed. It contains a summary of the modal
computation results, including the values of the rigid body modal participation
factors for the computed modes.
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Computing Static Constrained Solutions
This task shows how to compute a Static Case Constrained Solution.
The Compute command is most often applied to Analysis Case Solutions (which are
particular types of objects sets). In this case, it generates the analysis case solution,
along with partial results for all objects involved in the definition of the Analysis Case.

Avoid having CATAnalysis documents automatically saved. For this, go to Tools>Options->General (menu bar) and de-activate the Automatic save every xx
minutes option. Otherwise, on some models, each computation will be followed by a
Save, thus making temporary data become persistent data.

Open the Sample05.CATAnalysis document from the samples directory for this task.
1. Select the Static Constrained Modes.1 in the specification tree.

2. Click the Compute icon

.

The Compute dialog box appears.

3. Click OK in the Compute dialog box.
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The Static Constrained Mode is computed and can be visualized.

You can now:
❍

❍

Visualize images for various results. For this, you can use the Generate
Image contextual menu.
For more details, please refer to Generating Images.
Analyze the report of the computation. For this, select the Report contextual
menu.
For more details, please refer to Reporting.
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Computing Frequency Solutions
This task shows how to compute a Frequency Case Solution.
The Compute command is most often applied to Analysis Case Solutions (which are
particular types of objects sets). In this case, it generates the analysis case solution,
along with partial results for all objects involved in the definition of the Analysis Case.
The primary Frequency Solution Computation result consists of a set of frequencies and
associated modal vibration shape vectors whose components represent the values of the
system dof for various vibration modes.
The program can compute simultaneously several Solution objects sets, with optimal
parallel computation whenever applicable.

Avoid having CATAnalysis documents automatically saved. For this, go to Tools>Options->General (menu bar) and de-activate the Automatic save every xx
minutes option. Otherwise, on some models, each computation will be followed by a
Save, thus making temporary data become persistent data.

You can use the sample16.CATAnalysis document from the samples directory for this task.

1. Click the Compute icon

.

The Compute dialog box appears.
❍
The list allows you to choose between several options for the set of objects to
be updated:
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■

■

All: all objects defined in the analysis features tree will be computed.
Mesh Only: the preprocessing parts and connections will be meshed. The
preprocessing data (loads, restraints and so forth) will be applied onto the
mesh.
Capability is only available with the ELFINI Structural Analysis product:
for your information, in case the Mesh only option was previously
activated, you will then be able to visualize the applied data on the mesh
by using the Visualization on Mesh option (contextual menu)

■

❍

.

Analysis Case Solution Selection: only a selection of user-specified
Analysis Case Solutions will be computed, with an optimal parallel
computation strategy. This capability is only available with the ELFINI
Structural Analysis product

■

Page 604

.

Selection by Restraint: only the selected characteristics will be computed
(Properties, restraints, Loads, Masses).

The Preview option allows you to obtain an estimate of the Time and Memory
required to perform the computation, prior to triggering the actual
computation.

2. Select the All (or Analysis Case Solution Selection) option.
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In this case, the program will compute by default all objects up to (and including)
the Frequency Case Solution in the analysis features tree.
3. Activate the Preview option from the Compute dialog box.
4. Click OK in the Compute dialog box.

The estimations are displayed in the Computation Resources Estimation dialog
box. You can proceed with the computation or choose to postpone it.

5. Click Yes to launch the computation.
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The Computation Status dialog box provides a series of status messages
(Meshing, Factorization, Solution) that inform you of the degree of
advancement of the computation process.
The Frequency Analysis Solution is computed and can be visualized.
Upon successful completion of the computation, the FE mesh is visualized on your
part, and the status of all objects in the analysis features tree up to the Frequency
Case Solution objects set is changed to valid. You can now:
❍

analyze the report of the computation

❍

visualize images for various results
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Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional feature:
●

●

●

●

●

●

If several Frequency Analysis Cases have been defined, you can compute them
simultaneously by following the same procedure. You can also compute only a
selection of cases by selecting Analysis Cases Solution Selection. You can then specify
the cases in the Compute dialog box.
You can compute vibration modes either for the free system or for the system
subjected to supports. In the first case there are no restraints so your Analysis Case
must contain no Restraints objects set.
To display CPU time and memory requirement estimates prior to launching any
computations, activate the Estimates switch in the Update dialog box.
The status and results of intermediate pre-processor computations necessary to
perform this translation are reported in HTML format. For more detail see the basic
global Report capability .
The Definition parameters of an Analysis Case, (available, in the ELFINI Structural
Analysis product, in the New Case dialog box at the time of a Case Insertion) cannot
be modified once the Case has been created. These must not be confused with the
Computation parameters of a Case Solution, which are proposed by default at
creation, and are editable afterwards.
To edit the default values of the Computation parameters of a Case Solution, doubleclick the Solution objects set in the analysis specification tree (or right-click, then
click .Object -> Definition ) to display the Frequency Solution Parameters dialog
box.

The Frequency Solution Parameters dialog box contains the following parameters
which can all be modified in the dialog box:
❍

Number of Modes
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❍

Method
■
Iterative subspace
■

❍
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Lanczos

Dynamic parameters
■
Maximum iteration number
■

Accuracy

The ELFINI product offers the following additional features on a Frequency Case
Solution objects set:
●

Generate Image: proposes to generate the various images available along with the
Static Solution objects set. The image can be edited to include part or all of the
options available.
Right-click the Mass object and then click the Generate Image contextual menu (on
the condition you previously computed a solution using the Compute icon

).

The Image Generation dialog box appears. You can select images by clicking them in
the list.

●

Report: the global status and results of all computations are reported in HTML format.

Click the Basic Analysis Report icon

on the bottom toolbar (on the condition

you previously computed a solution using the Compute icon

).

The .html partial report file is displayed. It contains a summary of the modal
computation results, including the values of the rigid body modal participation factors
for the computed modes.
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Computing Buckling Solutions
This task shows how to compute a Buckling Case Solution.

Only available with the ELFINI Structural Analysis (EST) product.
The Compute command is most often applied to Analysis Case Solutions (which are
particular types of objects sets). In this case, it generates the analysis case solution,
along with partial results for all objects involved in the definition of the Analysis Case.
The primary Buckling Solution Computation result consists of a set of critical load factors
and associated buckling shape vectors, whose components represent the values of the
system degree of freedom for various buckling modes associated with a given Static
Case.
The program can compute simultaneously several Solution objects sets, with optimal
parallel computation whenever applicable.

Avoid having CATAnalysis documents automatically saved. For this, go to Tools>Options->General (menu bar) and de-activate the Automatic save every xx
minutes option. Otherwise, on some models, each computation will be followed by a
Save, thus making temporary data become persistent data.
You can use the sample29.CATAnalysis document from the samples directory: you created
a Finite Element Model containing a Buckling Analysis Case.
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1. Select the Buckling Case Solution feature from the specification tree.

2. Click the Compute icon

.

The Compute dialog box appears.

In this case, the program will compute the Buckling Case Solution in the analysis
specification tree.
3. Click OK in the Compute dialog box.

The Buckling Analysis Solution is computed and can be visualized.
Upon successful completion of the computation, the FE mesh is visualized on your
part, and the status of all objects in the analysis features tree up to the Buckling
Case Solution objects set is changed to valid. You can now:
❍

analyze the report of the computation

❍

visualize images for various results

Generative Structural Analysis

Version 5 Release 14

Page 611

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional feature:
●

●

●

●

If several Buckling Analysis Cases have been defined, you can compute them
simultaneously by following the same procedure.
To display CPU time and memory requirement estimates prior to launching any
computations, activate the Estimates switch in the Update dialog box.
The status and results of intermediate pre-processor computations necessary to
perform this translation are reported in HTML format. For more detail see the basic
global Report capability.
The Definition parameters of an Analysis Case, (available, in the ELFINI Structural
Analysis product, in the New Case dialog box at the time of a Case Insertion) cannot
be modified once the Case has been created. These parameters must not be confused
with the Computation parameters of a Case Solution, which are proposed by default at
creation, and are editable afterwards.
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To edit the default values of the Computation parameters of a Case Solution, doubleclick the Solution objects set in the analysis features tree (or right-click, then click
.Object -> Definition ) to display the Definition par... dialog box.
The Buckling Solution Parameters dialog box contains the following parameters which
can all be modified in the dialog box:
1. Number of modes
2. Method (Iterative subspace or lanczos)
3. Dynamic parameters (Maximum iteration number and Accuracy)

The ELFINI Structural Analysis (EST) product offers the following additional
features on a Buckling Case Solution:
●

Generate Image: allows to generate the various images available along with the
Static Solution objects set. The image can be edited to include part or all of the
options available.
Right-click the Buckling Case object and then click the Generate Image contextual
menu (on the condition you previously computed a solution using the Compute icon
).
The Image Generation dialog box appears. You can select images by clicking them in
the list.
Since a Buckling solution is a multi-occurrence solution, you can select the buckling
mode that will be displayed by clicking the Select button in the Image Generation
dialog box.
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The resulting images sequence is obtained by superposition.

●

Report: the global status and results of all computations are reported in HTML
format.

Click the Basic Analysis Report
a solution using the Compute icon

icon (on the condition you previously computed
).

The .html partial report file is displayed. It contains a summary of the buckling
computation results.

Generative Structural Analysis

Version 5 Release 14

Page 614

Computing Harmonic Dynamic Response
Solutions
This task shows how to compute a Harmonic Dynamic Response Case Solution.

Only available with the Generative Dynamic Analysis (GDY) product.
The Compute command is most often applied to Analysis Case Solutions (which are
particular types of objects sets). In this case, it generates the analysis case solution,
along with partial results for all objects involved in the definition of the Analysis Case.
The primary Dynamic Solution Computation result consists of a set of critical load
excitation set factors and associated damping.
The program can compute simultaneously several Solution objects sets, with optimal
parallel computation whenever applicable.

Avoid having CATAnalysis documents automatically saved.
For this, go to Tools->Options->General (menu bar) and de-activate the Automatic
save every xx minutes option. Otherwise, on some models, each computation will be
followed by a Save, thus making temporary data become persistent data.
You can use the sample58.CATAnalysis document from the samples directory: you created
a Finite Element Model containing a Dynamic Response Case.
In this example, the Load Excitation set and the Damping set have been previously
defined.
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1. Double-click on the Harmonic Dynamic Response Case Solution.1 in the
specification tree to edit it.
The Harmonic Dynamic Response Set dialog box appears to let you define the
computation parameters.

❍

❍

❍

❍

Name: allows you to modify the name of the set.
Minimum sampling: allows you to define the minimum sampling parameters
(in Hz).
Maximum sampling: allows you to define the maximum sampling
parameters (in Hz).
Number of steps: allows you to define the number of steps between the
minimum and maximum sampling.

2. Modify the desired parameters.
In this particular example, enter:
❍
0Hz as Minimum sampling value
❍

100Hz as Maximum sampling value

❍

2000 as Number of steps value

3. Click OK in the Harmonic Dynamic Response Set dialog box.
4. Select the Harmonic Dynamic Response Solution object in the specification
tree.

5. Click the Compute icon

.
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The Compute dialog box appears as shown here:

6. Click OK in the Compute dialog box.

The Dynamic Response Solution is computed.

Upon successful completion of the computation, the FE mesh is visualized on your
part, and the status of all objects in the analysis features tree up to the Dynamic
Response Solution objects set is changed to valid. You can now:
❍

analyze the report of the computation

❍

visualize images for various results

❍

visualize the 2D Display result
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Products Available in Analysis Workbench

The ELFINI Structural Analysis product offers the following additional feature:

●

●

●

●

●

If several Harmonic Dynamic Response Cases have been defined, you can compute
them simultaneously by following the same procedure.
To display CPU time and memory requirement estimates prior to launching any
computations, activate the Estimates switch in the Update dialog box.
The status and results of intermediate pre-processor computations necessary to
perform this translation are reported in HTML format. For more detail see the basic
global Report capability.
The Definition parameters of an Analysis Case (available, in the ELFINI Structural
Analysis product, in the New Case dialog box at the time of a Case Insertion) cannot
be modified once the Case has been created. These parameters must not be confused
with the Computation parameters of a Case Solution, which are proposed by default at
creation, and are editable afterwards.
To edit the default values of the Computation parameters of a Case Solution, doubleclick the Solution objects set in the analysis features tree (or right-click, then click
.Object -> Definition... ) to display the Dynamic Response Set dialog box.

The ELFINI Structural Analysis product offers the following additional features
on a Dynamic Response Solution objects set:
●

Generate Image: allows to generate the various images available along with the
Dynamic Response Solution objects set. The image can be edited to include part or all
of the options available.
Right-click the Dynamic Response Case object and then click the Generate Image
contextual menu (on the condition you previously computed a solution using the
Compute icon

).

The Image Choice dialog box is displayed. You can select images by clicking them in
the list.
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If you select the Current Occurrence button, the table below lets you choose the
desired Mode.

●

Report: the global status and results of all computations are reported in HTML format.
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icon (on the condition you previously computed

a solution using the Compute icon

).

The .html partial report file is displayed. It contains a summary of the harmonic
dynamic response computation results.
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Computing Transient Dynamic Response
Solutions
This task shows how to compute a Transient Dynamic Response Case Solution.
The Compute command is most often applied to Analysis Case Solutions (which are
particular types of objects sets). In this case, it generates the analysis case solution,
along with partial results for all objects involved in the definition of the Analysis Case.
The primary Dynamic Solution Computation result consists of a set of critical load
excitation set factors and associated damping.
The program can compute simultaneously several Solution objects sets, with optimal
parallel computation whenever applicable.
This capability is only available with the ELFINI Structural Analysis product

.

Avoid having CATAnalysis documents automatically saved.
For this, go to Tools->Options->General (menu bar) and de-activate the Automatic
save every xx minutes option. Otherwise, on some models, each computation will be
followed by a Save, thus making temporary data become persistent data.
You can use the sample58_1.CATAnalysis document from the samples directory: you
created a Finite Element Model containing a Dynamic Response Case.
In this example, the Load Excitation set and the Damping set have been previously
defined.
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1. Double-click on the Transient Dynamic Response Case Solution.1 in the
specification tree to edit it.
The Transient Dynamic Response Set dialog box appears to let you define the
computation parameters.

❍

❍

❍

❍

Name: allows you to modify the name of the set.
Minimum sampling: allows you to define the minimum sampling parameters
(in s).
Maximum sampling: allows you to define the maximum sampling
parameters (in s).
Number of steps: allows you to define the number of steps between the
minimum and maximum sampling.

2. Modify the desired parameters.
In this particular example, enter:
❍
0s as Minimum sampling value
❍

20s as Maximum sampling value

❍

2000 as Number of steps value

3. Click OK in the Transient Dynamic Response Set dialog box.
4. Select the Transient Dynamic Response Solution object in the specification
tree.

5. Click the Compute icon

.
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The Compute dialog box appears as shown here:

6. Click OK in the Compute dialog box.
The Transient Dynamic Response Solution is computed.

Upon successful completion of the computation, the FE mesh is visualized on your
part, and the status of all objects in the analysis features tree up to the Dynamic
Response Solution objects set is changed to valid. You can now:
❍

analyze the report of the computation

❍

visualize images for various results

❍

visualize the 2D Display result
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Products Available in Analysis Workbench

The ELFINI Structural Analysis product offers the following additional feature:

●

●

●

●

●

If several Transient Dynamic Response Cases have been defined, you can compute
them simultaneously by following the same procedure.
To display CPU time and memory requirement estimates prior to launching any
computations, activate the Estimates switch in the Update dialog box.
The status and results of intermediate pre-processor computations necessary to
perform this translation are reported in HTML format. For more detail see the basic
global Report capability.
The Definition parameters of an Analysis Case (available, in the ELFINI Structural
Analysis product, in the New Case dialog box at the time of a Case Insertion) cannot
be modified once the Case has been created. These parameters must not be confused
with the Computation parameters of a Case Solution, which are proposed by default at
creation, and are editable afterwards.
To edit the default values of the Computation parameters of a Case Solution, doubleclick the Solution objects set in the analysis features tree (or right-click, then click
.Object -> Definition... ) to display the Dynamic Response Set dialog box.

The ELFINI Structural Analysis product offers the following additional features
on a Dynamic Response Solution objects set:
●

Generate Image: allows to generate the various images available along with the
Dynamic Response Solution objects set. The image can be edited to include part or all
of the options available.
Right-click the Dynamic Response Case object and then click the Generate Image
contextual menu (on the condition you previously computed a solution using the
Compute icon

).

The Image Choice dialog box is displayed. You can select images by clicking them in
the list.
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If you select the Current Occurrence button, the table below lets you choose the
desired Mode.

●

Report: the global status and results of all computations are reported in HTML format.
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Click the Basic Analysis Report
a solution using the Compute icon

icon (on the condition you previously computed
).

The .html partial report file is displayed. It contains a summary of the dynamic
response computation results.
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Computing Using a Batch
This task shows how to update and compute a .CATAnalysis document using a batch:
●

in local mode

●

in remote mode

Computing a document will enable the analysis of any object of Restraints, Loads and Masses type, without requiring the
computation of a Solution.
For more details about computation, please refer to Computing Object Sets.
To know how to use the batch monitor, please refer to Running Batches using the Batch Monitor in the Infrastructure User's
Guide.

Local Mode
1. Open the Batch Monitor.

For more details about the use of the Batch Monitor, please refer to Running Batches using the Batch Monitor in the
Infrastructure User's Guide.
2. Double-click AnalysisUpdateBatch in the Batch Monitor.

The AnalysisUpdateBatch dialog box appears.

❍

❍

File to Compute: lets you select the .CATAnalysis file you want to update and compute (using the Browse...
button).
Folder to Save Computed Data: lets you select the folder in which you will save the .CATAnalysis document
and the associated .CATAnalysisResults and .CATAnalysisComputations files (using the Browse... button).

❍

Run Local: lets you run the batch on your local machine.

❍

Run Remote - host name: lets you indicate the name of the remote machine on which the batch will be run.

❍

Licensing Setup...: lets you select a license authorizing the use of the batch you want to run.

❍

Save: lets you save the xml file in the desired location.

❍

Run: lets you run the batch.

❍

Cancel: lets you return to the batch monitor without launching the analysis batch.

3. Click the Browse... button to choose the file to compute.
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The File Selection dialog box appears to let you select the .CATAnalysis document you want to compute.
In this particular example, you can select the sample00.CATAnalysis from the samples directory and click OK in
the File Selection dialog box.

Note that the Folder to Save Computed Data field is automatically updated.
By default, this folder is the same as the .CATAnalysis document.
You can change the default folder.
4. Click the Browse... button if you want to change the folder in which the computed .CATAnalysis document (and the
associated .CATAnalysisResults and .CATAnalysisComputations files) will be saved.

The Folder Selection dialog box appears.
You can change the folder or create a new one.

5. Click Run in the AnalysisUpdateBatch dialog box.
6. Select the Processes tab of the Batch Monitor.

The batch computation has been successfully done if you get 0 as Return Code.
7. Right-click the AnalysisUpdateBatch line and select the Results contextual menu.
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The Results dialog box appears.

You can retrieve the computed .CATAnalysis file and also the associated .CATAnalysisResults and
CATAnalysisComputations files in the same folder.

Remote Mode

Page 628

Version 5 Release 14

Generative Structural Analysis

Page 629

The recommended methodology to work in remote mode with the AnalysisUpdateBatch batch is:

a. Send the .CATAnalysis file and the pointed documents from the client to the server using the Send To menu.
b. Run the AnalysisUpdateBatch batch on the server.
c. Send the .CATAnalysis file and the pointed documents (including the computed documents) from the server to the
client using the Send To menu.

You can find here the supported configurations (client and server machines must be in Network File System visible):

Server
Supported configurations
Windows

Windows

Unix

*

Client
Unix

*: for this configuration, a manual edition of the .xml batch parameter file is required:

a. Save the .xml parameter file as MyBatch.xml.
b. Edit the file and enter the path for the input .CATAnalysis file:
u/samples/MyAnalysis.CATAnalysis
c. Associate the modified .xml parameter file to the AnalysisUpdateBatch batch using the Associate a
parameters file contextual menu.
d. Edit the properties to specify the remote machine using the Properties contextual menu.
e. Run the batch using the Run contextual menu.

For more details about the edition of the .xml batch parameter file, please refer to Running Batches using the
Batch Monitor in the Infrastructure User's Guide.

1. Open the Batch Monitor.
2. Double-click AnalysisUpdateBatch in the Batch Monitor.
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The AnalysisUpdateBatch dialog box appears.

For more details about this dialog box, please click here.
3. Click the Browse... button to choose the file to compute.

The File Selection dialog box appears to let you select the .CATAnalysis document you want to compute.
In this particular example, you can select the sample00.CATAnalysis from the samples directory and click OK in
the File Selection dialog box.
Note that the Folder to Save Computed Data field is automatically updated.
By default, this folder is the same as the .CATAnalysis document.
You can change the default folder.

In remote mode, the folder you indicate in the Folder to Save Computed Data field will not be taken into
account.
4. Select the Run Remote option.

5. Enter the name of the remote machine in the host name field.
6. Click Run in the AnalysisUpdateBatch dialog box.
7. Select the Processes tab of the Batch Monitor.

The batch computation has been successfully done if you get 0 as Return Code.
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8. Right-click the AnalysisUpdateBatch line and select the Results contextual menu.

The Results dialog box appears.
The Updated file field gives you the directory (on the remote machine) of the computed file.
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Results Visualization
Image Creation: Generate images corresponding to analysis
results
Visualize Deformations
Create a deformed mesh image.

Visualize Von Mises Stresses
Create a von Mises stress field image.

Visualize Displacements
Create a displacement field image.

Visualize Principal Stresses
Create a principal stresses image.

Visualize Precisions
Create an error map image.

Analysis Results
Report
Create an analysis report.

Advanced Reporting
Extract existing information for creating an analysis report.

Historic of Computation
Read and if needed modify the graphical properties.
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Elfini Listing
Give ELFINI solver listing.

Results Management: Post-processes results and images
Animate Images
Animate an image.

Cut Plane Analysis
Examine results in a plane cut.

Amplification Magnitude
Scale the deformed mesh amplitude.

Extrema Detection
Search for global or local extrema of the analyzed field.

Edit the Color Palette
Edit the Palette on Von Mises display.

Information
Return information on generated images.

Images Layout
Tile layout images

Simplify Representation
Display a simplified representation while moving an image.
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Generate Images
Generate images that are not those included in the Image toolbar.
Edit Images
Select the required options so that you may get the desired image.
Save As New Template
Save an image as template.
Generate 2D Display Visualization
Generate a 2D visualization for modulations, sensors and dynamic solutions.
Export Data
Transfer data in a .txt or .xls file.

For every image type, you can edit the Color Palette.
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Visualizing Deformations
This task shows how to generate Deformed Mesh images on parts.
Deformed Mesh images are used to visualize the finite element mesh in the deformed
configuration of the system, as a result of environmental action (loading). Deformed Mesh
Image objects can belong to Static Case Solution objects sets or to Frequency Case Solution
objects sets.
Open the sample23.CATAnalysis document from the samples directory for this task.
Before You Begin:
●

●

Go to View -> Render Style -> Customize View and make sure the Edges points,
Shading and Materials option are active in the Custom View Modes dialog box.
Compute the solution.
For this, click the Compute icon

1. Click the Deformation icon

.

.

The Deformed Mesh object appears in the specification tree under the active Static
Case Solution objects set.

The Deformed Mesh on the part is visualized.
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2. Double-click the Deformed Mesh object in the specification tree to edit the image.

The Image Edition dialog box appears.
For more details about the Image Edition dialog box, please click here.
3. Click OK in the Image Edition dialog box.

The image corresponding to the settings you defined is now visualized.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional feature:
Right-click the Deformed Mesh object and select the Report contextual menu.
This option generates a report in .html and .txt formats.
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Visualizing Von Mises Stresses
This task shows how to generate von Mises images on part geometries.
Von Mises Stress images are used to visualize Von Mises Stress field patterns, which
represent a scalar field quantity obtained from the volume distortion energy density and
used to measure the state of stress.
Von Mises Stress Image objects belong to Static Case Solution objects sets.
The volume distortion energy density is often used in conjunction with the material yield
stress value to check part structural integrity according to the Von Mises criterion. For a
sound structural design, the maximum value of the Von Mises stress should be less than
this yield value.
Open the sample22.CATAnalysis document from the samples directory.
Before You Begin:
●

●

Go to View -> Render Style -> Customize View and make sure the Materials option
is active in the Custom View Modes dialog box.
Compute the solution.
For this, click the Compute icon

1. Click the Von Mises Stress icon

.

.

The Von Mises Stress image is displayed, and a Von Mises Stress (nodal value)
Image object appears in the specification tree under the active Static Case Solution
objects set.
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The Von Mises Stress distribution on the part is visualized in Iso-value mode, along
with a color palette.
You can visualize the Von Mises Stress image in different ways by modifying the
Custom view modes. To do this, you open the View menu and select Render Style > Customize View option.
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2. When the mouse cursor is passing over finite elements of the mesh, the values of
the Von Mises Stress are visualized at each of their nodes.

3. Select a finite element to obtain a steady display.
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4. Double-click the Von Mises Stress Image object in the specification tree to edit the
image.

The Image Edition dialog box appears.
For more details about the Image Edition dialog box, please click here.
5. Click OK in the Image Edition dialog box.

An image corresponding to your settings is visualized.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional feature:
Right-click the Stress Von Mises feature in the specification tree and select the Report
contextual menu.
This option generates a report in .html and .txt formats.
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Visualizing Displacements
This task shows how to generate Displacement images on parts.
Translational Displacement vector images are used to visualize displacement field
patterns, which represent a vector field quantity equal to the variation of position vectors
of material particles of the system as a result of environmental action
(loading). Translational Displacement vector Image objects can belong to Static Case
Solution objects sets or to Frequency Case Solution objects sets.
The displacement resulting from part loading is important for a correct understanding of the
way in which the part behaves.
Open the sample23.CATAnalysis document from the samples directory.
Before You Begin:
Compute the solution.
For this, click the Compute icon

1. Click the Displacement icon

.

.

The Translational Displacement vector image is displayed and a Translational
displacement vector Image object appears in the specification tree under the
active Static Case Solution objects set.
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The Translational displacement vector distribution on the part is visualized in arrow
symbol mode, along with a color palette.

2. When the mouse cursor is passing over vector arrow symbols, their components
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with respect to the global reference frame are visualized.

3. Select an arrow to obtain a steady display.
4. Double-click the Translational displacement vector Image object in the
specification tree to edit the image.

The Image Edition dialog box appears.
For more details about the Image Edition dialog box, please click here.
5. Click OK in the Image Edition dialog box.
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Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional feature:
Right-click the Translational displacement vector feature in the specification tree and
select the Report contextual menu.
This option generates a report in .html and .txt formats.
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Visualizing Principal Stresses
This task shows how to generate Stress principal tensor symbol images on part geometries.

Stress principal tensor symbol images are used to visualize principal stress field
patterns, which represent a tensor field quantity used to measure the state of stress and
to determine the load path on a loaded part.
Stress principal tensor symbol Image objects belong to Static Case Solution objects sets.
At each point, the principal stress tensor gives the directions relative to which the part is in
a state of pure tension/compression (zero shear stress components on the corresponding
planes) and the values of the corresponding tensile/compressive stresses.

Open the sample24.CATAnalysis document from the samples directory.
Before You Begin:
Compute the solution.
For this, click the Compute icon

.

1. Click the Principal Stress icon

.

The Stress principal tensor symbol image is displayed, and a Stress principal
tensor symbol Image object appears in the specification tree under the active
Static Case Solution objects set.
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You can visualize the Stress principal tensor symbol image in different ways by
modifying the Custom view modes. To do this, you open the View menu and select
Render Style -> Customize View option.
The principal values stress tensor distribution on the part is visualized in symbol
mode, along with a color palette:
❍

❍

At each point, a set of three directions is represented by line symbols (principal
directions of stress).
Arrow directions (inwards / outwards) indicate the sign of the principal stress.
The color code provides quantitative information.
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2. When the mouse cursor is passing over tensor symbol representations, their
principal values are displayed.

3. Select a tensor symbol to obtain a steady display.
4. Double-click the Stress principal tensor symbol object in the specification tree to
edit the image.

The Image Edition dialog box appears.
For more details about the Image Edition dialog box, please click here.
5. Click OK in the Image Edition dialog box.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional feature:
Right-click the Stresses Principal tensor object in the specification tree and select the
Report contextual menu.
This option generates a report in .html and .txt formats.
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Visualizing Precisions
This task shows how to generate Estimated local error images on parts.
Estimated local error images are used to visualize computation error maps, which
represent scalar field quantities defined as the distribution of energy error norm estimates
for a given computation.
Estimated local error Image objects belong to Static Case Solution objects sets.
The program evaluates the validity of the computation and provides a global statement
about this validity. It also displays a predicted energy error norm map which gives
qualitative insight about the error distribution on the part.
Open the sample25.CATAnalysis document from the samples directory.
Before You Begin:
●

●

Go to View -> Render Style -> Customize View and make sure the Edges,
Shading, Outline and Materials options are active in the Custom View Modes dialog
box.
Compute the solution.
For this, click the Compute icon

1. Click the Precision icon

.

.

The Estimated local error image is displayed and an Estimated local error Image
object appears in the specification tree under the active Static Case Solution objects
set.
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You can visualize the Estimated Error image in different ways by modifying the
Custom view modes. To do this, you open the View menu and select Render Style > Customize View option.
The Estimated local error distribution on the part is visualized in fringe pattern
mode, along with a color palette.

This map provides qualitative information about the way in which estimated
computation errors are relatively distributed on the part.
❍

If the error is relatively large in a particular region of interest, the computation
results in that region may not be reliable. A new computation can be performed
to obtain better precision.
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To obtain a refined mesh in a region of interest, use smaller Local Size and Sag
values in the mesh definition step.

2. When the mouse cursor is passing over a finite element, its Error Estimate (relative
strain energy variation) is displayed.

3. Select a finite element to obtain a steady display.
4. Double-click the Estimated local error object in the specification tree to edit the
image.

The Image Edition dialog box appears.
For more details about the Image Edition dialog box, please click here.
5. Click OK in the Image Edition dialog box.

Products Available in Analysis Workbench
The ELFINI Structural Analysis product offers the following additional feature:
Right-click the Estimated local error feature in the specification tree and select the
Report contextual menu.
This option generates a report in .html and .txt formats.
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Reporting
This task shows how to generate a report for computed solutions.
You can generate a report:
●

using the Basic Analysis Report icon

●

using the Report contextual menu (only available in the ELFINI Structural Analysis product)

A report is a summary of an objects set computation results and status messages, captured in an editable file.
Once an objects set has been computed (meaning that the user-defined specifications have been converted into solver
commands, which in turn have been transformed into degree of freedom data and processed), all data contained in
the object is ready for use in the subsequent finite element computation process and the object can be analyzed.
●

Open the sample56.CATAnalysis document from the samples directory.

●

Compute the solution. For this, click the Compute icon

.

Using the Basic Analysis Report Command
1. Click the Basic Analysis Report icon

.

The Reporting options dialog box appears.

❍

❍

❍

❍

Output directory:
Pressing the button on the right gives you access to your file system for defining a path for the output
Report file. You can edit the title of the report.
Title of the report:
Modify the title, if desired.
Add created images:
Add automatically in the basic report the images created in the selected case.
Choose the analysis case(s)

2. Set the path and click OK to close the dialog box.
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A HTML file containing the Report of the Static Case Solution objects set computation is displayed. It contains
information relative to the static computation procedure:

❍

restraints translation

❍

loads translation

❍

numbering

❍

SPC singularity auto-fixing

❍

constraints factorization

❍

stiffness computation

❍

constrained stiffness and loads computation

❍

stiffness factorization

❍

displacement computation

❍

reactions computation

❍

equilibrium checking

For example, you will find the image of the Von Mises Stress (nodal value) you previously generated.
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3. If needed, you can perform the same operation with the Frequency Case.

A HTML file containing the Report of the Frequency Case Solution objects set computation is displayed. It
contains information relative to the frequency computation procedure. In complement to the Static Case
Report, one finds items such as:
❍

a list of vibration frequencies

❍

a list modal participation factors

4. Click OK in the Reporting options dialog box.

In addition to the HTML Report file, the program also generates a Text file ready for user editing.
Click here to open the .txt file: sample02_Image_Loads.txt.

Using the Report contextual menu
Only available with the ELFINI Structural Analysis (EST) product.
You can access the Report contextual menu on images and on several pre-processor sets as Loads, Restraints, Mass,
Properties.
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1. Generate an image.

For more details, please refer to Generating Images.
2. Right-click on the image feature in the specification tree and select the Report contextual menu.

The Report automatically appears and can now be saved, if needed in the directory you wish using File ->
Save as... command.
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Advanced Reporting
This task shows how to extract the desired data and generate a report for computed solutions.
An advanced report is an extract summary of an objects set computation results and status messages, captured in a
.html file.

Only available with the ELFINI Structural Analysis (EST) product.
●

Open the sample56.CATAnalysis document from the samples directory.

●

Compute the solution: for this, click the Compute icon

.

1. Create an image. In this particular example, click the Deformation icon
2. Click the Advanced Reporting icon

.

.

The Reporting Options dialog box appears.

❍

Output directory: lets you change the directory in which you will store the .html advanced report.
The last selected path is automatically proposed.

❍

Title of the report: lets you modify the title of the .html advanced report.

❍

Choose the analysis case(s): lets you choose the analysis case for which you want to work.
Multi-selection of analysis cases is available.

3. Modify the Output directory by clicking the ... button and choose the desired path.
4. Modify the name of the report if needed.

In this particular example, enter Analysis Report (56) as Title of the report option.
5. Choose the desired analysis case(s).
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In this particular example, select Frequency Case.

6. Click OK in the Reporting Options dialog box.
The Advanced reporting options dialog box appears and lets you define which information you wish to extract
from all the specifications before launching the browser, creating and if needed updating the output Report
file.
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There are two windows in the Advanced reporting options dialog box. The left window displays the data
corresponding to the specification tree. The right window displays the data which you want to appear in the
advanced report:
❍

Left window: contains all the entities you can export in the report. You can select a node to expand it (you
can also double-click the entity associated to this node). The entity types are:
■
Text:
■
Make description
■

■

Computation summary

Images: grouped according to the physical types. Each time you add an image in the report, the
representation is performed using the current viewpoint.
■
pre-defined images
■

user images

❍

Right window: contains all the entities which will be contained in the report.

❍

Launch browser: this button lets you launch the .html navigator.

7. Select all the desired entities.

In this particular example, double-click:
❍

Make description (under Frequency Case Solution.1),

❍

Translational displacement magnitude (under 3D translational vector) as pre-defined image,

❍

Deformed Mesh (under Frequency Case Solution.1) as user image.

8. Click OK in the Advanced Reporting Options dialog box.

In addition to the HTML report file, the program also generates a text (.txt) file in the same output directory.
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Reading a Historic of Computation
This task shows how to read and if needed modify the graphical properties of a Historic of Computation.
A Historic of computation allows comparing new values possibly assigned to a CATAnalysis. For this you
need to perform at least two computation operations.
You can use the sample30.CATAnalysis document from the samples directory for this task.
Before You Begin:
●

●

Go to View -> Render Style -> Customize View and make sure the Materials option are active in
the Custom View Modes dialog box.
Compute the solution. For this, click the Compute icon

.

1. Assign Global Error and Von Mises sensors. For this, right-click on Sensors in the specification
tree and select the Create Sensor contextual menu. Select misesmax option from the Sensor
Creation dialog box and then click OK. Repeat the same operation for creating the globalerror
sensor.

2. Click the Compute icon

(All option).

3. Modify the Global Mesh Size. For this, double-click in the specification tree on the OCTREE
Tetrahedron Mesh.1 object and modify the size value to 10 mm.

4. Click the Compute icon

(All option).

5. Select the Local Mesh Size icon
global size value to 5 mm.

, the desired support (for example, a face) and modify the
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(All option).

7. Click the Historic of Computations icon

.

The Convergence of computation visualization dialog box is displayed with the Historic of
Computation for the current case. You can select the different options at the right of the dialog
box and thus display the convergence information as desired:
❍
By default: Number of Elements, Number of Nodes.
❍

❍

Static Case: energy, mises max, disp max, global error (results based on created sensors). If
Adaptivity boxes were previously created, one local error per box appears on the graph.
Frequency Case: frequency for each mode requested in the computation operation (results
based on created sensors).

Global Precision
Note that if you position the cursor on the graph, the corresponding coordinates automatically
appear at the bottom of the Convergence of computation visualization dialog box.
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You can edit the graph. For this:
8. Double-click on the line you want to edit. In this example, the Global Precision line.
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The EditPopup dialog box appears:

You can modify the following Graphic Attributes and then click OK:
❍

Function Name: enter the desired new name.

❍

Show: you can show or not points and lines.

❍

Line: you can modify the line type, color and thickness.

❍

Point: you can modify the type and color of the points.

You will get this in the Convergence of computation visualization dialog box:
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Elfini Listing
This task shows how to extract the desired data and generate a Report for Computed
Solutions. The generated file is called FICELF.
The Elfini Listing file contains all the computation data of all the documents you computed in
a CATIA session.

When restarting a CATIA session, a new FICELF file is generated.
If you want to store the particular CATIA session FICELF, you have to copy it after closing
the CATIA session.

Open the sample02_Image_Loads.CATAnalysis document from the samples directory.

1. Click the Elfini Listing icon

.

The Elfini Listing dialog box appears.

The Modify button lets you change the Elfini Listing Folder location.
2. Click the Modify button.

The Selection dialog box appears.
3. Select the desired path in the Selection dialog box and click OK.
4. Click OK in the Elfini Listing dialog box.
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Animating Images
This task shows how to animate one image or a multi-selection of images.
Image Animation is a continuous display of a sequence of frames obtained from a given image. Each frame
represents the result displayed with a different amplitude. The frames follow each other rapidly giving the
feeling of motion.
By animating a deformed geometry or a normal vibration mode, you can get a better insight of the behavior of
the system. Sometimes, you gain a more thorough understanding of the system behavior.
Open the sample26.CATAnalysis document from the samples directory.
Before You Begin:
●

●

Go to View -> Render Style -> Customize View and make sure the Edges and points option is not
active and the Materials option is active in the Custom View Modes dialog box.
Compute the solution.
For this, click the Compute icon

●

.

Activate the Stress Von Mises image.
For this, right click the Von Mises Stress (nodal value) feature from the specification tree and select the
Activate/Deactivate option from the displayed contextual menu.

1. Click the Animate icon

.

The Animation dialog box appears and the image is animated with default animation parameters.

❍

Slider: lets you manually select the desired step.

❍

Play:
■

: Jump to Start

■

: Play Backward

■

: Steps Backward
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❍

■

: Pause

■

: Steps Forward

■

: Play Forward

■

: Jump to End
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Change loop mode:
■

: plays once in one shot

■

: repeats play non stop

■

: repeats play and reverse non stop

For a smooth animation enter the maximum value (20) as Steps number option and activate the
Repeat play and reverse non stop button.
❍

Steps number: makes the animation more or less fluent.

❍

Speed: lets you manually define the desired speed.

❍

More: this button expands the Animation dialog box.

The options available in this part of the dialog box depend on the solution type (mono-occurrence
or multi-occurrence).
Mono-occurrence solutions:
By default, you can access the following options:

: use non symmetrical animation (default value).

■

■

Interpolate values: animate the interpolated values of the activated image.

■

Interpolate displacements: animate the interpolated displacements of the activated
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image.

: use symmetrical animation.

■

Multi-occurrence solutions:
■

All occurrences: animate all the occurrences of the solution.
■

When activated, this option allows you to choose whether you want to memorize frames:

The frame animation will be speed driven but memory consuming. If you do not activate
the Memorize frames option, the frame animation will need less memory but will be
slower.

■

One occurrence: animate the selected occurrences of the solution.

■

: this button lets you select the previous occurrence.

■

: this button lets you select the next occurrence.

: this button lets you select the desired occurrence using the Frequencies dialog box.

■

When clicking this button, the Frequencies dialog box appears.
Multi-selection is not available in the Frequencies dialog box.

: use non symmetrical animation (default value).

■

■

Interpolate values: animate the interpolated values of the activated image.

■

Interpolate displacements: animate the interpolated displacements of the activated
image.

■

: use symmetrical animation.

2. Click the Pause button

.
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The animation is interrupted.
You access any point of the simulation at random using the slider.

3. If needed, modify the Steps Number and click the More button.
Both the the dialog box and the model appear as shown here:

4. Click the non symmetrical animation button

.
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Both the dialog box and the model appear as shown here:

5. Click the Play Forward button

.

Animation is resumed, with the new settings taken into account.
6. Click Close in the Animation dialog box.

●

The animation capability is also available for Frequency Solutions.

●

You can use the image animation with tiled images using the Images Layout functionality.
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Cut Plane Analysis
This task shows how to use the Cut Plane Analysis capability.
Cut Plane Analysis consists in visualizing results in a plane section through the structure.
By dynamically changing the position and orientation of the cutting plane, you can rapidly analyze the results
inside the system.
Open the sample26.CATAnalysis document from the samples directory.
Before You Begin:
●

●

●

Go to View -> Render Style -> Customize View and make sure the Materials option is active in the
Custom View Modes dialog box.
Compute the solution. For this, click the Compute icon

.

Activate the Stress Von Mises image.
For this, right click the Von Mises Stress (nodal value) feature from the specification tree and select the
Activate/Deactivate option from the displayed contextual menu.

1. Position the compass on the face that will be considered as the reference section.

Note that: if you do not position the compass, the compass will be automatically positioned on the part,
with a Cutting Plane normal to its privileged direction.
2. Click the Cut Plane Analysis icon

.
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The Cutting Plane appears.

The Cut Plane Analysis dialog box is displayed.

3. Handle the compass using the cursor and rotate or translate the Cutting Plane.
4. Activate the View section Only option in the Cut Plane Analysis dialog box to see the section relatively
to the position of the cutting plane.

5. De-activate the Show cutting plane option in the Cut Plane Analysis dialog box to see only the
boundary of this cutting plane.
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6. Click Close in the Cut Plane Analysis dialog box.

●

The cut plane capability is also available for Frequency Solutions.

●

All the existing images will be cut, if needed.

●

You can use the Cut Plane Analysis with tiled images using the Images Layout functionality.
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Amplification Magnitude
This task shows how to use the Amplification Magnitude functionality.
Amplification Magnitude consists in scaling the maximum displacement amplitude for
visualizing a deformed image.

Open the sample26.CATAnalysis document from the samples directory.
Before You Begin:
●

●

●

Go to View -> Render Style -> Customize View and make sure the Materials option
is active in the Custom View Modes dialog box.
Compute the solution. For this, click the Compute icon

.

Activate the Stress Von Mises image.
For this, right click the Von Mises Stress (nodal value) feature from the specification
tree and select the Activate/Deactivate option from the displayed contextual menu.

1. Click the Amplification Magnitude icon

.

The Amplification Magnitude dialog box appears.
❍

Scaling factor: lets you modify the amplification magnitude for deformation
visualization using a constant scale factor

■

Cursor: lets you dynamically modify the scale factor from 0 to a maximal
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value

❍

■

Factor: lets you specify the scaling factor

■

Default: lets you return to the default scaling factor

Maximum amplitude: lets you modify the amplification magnitude for
deformation visualization using a constant maximum amplitude (artificial)

■

Length: lets you specify the value of the maximum allowed deformation on
the image (in mm)
The default unit for the Length option is fixed in the Options dialog
box (General -> Parameters and Measure -> Units tab).
For more details, please refer to the Infrastructure User's Guide.

■

❍

Default: lets you return to the default amplification magnitude

Set as default for future created images: lets you apply the modified
amplification magnitude parameter (factor or length) to the future created
images

To summarize:

To visualize the real deformation, the scaling factor must be equal to 1.
2. Select the Scaling factor option in the Amplification Magnitude dialog box.
3. Enter 300 as Factor value and press Enter.
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As a result, the deformation is increased.

4. Click the Default button and then click OK in the Amplification Magnitude dialog
box.

The image retrieves the default deformation.

5. Modify the value of the load.
In this particular example:
❍
double-click the Distributed Force.1 load in the specification tree
❍

enter 1000N as Z value

❍

click OK in the Distributed Force dialog box

6. Activate the Von Mises Stress image.
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A message informs you that the solution must be updated.
Click OK to update the solution.

In this case, the real deformation is more important.
So the deformation visualization is more important with a constant scaling factor.
7. Click the Amplification Magnitude icon.
The Amplification Magnitude dialog box appears.
8. Select the Maximum amplitude option in the Amplification Magnitude dialog box.

The Length value is different:

9. Click the Default button and click OK in the Amplification Magnitude dialog box.

The Length value is equal to 27.985mm.
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10. Modify the load value.
In this particular example:
❍
double-click the Distributed Force.1 load in the specification tree
❍

enter 500N as Z value

❍

click OK in the Distributed Force dialog box

11. Activate the Von Mises Stress image.

A message informs you that the solution must be updated.
Click OK to update the solution.

In this case, the real deformation is less important, but the deformation visualization
is the same with a constant maximum amplitude.
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Extrema Creation
This task shows how to use the Extrema Creation capability.
Extrema Creation consists in localizing points where a results field is maximum or minimum. You can ask the program to
detect either one or both global extrema and an arbitrary number of local extrema for your field.
Open the sample26.CATAnalysis document from the samples directory.
Before You Begin:
●

●

●

Go to View -> Render Style -> Customize View and make sure the Materials option is active in the Custom View
Modes dialog box.
Compute the solution. For this, click the Compute icon

.

Activate the Stress Von Mises image. For this, right click the Von Mises Stress (nodal value) feature from the
specification tree and select the Activate/Deactivate option from the displayed contextual menu.

1. Click the Image Extrema icon

.

The Extrema Creation dialog box appears.

You can ask the program to detect given numbers of global (on the whole part) and/or local (relatively to neighbor
mesh elements) extrema at most, by setting the Global and Local switches.
❍

❍

If you activate the Global option, you will launch the detection of the minimum and maximum global extrema.
Global means that the system will detect all the entities which have a value equal to the Minimum or Maximum
value.
If you activate the Local option, you will launch the detection of the minimum and maximum local extrema. Local
means that the system will search all the entities which are related to the Minimum or Maximum value compared to
the two-leveled neighboring entities.

For more details about local extrema computation, please refer to Post-Processing and Visualization in the Frequently
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Asked Questions section.
2. Enter the desired parameters in the Extrema Creation dialog box.
3. Click OK in the Extrema Creation dialog box.

A new image corresponding to the default settings is displayed, with two arrow boxes locating the points of absolute
extremum for the current field and containing information about the detected value.

The Extrema object set containing the two Global Extrema appears under the current Image object in the specification
tree.

4. Double click the Extrema object set in the specification tree.

The Extrema Edition dialog box appears.
You can modify the objects set by setting the Global and Local switches.
5. Deactivate the Global option and activate the Local option.

The boxes locating the global extrema disappear, and symbols locating the local extrema are visualized.
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The Extrema objects set in the specification tree now contains, in addition to the two Global Extrema objects, as
many Local Extremum (Maximum or Minimum) objects as you have required.
6. Double-click one of the Local Extremum objects in the specification tree.

The Extremum Edition dialog box appears.

7. Select the Show Label option and click OK in the Extremum Edition dialog box.

A new arrow box is visualized, locating the position of the corresponding point and containing information about the
detected value.

The extrema detection capability is also available for images obtained under Frequency and Buckling Solutions.
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Editing the Color Palette
This task shows how to edit and lock the Color Palette on a Von Mises Stress display.
The Von Mises Stresses, the Displacements, the Precision, the Principal Stress distributions are employed along with
a Color Palette. Editing the palette enables you to emphasize on particular values spread on the parts.
Open the sample26.CATAnalysis document from the samples directory.
Before You Begin:
●

●

●

Go to View -> Render Style -> Customize View and make sure the Edges points option is not active and
the Materials option is active in the Custom View Modes dialog box.
Compute the solution. For this, click the Compute icon

.

Activate the Stress Von Mises image.
For this, right click the Von Mises Stress (nodal value) feature from the specification tree and select the
Activate/Deactivate option from the displayed contextual menu.

1. Double click on the color palette to edit it.
The Color Map Edition dialog box appears.
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❍

On boundary: lets you choose to compute the colors according to the boundary or the overall model.

❍

Number of colors: lets you modify the number of colors.

❍

Smooth: lets you smooth the colors.

❍

Inverse: lets you inverse the colors order.

❍

Imposed max: lets you impose a maximal value.

❍

Imposed min: lets you impose a minimal value.

❍

More/Less buttons: lets you enlarge/reduce the Color Map Edition dialog box.
The More/Less buttons are only available if you installed the ELFINI Structural Analysis
product.

■

Distribution mode:
■
Linear: regular values distribution between the minimum value (computed or imposed)
and the maximum value (computed or imposed).
■

Histogram: values distribution so that each interval contains the same number of
entities.
Only available if the Imposed max and Imposed min options are deactivated.

■

Logarithmic: logarithmic values distribution between the minimum value (computed or
imposed) and the maximum value (computed or imposed).
Only available if the minimum value (computed or imposed) is strictly positive.

■

Distribution edition: it is possible to edit the distribution using contextual menus.
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You can as well impose a particular value for a threshold in order not to modify it when
setting other values. (impose)
After each new value entered for a threshold, the list is computed to take into account the
potential interactions between this threshold and the two other thresholds which flank it. If
an interaction is detected, the former values are distributed taking into account if possible
the imposed values. (edit)
■

Display Format:
■
Style: Scientific, Decimal and Automatic
■

Number of significant digits

2. Modify the desired parameters.
3. Right-click the first value of the distribution.

4. Select the Impose contextual menu.
As a result, the Imposed value is Yes as shown bellow:

5. Right-click the first value of the distribution.

6. Select the Release contextual menu.
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As a result, the Imposed value is No as shown bellow:

7. Right-click the first value of the distribution.
8. Select the Edit... contextual menu.
The Edit Value dialog box appears.

In this particular example, enter 2.6e+007 and click OK in the Edit Value dialog box.
As a result, the value you have just edited is automatically imposed as shown bellow:

9. Click on Apply to check if the palette fits. If yes, click on OK.
The palette dialog box disappears and the modifications will be valid only for this display.
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You can move the Palette in the viewer.
10. Select the Palette and move it with the middle mouse button to the desired place.
When the Palette is selected, the part viewer is deactivated and the part is shaded.

11. Click again on the Palette to fix it there.

You can lock the palette (global maxima and minima).
This functionality is only available if you installed the ELFINI Structural Analysis product.
At any time, you can lock / unlock the Color Palette.
When a palette is locked, the color values are not updated anymore whatever the modifications you perform on the
image (using the Selections tab of the Image Edition dialog box).
It is an alternative to the Imposed min and Imposed max options and an easy way to set the palette scale being
independent of what is visualized.
For example, when dealing with an assembly, and if you select one part in the assembly, the palette is automatically
updated and all the colors are now defined in accordance with the selected color.

You can use the Analysis2_Lock01.CATAnalysis document from the samples directory.
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1. Select the part of which you want to lock the color, right-click the color palette and select the Lock
contextual menu.
2. Double-click an image of one part in the assembly.

The Palette is as follows:

3. Select the desired part (in the Image Edition dialog box (Selections tab), right-click the color palette and
select the Lock Option from the contextual menu.
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The selected color in the selected part now becomes some kind of a reference color.

The Palette is as follows (local maxima and minima now appear):

4. Select the All product in the Image Edition dialog box (Selections tab).
The colors of the whole product are modified according to the reference color. This color becomes the
reference color for the whole product. As a result all the other colors are set accordingly.
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The Palette is as follows (local maxima and minima are kept even though you are now using global maxima
and minima):
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Information
This task shows how to get information on one or more images and extrema you generated.
Open the sample15.CATAnalysis document from the samples directory for this task.
Before You Begin:

●

●

Compute the solution. For this, click the Compute icon

.

Right-click on the Static case solution feature in the specification tree and select the
Generate image option from the displayed contextual menu. Then select the Stress
full tensor component (nodal values) image from the Image choice dialog box.

1. Click the Information icon

.

2. Select the Stress full tensor component (nodal values) image from the
specification tree.
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The Information dialog box now appears with information on the selected image.

Note that you can add more information on another generated image by selecting
this image from the specification tree. The information on this secondly selected
image will appear in the box following the information on the image first selected.
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The information displayed in the Information dialog box depends on the type
of the image selected:

Type of Image

Type of Information

Deformed Mesh

Estimated Local

Any Other

Error

Type of
Image

Object Name

Display (On Boundary
or all elements ; Over
Local Selections or all
the Model)

Mesh Statistics (nodes
and elements)

Extrema Values (Min
and Max)

Surface elements vs
Volume elements

Process List
(component, name,
position)
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Used Materials (and
Yield Strength)

Precision Location

Estimated Precision

Strain Energy

Global Estimated
Error Rate

For Frequency cases or Buckling cases, in addition, you are informed on the
Mode Number and Mode Value.
3. You can also get information on an extremum (global or local).

For this, select an extremum in the specification tree and click the Information icon
.
The Information dialog box appears and gives you information on the selected
extremum.

To know more about extrema, please refer to Extrema Creation in this
guide.
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Images Layout
This task shows how to tile layout images.
Generated images corresponding to analysis results are superimposed into one image that cannot be
properly visualized. You can tile these superimposed images into as many layout images on the 3D
view.

Only available with the ELFINI Structural Analysis (EST) product.
Open the sample13.CATAnalysis document from the samples directory for this task.
Before You Begin:
●

Go to View -> Render Style -> Customize View and make sure the Shading, Outline and
Materials options are active in the Custom View Modes dialog box.

●

Compute the static solution.

●

Activate at least two images.
For this, right-click, one after the other, the Von Mises Stress and then the Deformed Mesh
images in the specification tree and select the Activate/Deactivate contextual menu.

1. Click the Images Layout icon

.

The Images Layout dialog box appears.

❍

Explode:
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Along: lets you specify the axis (X, Y or Z axis) or the plane (XY, XZ or YZ
plane) along which you want to explode the image visualizations.
Distance: lets you specify the distance between two images.
The Default button lets you retrieve an optimum Distance value.

Default: lets you retrieve the default superimposed visualization.
The Default option is only available if you have already explode the image
visualization.

2. Select the X axis option and enter 200mm as Distance value.
3. Click OK in the Images Layout dialog box.

The image visualization are tiled along the X axis.

4. Click the Images Layout icon

and select the Default option in the dialog box as shown

bellow:

5. Click OK in the Images Layout dialog box.
6. Activate the Translational displacement vector image.

7. Click the Images Layout icon

and select the Explode option.

8. Select XZ as Along option, enter 100mm as Distance value and click OK in the Images
Layout dialog box.
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●

You can animate one or more of these images, if desired.

●

Be careful: the cutting plane will cut all the images.
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Simplifying Representation
This task shows how to display a simplified representation while moving an image.

Only available with the ELFINI Structural Analysis (EST) product.
●

An image must must have been created.

●

The image must be activated.

Open the sample26.CATAnalysis document from the samples directory.
Before You Begin:
●

●

Go to View -> Render Style -> Customize View and make sure the Edges, Shading, Outline and
Materials options are active in the Custom View Modes dialog box.
Compute the solution.
For this, click the Compute icon

●

.

Activate an image.
In this particular example, right-click the Von Mises Stress (nodal value) image in the specification
tree and select the Activate/Deactivate contextual menu.

1. Click the Simplified Representation icon

.

2. Select an image in the specification tree.

In this particular example, select the Von Mises Stress (nodal value) image in the specification
tree.
The Simplified Representation dialog box appears.

❍

None: no simplified representation

❍

Bounding box: displays the image bounding box while moving

❍

Compressed: reduces the number of graphical entities of the representation.
The Rate list lets you choose the desired degree of reduction (Low, Medium, High).
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The Compressed option is not available in the following cases:
■
Text image type
■

■

■

■
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Symbol image type
the Shrink coefficient is not equal to 1.00 (for more details, please refer to the
Visualization Options dialog box)
the Display element without value is activated (for more details, please refer
to the Visualization Options dialog box)

This option could require significant computation time, so the Compressed
Representation status bar appears to inform you about the progress of compression:

At any time, you can click the Cancel button to stop the compression process.
3. Select the Bounding Box option.
4. Click OK in the Simplified Representation dialog box.
5. Zoom, pan or rotate the image.

The bounding box representation appears as shown bellow:

As soon as you release the mouse buttons, the bounding box representation is hidden.
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The current simplified representation is lost if you:
●

edit the image,

●

activate/deactivate the image,

●

close the CATAnalysis file even if you saved it.

Restrictions
a. Some visualization elements are not taken into account by the Compressed representation mode
❍

nodes (visualized using the Display nodes option)

❍

small elements (visualized using the Display small elements option)

b. Images with isolines:

Here you can find an example of isoclines:

The isolines are visible if you deactivate the Material option in the Custom View Modes dialog box
(View -> Render Style -> Customize View menu).
In this case, the isolines are not taken into account by the Compressed representation mode.
c. The Compressed representation is not displayed while moving in the following cases:
❍

the Triangles option is activated in the Custom View Modes dialog box (View -> Render Style
-> Customize View menu).

❍

the Shading option is deactivated in the Custom View Modes dialog box (View -> Render
Style -> Customize View menu) when visualizing a fringe image type.
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Generating Images
This task shows how to generate images in addition to those of the Image toolbar using a
contextual menu from the following sets:
●

Analysis Case Solution

●

Nodes and Elements

●

Loads

●

Masses

●

Restraints

●

Properties

Only available with the ELFINI Structural Analysis (EST) product.

Open the sample00.CATAnalysis document from the samples directory for this task.
Before You Begin:

Compute the solution. For this, click the Compute icon

.

1. Right-click the desired set in the specification tree and select the Generate Image
contextual menu

.

In this particular example, select the Static Case Solution.1 set in the specification
tree.
The Image Generation dialog box appears.
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❍
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Available Images: lists all the available images you can generate.
You will find bellow the list of the available images according to the set
from which they have been generated:

❍

■

Analysis Solution

■

Nodes and Elements

■

Loads

■

Masses

■

Restraints

■

Properties

Current occurrence: lets you select the current occurrence you want to
visualize.
This option is only available for the multi-occurrence analysis solutions.

❍

Deactivate existing images: lets you deactivate the display of all the images
you have previously generated.

2. Select the type of the image you want to generate in the Available Images list.
3. Select the desired Current occurrence.

Version 5 Release 14

Generative Structural Analysis

Page 701

This option is only available for the multi-occurrence analysis solutions.

For this, click the Select button.
The Frequencies dialog box appears.

4. If desired, select the Deactivate existing images option.
5. Click OK in the Image Generation dialog box.

The image is automatically generated. The feature of the newly generated image
appears in the specification tree under the selected set.

For the Frequency Case, the mode shapes are arbitrarily normalized
displacements. In this case, the images of stress and energy results give
only tendencies related to these mode shapes.

Analysis Solutions
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Meaning

Case Solution Type

Deformed Mesh

Deformed mesh

Static Case
Frequency Case
Free Frequency Case
Buckling Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Stress principal tensor
component (element's
nodes values)

Stress principal tensor.
Discontinuous iso-value image
of one algebraic component.
The first component is
displayed by default. This
component can be changed
through the Filter option
(Image Editor dialog box).

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Stress principal tensor
symbol

Stress principal tensor.
Symbols of tensor algebraic
values.

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Stress full tensor
component (element's
nodes values)

Static Case
Iso-value image of one
Frequency Case
component of the Stress
Free Frequency Case
Tensor. The first component is Combined Case
displayed by default. This
Static Constrained Mode
component can be changed
Harmonic Dynamic Response
through the Filter option
Case
Transient Dynamic Response
(Image Editor dialog box).
Case

Stress full tensor
component (nodal
values)

Static Case
Iso-value image of one
Frequency Case
component of the Stress
Free Frequency Case
Tensor. The first component is Combined Case
displayed by default. This
Static Constrained Mode
component can be changed
Harmonic Dynamic Response
through the Filter option
Case
Transient Dynamic Response
(Image Editor dialog box).
Case
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Stress full tensor text

Translational
displacement
magnitude

Translational
displacement
component

Translational
displacement vector

Von Mises Stress
(nodal values)
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Stress full tensor values at
nodes. By default, the six
components are displayed. A
given component can be
displayed through the Filter
option (Image Editor dialog
box).

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Iso-value image of the nodal
translation displacements
magnitude.

Static Case
Frequency Case
Free Frequency Case
Buckling Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Iso-value image of one
component of the nodal
translation displacements.
This component can be
changed through the Filter
option (Image Editor dialog
box).

Static Case
Frequency Case
Free Frequency Case
Buckling Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Symbols of the translation
displacements vector.

Static Case
Frequency Case
Free Frequency Case
Buckling Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Iso-value image of nodal
VonMises stress.

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case
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Von Mises Stress
(element node values)

Static Case
Frequency Case
Free Frequency Case
Discontinuous iso-value image Combined Case
of element's nodal VonMises
Static Constrained Mode
stress.
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Estimated local error

Fringe image of element's
energy error estimation.

Static Case
Combined Case

Strain principal tensor
component (nodal
values)

Iso-value image of one
component of the nodal
rotational displacements. This
component can be changed
through the Filter option
(Image Editor dialog box).

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Strain full tensor
component (nodal
values)

Static Case
Iso-value image of one
Frequency Case
component of the Strain
Free Frequency Case
Tensor. The first component is Combined Case
displayed by default. This
Static Constrained Mode
component can be changed
Harmonic Dynamic Response
through the Filter option
Case
Transient Dynamic Response
(Image Editor dialog box).
Case

Strain principal tensor
symbol

Rotational
displacement
magnitude

Strain principal tensor.
Symbols of tensor algebraic
values.

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Iso-value image of the nodal
translation displacements
magnitude.

Static Case
Frequency Case
Free Frequency Case
Buckling Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case
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Rotational
displacement vector

Symbols of the rotational
displacements vector.

Static Case
Frequency Case
Free Frequency Case
Buckling Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Friction force ratio iso

iso value image of the friction
force ratio.

Static Case

Point force vector

Symbols of the nodal force
reactions.

Static Case
Static Constrained Mode

Point moment vector

Symbols of the nodal moment Static Case
reactions.
Static Constrained Mode

Local strain energy

Local strain energy
density

Local strain energy
symbol

Force Flow text

Moment flow text

Transverse shear
strain text

Fringe image of element
strain energy

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode

Fringe image of element
strain energy density

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode

Symbol of strain energy

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode

Text of force flow

Static Case
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Text of moment flow

Static Case
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Text of transverse shear
strain

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case
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Transverse shear
stress text

Text of transverse shear
stress

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Translational velocity
vector

Symbol of translational
velocity

Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Translational
acceleration vector

Symbol of translational
acceleration

Harmonic Dynamic Response
Case

Symbol of rotational velocity

Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Rotational velocity
vector

Rotational acceleration Symbol of rotational
vector
acceleration

Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Curvature text

Text of curvature

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Pressure fringe

Fringe image of pressure

Static Case

Pressure vector

Symbol of pressure

Static Case

Pressure (nodal value)

Iso-value image of pressure

Static Case

Clearance iso

Iso value image of final
clearance

Static Case

Mass moment of
inertia (text)

Text of mass moment of
inertia (spring element)

Static Case
Frequency Case
Static Constrained Mode

Point Mass

Symbol of nodal mass

Static Case
Frequency Case
Static Constrained Mode
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Surface stress
principal tensor
symbol

Relative acceleration
vector

Relative translational
displacement vector

Relative velocity
vector
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Symbol of surface stress
principal tensor

Static Case
Frequency Case
Free Frequency Case
Combined Case
Static Constrained Mode
Harmonic Dynamic Response
Case
Transient Dynamic Response
Case

Symbol of nodal mass

Harmonic Dynamic Response
Case
(restraint excitation)
Transient Dynamic Response
Case
(restraint excitation)

Symbol of nodal mass

Harmonic Dynamic Response
Case
(restraint excitation)
Transient Dynamic Response
Case
(restraint excitation)

Symbol of nodal mass

Harmonic Dynamic Response
Case
(restraint excitation)
Transient Dynamic Response
Case
(restraint excitation)

Nodes and Elements
Image Names

Meaning

Mesh

Mesh

Elements text

Elements numbers

Nodes text

Nodes numbers

Degrees of
freedom

Nodal symbol of fixed degrees
of freedom

Local axis

Symbol of local axis

Physical type
fringe
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Fringe image of the element
physical type

Coordinate symbol
Nodal coordinate symbol
node

Loads
Image Names

Meaning

Load type

Translational
displacement
magnitude

Iso-value image of the
nodal translation
Enforced Displacement
displacements magnitude.

Translational
displacement
component

Iso-value image of one
component of the nodal
translation displacements.
This component can be
Enforced Displacement
changed through the
Filter option (Image
Editor dialog box).

Translational
displacement vector

Symbols of the translation
Enforced Displacement
displacements vector.

Rotational
displacement
magnitude

Iso-value image of the
nodal translation
Enforced Displacement
displacements magnitude.

Rotational
displacement vector

Symbols of the rotational
displacements vector.

Enforced Displacement

Point moment vector

Symbols of the nodal
moment reaction

Distributed force
Moment
Bearing load

Point force vector

Symbols of the nodal
force reactions.

Distributed Force
Moment
Bearing Load

Angular acceleration
vector

Symbol of the modal
angular acceleration.

Rotation Force

Generative Structural Analysis
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Angular velocity vector

Symbol of the modal
angular velocity.

Rotation Force

Acceleration vector

Symbol of the modal
angular nodal
acceleration.

Acceleration

Line force vector

Symbols of the nodal
force reactions.

Line Force Density

Surface force vector

Symbols of the nodal
force reactions.

Surface Force Density

Volume force vector

Symbols of the nodal
force reactions.

Body Force

Pressure vector

Symbols of vector
pressure on face of
elements.

Pressure

Pressure Fringe

Fringe image of contact
pressure on face of
elements.

Pressure

Pressure (nodal
values)

Iso value image of
average modal pressure.

Pressure

Temperature field
symbol

Symbols of temperature
field

Load

Local axis symbol

Symbol of local axis

Load

Masses
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Meaning

Mass type

Point mass symbol

Symbols of nodal mass

Mass

Point mass text

Text of nodal mass

Mass

Line mass symbol

Symbols of line mass

Mass

Line mass text

Texts of line mass

Mass

Surface mass symbol

Symbols of surface mass

Mass

Surface mass text

Texts of surface mass

Mass

Volume mass symbol

Symbols of volume mass

Mass

Volume mass text

Texts of volume mass

Mass

Restraints
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Meaning

Restraint type

Degrees of freedom
symbol

Clamp
Nodal symbol of the fixed Surface slider
degrees of freedom.
Restraint
Iso-Static Restraint

Local axis symbol

Symbol of local axis

Properties
Image Names

Meaning

Geometry Type

Area moment of inertia

Text of area moment of
inertia

1D

Area shear ratio in XY
plane (text)

Cross sectional area
above shear area in XY
plane

1D

Area shear ratio in XZ
plane (text)

Cross sectional area
above shear area in XZ
plane

1D

Clearance iso

Iso-value image of initial
clearance

Composite angle
symbol

Symbol of angle

2D composite

Cross sectional area
fringe

Fringe image of beam
element cross sectional
area

1D

Laminate number
fringe

Number of laminate in
fringe visualization

2D composite
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Laminate number text

Number of laminate in
text visualization

2D composite

Local axis symbol

Symbol of local axis

3D
2D
1D

Material fringe

Fringe image of element
material

3D
2D
1D

Material text

Text image of element
material

3D
2D
1D

Orientation vector
(symbol)

Symbol of orientation of
beam connection

1D

Physical type fringe

Fringe image of the
element physical type

3D
2D
1D

Physical type text

3D
Text image of the element
2D
physical type
1D

Ply id fringe

Fringe image of the
element physical type

Ply id text

Text image of the element
2D composite
physical type

Rotational stiffness
(symbol)

Symbol of rotational
stiffness

spring element

Shear center (text)

Shear center. Two
coordinates in the plane
of the beam section

1D

Thickness fringe

Fringe image of surface
element thickness

2D
1D

Translational stiffness
(symbol)

Symbol of translational
stiffness

spring element

2D composite
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Text image of surface
element thickness

Thickness text

2D
1D

Additional Images
You can edit the generated images.
For this, double-click the generated image.
For more details please refer to Editing Images.
You will find here the list of the images available by editing the images that by default
appear in the Image Generation dialog box.

Images Available Using GPS Product
Physical Type

Image Names

Error

Estimated local error

Mesh

Deformed Mesh
Stress principal tensor symbol

Stress

Stress principal shearing
(element's nodes values)

Stress principal tensor
component (element value)
Temperature

Temperature field fringe
Temperature field iso
Temperature field text

Von Mises

Von Mises Stress (nodal value)
Translational displacement
vector

Generated (via icons) or
edited ?*
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3D Nodal Displacement

Translational displacement
component

Translational displacement
magnitude

*

images edited using double-click

The ELFINI Structural Analysis product offers additional images.

Additional Images Available Using EST Product

Physical Type

Angle
Angular acceleration

Image Names

Angle text
Angular acceleration vector

Angular acceleration fringe

Angular acceleration text
Angular velocity

Angular velocity vector

Angular velocity fringe

Angular velocity text
Area moment of inertia

Area moment of inertia
(text)

Generated (via
contextual menu) or
Edited ?*

Generative Structural Analysis
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Clearance iso
Clearance symbol
Clearance text

Cross sectional area

Cross sectional area fringe
Cross sectional area text

Curvature

Curvature text

Effective shear ratio in XY
plane

Area shear ratio in XY plane
(text)

Effective shear ratio in XZ
plane

Area shear ratio in XZ plane
(text)

Elastic energy

Local strain energy
Local strain energy symbol
Local strain energy text

Elastic energy density

Local strain energy density
Local strain energy density
symbol
Local strain energy density
text

Elements material

Material fringe
Material text

Elements set
Estimated error

Elements text
Estimated local error symbol
Estimated local error text

Force Flow
Laminate number

Force flow text
Laminate number text
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Laminate number fringe
Lineic force vector

Line force vector
Line force text

Lineic mass

Line mass symbol
Line mass text

Local axis
Mass inertia
Mass moment of inertia
Material angle
Moment Flow
Nodes
Normal to tangential force
ratio

Local axis symbol
Mass inertia (text)
Mass moment of inertia
(text)
Material angle text
Moment flow text
Nodes text
Friction force ratio iso
Friction force ratio symbol
Friction force ratio text

Physical type

Physical Type fringe
Physical Type text

Ply id

Ply id text
Ply id fringe

Point force vector

Point force vector
Point force component
Point force magnitude
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Point force text
Point mass

Point mass
Point mass symbol
Point mass text

Point moment vector

Point moment vector
Point moment component
Point moment magnitude
Point moment text

Pressure

Pressure fringe
Pressure text
Pressure vector
Pressure (nodal values)

Rotational acceleration

Rotational acceleration
vector
Rotational acceleration iso
Rotational acceleration text

Rotational stiffness

Rotational stiffness (text)
Rotational stiffness (symbol)

Rotational velocity

Rotational velocity
Rotational velocity iso
Rotational velocity text

Shear center

Shear center (text)
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Strain principal tensor
component (nodal values)
Strain principal tensor
symbol
Strain principal tensor text
Strain full tensor component
(nodal values)
Strain full tensor text

Stress

Stress full tensor component
(element's nodes values)
Stress full tensor component
(nodal values)
Stress full tensor text
Stress principal tensor
component (element's nodes
absolute values)
Stress principal tensor
component (nodal absolute
values)
Stress principal tensor
component (nodal values)
Stress principal tensor text
Stress principal tensor text
(absolute)
Tensor for maximum
shearing (nodal values)
Tensor for maximum
shearing text
Von Mises Stress (center of
element's values)
Von Mises Stress (element's
nodes values)
Von Mises Stress (nodal
values)
Von Mises Stress text

Stress Von Mises

Von Mises Stress (element's
nodes values)
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Von Mises Stress (symbol)
Von Mises Stress text
Surface force vector

Surface force vector
Surface force fringe
Surface force text

Surface mass

Surface mass fringe
Surface mass symbol
Surface mass text

Surface stress

Relative Translation

Surface stress principal
tensor symbol
Relative translational
displacement vector

Relative translational
acceleration

Relative acceleration vector

Relative translational
velocity

Relative velocity vector

Temperature
Translational acceleration
vector

Temperature field symbol
Acceleration vector
Acceleration
Acceleration fringe
Acceleration text

Translational Stiffness

Translational stiffness
(symbol)
Translational stiffness (text)

Translational Velocity Vector

Velocity vector
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Velocity
Velocity text
Transverse shear strain

Transverse shear strain text
Transverse shear strain iso

Transverse shear stress

Transverse shear stress text
Transverse shear stress iso

Volumic force vector

Volume force vector
Volume force
Volume force fringe
Volume force text

Volumic mass

Volume mass
Volume mass fringe
Volume mass symbol
Volume mass text

3D coordinates

Nodal coordinates symbol
Nodal coordinates text

3D mechanical degrees of
freedom
3D orientation vector

Degrees of freedom symbol
Orientation vector (symbol)
Orientation vector (text)

3D rotational vector

Rotational displacement
component
Rotational displacement
magnitude
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Rotational displacement text
Rotational displacement
vector
3D shell thickness

Thickness fringe
Thickness text

3D translational vector

Translational displacement
text

*

images generated using the Generate Image contextual menu

images edited using double-click

You can also generate images that you have previously saved.
For more details, please refer to Saving an Image as New Template in this guide.
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Editing Images
This task will show you how to edit images.
You can generate an image in addition to those of the Image toolbar (using the Image
Generation dialog box). The list of these images will depend on the Case type. You will then
be able to edit different types of images that by default appear in the Image Generation
dialog box.
In other words, the names of the images depend on:
1. physical type (for example: Displacement)
2. visualization type (for example: Symbol or Text)
3. criterion (for example: Vector or Principal value)

Open the sample00.CATAnalysis document from the samples directory.
In this particular example, you have to generate images using the Generate Image
contextual menu or using the Images toolbar.

You have to activate the image before editing it.
For this, right-click the image you want to activate and select the Activate/Deactivate
contextual menu.

1. Double-click an activated image in the specification tree.

The Image Edition dialog box appears.
For more details about the Image Edition dialog box, please click here.
2. Set the desired parameters in the Image Edition dialog box.
3. Click OK in the Image Edition dialog box.
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In case of pre-processing specifications, the type of entities contained in a selection may be
different from a specification to another.
For example:
●

a Clamp symbolizes a list of nodes

●

a Lineic Force symbolizes a list of edges

●

a Pressure symbolizes a list of faces

You can find an example:
1. Open the sample49_2.CATAnalysis from the samples directory.
2. Double-click the Clamp.1 object in the specification tree.

You can see that the support of the clamp is one face.
You can close the Clamp dialog box.
3. Right-click the Von Mises Stress (nodal values) image in the specification tree
and select the Activate/Deactivate contextual menu.
4. Double-click the Von Mises Stress (nodal values) image in the specification tree
to edit it.
5. Select the Selections tab in the Image Edition dialog box.
6. Select Clamp.1 in the Image Edition dialog box.

You can visualize nodes:

7. Select Surface Group.1 in the Image Edition dialog box.
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Saving an Image As New Template
This task shows you how to save a generated image as template in a xml file which contains
all the images you have generated.
Visu type mesh images cannot be saved as template.

Only available with the ELFINI Structural Analysis (EST) product.
Open sample35.CATAnalysis document from the samples directory for this task.
Before You Begin:
●

●

Compute the solution.
For this click the Compute icon.
Generate an image.
For more details, please refer to Generating Images.
1. Right-click an image feature in the specification tree.

2. Select the Save As New Template contextual menu

.

The Save as new template dialog box appears.

❍

❍

❍

Output directory: lets you see the name of the directory in which the image will
be saved.
Output file name: lets you see the name of the file in which the image will be
saved.
New image name: lets you give a name to the image you want to save as
template.
To know more about the management of the xml file, please refer to the Post
Processing task in the Customizing section of this user's guide.

3. Modify the name of the image you want to save as template in the Save as new

Generative Structural Analysis

Version 5 Release 14

Page 725

template dialog box, if needed.
4. Click OK in the Save as new template dialog box.
The saved image is now available in the Image Generation dialog box.

You can retrieve the template image you just have saved.
For this, right-click the Static Case Solution.1 object in the specification tree and select the
Generate Image contextual menu.
The Image Generation dialog box appears and you can create an image from the template
image you just have saved you have saved.
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Generating 2D Display Visualization
Only available with the Generative Dynamic Response Analysis (GDY) product.
The 2D Display functionality allows you to visualize in two dimensions a modulation, the
results of a dynamic response computation or sensors (in certain conditions).
You can modify the parameters associated to the plot, axis, legend or background.
You can also resize the plot.
Generating 2D Display for Modulation
Generate a 2D Display visualization of a modulation.

Generating 2D Display for Dynamic Response
Generate a 2D Display result after a dynamic response computation.

2D Display for Local Sensor
Generate a 2D Display visualization of a sensor.

Editing the 2D Display Parameters
Edit the 2D Display parameters (axis, display, legend, plot, ...).
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Generating a 2D Display for Modulation
This task shows you how to generate a 2D Display visualization for a modulation (frequency modulation or
time modulation).

Open the sample59.CATAnalysis document from the samples directory for this task.
1. Right-click the Frequency Modulation.1 object in the specification tree and select the Generate
2D Display contextual menu

.

The corresponding view appears in a 2D Display document.

You can change the units and the format of the axis to have a better visualization.
For this, please refer to Editing the 2D Display Parameters:
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2. Close the window to retrieve the CATAnalysis document.

A 2D Display - Frequency Modulation.1 object appears in the specification tree.

You can retrieve the 2D view and edit it.
For this, double-click the 2D Display - Frequency Modulation.1 object in the specification tree.
3. Right-click the Time Modulation.1 object in the specification tree and select the Generate 2D
Display contextual menu.

The corresponding view appears in a 2D Display document.
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4. Close the 2D Display window.

A 2D Display - Time Modulation.1 object appears in the specification tree.

●

●

For an easier navigation between the two documents, select the Tile Horizontally or Tile Vertically
submenu of the Window menu.
You can delete a 2D display.
For this, right-click the 2D Display you want to delete in the specification tree and select the Delete
contextual menu.

You can edit several graphic parameters.
For more details, please refer to Editing 2D Display Parameters.
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Generating 2D Display for Dynamic Response Solution
This task shows you how to generate a 2D Display result after a dynamic response computation (harmonic or transient).
Open the sample59.CATAnalysis document from the samples directory for this task.

●

The computation of the solution is automatically launched when you use this functionality.
The computation process may be long.

●

Results generated from a dynamic response solution with restraint excitation (using the Generate 2D Display contextual menu)
are displayed in a relative axis system. That means that observed displacements correspond to displacements resulting from the
elastic strain.
On the contrary, images generated from a dynamic response solution with restraint excitation (using the Generate Image
contextual menu) are displayed in the absolute axis system. That means that observed displacements are the sum of rigid body
displacements resulting from the excitation and displacements resulting from the elastic strain.

1. Right-click the Harmonic Dynamic Response Solution.1 object and select the Generate 2D Display contextual menu
.

The New Function Display dialog box appears.

The content of this dialog box depends on the excitation set you defined.
If you work on a dynamic response case (harmonic or transient) defined with a Restraint Excitation set, the New
Function Display dialog box appears as shown bellow:

❍

Results in relative axis: lets you visualize results in a relative axis system.

❍

Results in absolute axis: lets you visualize results in an absolute axis system.

❍

Cancel: lets you cancel the 2D Display generation.
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❍

Previous: this button is not available at this step.

❍

Next: lets you access the next step of the 2D Display generation.

❍

Finish: lets you finish the 2D Display generation.
If you click this button at this step, you will create only one graph.

2. Click Next in the New Function display dialog box.

The dialog box appears as shown bellow:

❍

1 graph: lets you generate a 2D Display document containing only one graph.

❍

2 graphs: lets you generate a 2D Display document containing two graphs.

❍

2 graphs: lets you generate a 2D Display document containing only three graphs.

❍

Cancel: lets you cancel the 2D Display generation.

❍

Previous: lets you access the previous step.

❍

Next: this button is not available at this step.

❍

Finish: lets you finish the 2D Display generation.

3. Select 3 graphs and click Finish in the New Function Display dialog box.

A 2D Display document and the Select Data dialog box appear simultaneously.

❍

Selection tab:
■
Node: gives you the number of the selected node.
■

❍

Degrees of freedom: lets you choose the degrees of freedom you want.

Layout tab:
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Graph 1: lets you choose which type of results (Displacement, Velocity or Acceleration) you want to display in the
first graph.
Graph 2: lets you choose which type of results (Displacement, Velocity or Acceleration) you want to display in the
second graph.
Graph 3: lets you choose which type of results (Displacement, Velocity or Acceleration) you want to display in the
third graph.
It is possible to select the same result type for two or three graphs. This will be useful to visualize the

❍

Add>>: this button lets you add parameters of a selected node.

❍

Delete<<: this button lets you remove parameters of a selected node.

❍

Clear: this button lets you clear the contain of the Selected curves field.

❍

Close: this button lets you close the Select Data dialog box.

A Results in relative axis - 3 graphs object appears in the specification tree in the CATAnalysis document:

For an easier navigation between the two documents, select the Tile Horizontally or Tile Vertically submenu of the
Window menu.
4. Select a node on the mesh visualization in the .CATAnalysis document.

5. Select the degree of freedom (TX and/or TY and/or TZ).

In this particular example, deactivate the TY and TZ options.
6. Click the Add>> button.

The Select Data dialog box is automatically updated.
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The three curves are automatically displayed in the 2D Display document.

In this particular example, the first graph gives you the displacement results, the second one gives you the velocity results and
the third one gives you the acceleration results.
7. Select the Layout tab in the Select Data dialog box and select Displacement as output type for Graph 2.

The legend of the second graph is updated.
8. Click Close in the Select Data dialog box.
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9. Change the format of the Y axis in the first graph and second graph.

For this:
a. Double-click the Y axis of the first graph to edit it.
b. Select Real in the Format tab of the Y Axis dialog box.
c. Click OK.
d. Double-click the Y axis of the second graph to edit it.
e. Select Real in the Format tab of the Y Axis dialog box.
f. Click OK.
The 2D Display document is updated:

10. You can close the 2D Display window.

You can edit several graphic parameters.
For more details, please refer to Editing 2D Display Parameters.
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Generating a 2D Display for Sensor
This task shows you how to generate a 2D Display visualization of a sensor.
●

●

You can generate a 2D Display visualization only in case of multi-occurrence solutions (frequency, dynamic
response, ...).
The computation of the solution containing the sensor is automatically launched when you use this functionality.
The computation process may be long.

Open the sample59.CATAnalysis document from the samples directory for this task.
Before You Begin:
Compute all the solution. For this, click the Compute icon.
1. Right-click the Displacement Vector sensor under the Sensor.3 object in the specification tree and select
the Generate 2D Display contextual menu
The corresponding view appears in a 2D Display document.

2. Close the window to retrieve the CATAnalysis document.

.
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A 2D Display object appears in the specification tree.

You can retrieve the 2D view and edit it.
For this, double-click the 2D Display object in the specification tree.

For an easier navigation between the two documents, select the Tile Horizontally or Tile Vertically submenu of the
Window menu.
You can edit several graphic parameters.
For more details, please refer to Editing 2D Display Parameters.
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Editing 2D Display Parameters
This task shows you how to edit the 2D Display parameters.
You can edit:
●

x axis parameters (limits, scale, ...)

●

y axis parameters (limits, scale, ...)

●

plot parameters (color, thickness of the line, ...)

●

legend parameters (position, text style, ...)

●

display parameters (background color, units, ...)

The following diagram gives you the main parts of a 2D Display document.

To perform this task, you have to:
●

●

open the sample58.CATAnalysis document from the samples directory.
generate a 2D display result with only one graph for a dynamic response computation.
For more details, please refer to Generating 2D Display for Dynamic Response.

In this task, you will work with the following graph:
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Editing X Axis Parameters
You will see here how to edit the x axis system parameters.
1. Right-click the X axis system.

The following contextual menus are available:

❍

❍

❍

Limits: lets you choose between the following options:
■
Free
■

Optimized

■

Fixed...: lets you fix the limit of the X axis by entering Lower and Upper values.

■

Application Defined

Format:
■
Linear: lets you select a linear scale
■

Octaves: lets you choose a scale with logarithm in base 2

■

Decades: lets you choose a scale with logarithm in base 10

■

Power2: lets you choose a scale with logarithm in base 2 and the annotation in real powers of 2

Options...: lets you access the X Axis dialog box.
You can also double-click the X Axis to access the X Axis dialog box.
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❍

Limits: for more details, please click here.

❍

Format: for more details, please click here.

❍

Title: lets you modify the name of the axis.
■
Default: lets you preserve the default axis name (X axis).
■

❍

Custom: lets you enter a new axis name.
This will modify the name of the dialog box.

Annotation:
■
Include limit annotation: lets you hide or show the limit values of the axis.
■

Include tick annotation: lets you hide or show the tick values.

■

Include labels: lets you hide or show information about the axis.

■

Setting for Linear Formats
■
Number of divisions: Automatic, One, Two, Four, Five, Ten
■

❍

Resolution: Automatic, One, Two, Four, Five, Ten

Grid: lets you modify the Color, the Dash Style and the Weight of the grid.
■
Show on major ticks
■

❍
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Show on minor ticks

Text Style: lets you change the style of the x axis text.
■
Inherit
■

■

Customized: lets you customize the text style of the X axis. You can choose the Size and the Font
of the X axis text.
Make children inherit

2. Select the Options... contextual menu.
3. Select the desired parameters in the X Axis dialog box.
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In this particular example,
❍

select Fixed limits in the Limits tab,

❍

enter 600 as Upper value,

❍

select the Customized option in the Text Style tab,

❍

enter 2.00 as Size value.

4. Click OK in the X Axis dialog box.

The x axis appears as shown here:

Editing Y Axis Parameters
You will see here how to edit the y axis system.
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1. Right-click the y axis.

The following contextual menus are available.

❍

❍

❍

Limits: for more details, please click here.
Format:
■
Real
■

Imaginary

■

Phase degrees

■

Phase radians

■

Amplitude

■

Logarithmic

■

dB(RMS)

■

dB(Peak)

Options...: lets you access the Y Axis dialog box.
You can also double-click the Y Axis to access the Y Axis dialog box.

❍

Limits: for more details, please click here.

❍

Format: for more details, please click here.
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❍

Title: for more details, please click here.

❍

Annotation: for more details, please click here.

❍

Grid: for more details, please click here.

❍

Text Style: for more details, please click here.
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2. Select the Options... contextual menu.
3. Select the desired parameters.
4. Click OK in the Y Axis dialog box.

Editing Plot Parameters
You will see here how to edit the plot.
1. Right-click the plot.

The following contextual menus are available.

❍

❍

❍

Delete: lets you delete the plot.
Export Data...: lets you export the 2D Display results in a Text (.txt) file or in a Exel (.xls) file.
If you select this contextual menu, the Export Data dialog box appears to let you:
■
select the directory in which you will export the 2D Display data,
■

name the file containing the 2D Display data,

■

choose between the .txt or .xls file type.

Options...: lets you access the Edit Plot dialog box.
You can also double-click the plot to access the Edit Plot dialog box.
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❍
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Data tab:
■
Variables
■
Select Result
■

❍
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Attributes

Visualization tab: lets you define the Line Style
■
Line color: lets you choose the color of the plot
■

Use line: lets you draw the plot with a line. You can define the Dash and the Weight of the line.

■

Use symbol: lets you draw the plot with symbols.

2. Select the Export Data... contextual menu.
3. Select the desired directory and enter a name in the Export Data dialog box.
4. Select Exel as Save as type option in the Export Data dialog box.
5. Click OK in the Export Data dialog box.

To visualize an example of Exel export data file, please click here.
To visualize an example of Text export data file, please click here.

Editing Legend Parameters
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You will see here how to edit the legend.
1. Double-click the graph legend.

❍

❍

❍

Plots tab: lets you visualize details of attributes
■
Show entries with no data attached
Attributes tab:
■
Hide Attributes: lets you hide an attribute in the legend
■

Show Attributes: lets you show an attribute in the legend

■

Up and Down: let you change the position of attributes in the legend

Text Style tab: for more details, please click here.

2. Select the desired parameters.
3. Click OK in the Edit Legend dialog box.
4. Right-click the graphic legend.

The Show Legend contextual menu is available.

This contextual menu lets you hide the legend.
To show again the legend, use the Legend contextual menu.
For more details about the Legend contextual menu, please click here.
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Editing Display Parameters
You will see here how to edit the background.
1. Right-click the display area.

The following contextual menus are available.

❍

❍

❍

❍

Select Data: lets you access to the Select Data dialog box.
For more details, please refer to Generating a 2D Display for Dynamic Response Solution.
Options...: lets you access the Edit Display dialog box.
You can also double-click the plot to access the Edit Display dialog box.
Image options...: lets you access the Edit Image dialog box.

Text Style tab:
■
Inherit
■

■

❍

Customized: lets you customize the style of the all the text elements of the 2D Display document.
You can change the Size and the Font of all these elements.
Make children inherit

Background Colors tab:
■
Display Area: lets you choose the display area color. You can choose to have no background color
(No background) or have a background color (Include background and Choose color).
■

Graph Area: lets you choose the graph area color. You can choose to have no background color
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(No background) or have a background color (Include background and Choose color).
■

❍

❍

Restore Defaults: lets you restore the default parameters.

Title: for more details, please click here.
XY_Graph1 tab:
■
Units: MKS, Data Defined, Options Defined
■

Interpretation: Default

■

OrientationLabel: Default (XY), YX

2. Select the desired parameters.
3. Click OK in the Edit Display dialog box.

Editing Graph Parameters
You will see here how to edit the graph.
1. Right-click the graph area.

The following contextual menus are available.

❍

❍

Select Data: lets you access to the Select Data dialog box.
For more details, please refer to Generating a 2D Display for Dynamic Response Solution.
Cursor: lets you visualize a value corresponding to a particular abscissa or a particular ordinate.
■
Single X:

Generative Structural Analysis

❍

❍

■

Double X:

■

Single Y:
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Legends: lets you hide or show the graph legend.
Options...: lets you access the Edit Graph dialog box.
You can also double-click the plot to access the Edit Graph dialog box.
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2. Select the desired parameters.
3. Click OK in the Edit Display dialog box.
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Export Data
This task shows you how to transfer image content (coordinates, values, axis system if needed)
into a .txt or .xls file. This can be performed in the case of hybrid or non-hybrid models.
Only available with the ELFINI Structural Analysis (EST) product.
The Export Data contextual menu is not available for the Mesh and Deformed Mesh images.
This contextual menu is valid only for images with the following positions:
●

node

●

element

●

center of element

●

node of element

Open sample35.CATAnalysis document from the samples directory for this task.
1. Right-click the image feature in the specification tree.

2. Select the Export Data contextual menu

.

The Export Data dialog box appears, which lets you define the desired directory, name and
type of the file to be generated.

❍

Output directory: you can select the directory in which the data will be exported.
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❍

File name: You can choose the desired file name.

❍

File type: The file type can be either .txt or .xls.

3. Click OK in the Export Data dialog box.
The file appears as shown here:
❍
x, y and z values
❍

values previously assigned to the image via the Filter operation.
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The exported data (for example, the number of the nodes) depends on
●

●

the Selection elements that you chose to visualize on a generated image
whether you activated or not the on boundary option from the Color Map Editor dialog box
(displayed when double clicking on the color palette).
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Analysis Application Interoperability
This section will show you how to work with analysis data stored in ENOVIA.
VPM Navigator Interoperability
ENOVIAVPM / CATIA V5 Analysis Integration
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VPM Navigator Interoperability
This section deals with the interoperability between the analysis data and the VPM Navigator
product.
Retrieving Pointed Documents of an Analysis File
Data-Mapping
Analysis Impact Graph
Synchronizing Documents with Versioned Parts or Products

You can find in the following table the VPM Navigator functionalities supported in an analysis
context (depending on the analysis pointed document):

VPM Navigator functionalities

Pointed
Documents of
Analysis File

Document

Document

Document

Update

Impact Synchronization on

Storage

Renaming

Reading

Status

Graph

version

CATPart

CATProduct
(Work
Package)

CATProduct
(Explode)

External
Storage

-*

-
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Data Mapping

Analysis
Assembly

-

-

-

-

-

-

-

* a product saved in Explode mode cannot be versioned, but the parts that are pointed by
the product can be versioned.
For more details, please refer to Synchronizing Documents with Versioned Parts and
Products.

For more details about the VPM Navigator product, please refer to the VPM Navigator User's
Guide.
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Retrieving Pointed Documents of an Analysis File
This task will show you how to work with analysis data stored in ENOVIA, using VPM Navigator.
You will see how to retrieve pointed document of a CATAnalysis file.
You will create an analysis from a product saved in ENOVIA either in Work Package mode or in Explode mode.
For more details about the VPM Navigator product, please refer to the VPM Navigator User's Guide.
1. Connect your session to ENOVIA.
2. Load a product stored in ENOVIA.

In this example, choose a product that has been saved in ENOVIA in Work Package mode.
3. Enter the Generative Structural Analysis workbench.

For this, select the Start -> Analysis & Simulation -> Generative Structural Analysis menu.
4. Click OK in the New Analysis Case dialog box.
5. Define the analysis specifications.
For example, define the restraint set and the load set, apply a analysis connection property to an assembly
constraint, and finally perform a compute execution.
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6. Save the analysis document in ENOVIA.

An analysis document can only be saved in Work Package mode.
For this, click the Save data in Enovia V5 icon.
The following dialog box appears:

Select the More >> button.

7. Click OK in the Save in ENOVIA V5 dialog box.
8. Close the analysis document.
9. Load your analysis data stored in ENOVIA.
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Click the Search ENOVIA data icon and launch the search.
10. Right-click the analysis you want to load in the Search Result dialog box and select the Open contextual menu.

The Open Modes dialog box appears.

11. Select the Out of context option and click OK in the Open Modes dialog box.

Note that you retrieve all the analysis specifications and the updated status you saved in the analysis document.
Moreover, the referenced CATProduct, CATAnalysisResults and CATAnalysisComputations files become ENOVIA V5
documents.
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Data-Mapping
You will see here how to work with analysis data-mapping files stored in ENOVIA.
To modify a data-mapping file (.xls) stored in ENOVIA, you have to work with ENOVIA LCA:
●

search the data-mapping file (.xls file)

●

check-out the data-mapping file

●

modify the data-mapping file

●

check-in the data-mapping file

To know more, please refer to the ENOVIA / CATIA Interoperability User's Guide - Checking-in
an ENOVIA LCA Document.
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Analysis Impact Graph
This task will show you how to use the analysis impact graph. The analysis impact graph allows you to visualize the exposure of dependency links in
ENOVIA V5.
The analysis graph depends on the save mode of the pointed product (Work Package mode or explode mode).
You will see here how to use the Impacted by and Impacts on functionalities in an analysis document pointing:
●

a CATPart file

●

a CATProduct file saved in Work Package mode

●

a CATProduct file saved in Explode mode

For more details about the Impact Graph, please refer to the VPM Navigator User's Guide.

Analysis Document Pointing a .CATPart File
In the specification tree, you will find a CATAnalysis links to a CATPart document, a CATAnalysisResults file and a CATAnalysisComputations file:
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The analysis impact graphs looks like:

All the dependency links between analysis document and part, results and computations documents are valid.
The type of these links are document/document.
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Analysis Document Pointing a .CATProduct File Saved in Work Package Mode
In this case, the analysis document points at a product saved in Work Package mode. This product points at two parts.
The analysis impact graph looks like:

The type of these links are document/document.

Analysis Document Pointing a .CATProduct File Saved in Explode Mode
In this case, the analysis document points at a product saved in Explode mode. This product points at two parts.
The analysis impact graph looks like:

Note that you can visualize the part instance. The type of these links are document/instance.
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Synchronizing Documents with
Versioned Parts or Products
This task will show you how to manually synchronize an analysis document with versioned
parts and products.
For more details about the VPM Navigator product, please refer to the VPM Navigator User's
Guide.

1. Save in ENOVIA V5 an analysis document pointing at parts and products.
2. Modify a pointed document (part or product) and create an new version of this
document using the Save in ENOVIA V5 functionality.

❍

You can create new versions of parts and products saved in Work Package
mode.

❍

If you create a new version of a part belonging to product saved in
Explode mode, the product will be automatically synchronize with this last
version and so, the analysis document will be automatically synchronize.

3. Open the analysis document from the VPM Navigator product.
4. Select the Edit -> Links menu.
5. Select the Pointed Documents tab.
6. Click the Synchronize to last version button.

The analysis document is synchronized with the last existing version.
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ENOVIAVPM / CATIA V5 Analysis Integration
This task will show you how to work (modify, save and manage) with a .CATAnalysis document in ENOVIAVPM context.
Usually, to save a document in ENOVIAVPM, you have to use the Set PDM Properties functionality, except with .CATAnalysis
documents.
For more details about ENOVIAVPM, please refer to the VPM User's Guide.
You have to launch an ENOVIAVPM session, and if needed, connect your CATIA session to ENOVIAVPM.
1. Send to CATIA V5 a .CATPart or a .CATProduct document from the Virtual Product Model Access dialog box.
2. Enter the Generative Structural Analysis workbench.

For this, select the Start -> Analysis & Simulation -> Generative Structural Analysis menu.
3. Click OK in the New Analysis Case dialog box.
4. Apply the desired specifications (restraints and loads).
5. Save the analysis document in ENOVIAVPM.
For this, click the Create and Save icon in the Virtual Product Model Access dialog box.

A new VPM Part with the provided part number is created.

Do not use the Set PDM Properties functionality to save the .CATAnalysis document in ENOVIAVPM.
Always use the Create and Save functionality.
6. Compute the document.
7. If needed, clear computation data.
8. Rename the .CATAnalysisResults (and .CATAnalysisComputations) file(s).

For this, click the Storage Location icon

from the Solver Tools toolbar (or double-click them in the specification

tree).

Do not use the Set PDM Properties functionality to rename the .CATAnalysisResults (and
.CATAnalysisComputations) document(s) in ENOVIAVPM.
Always use the Storage Location functionality to rename these files.

9. Click the Set PDM Properties icon

from the ENOVIAVPM toolbar

Each pointed document appears in the dialog box.
10. Select the pointed documents you want to save in ENOVIAVPM.

.
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For each pointed document, select the appropriate VPM database environment in Doc Env (please refer to your VPM
administrator).

When saving assemblies containing applicative data (such as Analysis Connection), make sure the Publication
exposed option is selected.
11. Select the File -> Save All menu to store all modified or created data in ENOVIAVPM.
12. Refresh the view in ENOVIAVPM.

Newly created VPM parts and documents now appear.

13. Close the current analysis document in CATIA.
14. Open the CATAnalysis document you saved from ENOVIAVPM.

The previously saved CATAnalysis document is loaded in CATIA, updated and appears with the corresponding results if
any.
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Workbench Description
This section contains the description of the icons and menus which are specific to this workbench.
You can click the sensitive areas on this image to see related documentation.

Generative Structural Analysis Menu Bar
Model Manager Toolbar
Adaptivity Toolbar
Modulation Toolbar
Groups Toolbar
Analysis Connections Toolbar
Connection Toolbar
Analysis Assembly Toolbar
Virtual Part Toolbar
Mass Toolbar
Restraint Toolbar
Load Toolbar
Compute Toolbar
Solver Tools Toolbar
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Image Toolbar
Analysis Tools Toolbar
Analysis Results Toolbar
Analysis Symbol
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Generative Structural Analysis Menu Bar
The Menu Bar and most of the items available in Generative Structural Analysis workbench are the standard ones. The
different commands and tools are described in the Infrastructure Version 5 User's Guide.
For more information, please refer to the standard Menu Bar section.
However, the Insert menu is specific to the Generative Structural Analysis workbench.
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Model Manager Toolbar

Mesh Creation

See Creating 3D Mesh Parts

See Creating 2D Mesh Parts

See Creating 1D Mesh Parts
Mesh Specification

See Creating Local Mesh Sizes (Element Type)

See Creating Local Mesh Sizes

See Creating Local Mesh Sags
Mesh Property

See Creating 3D Properties

See Creating 2D Properties

See Importing Composite Properties

See Creating 1D Properties
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See Creating Imported Beam Properties
Check

See Checking the Model
Isotropic Material

See Creating User Materials
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Adaptivity Toolbar

See Creating Global Adaptivity Specifications
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Modulation Toolbar

See Creating White Noise Modulation

Import Modulation

See Importing Frequency Modulation

See Importing Time Modulation
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Groups Toolbar

Geometry Groups

See Grouping Points

See Grouping Lines

See Grouping Surfaces

See Grouping Bodies
Free Groups

See Box Group

See Sphere Group
Proximity Groups

See Grouping Point by Neighborhood

See Grouping Line by Neighborhood

See Grouping Surface by Neighborhood
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Analysis Connections Toolbar

See General Analysis Connection

See Point Analysis Connection

See Point Analysis Connection Within One Part

See Line Analysis Connection

See Line Analysis Connection Within One Part

See Surface Analysis Connection

See Surface Analysis Connection Within One Part
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Connection Toolbar

Face Face Connections

See Slider Connection Properties

See Contact Connection Properties

See Fastened Connection Properties

See Fastened Spring Connection Properties

See Pressure Fitting Connection Properties

See Bolt Tightening Connection Properties
Distant Connections

See Rigid Connection Properties

See Smooth Connection Properties

See Virtual Rigid Bolt Tightening Connection Properties

See Virtual Spring Bolt Tightening Connection Properties

See Customized Distant Connection
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Welding Connections

See Spot Welding Connection Properties

See Seam Weld Connection Properties

See Surface Weld Connection Properties

Page 776

Generative Structural Analysis

Version 5 Release 14

Analysis Assembly Toolbar

See Analysis Assembly 2D Viewer
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Virtual Part Toolbar

See Creating Rigid Virtual Parts

See Creating Smooth Virtual Parts

See Creating Contact Virtual Parts

See Creating Spring Virtual Parts

See Creating Smooth Spring Virtual Parts

See Periodicity Conditions
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Mass Toolbar

See Creating Distributed Masses

See Creating Line Mass Densities

See Creating Surface Mass Densities

See Inertia on Virtual Part
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Restraint Toolbar

See Creating Clamps
Mechanical Restraint

See Creating Surface Sliders

See Creating Ball Joints

See Creating Sliders

See Creating Pivots

See Creating Sliding Pivots
Advanced Restraint

See Creating Advanced Restraints

See Creating Iso-Static Restraints
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Load Toolbar

See Creating Pressures

See Creating Enforced Displacements
Force
See Creating Distributed Forces
See Creating Distributed Moments

See Creating Distributed Bearing Loads

See Importing Forces

See Importing Moments

Acceleration

See Creating Accelerations

See Creating Rotation Forces
Force Density
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See Creating Line Force Densities

See Creating Surface Force Densities

See Creating Volume Force Densities
Temperature

See Creating Temperature Field

See Importing Temperature Field from Thermal Solution
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Compute Toolbar

See Computing Objects Sets
See also Computing Static Solutions
Computing Static Constrained Solutions
Computing Frequency Solutions
Computing Buckling Solutions
Computing Dynamic Response Solutions

See Computing with Adaptativity

Page 783

Version 5 Release 14

Generative Structural Analysis

Solver Tools Toolbar

See Specifying External Storage

See Clearing External Storage

See Specifying Temporary Data Directory
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Image Toolbar

See Visualizing Deformations

See Visualizing Von Mises Stresses
Other Images

See Visualizing Displacements

See Visualizing Principal Stresses

See Visualizing Precisions
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Analysis Tools Toolbar

See Animating Images

See Cut Plane Analysis

See Amplification Magnitude

See Extrema Detection

See Information

See Images Layout

See Simplifying Representation
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Analysis Results Toolbar

See Reporting

See Advanced Reporting

See Historic of Computation

See Elfini Listing
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Analysis Symbol
A CATAnalysis file is composed of:
1. Links Manager, which references the part or the product to be analyzed.
2. Connection Design Manager, which contains the analysis design connections.
3. Finite Element Model, which contains the specifications of finite element model.

Analysis Manager
Links Manager
The Links Manager gives you the directory path and the main information on the
linked documents or files.
●

Product

●

Part

●

Results and Computations: gives you the directory path of the
CATAnalysisComputations and the CATAnalysisResults files

Connection Design Manager
The Connection Design Manager is composed of:

General Design Connection
Point Design Connection
Point Design Connection within one Part
Line Design Connection
Line Design Connection within one Part

.
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Finite Element Model
The Finite Element Model is composed of:

Nodes and Elements
Properties
Modulation
Group
Analysis Case
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Customizing
This section describes the different type of setting customization you can perform in the Analysis workbenches using
the Tools -> Options... submenu.
This type of customization is stored in permanent setting files: these settings will not be lost if you end your session.
1. Select the Tools -> Options... submenu.

The Options dialog box appears.
2. Select the Analysis and Simulation category.

The following tab appears:

These tabs lets you define the:
❍

general settings

❍

graphic settings

❍

post processing settings

❍

quality settings

❍

external storage settings

3. Change the desired parameters.
4. Click OK in the Options dialog box when done.
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General

This task explains how to customize Analysis and Simulation general settings.
The General tab deals with the following settings:
●

Default Analysis Case

●

Specification Tree

Default Analysis Case

Define a default starting analysis case
This option lets you define a default analysis case that will be inserted each time you enter the
Generative Structural Analysis workbench or the Advanced Meshing Tools workbench.
Before defining a default analysis case using Tools->Options command, make sure you started the
Analysis & Simulation (Generative Structural Analysis or Advanced Meshing Tools) workbench at
least once.
The default starting analysis case is Static Analysis. You can decide that the new default case will
be:
●

Static Analysis

●

Frequency Analysis

●

Free Frequency Analysis
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The cases will only be displayed if an analysis workbench has been loaded at least once
because the listed cases are linked to the Analysis workbenches last loaded.

By default, this option is deactivated.

Specification Tree

Show parameters
This option lets you display parameters in the specification tree.
By default, this option is deactivated.

Show relations
This option lets you display relations in the specification tree.
By default, this option is deactivated.
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Graphics

This page deals with the following options:
●

Nodes

●

Elements

Nodes

This option lets you select the symbol and color you wish to assign to the nodes.

Elements

This option lets you define the shrink of 1D elements.
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Post Processing

This task explains how to customize Analysis and Simulation post processing image settings.
●

Save as new template

●

Image edition

Save As New Template Folder

You can define the location of the SPMUserTemplateImageDefinition.xml file or manage this
file.
This file contains all the generated images that have been saved with the Save As New
Template contextual menu.

Output directory
This option lets you choose the directory in which you want to store the .xml file.
By default, this field is empty.

Output file name
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This option indicates the name of the associated .xml file. You can rename or remove the stored
images.

Images must have been saved with the Save As New Template contextual menu and a
.CATAnalysis document must be launched (in the opposite case, the Manage button is not
available).
If you click the Manage button, the Available Images dialog box appears.

●

Remove...: lets you remove the selected images (multi-selection is available).

●

Rename...: lets you rename a selected image.

●

Remove All: lets remove all the images that are stored in the xml file.

All modifications are updated only if you click OK in the Options dialog box.
For example: if you change the path directory after managing images and without clicking
OK in the Options dialog box, your modifications are not preserved.
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Image Edition

Automatic preview mode
This option lets you preview automatically the changes you done in the Image Edition dialog box.
If this option is deactivated, the Preview button will be available in the Image Edition dialog box:
the visualization will be launched only if you click the Preview button.
By default, this option is activated.
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Quality

This page deals with the following options:
●

Export Default Directory

●

Default Standard File

●

Quality Criteria

Export Default Directory

This option lets you define the default directory in which the criteria configuration have been
saved.
By default, the Export Default Directory field is empty.
While a default directory is not defined, you cannot use the Export Criteria option in
the Quality Analysis functionality in the Advanced Meshing Tools workbench (for more
details, please refer to the Advanced Meshing Tools User's Guide - Analyzing Element
Quality).

Default Standard File

This option lets you define the list of quality criteria that will be used by default.
By default, the Default Standard File field is empty and so all the Quality Criteria are
taken into account.
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Quality Criteria

This frame lets you visualize the quality criteria that are taken into account and their limit values
between:

●

good and poor elements

●

poor and bad elements
By default, all the Quality Criteria are taken into account.

The limit values change as you define the Default Standard File option.
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External Storage

This page deals with the following options:
●

Default CATAnalysisResults File Folder

●

Default CATAnalysisComputations File Folder

●

Default Temporary External Storage Folder

●

Computations Data Management on Save

●

File Name Management on Save

Default CATAnalysisResults File Folder

This option lets you change the default directory location of the CATAnalysisResults file.
●

●

●

●

Last used: lets you choose the last selected default directory location (CATSettings).
Current CATAnalysis file folder: lets you choose the same default directory as the
current CATAnalysis directory.
Local host temporary folder: lets you choose the temporary directory.
Always...: lets you define a default directory that will be always the same. You have to
define the path directory.

By default, the Last used option is activated.
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Default CATAnalysisComputations File Folder

This option lets you change the default directory location of the CATAnalysisComputations file.
●

●

●

●

Last used: lets you choose the last selected default directory location (CATSettings).
Current CATAnalysis file folder: lets you choose the same default directory as the
current CATAnalysis directory.
Local host temporary folder: lets you choose the temporary directory.
Always...: lets you define a default directory that will be always the same. You have to
define the path directory.

By default, the Last used option is activated.

Default Temporary External Storage Folder

This option lets you specify the default directory location of temporary data.
●

Last used: lets you choose the last selected default directory location (CATSettings).

●

Local host temporary folder: lets you choose the temporary directory.

●

Always...: lets you define a default directory that will be always the same. You have to
define the path directory.
By default, the Last used option is activated.
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Computation Data Management on Save

Automatic clearing of computations data
This option lets you set the automatic clearing of computations data before saving documents.
By default, this option is deactivated.

File Name Management on Save

Automatic renaming of CATAnalysisResults and CATAnalysisComputations files
This option lets you rename automatically the CATAnalysisResults and
CATANalysisComputations files when you save a CATAnalysis document (using the Save as...
menu or the Save Management menu) with the new name of the associated CATAnalysis
document.
By default, this option is deactivated.
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Reference Information
This section provides essential information on the following topics:
Image Edition
Advanced Edition for Images and Local Sensors
Filtering Mesh Parts
Integration with Product Engineering Optimization
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Image Edition
This task describes the Image Edition dialog box.
The names of the images depend on:
1. physical type (for example: Displacement)
2. visualization type (for example: Symbol or Text)
3. criterion (for example: Norm or Vector component)

You will find in the following table the available tabs and buttons in the Image Edition dialog box.

Mono-occurrence solutions Multi-occurrence solutions

Deformed Mesh image
Mesh Visualization image

Mesh

Mesh

Selections

Selections

Preview

Occurrences
Preview

Other images

Visu

Visu

Selections

Selections

More

Occurrences

Preview

More
Preview

Mesh Tab

Generative Structural Analysis
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On deformed mesh: lets you visualize results in deformed mode.
In the case of Dynamic Response Analysis Case (Harmonic or Transient) with restraint
excitation, you can specify if you want to visualize the image in an absolute axis (Absolute
option) or in a relative axis (Relative option).

❍

❍

Absolute: lets you visualize both the displacement and the elastic deformation of the
part.
Relative: lets you visualize only the elastic deformation of the part.

●

Display free nodes: lets you display free nodes (nodes that are referenced by any element).

●

Display nodes of elements: lets you visualize nodes of elements.

●

Display small elements: lets you choose to display or not the very small elements.

●

Shrink Coefficient: lets you shrink the element visualization.

Visu Tab

Generative Structural Analysis

●
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On deformed mesh: lets you visualize the deformation.
In the case of Dynamic Response Analysis Case (Harmonic or Transient) with restraint
excitation, you can specify if you want to visualize the image in an absolute axis (Absolute
option) or in a relative axis (Relative option).

❍

❍

●

Absolute: lets you visualize both the displacement and the elastic deformation of the
part.
Relative: lets you visualize only the elastic deformation of the part.

Type: provides a list with visualization types (how).
The list of visualization types depends on the selected image.
❍
Average iso: lets you visualize isolines at nodes.
This visualization type uses the Material Rendering capabilities.
❍

Discontinuous iso: lets you visualize isolines at nodes of element.
This visualization type uses the Material Rendering capabilities.

❍

❍

❍

Fringe: lets you color an element, a face of element or an edge of element according to the
scalar value defined for this entity.
Text: lets you visualize results using text.
Symbol: lets you visualize results using symbol.
The available symbols depend on the values to be displayed.

Generative Structural Analysis
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Criteria: provides a list of visualization criteria.
The list of visualization criteria depends on the physical type of the selected image and the selected
Type.
Options...: lets you define visualization options.
Only available if you installed the ELFINI Structural Analysis product.

The dialog box that appears depends on the Type option you previously selected.
For more details about this button, please click here.

Options... button
Here you will find the available visualization options you obtain using the Options... button:

●

if you selected the Discontinuous iso, Average iso or Fringe type, the Visualization Options
dialog box appears as shown bellow:

❍

Shrink Coefficient: lets you shrink the element visualization

❍

Display elements without value: lets you display elements with or without value

❍

Display small elements: lets you choose to display or not the very small elements
This option is only available if you selected the Fringe type.

●

if you selected the Symbol type, the Visualization Options dialog box appears as shown bellow:

Generative Structural Analysis
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●
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Type:
■
Representation: lets you choose between the symbol representation types. The number of
the available representations depends on the visualization Type and Criteria.
Color:
■
Imposed: enables the color to be fixed.
If this option is selected, you can use the Color Chooser.
Size:
■
Minimum length: lets you define the minimum symbol length.
■

Maximum length: lets you define the maximum symbol length.

■

Variable: enables the variability of the symbols in function of the value.

■

Zoom sensitive: enables the length of the symbols to be zoom sensitive.

if you selected the Text type, the Visualization Options dialog box appears as shown bellow:

❍

Page 807

Color:
■
Imposed: enables the color to be fixed.
If this option is selected, you can use the Color Chooser.
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Selections Tab

The Selections tab lets you limit the image visualization to a list of entities.
●

Available Groups: gives you the list of the available entities.
The available entities could be:
❍

❍

❍

mesh parts (under the Nodes & Elements set in the specification tree)
pre-processing specifications (under the Restraints, Loads and Masses sets in the specification
tree)
user groups (under the Groups set in the specification tree)
You can filter the list of the available entities using the Filter groups... contextual menu.
For more details, please click here.

●

●

●

●

button: lets you activate the visualization of all the available entities contained in the Available
Groups frame.
button: lets you activate the visualization of entities selected in the Available Groups frame.
button: lets you deactivate the visualization of entities selected in the Activated Groups
frame.
button: lets you lets you deactivate the visualization of all the selected entities contained in the
Activated Groups frame.

Generative Structural Analysis
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Activated Groups: shows you the list of the entities you have activated the visualization.

●

Multi-selection is available.
In this case, the resultant selection is the union of the selected entities.

●

You can double-click an entity to activate or deactivate the entity visualization.

●

You can select entities directly in the specification tree or in the viewer.

●

Minimum value and the maximum value of the color palette depend on the selected entities.

●

If the Activated Groups field is empty, all the entities listed in the Available Groups field
will be visualized.

In case of pre-processing specifications, the type of entities contained in a selection may be
different from a specification to another.
For example:
●

a Clamp symbolizes a list of nodes

●

a Lineic Force symbolizes a list of edges

●

a Pressure symbolizes a list of faces

Filtering Groups
a. Right-click in the Available Groups frame and select the Filter Groups... contextual menu as
shown bellow:

The Filter Groups dialog box appears.

❍

User groups: lets you activate all the groups under the Groups set in the specification tree.

Generative Structural Analysis
❍

❍

❍

❍

❍
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1D mesh parts: lets you activate all the 1D mesh parts under the Nodes and Elements
set in the specification tree.
2D mesh parts: lets you activate all the 2D mesh parts under the Nodes and Elements
set in the specification tree.
3D mesh parts: lets you activate all the 3D mesh parts under the Nodes and Elements
set in the specification tree.
Connection mesh parts: lets you activate all the connection mesh parts under the Nodes
and Elements set in the specification tree.
Specification groups: lets you activate all the entity under the Restraints, Loads and
Masses sets in the specification tree.

b. Set the desired options.
c. Click OK in the Filter Groups dialog box.

For example, with the following analysis specification tree:

●

if you activate the User groups and the Specification groups options, the Available Groups
frame is updated as shown bellow:

Generative Structural Analysis
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if you activate the 3D mesh parts and the Specification groups options, the Available Groups
frame is updated as shown bellow:

Occurrences Tab
The Occurrences tab is available in the Image Edition dialog box only for multi-occurrence solutions.
This tab gives you the list of modes with the associated:
●

frequencies (Hz) for a Frequency Case and a Harmonic Dynamic Response Case

●

Buckling factor for a Buckling Case

Generative Structural Analysis
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Time (s) for a Transient Dynamic Response Case

Page 812

Generative Structural Analysis

Version 5 Release 14

Page 813

You can then activate separately each mode of the multi-occurrence solution.

More and Less Buttons

For more details on Values and Filters options, please click here.

Preview button
By default, the visualization process is launched after each modification in the Image Edition dialog box.
The Preview button allows you to launch the visualization process after performing all the needed
changes in the Image Edition dialog box.

The Preview button is available only if you deactivate the Automatic preview mode option in
the Options dialog box (Tools -> Options... menu).
For more details, please refer to the Customizing - Post Processing section of the Generative
Structural Analysis User's Guide.
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Advanced Edition for Images and Local
Sensors
This task describes the advanced edition of the values that are taken into account for the
visualization (advanced edition of images) or for the local sensors.

●

●

Values:
❍

Position

❍

Value type

❍

Complex part

❍

Do not combine

Filters:
❍

Show filters for

❍

Axis system

❍

Display locally

❍

Component

❍

Layer

❍

Lamina

❍

Ply id
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Values

●

Position: the position depends on the selected Type and Criteria option in the Visu tab.

Node

Linked to the mesh nodes.
For each node, there is only one value.

Node of element

For each node, there is as many values as elements linked to
this node.

Center of element

For each element center, there is only one value.

Edge of element

For each edge element, there is only one value.

Face of element

For each face element, there is only one value.

Element

For each element, there is only one value.

Gauss point of element The position of the Gauss points depend on the type of
element.
For more details, please refer to the Finite Element Reference
Manual.
"(from solver)" indicates that the position is provided by the solver.

To know more about the authorized position according to a selected Visu Type, please
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refer to the Frequently Asked Section - Post-Processing and Visualization section of the
Generative Structural Analysis User's Guide.
●

●

●

Value type: corresponds to the type of the value (integer, real, double precision, complex,
complex with double precision).
Complex part: the complex part is available when the selected Value Type is complex
and complex with double precision.
Do not combine:
❍
if this option is not activated, combined values will be displayed whenever available. The
desired resulting force will be displayed.
❍

if this option is activated, each specification (force, restraints and so forth) can be
displayed separately. You will use the Value set list box to choose the desired value
set.
For example, if three forces were applied on a single surface, three values will be
available in the Value set combo box. You can then select the desired Value set.

Filters

●

Show filters for: lets you select the entity type on which you will change the Axis System,
Component, Layer, Lamina and Ply id options.
The Show filters for option does not modify the feature you are editing.
The following options are available:
❍

❍

●

Nodes of 1D elements, Nodes of 2D elements or Nodes of 3D elements for a
Node position type.
1D elements, 2D elements or 3D elements for an Element position type.

Axis System: lets you select the current axis system to be used.
For this, click the ... button.

Generative Structural Analysis
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The Axis system functionality is only available if you installed the ELFINI
Structural Analysis (EST) product.

❍

The ... button is only available if you have selected Vector, Tensor, Vector
component or Tensor component as Criteria option.

❍

❍

❍

Global: lets you select the main axis system.

User: lets you select an axis system feature (created in the Part Design workbench or
the Generative Shape Design workbench).

Manual: lets you specify an axis system by defining the origin coordinates and the
different directions.

Generative Structural Analysis
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●
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Local: lets you select an axis system that is locally defined (related to a finite
element).

Display locally: lets you visualize the axis on each entity.
The Display locally functionality is only available
❍

if you installed the ELFINI Structural Analysis (EST) product.

❍

in the image edition context.
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❍

Display locally option deactivated with a Global axis system

❍

Display locally option activated with a Global axis system

Component: lets you select the component to visualize.
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For example, if you select a Translational displacement symbol image, you will get
the following Component options:
■

ALL: all the components
C1: components according to x in the current axis system
C2: components according to y in the current axis system
C3: components according to z in the current axis system
You can also have a combination of these components (for example, C1 & C2).

❍

For Stress principal tensors image:
■

In the case of 3D elements:
C11: is the maximum principal stress
C22: is the middle principal stress
C33: is the minimum principal stress
You can also have a combination of these components (for example, C11 & C22).

■

In the case of 2D elements:
C1: is the maximum principal stress
C2: is the minimum principal stress

●

Layer: (only available in the case of 2D elements).
In a lamina, you can select the Upper, Middle or Lower layer from which the results will
be computed.
If you installed the ELFINI Structural Analysis (EST) product, you can display
both the upper and lower layers according to local normal orientation using the
Upper and lower option.

●

Lamina: (only available in the case of 2D elements with composite property).

You can select the Lamina from which the results will be visualized.
●

Ply id: (only available in the case of 2D elements with composite property).

You can select the Ply id from which the results will be visualized.
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Filtering Mesh Parts
This task shows you how to use the Mesh Part Selection button in the Advanced Meshing
Tools workbench.

1. Click the Mesh Part Filter button

.

The Mesh Part Selector dialog box appears.

❍

Mesh Parts: lets you select the desired mesh parts.

❍

Remove: lets you remove a previously selected mesh part.

❍

Remove all: lets you remove all the selected mesh parts.

2. Select the desired Mesh Part.
3. Click OK in the Mesh Part Selector dialog box.
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Integration with Product Engineering
Optimization
This section gives you information about the analysis data authorized in the Product Engineering
Optimization (PEO) product.

For more details about the algorithm for constraints and derivatives providers, please refer to
the Product Engineering Optimization User's Guide - Basic Tasks - Using a Dedicated
Structural Analysis Algorithm.

What are the authorized sensors?
What are the restrictions?

What are the authorized sensors?
You can find here what are the analysis sensors authorized in the algorithm for derivatives providers
of the Product Engineering Optimization (PEO) product.

Authorized Sensors

Global Sensors

Mass

Local Sensors

All (except the Von Mises Stress local sensor) *

* only if the local sensor has been defined with None or Average as Post-Treatment option.
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What are the restrictions?
You can find here the restrictions when using analysis sensors in the derivatives computation.
●

Only the structural parameters (parameters that do not impact the mesh) will be taken into
account in the derivatives computation.
The geometrical parameters (those whose the variation invalidates the mesh) must not be taken
into account in the derivatives computation.
In the case of an analysis containing a 2D body and a 3D body:
❍

The Thickness parameter (defined in the 2D Property) can be referenced in the
optimization because its variation does not impact the 2D mesh.

❍

The Length parameter (defined in the Pad) cannot be referenced in the optimization
because its variation impacts the 3D mesh.

●

Analysis sensors will have to expose one single output parameter to be used as objectives inside
the Product Engineering Optimization (PEO) product:

●

❍

local sensor with post-treatment

❍

global sensor with a single output parameter

The sensors must have been defined in a mono-occurrence solution.
You cannot use analysis sensors belonging to a multi-occurrence solution (Frequency Case, a
Buckling Case or Dynamic Response Case) in the derivatives computation.
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Frequently Asked Questions
Here is a non-exhaustive list of frequently asked questions about the analysis products.
Entering the Generative Structural Analysis Workbench
Associativity
Connection
Data Mapping
Dynamic Response Analysis
Solver Computation
Post-processing and Visualization
Frequent Error Messages
Licensing
Integration with Product Engineering Optimization
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Entering the Generative Structural Analysis
Workbench
This section gives you information about problems you may encounter when entering the Analysis
Generative Structural Analysis workbench.
Why is no mesh part created when entering the workbench?
How to create a mesh part?

Why no mesh part is created when entering the
workbench?
Sometimes, no mesh part is created when entering the Generative Structural Analysis workbench.
You did not indicate in the Generative Shape Design workbench which geometry you want to be
analyzed.

For more information, please refer to How to create a mesh part?

How to create a mesh part?
Sometimes, no mesh part is created when entering the Generative Structural Analysis workbench.
For more information, please refer to Entering the Generative Structural Analysis Workbench.
You can create a mesh part in:
●

●

a Generative Shape Design context.
For this, select Tools -> External View commands from the menu bar in the Generative Shape
Design workbench and select the geometry to be analyzed
an analysis context.
For this, use the mesh creation functionalities:
❍
Creating 1D Mesh Parts.
❍

Creating 2D Mesh Parts.

❍

Creating 3D Mesh Parts.
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Associativity
Associativity means that any part modifications occurring outside the Analysis workbench are
automatically reflected when performing tasks within the Analysis workbench. In particular, any
parametric changes on the parts are automatically accounted for.
Analysis specifications (load, restraints, masses and virtual parts) can be applied to different types of
supports (or features):
●

Mechanical Feature (Pad, Fill, ...)

●

Geometrical Feature (Vertex, Face, ...)

●

Analysis Feature (Virtual Part, Mesh Part, Geometrical Groups, Free Groups, Proximity Groups,
...)

You will see in this section on which support analysis specifications can be applied.

In the following tables, the

symbol indicates that the feature is authorized.

If the only authorized Geometrical Feature is Face, the following supports are available (if
they are authorized):
●

all the faces of pad, or all the faces of a hole, ... as Mechanical Feature.

●

Surface Group as Geometrical Groups.

●

Surface Group by Neighborhood as Proximity Groups.

For example:
pressure is applied on pad means that pressure is applied to faces of pad.

On which supports can loads be applied?
On which supports can restraints be applied?
On which supports can masses be applied?
On which supports can properties be applied?
On which supports can virtual parts be applied?
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On which supports can loads be applied?
Load specifications can be applied to different types of supports (or features):

Supports
Geometrical

Mechanical

Feature

Feature

Analysis Feature

Free
Groups
Pressure

Distributed
Force

Geometrical Proximity
Groups

Groups

Others

Face

Point/Vertex
Edge
Face

Virtual
Part

(homogeneous
selection)
Moment

Point/Vertex
Edge
Face

Virtual
Part

(homogeneous
selection)
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Bearing Load
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Cylindrical
Surface
Cone
Revolution
surface

Imported
Force

Imported
Moment

Point/Vertex
Face

Point/Vertex
Face

Acceleration
Body 1D
Body 2D
Body 3D

Rotation Force
Body 1D
Body 2D
Body 3D

Mesh
Part
Virtual
Part

Mesh
Part
Virtual
Part

Line Force
Density

Edge

Surface Force
Density

Face

Volume Force
Density

Body 3D

Mesh
Part

Force Density
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Edge
Face
Body
(homogeneous
selection)

Enforced
Restraint

Displacement
Creating
Temperature
Field

Face

Mesh

Body

Part

On which supports can restraints be applied?
Restraint specifications can be applied to different types of supports (or features):

Supports

Clamps

Geometrical

Mechanical

Feature

Feature

Point/Vertex
Edge
Face

Surface
Sliders

Face

Analysis Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Virtual
Part
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Sliders

Virtual
Part

Sliding

Virtual

Pivots

Part

Ball Joins

Virtual

Point/Vertex

Part

Pivots

Virtual
Part

Advanced
Restraints

Point/Vertex

Virtual

Edge

Part

Face

On which supports can masses be applied?
Mass specifications can be applied to different types of supports (or features):

Supports

Analysis Feature
Geometrical

Mechanical

Feature

Feature

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Distributed
Mass
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Point/Vertex
Edge
Virtual

Face

Part
Homogeneous
selection
Line Mass
Densities

Edge

Surface
Mass

Face

Densities
Inertia on

Virtual

Virtual Parts

Part

On which supports can properties be applied?
Properties specifications can be applied to different types of supports (or features):

Supports

Analysis Feature
Geometrical

Mechanical

Feature

Feature

1D Property
Body 1D

Free

Geometrical

Proximity

Groups

Groups

Groups

Others

Mesh
Part
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Local 1D
Edge

Property

?

Imported
Beam

Body 1D

Property
2D Property

Mesh

Body 2D

Part

Local 2D
Face

Property

?

Composite

Mesh

Body 2D

Property

Part

3D Property

Mesh

Body 3D

Part

On which supports can virtual parts be applied?
Virtual Part specifications can be applied to different types of supports (or features):

Supports

Analysis Feature
Geometrical

Mechanical

Feature

Feature

All
Virtual
Parts

Edge
Face

Free

Geometrical

Proximity

Groups

Groups

Groups

Others
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Connection
This section gives you information about connections and properties available in the Generative
Assembly Structural Analysis (GAS) product.
What types of modeling do connections generate?
What type of property for what type of connection?

What types of modeling do connections generate?
When you associate a Connection Property to a Connection, finite elements will be automatically
generated.
The following table gives you the correspondence between connection properties and generated
finite element.

Connection Properties Type

Face Face

Distant

Connection Property

Generated Finite Element

Slider Connection Property

Slider Join

Contact Connection Property

Contact Join

Fastened Connection Property

Fastened Join

Fastened Spring Connection Property Fastened Join
Spring
Pressure Fitting Connection Property

Fitting Join

Bolt Tightening Connection Property

Tightening Join

Rigid Connection Property

Rigid Spider

Smooth Connection Property

Smooth Spider

Virtual Rigid Bolt Tightening
Connection Property

Tightening Beam
Rigid Spider

Virtual Spring Bolt Tightening
Connection Property

Tightening Beam
Spring
Smooth Spider

To know more about finite element, please refer to the Finite Element Reference Manual.
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What type of property for what type of connection?
When you want to use the connection properties of the Generative Assembly Structural Analysis
product, you first need to define a connection that the connection property will reference.
You can apply connection properties on Analysis Connections, Assembly Constraints, Welding
Joints or Joint Connections.
To know which connection properties can be applied on the desired connection, please refer to the
About Connection Properties section.
Certain connection properties need a few precisions.
For more details, please refer to the Precisions and Restrictions paragraph.
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Data Mapping
This section gives you information about the Data Mapping process.
Note that: this functionality is only available with the ELFINI Structural Analysis (EST) product

.

What is Data Mapping?
How are Data Mapping files filled?
Which algorithm is used for Data Mapping?
In which functionalities is the Data Mapping process available?

What is Data Mapping?
Data Mapping is a functionality allowing load import described by a scalar field from a text (.txt) or an Excel
(.xls) file. This file must respect a pre-defined format.
You can re-use data that are external data (experimental data or data coming from in-house codes or
procedures).
The imported values will be interpolated at the center of gravity of each element.
You can also integrate user loading knowledge and processes into this version.
The selected external data file will be either a .txt file (columns separated using the Tab key) or a .xls file. This
file must respect a pre-defined format.
Data Mapping is useful when you want to re-use a load field created without CATIA or with a former version of
CATIA.

How are Data Mapping files filled?
Data Mapping files are text files (.txt) or Excel files (.xls) that must respect a pre-defined format.
●

For pressure, line force density, surface force density, body load, temperature and shell property
functionalities, the data mapping file must respect the following format:
❍
four columns
❍

❍

the first three columns allow you to specify X, Y and Z point coordinates in the global axis.
Unit symbol written between parentheses must be specified.
the last one allows you to specify the amplification coefficient
No unit symbol must be specified for the last column (the amplification coefficient is not assigned to a
dimensional value).

Generative Structural Analysis

Version 5 Release 14

Page 836

Example of data mapping for a pressure:

●

For imported force and imported moment functionalities, the data mapping files must respect the following
format:
❍

❍

❍

six columns
the first three columns allow you to specify X, Y and Z point coordinates in the global axis.
Unit symbol written between parentheses must be specified.
the last three columns allow you to specify FX, FY and FZ force coordinates in the global axis in case of
imported forces or MX, MY and MZ moment coordinates in case of imported moment.
Unit symbol written between parentheses must be specified.

Example of data mapping for an imported force:
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Which algorithm is used for Data Mapping?
There are three steps in this algorithm:
1. Checking that the center of gravity of each element of the recipient mesh is inside the axis-aligned
bounding box of the source mesh (automatic tolerance: 1.0 e-6 m).
2. Matching the center of gravity of each element of the recipient mesh with some of the nearest points of
the scalar field.
❍

❍

These points are processed as if they were the vertex of a finite element.
The matching is done at the centers of gravity of the recipient mesh elements, and not at
their nodes, because it is the resulting loads location.

3. Interpolating the scalar field of the source mesh on the recipient mesh using the nodal functions of the
finite element.
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Version 5 Release 14

In which functionalities is the Data Mapping process
available?
The Data Mapping process is available in the following functionalities:
●

pressure

●

line force density

●

surface force density

●

body load

●

temperature field

●

shell property

●

imported force

●

imported moment
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Dynamic Response Analysis
This section gives you formulas to calculate excitation in a harmonic dynamic response case or in a
transient dynamic response case.
To know more about the load excitation and the restraint excitation, please refer to Defining a Load
Excitation Set and Defining a Restraint Excitation Set.
Note that: Excitation is only available with the Generative Dynamic Response Analysis (GDY)
product

.

Load excitation in frequency domain
Load excitation in time domain
Restraint excitation in frequency domain
Restraint excitation in time domain

Load excitation in frequency domain
The formula corresponding to the Load Excitation Set dialog box in a harmonic dynamic response
case is:

where:
●

f is a frequency

●

Fk is the static load

●

Mk(f) is the frequency modulation

●

●

is the phase
Ck is the factor

The user interface looks like:
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In this particular example:
k = 1 ; F1 = Loads.1 ; M1(f) = White Noise.1 = 1

f ; C1 = 1 ;

= 0 deg = 0 rad

Load excitation in time domain
The formula corresponding to the Load Excitation Set dialog box in a transient dynamic response
case is:

where:
●

t is the time

●

Fk is the static load

Generative Structural Analysis
●

Mk(t) is the time modulation

●

Ck is the factor
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The user interface looks like:

In this particular example:
k = 1 ; F1 = Loads.1 ; M1(t) = Time Modulation.1 ; C1 = 1
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Restraint excitation in frequency domain
The formula corresponding to the Restraint Excitation Set dialog box in a harmonic dynamic
response case is:

where:
●

●

●

●

f is the frequency
is the value of acceleration corresponding to the degree i of the vector
M i (f) is the frequency modulation corresponding to the degree i of the vector
is the phase corresponding to the degree i of the vector

The user interface looks like:
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In this particular example:
; M1(f) = White Noise.1 = 1
= 180 deg =

rad

f ; M2(f) = ... = M6(f) = 0 ;
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Restraint excitation in time domain
The formula corresponding to the Restraint Excitation Set dialog box in a transient dynamic
response case is:

where:
●

●

●

t is the time
is the value of acceleration corresponding to the degree i of the vector
M i (t) is the time modulation corresponding to the degree i of the vector

The user interface looks like:
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In this particular example:
; M1(t) = Time Modulation.1 ; M2(t) = M3(t) = 0
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Solver Computation
This section gives you information about the computation process.
How are element stresses computed?
How are node stresses computed?
How is error computed?
How are result and computation files managed?

How are element stresses computed?
Element stresses at Gauss points are the product of the Comportment Law and the Strain
Deformation.

is the element stress

●

●
❍

❍

●

is the Comportment Law, computed as a function of the following parameters, where:
is the Poisson Ratio
is the Young's Modulus

is the Strain deformation, computed according to the displacement.
For example, with a 2D displacement:

where

and

are the two partial derivatives.
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How are node stresses computed?
Node stresses are extrapolations of element stresses.
The method consists in defining a continuous stress field within the element:

where:
are the element shape functions

●

are the node stresses to be computed

●

These nodal stresses values are obtained using the least square minimization method:

where

are the stresses computed with the finite element method from the nodal displacements.

How is error computed?
There are two steps in the error computation:
1. Stress smoothing.
This method consists in computing a weighted nodal stress value at each nodes.
For more information about the nodal stresses values, please refer to How are
computed node stresses?
2. Error estimation.
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Once the nodal stresses values have been found, a continuous stress field is defined for
each element:

where:
are the element shape functions

❍

are the smoothed nodal stresses

❍

For more information about the nodal stresses values, please refer to How are
computed node stresses?
The error for each element (local error) is:

where:
❍

is the finite element solution field

❍

is the Comportment Law
For more information about the nodal Comportment Law, please refer to How are
computed element stresses?

The total error (Estimated Precision) is the sum of all the local errors:

And the Global Estimated Error Rate is:

where

is the global strain energy.
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How are result and computation files managed?
You can manage analysis results (contained in .CATAnalysisResults files) and analysis
computations (contained in .CATAnalysisComputations files):
●

●

●

Specify the path of an external storage file directory.
For more details, please refer to Specify External Storage.
Clear Elfini Storage in order to save space on your disk.
For more details, please refer to Clear External Storage.
Specify a temporary data directory for the CATElfini stored data and computation results.
For more details, please refer to Specify Temporary Data Directory.

You can also customize analysis default external storage (computation and result data) settings.
For more details, please refer to External Storage.

Version 5 Release 14

Generative Structural Analysis

Page 850

Post-processing and Visualization
This section gives you information about the visualization results.
What is the difference between Hide/Show and Activate/Deactivate?
How do you visualize the mesh?
What are the authorized position according to a visualization type?
How are Von Mises Stress computed?
How are local extrema computed?

What is the difference between Hide/Show and
Activate/Deactivate?

●

The Hide/Show contextual menu allows you to move the selected element to the invisible
space.
Note that you can visualize and modify elements you have hidden (using the Hide/Show
contextual menu) in the invisible space (as a second workspace).
To work in the invisible space and display the hidden elements, click the Swap Visible
Space icon

●

.

The Activate/Deactivate contextual menu allows you to destroy the screen representation of
the selected element and to regenerate its screen representation later.
This functionality is useful with a large size model to improve your computer performance.

How do you visualize the mesh?
You can visualize:
●

mesh, if you are working with the Nodes and Elements set

●

deformed mesh, if you are working with an Analysis Case set

Visualizing Mesh
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1. Launch the computation.

For this, click the Compute icon, select the Mesh only option and click OK in the Compute
dialog box.

For more information, please refer to Results Computation.
2. Right-click the Nodes and Elements set from the specification tree and select the Mesh
Visualization contextual menu.

If you select the Mesh Visualization contextual menu before the computation, a warning
message appears to inform you that the mesh needs to be updated.
This operation may take some time.
If you decide to update the mesh, a mesh only computation will be launched.

Visualizing Deformed Mesh
1. Launch the computation.

For this, click the Compute icon, select the All option and click OK in the Compute dialog
box.

For more information, please refer to Results Computation.
2. Generate a Deformed Mesh image on the part.
For more information, please refer to Visualizing Deformations.

Version 5 Release 14

Generative Structural Analysis

Page 852

What are the authorized positions according to a
visualization type?
The authorized positions depend on the representation type:

VISU Type

Node
Position

Element Position

Node

Gauss
Center
Edge of Face of
Node of
Element point of
of
element element
element
element element

Average iso
Discontinuous iso
Fringe
Symbol
Text
The solver process gives results only for certain positions that are not always authorized or really
useful.
Results need to be post-treated.
The post-treatment can be either a smoothing (element to node) or an extrapolation (node to
element).

For a smoothing post-treatment, the way of computing average values changed according to
the different versions of CATIA:
●

before CATIA V5 Release 5:
The solver process takes into account all the linked elements.

●

from CATIA V5 Release 5 to CATIA V5 Release 9:
The solver process takes into account an element only if this element had at least two
nodes on the skin.

●

from CATIA V5 Release 10:
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The solver process takes into account all the elements linked to a node, but a weighting
is done according to the distance between this node and the center of gravity of the
elements.

How are Von Mises Stress computed?
You can obtain a Von Mises Stress (nodal values) image using the:

1. dedicated icon

.

For this, click the Von Mises Stress icon

2. image edition (only available if you installed the ELFINI Structural Analysis (EST)
product).

a. Click the Principal Stress icon

.

b. Double-click the Stress principal tensor symbol image in the specification tree
c. Select the Average iso visualization type and then the Von Mises criteria in the
Image Edition dialog box:

Generative Structural Analysis
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d. Click OK in the Image Edition dialog box.

The Von Mises Stress (nodal values) values displayed using the Von Mises Stress icon and the
Von Mises Stress (nodal values) values displayed from the edition of the Stress principal
tensor symbol image can locally produce different results due to two computation modes:

1. In the first case (icon), the solver computation gives directly the result and then the postprocessing performs a smoothing (element to node).
2. In the second case (edit), the solver calculates the principal stress tensor, then the postprocessing performs a smoothing (element to node), diagonalizes the matrix, and calculates
values using the following formula:
and

are the principal stresses.

where

,
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The first method requires less time and less performance.

How are local extrema computed?
A node (or an element) is a local extrema if it is an extrema compared to the nodes (or elements)
belonging to the two rings.
The number of maximum local extrema is defined by an ascending sort; the number of minimum
local extrema is defined by a descending sort.
These rings are defined as follow:
●

For a node:

●

For an element:
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Frequent Error Messages
This section gives you information and solutions when an error message appears.
Why does the "Singularity detected" error message appear?
Why does the "Entity cannot be updated" error message appear?

Why does the "Singularity detected" error message
appear?
If a singularity is detected while launching the computation operation, the following error message
appears:

The part or the product is not fully constrained. You have to add the missing specifications.
To find the missing specifications you can generate deformations images (Visualizing
Deformations) or displacements image (Visualizing Displacements) and then animate the
generated image (Animating Images).
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For example, you can open the sample31.CATAnalysis document from the samples
directory.

1. Click the Compute icon

, select the All option in the Compute dialog box and

click OK.
As a result an error message appears.
In addition, an exclamation mark

lets you know in the specification

tree (assigned to the Case solution feature) that a singularity was
detected. This exclamation mark will appear either when you
expand/collapse the tree or still when adding or updating a generated
image. In other words, you will be able to know, visually speaking, which
computed solutions are singular and which computed solutions are not
singular.
2.

Click OK in the Error message dialog box.

3. Click the Deformation icon

. Note that as the computation failed, only the

Deformation type of image is available.

4. Click the Animate icon

to understand why singularity was detected. Most

commonly, the reasons are that a restraint or a connection is missing.

5. In this particular case, you need to assign a restraint (for example a Clamps
to the part.

)

Generative Structural Analysis

6. Click the Compute icon
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.

Why does the "Entity cannot be updated" error
message appear?

Some inconsistencies were found on the part or the product.

Check the model to find which specifications are not consistent with the part or the
product.
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Licensing
This section gives you information about the licensing in the Generative Structural Analysis
workbench.
What are the available products in the Generative Structural Analysis Workbench?
Which functionality belongs to which product?
Which contextual menu belongs to which product?

What are the available products in the Generative
Structural Analysis workbench?
The Generative Structural Analysis workbench includes the following products:
GPS: Generative Part Structural Analysis (P2)
Addresses transparent and automatic stress and vibration analysis for parts, integrating simulation
and design specifications, with the core application of V5 analysis.
EST: ELFINI Structural Analysis (P2)
Performs advanced pre, post processing and solving with complementary analysis options.
GAS: Generative Assembly Structural Analysis (P2)
Addresses transparent, integrated and automatic stress and vibration analysis for assemblies of
parts integrating simulation and design specifications.
GDY: Generative Dynamic Response Analysis (P2)
Gives access to the functionalities of dynamic computations.

Positioning the products
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Which functionality belongs to which product?
The following table shows you in which product you will access the analysis functionalities:
Analysis Cases
Static Case

GP1

*

GPS

EST GAS GDY

*

Static Constrained Case
Frequency Case

*

Buckling Case
Combined Case
Harmonic Dynamic
Response
Transient Dynamic
Response

* some functionalities in these commands are only available if you
previously installed EST product (for more details see the
documented task itself).
Modulation

GP1

GPS

EST GAS GDY

GP1

GPS

EST GAS GDY

White Noise Modulation
Import Frequency
Modulation
Import Time Modulation
Model Manager
3D Mesh Part
2D Mesh Part
1D Mesh Part
Local Mesh Sizes
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Local Mesh Sags
Element Type
3D property
2D property

*

Imported composite
property
1D property

*

Imported Beam Property
Check the Model
User Material

* some functionalities in these commands are only available if you
previously installed EST product (for more details see the
documented task itself).
Mesh Specifications

GP1

GPS

EST GAS GDY

GP1

GPS

EST GAS GDY

GP1

GPS

EST GAS GDY

Adaptivity Boxes
Groups
Group Points
Group Lines
Group Surfaces
Group Bodies
Box Group
Sphere Group
Point Group by
Neighborhood
Line Group by
Neighborhood
Surface Group by
Neighborhood
Analysis Connections
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General Connections
Point Analysis Connections
Point Analysis Connections
within one Part
Line Analysis Connections
Line Analysis Connections
within one Part
Surface Analysis
Connections
Surface Analysis
Connections within one
Part
Connection Properties
Fastened Connection
Property
Fastened Spring
Connection Property
Slider Connection Property
Contact Connection
Property
Pressure Fitting Connection
Property
Bolt Tightening Connection
Property
Virtual Rigid Bolt
Tightening Connection
Property
Virtual Spring Bolt
Tightening Connection
Property
Rigid Connection Property
Smooth Connection
Property
User-Defined Distant
Connection Properties
Spot Welding Connection
Properties
Seam Weld Connection
Properties

GP1

GPS

EST GAS GDY
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Surface Weld Connection
Properties
Virtual Parts

GP1

GPS

EST GAS GDY

GP1

GPS

EST GAS GDY

Rigid Virtual Parts
Smooth Virtual Parts
Contact Virtual Parts
Rigid Spring Virtual Parts
Spring Smooth Virtual
Parts
Periodicity Conditions
Mass Equipment
Distributed Mass

*

Line Mass Densities

*

Surface Mass Densities

*

Inertia on Virtual Parts

* some functionalities in these commands are only available if you
previously installed EST product (for more details see the
documented task itself).
Restraints

GP1

GPS

Clamps

*

*

Surface Sliders

*

*

Ball Joins

*

*

Sliders

*

*

Pivots

*

*

Sliding Pivots

*

*

Advanced Restraints

*

*

Iso-static Restraints

*

*

EST GAS GDY
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* some functionalities in these commands are only available if you
previously installed EST product (for more details see the
documented task itself).
Loads

GP1

GPS

Pressures

*

*

Distributed Force

*

*

Moment

*

*

Line Force Density

*

*

Surface Force Density

*

*

Body Force

*

*

Acceleration

*

*

Rotation Force

*

*

Enforced Displacement

*

*

EST GAS GDY

Bearing Load
Importing Forces
Importing Moments

Force Density

Creating Temperature Field

* some functionalities in these commands are only available if you
previously installed EST product (for more details see the
documented task itself).
Sensors

GP1

GPS

Create Global Sensors
Create Local Sensors
Create Reaction Sensors

*

EST GAS GDY

Page 865

Version 5 Release 14

Generative Structural Analysis

* some functionalities in these commands are only available if you
previously installed EST product (for more details see the
documented task itself).
Results Computation

GP1

GPS

EST GAS GDY

Specify External Storage
Clear External Storage
Temporary Data Directory
Computing Object sets

*

Computing with Adaptivity

*
*

Computing using a Batch

* some functionalities in these commands are only available if you
previously installed EST product (for more details see the
documented task itself).
Results Visualization

GP1

GPS

Visualize Deformation

*

*

Visualize Von Mises
Stresses

*

*

Visualize Displacements

*

*

Visualize Principal Stresses

*

*

Visualize Precisions

*

*

Reporting
Advanced Reporting
Historic of Computation
Elfini Listing
Animate Image
Cut Plane Analysis

EST GAS GDY
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Amplification Magnitude
Extrema Detection
Information
Images Layout
Simplified Representation

* some functionalities in these commands are only available if you
previously installed EST product (for more details see the
documented task itself).

Which contextual menu belongs to which product?
The following table shows you in which products you will access the contextual menus.
Contextual Menu

Element Model set

restraints

GP1 GPS EST GAS GDY

on Finite

on
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pressure

on

for sensor

modulation

response solutions

for

for dynamic

* some functionalities in these contextual menus are only available
if you previously installed EST product (for more details see the
documented task itself).
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Integration with Product Engineering
Optimization
This section gives you information about the analysis data authorized in the Product Engineering
Optimization (PEO) product.

For more details about the algorithm for constraints and derivatives providers, please refer to
the Product Engineering Optimization User's Guide - Basic Tasks - Using a Dedicated
Structural Analysis Algorithm.

What are the authorized sensors?
What are the restrictions?

What are the authorized sensors?
You can find here what are the analysis sensors authorized in the algorithm for derivatives providers
of the Product Engineering Optimization (PEO) product.

Authorized Sensors

Global Sensors

Mass

Local Sensors

All (except the Von Mises Stress local sensor) *

* only if the local sensor has been defined with None or Average as Post-Treatment option.
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What are the restrictions?
You can find here the restrictions when using analysis sensors in the derivatives computation.
●

Only the structural parameters (parameters that do not impact the mesh) will be taken into
account in the derivatives computation.
The geometrical parameters (those whose the variation invalidates the mesh) must not be taken
into account in the derivatives computation.
Open the sample17.CATAnalysis document from the samples directory. In this particular
example, you can find a 2D body and a 3D body.
❍

The Thickness parameter (defined in the 2D Property) can be referenced in the
optimization because its variation does not impact the 2D mesh.

❍

The Length parameter (defined in the Pad) cannot be referenced in the optimization
because its variation impacts the 3D mesh.

●

Analysis sensors will have to expose one single output parameter to be used as objectives inside
the Product Engineering Optimization (PEO) product:

●

❍

local sensor with post-treatment

❍

global sensor with a single output parameter

The sensors must have been defined in a mono-occurrence solution.
You cannot use analysis sensors belonging to a multi-occurrence solution (Frequency Case, a
Buckling Case or Dynamic Response Case) in the derivatives computation.
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Glossary

A
acceleration

A load that generates a uniform acceleration field over a
part.

adaptivity boxes

The local specifications relative to the maximum error in
the approximate computed solution relative to the exact
solution.

adaptivity process

Any specification required for managing the process that
will let you perform adaptativity computation (remeshing).

assembly

A set of parts, each parts being associated with a material
and linked possibly to another one by the means of a
connection. Assemblies can be modeled with the product
Generative Assembly Structural Analysis.

analysis connection

An assembly connections used to specify the boundary
interaction between bodies in an assembled system. Once
the geometric assembly positioning constraints are
defined at the Product level, the user can specify the
physical nature of the constraints.
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A combination of three normal and unit sized vectors
which defines a reference to express geometric entities
coordinates. There are two different axis systems called:
●

●

reference axis system (which corresponds to the
model Axis System).
local axis system, whose vectors are normal or
tangent to the selected geometry. The presence of
material on one side of the selected geometry does
not influence the choice of the vectors directions but
the nature of the geometric element determinates
whether the local axis system will be Cartesian,
circular or revolute.

The reference axis system is symbolized at two locations:
the bottom and right side of the workbench (without its
origin) and at is real place: the model origin.

B
ball join

A restraint (or boundary condition) that generates
spherical joins (balls), which allow a rigid body to rotate
about a given point (fixes all translation degrees of
freedom of a point).

bearing load

A load that simulates contact loads applied to cylindrical
parts.

body force

A load type including volume body force and mass body
force. This load type is based on the body of the part
(that is, its geometry and possibly its mass density).
Therefore, body forces represent intensive (volume
density-type) quantities, as opposed to forces which are
extensive (resultants, i.e., integrals over regions)
quantities.
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An analysis connection that takes into account pretension in bolt-tightened assemblies by simulating the
tightening between a bolt and a screw.

boundary condition

Please refer to restraint.

buckling case

A procedure for the computation of the system buckling
critical loads and buckling modes for a given Static
Analysis Case.

C
clamp

A restraint (or boundary condition) applied to surface or
line geometries of the part, for which all points are to be
blocked (by imposing their translation value) in the
subsequent analysis.

computation data

Path to an external storage file directory.

connection

A set of constraints between parts at their common
interface or a set of constraint modeled by the means of a
virtual body between two parts. Using connections, the
user can model an assembly prior to analyze it.

CONSTR-N

A Finite Element type enabling points of a geometry that
are linked together and free to translate in order to
preserve the average behavior.
For example, imposing a translation to such a linked
group enables all of the included points, free to translate
differently than the imposed translation but the center of
mass of the group must correspond to the imposed
behavior: the imposed translation. According to the type
of the imposed mechanical behavior (kinematical
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constraint or load) the corresponding kinematical, static
or dynamic tensor will be respected at the center of mass
of the selected group.
This particular element is sufficient to model a smooth
interface.

contact element

A Finite Element type enabling two linked points free to
translate prevented that the linear contact condition is
respected. Once the linear contact condition is reached,
the contact element behaves like a RIG-BEAM element.
The linked points are only free to translate along the two
normal directions of the beam.

contact connection

An analysis connection that prevents bodies from
penetrating each other at a common interface.

D
distributed force

A load that generates a distributed force system
equivalent to a pure force at a point (given force
resultant and zero moment resultant).

distributed mass equipment

A non-structural lumped mass distribution equivalent to a
total mass concentrated at a given point.

E
enforced displacement

A load that assigns non-zero displacement values to
restrained geometric selections.
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A file of the directory where this structured computed
data is stored. The link between the .CATAnalysis
document and the External Storage is maintained after
the end of a session, in a way similar to the link between
a .CATPart document and the associated .CATAnalysis
document.

F
fastened connection

An analysis connection that fastens bodies together at
their common interface.

finite element model

Models with representations used for performing
computer-aided engineering analysis (CAEA) of products.
They are complementary to computer-aided design (CAD)
models, which are mainly geometric representations of
products.

force

A force-type load, including tractions, distributed forces
and forces transmitted through a virtual rigid body. The
latter includes contact, rigid and smooth transmission
types.

frequency case

A procedure for the computation of the system vibration
frequencies and normal modes for a given non-structural
mass distribution under given restraints.

I
image

A 3D visualization of analysis results on the Finite
Element Modeler mesh.
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A statically speaking determinated support generated on
a part.

L
line mass density

A scalar line mass field of given uniform intensity on a
curve geometry.

line force density

A load that generates a line force field of given uniform
intensity on a part edge.

links manager

All the links managed from the CATAnalysis document to
other documents: a part, result data or computation data.

load

A distributed force system equivalent to given static
resultants, force densities of given intensity or
acceleration fields.

M
mass

Non-structural mass densities of given intensity.

mass equipment

An additional mass attached to the geometry (point, line
or surface) of the part. It represents a scalar, purely
inertial (non-structural) load.

material property

A link to the material (either 2D or 3D) assigned to the
part: name, support and thickness.

Generative Structural Analysis

moment

Version 5 Release 14

Page 877

A transmitted moment-type load, which includes rigid and
smooth transmission types.
A load that generates a distributed force system
equivalent to a pure couple (given moment resultant and
zero force resultant).

O
OCTREE tetrahedron mesh

Automatic mesh specifications generating tetrahedron
mesh elements and using OCTREE methods.

P
part

A 3D entity obtained by combining different features in
the Part Design workbench. Please see Part Design User's
Guide for further information.

pivot

A restraint (or boundary condition) that generates conical
joins (hinges), which allow a rigid body to rotate around a
given axis (fixes all degrees of freedom of a point, except
for one rotation).

pressure

A load that generates pressure loads over a surface.

pressure fitting

An assembly type which can be modeled with a virtual
restraint or a force, both transmitted through contact.
Only normal loads can be applied or transmitted with
such modeling. So moment transmission through this
interface cannot be analyzed.

pressure fitting connection

An analysis connection that prevents bodies from
penetrating each other at a common interface.
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Any specification linked to physical properties: material
and thickness (surface).

R
restraint

or boundary conditions
Any combination of degrees of freedom on a geometry
selection.
Generated restraining joins, either on a geometry
selection or on a virtual part or still various types of
degree of freedom restraints.

resultant

For the Generative Part Structural Analysis product, the
resultant indicates an extensive quantity, an integral over
a region, opposed to an intensive quantity which indicates
a surface (or volume) density-type quantity.

result data

Path to an external storage file directory.

RIG-BEAM

A Finite Element type that rigidly links two points.

rigid connection

An analysis connection that fastens bodies together at a
common rigid interface.

rotation force

A load that generates a linearly varying acceleration field
over a part.

S
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Global sag is the general maximum tolerance between
discretization and the real part used for the computation.
Local sag is the maximum tolerance between
discretization and the real part applied locally, to a
chosen area of the model specified by the user.

sensors

A synthesis of analysis results which provide measures
that can be re-used in Knowledgeware.

sensor set

A set of different types of object can be generated:
●

●

●

size

Static case: misesmax (Maximum von Mises),
dispmax (Maximum Displacement), reaction
(Reaction on geometry associated to restrain and
connection specifications) and globalerror
Frequency case: Frequency (Represents the
frequency value) and Frequencies (Represents the
list of the frequency values)
Buckling case: Buckling Factor

Global size is the general size of the longest edge of the
finite elements used for the computation.
Local size is an element size different to the general
element size and applied locally, to a chosen area of the
model specified by the user.

spot welding connection

An analysis connection that fastens bodies together at a
common soft interface.

SPRING

Finite element type which has an elastic behavior along
all its degrees of freedom. This element models ideally
elastic interfaces between parts.
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A generalization of the clamp restraint in the sense that
you can release some of the clamped directions thus
allowing the part to slide along the released translation
directions.

slider connection

An analysis connection that fastens bodies together at
their common interface in the normal direction while
allowing them to slide relative to each other in the
tangential directions.

sliding pivot

A restraint (or boundary condition) that generates
cylindrical joins (actuators) which allow a rigid body to
translate about and rotate around a given axis (fixes all
degrees of freedom of a point, except for one translation
and one rotation).

smooth connection

An analysis connection that fastens bodies together at a
common soft interface.

static case

A procedure for the computation of the system response
to applied static loads under given restraints.

storage (external)

An optional computation mode that enables the user to
define a directory path where a temporary file will receive
solver data during the computation.

surface force density

A load that generates a surface traction field of given
uniform intensity on a part face.

surface mass density

A scalar surface mass field of given uniform intensity on a
surface geometry.

Generative Structural Analysis
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A restraint (or boundary condition) that generates surface
constraint joins, which allow points of a surface to slide
along a coinciding rigid surface (fixes the translation
degree of freedom for a surface in the direction of the
local normal).

T
traction

An intensive (surface density-type) quantity, as opposed
to forces which are extensive (that is, resultant)
quantities.

V
virtual restraint

A restraint applied indirectly to the part, through the
action of a virtual rigid body. The interface specifications
(smooth rigid or contact transmission) are selected by the
user.

virtual rigid bolt tightening

An analysis connection that takes into account pre-

connection

tension in a bolt-tightened assembly with a non-included
bolt and an ideal screw.

virtual spring bolt tightening

An analysis connection that specifies the boundary

connection

interaction between bodies in an assembled system.
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1D mesh
1D Property
command
2D display
editing parameters
for dynamic response solution
for modulation
for sensors
2D mesh
2D Property
command
3D mesh
3D Property
command

A
Acceleration
command
Activate/Deactivate
contextual menu
Adaptivity
toolbar
adaptivity
global
local
adaptivity, managing
advanced edition for images and local sensors
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advanced report
Advanced Reporting
command
Advanced Restraint
command
Amplification Magnitude
command
Analysis Assembly
toolbar
analysis assembly
basic concept
graph
methodology
Analysis Assembly 2D Viewer
command
analysis case
buckling
combined
frequency
harmonic dynamic response
static
static constrained
transient dynamic response
analysis connection
general
line
line within one part
point
point within one part
surface
surface within one part
Analysis Connections
toolbar
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analysis external storage
analysis general settings
analysis graphical settings
analysis post processing setting
analysis quality settings
Analysis Results
toolbar
analysis results
analysis settings
customizing
analysis symbol
Analysis Tools
toolbar
Analyze Group
contextual menu
Animate
command
animating, image
associativity

B
Ball Join
command
Basic Analysis Report
command
basic concept
analysis assembly
batch, computing using a
beam
mesh
Beam Mesher
command
beam property, importing
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Bearing Load
command
bearing load, creating
Body Force
command
Body Group
command
body, grouping
Bolt Tightening Connection Property
command
Box Group
command
box, grouping based on
buckling
computing a buckling solution
inserting a buckling case

C
Change Type
contextual menu
changing element type
checking, model
Clamp
command
color palette
editing
locking
combined case, inserting
command
1D Property
2D Property
3D Property
Acceleration
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Advanced Reporting
Advanced Restraint
Amplification Magnitude
Analysis Assembly 2D Viewer
Animate
Ball Join
Basic Analysis Report
Beam Mesher
Bearing Load
Body Force
Body Group
Bolt Tightening Connection Property
Box Group
Clamp
Compute
Compute with Adaptivity
Contact Connection Property
Contact Virtual Part
Cut Plane Analysis
Deformation
Displacement
Distributed Force
Distributed Mass
Element Type
Elfini Listing
Enforced Displacement
External Storage
External Storage Clean-up
Fastened Connection Property
Fastened Spring Connection Property
Force Density
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General Analysis Connection
Historic of Computations
Image Extrema
Image Layout
Import From File
Imported Beam Property
Imported Composite Property
Imported Force
Imported Moment
Inertia on Viratual Part
Information
Isostatic Restraint
Line Analysis Connection
Line Analysis Connection Within One Part
Line Force Density
Line Group
Line Group by Neighborhood
Line Mass Density
Local Mesh Sag
Local Mesh Size
Model Check
Moment
New Adaptivity Entity
Octree Tetrahedron Mesher
Octree Triangle Mesher
Periodicity Conditions
Pivot
Point Analysis Connection
Point Analysis Connection Within One Part
Point Group
Point Group by Neighborhood
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Precision
Pressure
Pressure Fitting Connection Property
Principal Stress
Rigid Connection Property
Rigid Spring Virtual Part
Rigid Virtual Part
Rotation
Seam Weld Connection Property
Slider
Slider Connection Property
Sliding Pivot
Smooth Connection Property
Smooth Spring Virtual Part
Smooth Virtual Part
Sphere Group
Spot Welding Connection Property
Stress Von Mises
Surface Analysis Connection
Surface Analysis Connection Within One Part
Surface Force Density
Surface Group
Surface Group by Neighborhood
Surface Mass Density
Surface Slider
Surface Weld Connection Property
Temperature Field
Temperature Field from Thermal Solution
Temporary External Storage
Time Modulation Imported From File
User Material
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User-Defined Distant Connection Property
Virtual Bolt Tightening Connection Property
Virtual Spring Bolt Tightening Connection Property
White Noise
composite
computation
error
node stresses
reading a historic
stresses
Compute
command
toolbar
Compute with Adaptivity
command
computing
buckling solution
frequency solution
harmonic dynamic response solution
objects sets
static constrained solution
static solution
transient dynamic response solution
using a batch
Connection
toolbar
connection property
bolt tightening
contact
fastened
fastened spring
pressure fitting
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rigid
seam weld
slider
smooth
spot welding
surface weld
user-defined distant
virtual bolt tightening
virtual spring bolt tightening
Contact Connection Property
command
Contact Virtual Part
command
contextual menu
Activate/Deactivate
Analyze Group
Change Type
Create Global Sensor
Create Local Sensor
Create Reaction Sensor
Export Data
Expot Data...
Generate 2D Display
Generate Image
Load
Local 1D Property
Local 2D Property
Local Adaptivity
Save As New Template
Unload
Update All Groups
Update Group
Create Global Sensor
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contextual menu
Create Local Sensor
contextual menu
Create Reaction Sensor
contextual menu
creating
clamp
distributed force
global sensor
local sensor
moment
reaction sensor
creating images
creation, extrema
customizing
analysis settings
cut plane
Cut Plane Analysis
command

D
damping
data mapping
Deformation
command
deformation, visualizing
deformed mesh
Displacement
command
displacement, visualizing
Distributed Force
command
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Distributed Mass
command
dynamic excitation formula
dynamic response
dynamic response set
inserting a harmonic dynamic response case
inserting a transient dynamic response case

E
editing
2D display parameters
color palette
image
user isotropic material
Element Type
command
element type, changing
Elfini Listing
command
Enforced Displacement
command
entering the Generative Structural Analysis
error
computation
error maps, visualizing
error messages
estimated local error image
export 2D Display data
Export Data
contextual menu
Expot Data...
contextual menu
External Storage
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command
external storage
clearing
specifying
temporary
External Storage Clean-up
command
extrema, creation

F
Fastened Connection Property
command
Fastened Spring Connection Property
command
FICELF file
finite element model, creating
force
importing
Force Density
command
free groups
frequency
computing a frequency solution
inserting a frequency case
frequency modulation
imported from an existing file
frequent error messages

G
general
analysis connection
General Analysis Connection
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command
Generate 2D Display
contextual menu
Generate Image
contextual menu
generating, image
geometrical groups
global
adaptivity
global sensor
group
free
geometrical
proximity
grouping
based on box
based on sphere
body
line
point
surface
grouping by neighborhood
line
point
surface
Groups
toolbar

H
harmonic dynamic response solution
computing
historic of computation, reading a
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Historic of Computations
command

I
Image
toolbar
image
animating
editing
generating
image creation
Image Edition dialog box
Image Extrema
command
Image Layout
command
images
advanced edition
Import From File
command
Imported Beam Property
command
Imported Composite Property
command
Imported Force
command
Imported Moment
command
importing
force
moment
temperature field
improving performances on multi-processor computers
Inertia on Viratual Part
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command
inertia relief
Information
command
inserting
buckling case
combined case
frequency case
harmonic dynamic response case
static case
static constrained case
transient dynamic response case
integration with Product Engineering Optimization
Isostatic Restraint
command

K
knowledge parameters for sensors

L
licensing
line
analysis connection
Line Analysis Connection
command
Line Analysis Connection Within One Part
command
Line Force Density
command
Line Group
command
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Line Group by Neighborhood
command
Line Mass Density
command
line within one part
analysis connection
line, grouping
line, grouping by neighborhood
listing
Load
contextual menu
toolbar
load
acceleration
bearing load
body force
distributed force
enforced displacement
force density
imported force
line force density
moment
pressure
rotation force
surface force density
temperature field
temperature field from thermal solution
load excitation
local
adaptivity
Local 1D Property
contextual menu
Local 2D Property
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contextual menu
Local Adaptivity
contextual menu
Local Mesh Sag
command
Local Mesh Size
command
local sensor
local sensors
advanced edition
locking
color palette

M
managing, adaptivity
Mass
toolbar
mass
distributed mass
line mass density
surface mass density
mass equipment
material
physical properties
mesh
1D or beam
2D
3D
methodology
analysis assembly
Model Check
command
Model Manager
toolbar
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model manager
Modulation
toolbar
modulation
white noise
Moment
command
moment
creating
importing
multi-processor computers

N
New Adaptivity Entity
command
node stresses
computation

O
Octree Tetrahedron Mesher
command
Octree Triangle Mesher
command

P
Periodicity Conditions
command
physical properties
material
Pivot
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command
point
analysis connection
Point Analysis Connection
command
Point Analysis Connection Within One Part
command
Point Group
command
Point Group by Neighborhood
command
point within one part
analysis connection
point, grouping
point, grouping by neighborhood
post-processing
resuts and images
Precision
command
precision, visualizing
Pressure
command
Pressure Fitting Connection Property
command
Principal Stress
command
principal stress, visualizing
property
1D
2D
3D
composite
imported beam
local 1D
local 2D
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proximity group

R
reaction sensor
report
Restraint
toolbar
restraint
advanced
ball join
clamp
iso-static restraint
pivot
slider
sliding pivot
surface slider
restraint excitation
result visualization
Rigid Connection Property
command
Rigid Spring Virtual Part
command
Rigid Virtual Part
command
rigid virtual part
Rotation
command
rotation force

S
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Save As New Template
contextual menu
Seam Weld Connection Property
command
self-balancing on loads set
sensor
displaying knowledge parameters
global
local
reaction
singularity
slave process
Slider
command
Slider Connection Property
command
Sliding Pivot
command
Smooth Connection Property
command
Smooth Spring Virtual Part
command
Smooth Virtual Part
command
solver computation
solver process
Solver Tools toolbar
specification
local mesh sag
local mesh size
specification tree, analysis
Sphere Group
command
sphere, grouping based on
Spot Welding Connection Property
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command
static
computing a static solution
inserting a static case
static constrained
computing a static constrained solution
inserting a static constrained case
Stress Von Mises
command
stresses
computation
surface
analysis connection
Surface Analysis Connection
command
Surface Analysis Connection Within One Part
command
Surface Force Density
command
Surface Group
command
Surface Group by Neighborhood
command
Surface Mass Density
command
Surface Slider
command
Surface Weld Connection Property
command
surface within one part
analysis connection
surface, grouping
surface, grouping by neighborhood
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T
Temperature Field
command
Temperature Field from Thermal Solution
command
template, save as new
Temporary External Storage
command
temporary external storage, specifying
time modulation
imported from an existing file
Time Modulation Imported From File
command
toolbar
Adaptivity
Analysis Assembly
Analysis Connections
Analysis Results
Analysis Tools
Compute
Connection
Groups
Image
Load
Mass
Model Manager
Modulation
Restraint
Solver Tools
Virtual Part
Tools Options - Analysis and Simulation
External Storage
General
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Graphics
Post Processing
Quality
transient dynamic response solution
computing
translational displacement

U
Unload
contextual menu
Update All Groups
contextual menu
Update Group
contextual menu
user isotropic material
editing
User Material
command
User-Defined Distant Connection Property
command
utility
AnalysisUpdateBatch

V
Virtual Bolt Tightening Connection Property
command
Virtual Part
toolbar
virtual part
contact
rigid
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rigid spring
smooth
smooth spring
Virtual Spring Bolt Tightening Connection Property
command
visualization
visualization, results
visualizing
deformation
displacement
precision
principal stress
Von Mises Stress
Von Mises Stress, visualizing

W
White Noise
command
white noise modulation
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